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Notice
While reasonable efforts were made to ensure that the information in this 
document was complete and accurate at the time of printing, Avaya Inc. can 
assume no liability for any errors. Changes and corrections to the information 
in this document might be incorporated in future releases.

Documentation disclaimer
Avaya Inc. is not responsible for any modifications, additions, or deletions to 
the original published version of this documentation unless such modifications, 
additions, or deletions were performed by Avaya. Customer and/or End User 
agree to indemnify and hold harmless Avaya, Avaya's agents, servants and 
employees against all claims, lawsuits, demands and judgments arising out of, 
or in connection with, subsequent modifications, additions or deletions to this 
documentation to the extent made by the Customer or End User. 

Link disclaimer
Avaya Inc. is not responsible for the contents or reliability of any linked Web 
sites referenced elsewhere within this documentation, and Avaya does not 
necessarily endorse the products, services, or information described or offered 
within them. We cannot guarantee that these links work all the time and we 
have no control over the availability of the linked pages.

Warranty
Avaya Inc. provides a limited warranty on this product. Refer to your sales 
agreement to establish the terms of the limited warranty. In addition, Avaya�s 
standard warranty language, as well as information regarding support for this 
product, while under warranty, is available through the Avaya Support Web 
site:
http://www.avaya.com/support 

License
USE OR INSTALLATION OF THE PRODUCT INDICATES THE END USER'S 
ACCEPTANCE OF THE TERMS SET FORTH HEREIN AND THE GENERAL 
LICENSE TERMS AVAILABLE ON THE AVAYA WEB SITE http://
support.avaya.com/LicenseInfo/ ("GENERAL LICENSE TERMS"). IF YOU DO 
NOT WISH TO BE BOUND BY THESE TERMS, YOU MUST RETURN THE 
PRODUCT(S) TO THE POINT OF PURCHASE WITHIN TEN (10) DAYS OF 
DELIVERY FOR A REFUND OR CREDIT.
Avaya grants End User a license within the scope of the license types 
described below. The applicable number of licenses and units of capacity for 
which the license is granted will be one (1), unless a different number of 
licenses or units of capacity is specified in the Documentation or other 
materials available to End User. "Designated Processor" means a single 
stand-alone computing device. "Server" means a Designated Processor that 
hosts a software application to be accessed by multiple users. "Software" 
means the computer programs in object code, originally licensed by Avaya and 
ultimately utilized by End User, whether as stand-alone Products or 
pre-installed on Hardware. "Hardware" means the standard hardware 
Products, originally sold by Avaya and ultimately utilized by End User. 

License Type(s)
Designated System(s) License (DS). End User may install and use each 
copy of the Software on only one Designated Processor, unless a different 
number of Designated Processors is indicated in the Documentation or other 
materials available to End User. Avaya may require the Designated 
Processor(s) to be identified by type, serial number, feature key, location or 
other specific designation, or to be provided by End User to Avaya through 
electronic means established by Avaya specifically for this purpose.
Concurrent User License (CU). End User may install and use the Software on 
multiple Designated Processors or one or more Servers, so long as only the 
licensed number of Units are accessing and using the Software at any given 
time. A "Unit" means the unit on which Avaya, at its sole discretion, bases the 
pricing of its licenses and can be, without limitation, an agent, port or user, an 
e-mail or voice mail account in the name of a person or corporate function 
(e.g., webmaster or helpdesk), or a directory entry in the administrative 
database utilized by the Product that permits one user to interface with the 
Software. Units may be linked to a specific, identified Server.
Database License (DL). Customer may install and use each copy of the 
Software on one Server or on multiple Servers provided that each of the 
Servers on which the Software is installed communicate with no more than a 
single instance of the same database. 
Named User License (NU). Customer may: (i) install and use the Software on 
a single Designated Processor or Server per authorized Named User (defined 
below); or (ii) install and use the Software on a Server so long as only 
authorized Named Users access and use the Software. "Named User," means 
a user or device that has been expressly authorized by Avaya to access and 
use the Software. At Avaya's sole discretion, a "Named User" may be, without 
limitation, designated by name, corporate function (e.g., webmaster or 
helpdesk), an e-mail or voice mail account in the name of a person or corporate 
function, or a directory entry in the administrative database utilized by the 
Product that permits one user to interface with the Product. 

Shrinkwrap License (SR). With respect to Software that contains elements 
provided by third party suppliers, End user may install and use the Software in 
accordance with the terms and conditions of the "shrinkwrap" or "clickwrap" 
license accompanying the Software ("Shrinkwrap License"). The text of the 
Shrinkwrap License will be available from Avaya upon End User's request (see 
"Copyright" below for more information).

Copyright 
Except where expressly stated otherwise, the Product is protected by copyright 
and other laws respecting proprietary rights. Unauthorized reproduction, 
transfer, and or use can be a criminal, as well as a civil, offense under the 
applicable law.

Third-party Components
Certain software programs or portions thereof included in the Product may 
contain software distributed under third party agreements ("Third Party 
Components"), which may contain terms that expand or limit rights to use 
certain portions of the Product ("Third Party Terms"). Information identifying 
Third Party Components and the Third Party Terms that apply to them is 
available on the Avaya Support Web site:
http://support.avaya.com/ThirdPartyLicense/ 

Preventing Toll Fraud
"Toll fraud" is the unauthorized use of your telecommunications system by an 
unauthorized party (for example, a person who is not a corporate employee, 
agent, subcontractor, or is not working on your company's behalf). Be aware 
that there might be a risk of toll fraud associated with your system and that, if 
toll fraud occurs, it can result in substantial additional charges for your 
telecommunications services.

Avaya Fraud Intervention
If you suspect that you are being victimized by toll fraud and you need technical 
assistance or support, call Technical Service Center Toll Fraud Intervention 
Hotline at +1-800-643-2353 for the United States and Canada. For additional 
support telephone numbers, see the Avaya Support Web site:
http://www.avaya.com/support 

Providing Telecommunications Security
Telecommunications security (of voice, data, and/or video communications) is 
the prevention of any type of intrusion to (that is, either unauthorized or 
malicious access to or use of) your company's telecommunications equipment 
by some party.
Your company's "telecommunications equipment" includes both this Avaya 
product and any other voice/data/video equipment that can be accessed by this 
Avaya product (that is, "networked equipment").
An "outside party" is anyone who is not a corporate employee, agent, 
subcontractor, or is not working on your company's behalf. Whereas, a 
"malicious party" is anyone (including someone who might be otherwise 
authorized) who accesses your telecommunications equipment with either 
malicious or mischievous intent.
Such intrusions might be either to/through synchronous (time-multiplexed and/
or circuit-based), or asynchronous (character-, message-, or packet-based) 
equipment, or interfaces for reasons of:

� Utilization (of capabilities special to the accessed equipment)
� Theft (such as, of intellectual property, financial assets, or toll 

facility access)
� Eavesdropping (privacy invasions to humans)
� Mischief (troubling, but apparently innocuous, tampering)
� Harm (such as harmful tampering, data loss or alteration, 

regardless of motive or intent)
Be aware that there might be a risk of unauthorized intrusions associated with 
your system and/or its networked equipment. Also realize that, if such an 
intrusion should occur, it might result in a variety of losses to your company 
(including but not limited to, human/data privacy, intellectual property, material 
assets, financial resources, labor costs, and/or legal costs).

Responsibility for Your Company�s Telecommunications Security
The final responsibility for securing both this system and its networked 
equipment rests with you � Avaya�s customer system administrator, your 
telecommunications peers, and your managers. Base the fulfillment of your 
responsibility on acquired knowledge and resources from a variety of sources 
including but not limited to:

� Installation documents
� System administration documents
� Security documents
� Hardware-/software-based security tools
� Shared information between you and your peers
� Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and your 
peers should carefully program and configure:

� Your Avaya-provided telecommunications systems and their 

http://www.avaya.com/support
http://www.avaya.com/support
http://support.avaya.com/LicenseInfo/
http://support.avaya.com/LicenseInfo/
http://support.avaya.com/ThirdPartyLicense/


interfaces
� Your Avaya-provided software applications, as well as their 

underlying hardware/software platforms and interfaces
� Any other equipment networked to your Avaya products

TCP/IP Facilities
Customers might experience differences in product performance, reliability and 
security depending upon network configurations/design and topologies, even 
when the product performs as warranted.

Standards Compliance
Avaya Inc. is not responsible for any radio or television interference caused by 
unauthorized modifications of this equipment or the substitution or attachment 
of connecting cables and equipment other than those specified by Avaya Inc. 
The correction of interference caused by such unauthorized modifications, 
substitution or attachment is the responsibility of the user. Pursuant to Part 15 
of the Federal Communications Commission (FCC) Rules, the user is 
cautioned that changes or modifications not expressly approved by Avaya Inc. 
might void the user�s authority to operate this equipment.

Federal Communications Commission Statement

Part 15:

Canadian Department of Communications (DOC) Interference Information
This Class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du 
Canada.
This equipment meets the applicable Industry Canada Terminal Equipment 
Technical Specifications. This is confirmed by the registration number. The 
abbreviation, IC, before the registration number signifies that registration was 
performed based on a Declaration of Conformity indicating that Industry 
Canada technical specifications were met. It does not imply that Industry 
Canada approved the equipment.

European Union Declarations of Conformity

Avaya Inc. declares that the equipment specified in this document bearing the 
"CE" (Conformité Europeénne) mark conforms to the European Union Radio 
and Telecommunications Terminal Equipment Directive (1999/5/EC), including 
the Electromagnetic Compatibility Directive (89/336/EEC) and Low Voltage 
Directive (73/23/EEC).
Copies of these Declarations of Conformity (DoCs) can be obtained by 
contacting your local sales representative and are available on the Avaya 
Support Web site:
http://www.avaya.com/support 

Trademarks
Avaya is a registered trademark of Avaya Inc.
Aria, AUDIX, DEFINITY, INTUITY, and Serenade are registered trademark of 
Avaya Inc.
Mailbox Manager and COMPAS are trademarks of Avaya Inc.
All non-Avaya trademarks are the property of their respective owners.

Document ordering information:
Avaya Publications Center
For the most current versions of documentation, go to the Avaya Support Web 
site:
http://www.avaya.com/support 

Avaya support
Avaya provides a telephone number for you to use to report problems or to ask 
questions about your product. The support telephone number 
is 1-800-876-2835 in the United States. For additional support telephone 
numbers, see the Avaya Support Web site:
http://www.avaya.com/support 

Note: This equipment has been tested and found to comply with 
the limits for a Class A digital device, pursuant to Part 15 of the 
FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if 
not installed and used in accordance with the instruction manual, 
may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause 
harmful interference in which case the user will be required to 
correct the interference at his own expense.

http://www.avaya.com/support/
http://www.avaya.com/support/
http://www.avaya.com/support/
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 About this book

This book, Avaya Modular Messaging for Microsoft Exchange Release 3 Installation and 
Upgrades, Issue 1, contains instructions for installing or upgrading the Avaya Modular 
Messaging software in a Microsoft Exchange environment. 

The Avaya-provided hardware for new systems is the Avaya S3500-family message server 
hardware. Upgraded Avaya-hardware systems can use Avaya S3400-family message server 
hardware, or upgrade to the new Avaya hardware. 

Customer-provided equipment (CPE) for a Modular Messaging install or upgrade must match 
the specifications described in Avaya Modular Messaging Concepts and Planning Guide.

Information in this book includes: 

● Instructions for installing a new system, including equipment assembly, set up and 
configuration, initial administration, and acceptance testing 

● Instructions for upgrading a system from Modular Messaging Release 1.1 software 

Note:
Note: Use this document to get a Modular Messaging system up and running. After the 

installation, customers must tailor the Modular Messaging parameters for their 
site. For more information, see the Avaya Modular Messaging Software 
Messaging Application Server Administration Guide (PDF 3 MB). For additional 
information about installing and initial administration for Web Subscriber Options, 
see Modular Messaging Web Subscriber Options Server Installation. Copies of 
these guides are available on the Avaya Modular Messaging Documentation 
media or from the Avaya Support web site at http://www.avaya.com/support.

Intended audiences
This book is intended for system administrators and on-site technical support staff. The content 
is targeted to those who installing, configure, or upgrade the hardware and software for an 
Avaya Modular Messaging system. 

Users of this book must be familiar with administering Microsoft Windows 2000 or 2003 and 
Microsoft Exchange systems. Avaya assumes that users have read the Avaya Modular 
Messaging Concepts and Planning Guide. 

Technicians who install an Avaya-provided Messaging Application Server should have 
completed a relevant hardware installation training course. For information on training, see 
Related resources on page xviii.

http://www.avaya.com/support
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Changes to this book
Changes from Release 1.1 issue of this book, published in December 2003, include:

● New hardware installation procedures for Avaya S3500-family message servers.

● New port board installation procedures for customer-provided servers.

● New software installation procedures for both S3500-family servers and 
customer-provided servers.

● New upgrade procedures for S3500-family servers, S3400-family servers and 
customer-provided servers.

● Microsoft Exchange 5.5 is not supported. Procedures require Microsoft Exchange 2003 
System Management Tools. Microsoft Exchange 2000 System Management Tools are not 
supported.
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How to use this book
Review the appropriate section, depending on whether you are installing a new Avaya Modular 
Messaging system, or upgrading a system that was already in operation. 

Installing a new system 
This document describes how to install Avaya Modular Messaging software either on a 
customer-provided Messaging Application Server (MAS), or on hardware provided by Avaya. 
Avaya-provided hardware is called the Avaya MAS in this guide. Although most steps are 
similar for both types of installation, this guide does contain sections that are only applicable to 
one or another of these specific hardware types, as noted in the text. 

Before you start a new installation:

1. Verify that the system meets the requirements specified in the Avaya Modular Messaging 
Concepts and Planning Guide (PDF 2 MB). The planning guide explains important concepts 
and provides information that is crucial for planning a Modular Messaging installation. 

2. Complete all the worksheets in Appendix A: System planning forms on page 209 You 
cannot complete an installation successfully unless this material is complete and accurate. 
The customer must provide some of the information in advance.

3. Enter the information collected on the planning forms into the Avaya Modular Messaging 
Data Collection Tool (DCT). Usually a project planner completes this task in advance of the 
installation, and sends the DCT data file to the on-site technical support representative. 

4. Print the checklist for a new installation from Appendix B: Installation and upgrade 
checklists on page 231. Use it to track your progress. There are different checklist for the 
Avaya MAS and CPE MAS. Be sure to print the checklist for your configuration. 

5. Read Chapter 1: Preinstallation requirements on page 1. This chapter lists installation 
prerequisites, including the required documentation, software, tools, and equipment that 
you need to complete an installation. 

Using the checklist as a guide, follow the directions in each subsequent chapter to install, 
configure, and test the Modular Messaging software.

Upgrading or recovering a system
To upgrade a Modular Messaging system for either the Avaya MAS or customer-provider MAS: 

1. Obtain a copy of the filled-out worksheets that were completed for the original system 
installation. Obtain the latest copy of the Release 3 planning forms, and enter any new 
information that is required. 
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2. Print the relevant upgrade checklist from Appendix B: Installation and upgrade checklists on 
page 231. Use it to track your progress. There are different checklist for the Avaya MAS and 
CPE MAS. Be sure to print the checklist for your configuration. 

3. Obtain the software and documentation listed in the chapter overview of the configuration 
you are upgrading. 

4. Follow the instructions in the appropriate chapter to upgrade the system.

● For an Avaya MAS, see Chapter 10: Upgrading Modular Messaging software on an Avaya 
MAS on page 151

● For a CPE MAS, see Chapter 11: Upgrading Modular Messaging software on a 
customer-provided server on page 187

To recover an MAS from a catastrophic disk failure:

1. Print a copy of the disk failure recovery checklist in Appendix G: Disk Failure Recovery on 
page 289.

● For an Avaya MAS, see Recovering from a catastrophic disk failure on an Avaya 
MAS on page 290

● For a customer-provided MAS, see Recovering from a catastrophic disk failure on a 
customer-provided MAS on page 296

2. Follow the procedures in the references chapters to recover the MAS.

Using links in this document
For your convenience, the installation guide provides direct linking to other files or pages when 
viewed in PDF form. Links appear in blue text and operate as follows: 

● Internal links within this document always work when you are using the PDF version of this 
guide. Internal links include those to tables, figures, or other sections of the book. 

● You might view the PDF version of this guide on the documentation media or on a Web site 
that contains the complete document set. If you do, you can click any blue link to an 
external file, such as another PDF file or HTML file to view the linked page or document. 

● You might use the PDF version of this installation guide on a system that is connected to 
the Internet. If you do, you can click the blue link for any Web site address, such as 
www.avaya.com, to go directly to the linked page.

http://www.avaya.com
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Trademarks
Avaya and the Avaya Logo are trademarks of Avaya Inc. and might be registered in certain 
jurisdictions. Unless otherwise specified, all trademarks identified by ® and � are registered 
trademarks or trademarks, respectively, of Avaya Inc.

Microsoft is a registered trademark of Microsoft Corporation. All other trademarks are the 
properties of their respective owners. 

Related resources
This section describes additional documentation and training available to you. 

Documentation
For information about items in the documentation set for this product, go to the Avaya Support 
Web site at http://www.avaya.com/support. Always use the appropriate CD or book to obtain 
specific information about planning, installing, administering, or maintaining an Avaya system. 

Technical assistance
The following technical assistance is available if needed. 

Remote support center

Your project manager or systems consultant is responsible for providing you with the telephone 
number of the appropriate remote support center. 

The following numbers are available for technical assistance with Avaya products and services: 

● Within the United States and Canada: call 1-800-876-2835, choose prompt 2, and then 
choose 2 again.

● Within any other country: call your local distributor.

Help on the system

Online help is available on the MAS. Use the Help menu or Help button (if available) for the 
application or wizard you are in. 

http://www.avaya.com/support
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Training 
For information about product training, go to the Avaya Web site at www.avaya.com and click 
Training. 

How to comment on this book
Avaya is interested in your suggestions for improving this information. Use one of the following 
methods to communicate with us: 

Be sure to include the name, issue number, and date of this book:

Avaya Modular Messaging for Microsoft Exchange Release 3 Installation and Upgrades, Issue 
1, April 2006. 

Method Contact

E-mail infodev@avaya.com

Voice mail or fax 303-538-9625

http://www.avaya.com
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Chapter 1: Preinstallation requirements

This chapter describes requirements and prerequisites for installing Avaya Modular Messaging 
software in a Microsoft Exchange environment. 

Topics in this chapter include:

● Required documentation and software on page 1

● Security considerations on page 4

● Initial switch and LAN administration on page 6

● Hardware requirements on page 7

● Test equipment and tools on page 5

Required documentation and software
You must use the documentation and software described in this section to install or upgrade an 
Avaya Modular Messaging system. You can obtain some of this information only from the Avaya 
Web site, such as the configuration notes or Avaya software patches. Other information is 
available on the Avaya Modular Messaging Documentation media that is shipped with the 
system software. However, you can also access this information online in advance. 

Download or print out all required files and information before you go to the customer site. 
Some Modular Messaging sites do not have Internet access. 

Note:
Note: Always check the Avaya Support Web site at http://www.avaya.com/support for 

recent updates and current information before starting an installation or upgrade.

Obtaining information on the Web
Obtain the documentation required for a new Modular Messaging installation or upgrade before 
you go on site. Information includes: 

Note:
Note: Be aware that links and paths on the Avaya Support Web site might change.

● Configuration notes are required for integrating the MAS and any installed Dialogic port 
boards with the PBX or switch at this site. To obtain the most current copy: 

a. Go to the Avaya Support Web site at http://www.avaya.com/support. 

http://www.avaya.com/support
http://www.avaya.com/support
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b. Click the link to Find documentation and downloads by product name. 

c. Under M, click Modular Messaging. 

d. On the Modular Messaging page, select Release 3.0 from the drop-down list. 

e. Click Configuration Notes.

f. Download or print the configuration notes for the switch integration you need. 

Note:
Note: This information is available only on the Avaya Support Web site and must be 

obtained before you install the software.

● The Avaya Support Web site provides access to an Microsoft Word version of the planning 
forms, and the installation and upgrade checklists. The Word document is an editable 
version of the information in Appendix A: System planning forms on page 209 and 
Appendix B: Installation and upgrade checklists on page 231. To download a Microsoft 
Word or PDF version of this file: 

a. On the Modular Messaging page, click View all documents.

b. Locate the link for the system planning forms in this list.

c. Follow the link to download the version of the planning forms that you need. 

● Additional information needed for installing a new system is on the Avaya Modular 
Messaging Documentation media. To access this information online:

a. On the Modular Messaging page, click Documentation Library (CD Collections).
b. Click Avaya Modular Messaging Release 3 Documentation.

c. Click View HTM.

d. On the Modular Messaging documentation menu, click the link to view the document set.

e. Click Reference for a list of downloadable documents. 

f. Either click to view or print files, or right-click to download the files you need:

● Any Dialogic port board documents appropriate for this site. For more information, see 
Table 7: Supported MAS port boards�S3500-family servers on page 20 or 
Table 8: Supported MAS port boards for customer-provided servers on page 44.

● Avaya Modular Messaging Subscriber Options User Guide (PDF) or Avaya Modular 
Messaging Client Add-in for Microsoft Outlook User Guide (PDF). You use these 
documents for acceptance testing. 

● The planning forms and checklists in Microsoft Word or PDF format. 

Note:
Note: You can use the PDF version of this installation guide on the documentation 

media or on a Web site that contains the complete document set. If you then click 
any blue link, such as the examples shown in this list, you go directly to the linked 
page or document. 
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Obtaining software updates on the Web
You must update the Avaya Modular Messaging software for each installation or upgrade to 
bring it up to date with the latest changes. To obtain the latest Avaya Service Pack (SP), 
software patches, and hotfixes for this system: 

1. Go to the Avaya Support Web site at http://www.avaya.com/support. 

2. Access the Modular Messaging page for Release 3. For complete steps, see Obtaining 
information on the Web on page 1. 

3. Click Downloads.

a. Download any files needed to update a Release 3 system. For example, download the 
MMDCTDistribute.exe self-extracting zip file to update the DCT program. Ensure that 
you download any instructions required to install the Service Pack or software update.

b. Copy the downloaded files to a USB storage device such as a flash drive, memory stick, 
or equivalent. Bring the USB storage device with you to the installation site. 

Documentation and software shipped with the system
The software and documentation listed in Table 1 ships with each Modular Messaging system. 

Table 1: Required Modular Messaging software

Disk Purpose

Avaya Modular Messaging 
Messaging Application Server 
Software �2 DVD set

● Installing the Modular Messaging software, Dialogic 
port board drivers, and Text-to-Speech (TTS) software

● Upgrading an MAS that is running Modular 
Messaging R1.1 software to Release 3 

Avaya Modular Messaging 
Documentation media 

Two copies are shipped, one for 
the customer and one for the 
technician. 

Accessing required documentation, including:
● The port board installation documents
● Avaya Modular Messaging Subscriber Options User 

Guide (PDF) or Avaya Modular Messaging Client 
Add-in for Microsoft Outlook User Guide (PDF), used 
for acceptance testing 

● Any required hardware replacement procedures 

Avaya Modular Messaging 
Messaging Application Server 
and Boot Software for Microsoft 
Exchange �3 DVD set

For S3500-family server hardware, reinstalling the 
boot-image software on an Avaya server. You might do this 
to upgrade a system to Release 3, or after you replace a 
hard disk drive. For more information, see Appendix 
F: Reloading software on an Avaya MAS on page 283. 

http://www.avaya.com/support
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Security considerations
The following security-related issues apply to all Modular Messaging installations. 

On-site security
On-site installers must take precautions to protect passwords and restrict access to the system. 

Password security 

To protect password security: 

● Do not leave written passwords lying out or allow anyone to see them.

● At the first opportunity, give the passwords directly to the designated customer 
representative.

● If you suspect that the security of the system was compromised, notify the project 
manager or system administrator.

System security during installation

To protect system security during the installation: 

● Remove all test subscribers and test mailboxes from the system when the procedures 
instruct you to do so.

● Always log off or lock the server if you leave it unattended, even for a short period of time.

● Give a copy of the most current DCT data file to the customer and the appropriate support 
organization after you finish an installation or upgrade. Afterwards, remove the DCT data 
file from your USB storage device or laptop. 

Ongoing system security
Customers are responsible for obtaining and installing anti-virus software on any Microsoft 
Windows computer that is to run Avaya Modular Messaging software. Customers must also 
routinely install Avaya-approved updates for Microsoft Windows systems to protect the system 
from known security weaknesses. Updates include operating system updates, security patches, 
and hotfixes. For more information, see �Modular Messaging and security�on the Avaya 
Modular Messaging Documentation media. 



Test equipment and tools

Issue 1 April 2006 5

 

Note:
Note: Avaya technical support representatives must follow their specified internal 

procedures for verifying the software that is installed. If required, they must 
update the software with the latest patches as instructed.

Test equipment and tools
Obtain the following test equipment and tools for all new Modular Messaging installations.

Test equipment
Recommended test equipment for a successful installation includes: 

● At least one telephone that is connected through the switch or Private Branch Exchange 
(PBX). The telephone must be of the same type as the majority of telephones the 
customer plans to use on the system. 

- If the message waiting indicator (MWI) for the system is a lamp, the test telephone must 
be equipped with a lamp. If the MWI is a stutter tone, the telephone must be able to 
provide the stutter notification. 

- Place the test telephone so you can easily see the monitor while using the telephone. 
● A volt/ohm meter. 

Tools
You must have the following tools on site to successfully install a new system: 

● A medium-width flat-blade screwdriver 

● A No. 2 Phillips screwdriver 

● A small pair of needlenose pliers 

● A small pair of wire cutters 

● A sharp, pointed instrument, such as a ballpoint pen 

! CAUTION:
CAUTION: Do not use the point of a lead pencil to operate the system reset switch. The 

graphite can damage a circuit board and cause problems, such as electrical 
shorts. 
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Initial switch and LAN administration
This section describes the initial switch or Private Branch Exchange (PBX) and local area 
network (LAN) administration that is required. Customers must complete this administration 
before or during a new Avaya Modular Messaging installation. 

Initial switch or PBX administration

Initial switch or PBX administration might or might not be complete when you arrive on site, 
depending on the contract or customer agreements. When you install a new server, the switch 
administration must support: 

● Testing the system with at least one test subscriber. 

● Cut to service procedures that provide the subscribers with an active coverage path. 

● For configurations that use analog and DSE port boards, the ability for testers to call each 
channel individually. The appropriate party must test each channel to be connected to the 
system before assigning the channels to the server or another application.

Verify that initial switch administration and testing is complete before you start.

Initial LAN administration

The LAN administrator must administer the corporate LAN for the messaging system. Some 
LANs might be administered before the on-site installation starts. Other LANs require that the 
administration for a new server be done at the time of installation. 

Note:
Note: Avaya is not responsible for the installation, administration, or test of 

communications between customer computers and the LAN.

Preinstallation planning forms

Complete the planning forms in Appendix A: System planning forms on page 209 before you 
start an installation. By gathering the data in advance, you can save hours of installation time 
and debugging. 

! CAUTION:
CAUTION: It is crucial to coordinate the IP addresses that are to be used with the Avaya 

Modular Messaging system with those on the corporate LAN. If you specify an IP 
address for a message server that conflicts with another Ethernet endpoint, the 
resulting traffic problems on the local area network can be extremely difficult to 
diagnose and solve. 
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Hardware requirements
A Modular Messaging software installation requires the following hardware: 

● One or more Messaging Application Server (MAS) units that will run the Modular 
Messaging software. These MASs can be:

- An Avaya-provided Messaging Application Server, called the Avaya MAS in this guide. 
An Avaya MAS has the port boards and much of the required software already installed. 
Some preinstallation requirements for this configuration are covered in Chapter 
2: Installing Avaya-provided hardware on page 9.

- A customer-provided equipment (CPE) server that meets the minimum requirements 
specified in the Avaya Modular Messaging Concepts and Planning Guide (PDF). A CPE 
server requires the appropriate port boards and drivers to be installed before you install 
the Modular Messaging software. For more information, see Chapter 3: Installing 
Dialogic port boards in a customer-provided MAS on page 43. 

Note:
Note: No hardware installation is required if you are using an IP H.323 or IP SIP switch 

integration on a customer-provided MAS. 

● A server that is running a compatible release of Microsoft Exchange software. This server 
is hereafter referred to as the Exchange server. 

● A server that contains the subscriber mailboxes, such as Active Directory or the Microsoft 
Exchange Administrator application. This server is hereafter referred to as the directory 
server. This server can be the same as the Exchange server, or it can be a separate 
computer. 

Both the Exchange server and the directory server must be in place and operational before 
installing the Modular Messaging software. 

Note:
Note: Chapter 4: Preparing to install Modular Messaging software on page 55 

describes prerequisite steps that must be performed by the directory server 
administrator or other authorized personnel. This work can be done before or 
during hardware installation, but must be completed before any other Modular 
Messaging software is installed. 

Because a Modular Messaging installation requires many steps, print a copy of the checklist 
relevant to this configuration. See Appendix B: Installation and upgrade checklists on page 231. 
Check off items as you complete them to track your progress.
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Chapter 2: Installing Avaya-provided hardware

Avaya Inc. can provide the hardware for the Modular Messaging system. Avaya-provided 
hardware includes one or more Avaya Messaging Application Servers, called the Avaya MAS in 
this guide, and other optional peripheral devices. Any required port boards and much of the 
required software are already installed in an Avaya-provided MAS. 

Note:
Note: Before you can successfully complete the tasks described in this section, you 

must verify that all preinstallation requirements were met. See Chapter 
1: Preinstallation requirements on page 1. 

! CAUTION:
CAUTION: This chapter applies only to installing Avaya-provided hardware. The hardware 

can include one or more Avaya Messaging Application Server (Avaya MAS) units 
and any Avaya-provided peripheral equipment. 

To install port boards in a customer-provided MAS, continue with Chapter 
3: Installing Dialogic port boards in a customer-provided MAS on page 43. 

Topics in this chapter include:

● Overview on page 9

● Site requirements for Avaya message servers on page 10

● Identifying Avaya S3500-family message servers on page 14

● Unpacking the system hardware on page 18

● Installing S3500-family servers on page 21

Overview
A new system installation follows these basic steps:

● Preparing the site for the Avaya Modular Messaging system

● Identifying the servers and unpacking the system components 

● Installing the Avaya MAS and its peripheral equipment. 

Note:
Note: Because a Modular Messaging installation requires many steps, print a copy of 

the checklist from Appendix B: Installation and upgrade checklists on page 231. 
Check off items as you complete them to track your progress.
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Site requirements for Avaya message servers
This section describes the physical requirements for Avaya-provided equipment, including 
environmental, weight, space, and power considerations. These specifications apply to any 
Avaya-provided server that uses Avaya S3500-family message server hardware. 

Environmental requirements
Table 2 lists the environmental conditions that must be maintained in the area where an Avaya 
S3500-family message server is installed and operated. Maximum heat output is shown in 
British thermal units (BTUs). 

Weight and space considerations
Table 3 lists the weight and spacial dimensions of an Avaya S3500-family message server. 

For safety considerations, at least two technicians must be available to mount the units.

Table 2: Environmental requirements for S3500-family servers

Operating state Temperature Humidity 
(noncondensing) 

Maximum heat 
output

Operating +10 to +35ºC 
(+50 to +95ºF)

20% to 80% RH 1498 BTU per hour 

Nonoperating �
in storage or being shipped

-20 to +50ºC 
(-4 to+122ºF)

20% to 90% RH N/A 

Table 3: Weight and space considerations for S3500-family servers

Server Weight (full) Height Width Depth

Avaya Messaging Application 
Server (Avaya MAS) or 
supplementary server 

36 lb
(16.3 kg)
without port boards

3.5 in. 
(9 cm)

16.9 in. 
(43 cm)

26 in.
(66 cm)
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Customer-provided cabinet requirements
If an Avaya S3500-family message server is to be installed in a rack-mount configuration, the 
customer-provided cabinet must meet the following requirements: 

● The cabinet must contain a 4-post rack to support the weight of the servers. 

● The cabinet must be secured to the floor before you attempt to mount any units.

● The sliding rails provided with each server are designed for mounting in cabinets 26 to 36 
inches in depth.

● The cabinet height must accommodate the number of units to be mounted. For more 
information about server height, see Table 3. The cabinet might also need to hold the MAS 
modems, UPS, and optional equipment, such as the KVM switch. For an example of a 
rack-mount system, see Figure 3: Example of a rack-mount system with S3500-family 
servers�front view on page 22.

Installation area requirements
Observe the following when determining where to place the system: 

● Maintain an air-distribution system that provides adequately cooled, filtered, and 
humidity-controlled air. 

● Do not install Avaya S3500-family message servers in such a way that the ventilation or 
fan openings are blocked.

● For T1 and E1 QSIG connections, the circuits require isolation from exposed lines. For T1 
lines, the customer must provide a CSU (T1) at the building point of entry. This CSU must 
be UL Listed, CSA Certified, or both. For E1 lines, either the network provider or the 
customer must provide a CSU (E1) or other equivalent protection. The protection must 
have the product safety approvals required by the local jurisdictions. 

! CAUTION:
CAUTION: To reduce the risk of fire, use only No. 26 AWG or larger telecommunications line 

cord.

● Systems in Finland, Norway, Sweden, and Australia must be installed in a 
restricted-access location. A restricted-access location is an installation site where only 
technical support staff or customers who are instructed on the reasons for the restricted 
access can gain access. Authorized personnel must also be trained in all required safety 
precautions. A restricted-access location also allows access through the use of a tool, 
such as a lock and key, or other means of security. 
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Power requirements
Table 4 lists the power requirements for Avaya S3500-family message servers. Use these 
figures for equipment room planning, not for UPS sizing. The AC power supply source must be 
a single phase 3-conductor consisting of line, neutral, and ground connections. 

. 

For equipment room planning, the AC power source requires a 15 A circuit breaker for 100-127 
Vac installations or a 10 A circuit breaker for 200-240 Vac installations. Consider the server 
connection to a branch circuit with regard to overload or overcurrent protection. Verify the 
system ratings to ensure that, together with other equipment connected to the same branch 
circuit, an overcurrent or overload condition does not exist. 

Note:
Note: All Modular Messaging systems must use an uninterruptible power supply (UPS). 

To size a UPS, use the maximum power dissipation figures in watts. For example, 
an Avaya MAS with port boards dissipates up to 450 watts, assuming 65% power 
supply efficiency. This figure divided by 120 Vac is about 4 amps per server. 

Grounding requirements
An Avaya S3500-family message server relies on the ground connection through the mains 
socket-outlet for safe operation. Ensure that the AC main outlet used to power the system, 
through the power cord or the UPS, is a grounded outlet. If you are unsure of the ground 
integrity of the outlet, have a trained and certified electrician check the outlet. 

! DANGER:
DANGER: You must connect the S3500-family servers to an earthed mains socket-outlet. If 

you fail to do so, you allow a hazard to be present that might cause severe 
personal injury or death.

In addition, observe the following grounding requirements for the server location:

● Use only the power cord provided with each unit to connect that unit to the universal power 
supply (UPS) or to an AC mains outlet.

● Install the server within 6 feet (2 m) of a grounded AC mains socket-outlet.

Table 4: Power requirements for S3500-family servers

Server Number of power 
supply units

Volts AC Hertz Maximum 
amperes 
120V/240V

Avaya MAS or 
supplementary server

1 90 to 264 Vac 47 to 63 Hz 8.0/4.0
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● Do not use extension cords with the system.

! CAUTION:
CAUTION: System grounding must comply with the general rules for grounding. For more 

information, see article 250 of the National Electrical Code (NEC), National Fire 
Protection Agency (NFPA). Alternatively, see the applicable electrical code in the 
country of installation.

Demarcation points
This section lists the demarcation points for switches (PBXs) and LAN connectivity. 

Demarcation point for switches (PBXs)

For Avaya switches, the demarcation point for switch (PBX) connections to an Avaya Modular 
Messaging server is the wall field. 

For non-Avaya switches, the demarcation point is the end of the connector of the 
Avaya-provided cables for the port boards. Avaya technical support representatives dispatched 
for the system installation are not responsible for making any connections directly to switches 
that Avaya does not maintain.

Note:
Note: Avaya recommends joint acceptance testing for systems integrated with switches 

that Avaya does not maintain. 

Demarcation point for LAN connectivity 

The demarcation point for the LAN connection to an Avaya Modular Messaging server is the 
physical Ethernet interface on the server that connects to the corporate LAN. The customer is 
responsible for: 

● Providing the LAN cables that connect the Avaya Modular Messaging server to the 
corporate system. If the customer uses Avaya-provided cables, the demarcation point is 
the modular connector at the end of the LAN cables. 

● Doing LAN administration that is not done on the Modular Messaging server. 

● Maintaining the TCP/IP addresses and administration on the server after cutover, unless 
otherwise specified by contract. 

● Providing the IP address, subnet mask, and gateway information for administration on the 
server. 

● Providing any DNS server IP information and corporate domain names. 

Avaya technical support representatives dispatched for system installation are not responsible 
for troubleshooting the customer LAN.



Installing Avaya-provided hardware

14 Avaya Modular Messaging for Microsoft Exchange Release 3 Installation and Upgrades

 

Identifying Avaya S3500-family message servers
An Avaya Modular Messaging system contains the following S3500-family servers: 

● One to ten Avaya Messaging Application Server (Avaya MAS) units, depending on the 
system configuration. The MASs handle voice calls. They might contain telephony port 
boards, depending on the type of switch integration that is to be used. 

● Optional: One or more additional servers that provide other messaging-related services. 
The additional supplementary servers might be customer-provided servers or Avaya 
MAS-like units. For more information, see Identifying Avaya MAS-like servers on page 15. 

Note:
Note: A supplementary server might use customer-provided equipment. For more 

information, see Using customer-provided equipment (CPE) servers on page 15. 

Identifying Modular Messaging servers
If a system ships with several S3500-family servers, it is crucial to correctly identify each server. 
The installation and configuration procedures vary for different types of servers. 

To help you identify each server, the S3500-family servers have two labels: 

● A label on the right side of the server near the front identifies the type of S3500-family 
server, such as an Avaya Modular Messaging (MM) MAS. 

● A label on the left side of the server near the middle identifies the software that is 
preinstalled on an Avaya-provided server. For a list of labels, see Table 5. 

 
Table 5: Labels for S3500-family servers 

Label�MM stands for Modular Messaging Server type Action

AVAYA MM MAS SOFTWARE LOADED:
● EXCHANGE STORE
● DOMINO STORE
● AVAYA MSS STORE

MAS Check the box for 
EXCHANGE STORE. 

AVAYA MM SUPPLEMENTARY SERVER:
● DOM/EXCH TRACING�Domino or 

Exchange system Tracing server 
● OLA�Offline Access server
● WEB CLIENT�Web Client server� 

available only for MSS configurations. 
● WEB SUB OPTS�Web Subscriber Options 
● UCC-SA SERVER�Unified Communication 

Center Speech Access server

Supplementary 
server for 
various optional 
applications 

Check all appropriate 
boxes to identify the 
purpose and content of the 
supplementary server. 

Note: If a server is to host 
multiple applications, check 
multiple boxes such as 
DOM/EXCH TRACING and 
WEB SUB OPTS. 
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Check the label on each server to identify the purpose and content of the server. Use the label 
as a guide to correctly install the server and load any required application software. 

Identifying Avaya MAS-like servers

In addition to the label, you can identify servers that you must set up as an Avaya Messaging 
Application Server (Avaya MAS) as follows:

● You must set up any server that has telephony port boards as an MAS. 

Note:
Note: Systems that use an IP H.323 or IP SIP switch integration do not use port boards. 

● All Avaya-provided MASs have the Avaya Modular Messaging Messaging Application 
Server Software media in the box. The application media identifies the server as an MAS 
even if the server does not contain telephony port boards. 

● Avaya-provided supplementary servers have only the boot software media in the box. 

Identifying and installing additional servers

Customers might order a separate server to run the following optional services: 

● Web Subscriber Options�can be on its own server or co-resident on an MAS. Check the 
planning forms to determine if you must activate Web Subscriber Options on a particular 
server. For more information, see Avaya Modular Messaging Web Subscriber Options 
Server Installation (PDF).

● Any server that provides only storage for offline access to messages. This server is called 
the offline access (OLA) server. An OLA server might also support resource-intensive 
administrative tools such as the Reporting Tool. 

Note:
Note: These additional servers might use either Avaya S3500-family message server 

hardware or customer-provided equipment (CPE). 

Using customer-provided equipment (CPE) servers

Some customers might choose to provide their own servers to support messaging-related 
services or other applications. Any server that does not use Avaya-provided hardware is 
considered customer-provided equipment (CPE). The customer is responsible for installing and 
maintaining all CPE servers. For more information about installing or configuring CPE servers, 
see Chapter 7: Configuring a customer-provided server on page 91. 
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Identifying key components of S3500-family servers
This section describes the key components of Avaya-provided S3500-family servers.

! CAUTION:
CAUTION: The same hardware can be used both as an Avaya Messaging Application 

Server (Avaya MAS), and as a supplementary server that provides special 
services. To distinguish the Avaya MAS units from any optional supplementary 
servers, see Identifying Modular Messaging servers on page 14. 

Figure 1 shows the front view of an Avaya S3500-family message server. 
 

Figure 1: S3500-family server�front view with bezel removed

Figure notes:

1. Chassis handles
2. Hard disk drive bays�the MAS uses 

only bay 3 on the upper-right
3. Label for disk drive bays 0 through 5 
4. Disk drive presence indicator�not 

used on the MAS
5. Disk drive activity indicator�not 

used on the MAS
6. USB port
7. System reset switch
8. System power on/off button 

9. Audible alarm reset switch for power 
supply�not used on the MAS 

10. System power indicator 
11. Disk drive access indicator 
12. Corporate LAN indicator�always on when 

corporate LAN cable is connected
13. Private LAN indicator�not used in this 

configuration
14. Power supply failure indicator�not used on 

the MAS 
15. DVD player 
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Figure 2 shows the back view of an Avaya Messaging Application Server (Avaya MAS). 
. 

Figure 2: S3500-family MAS�back view

Figure notes:

1. Power supply 
2. AC power receptacle
3. Screw for top cover
4. USB ports�one is used for the 

required modem on the MAS
5. Mouse connector
6. Keyboard connector
7. Serial port (COM1)�Used for 

serial PBX integration
8. Video connector
9. Corporate LAN interface

10. Private LAN interface

11. Serial port (COM2)�not used on the MAS
12. Port boards�type varies. Port boards are not 

present for IP H.323 or IP SIP integrations. 

Up to two (2) port boards can be installed in 
an MAS as needed. The middle PCI slot is 
filled first, if the MAS has only one port board. 
For more information, see Supported MAS 
port boards on page 44.

13. Extra PCI card slot�not used on the MAS 
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Unpacking the system hardware
This section lists required and optional hardware needed to install an Avaya Modular 
Messaging system that uses S3500-family server hardware. 

Note:
Note: Label each component as you identify it, particularly on a system that has 

multiple MAS-like units. For more information, see Identifying Modular Messaging 
servers on page 14. 

Required and optional hardware
Table 6 lists required and optional hardware needed to set up an Avaya Modular Messaging 
system. Verify that all components needed for this installation are on site. 

 
Table 6: Required and optional Avaya MAS hardware 

Item Quantity Required/optional

Required equipment:

Avaya Messaging Application Server (Avaya MAS) 1 minimum, 
10 maximum

Required

Additional MAS-like units, called supplementary 
servers�might be Avaya-provided hardware or 
customer-provided equipment (CPE) 

Varies Optional�can be 
customer-provided

Server AC power cables 1 per Avaya server Required

Front bezel 1 per server Required

Rack-mount assembly including rails, slides, and 
connecting hardware, and rubber spacers for 
stackable desktop configuration

1 set of each per 
server�use mount 
type required

Required

Ethernet LAN cable 1 per server Required

USB modem�includes USB cable 1 per server Required

Port board cables, if port boards are present�see 
Table 7: Supported MAS port boards�S3500-family 
servers on page 20. 

IP H.323 or IP SIP switch integrations do not use port 
boards. 

1 set per port board Required to connect 
port boards�type 
varies
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Identifying MAS port boards
Table 7: Supported MAS port boards�S3500-family servers on page 20 lists the Dialogic port 
boards that S3500-family servers support. The type of port boards used varies depending on 
the switch integration, but each MAS can have only one type of port board installed. 

For new systems, the appropriate port boards, if required, are preinstalled in an Avaya MAS. 
Inspect each MAS-like unit to determine if port boards are present: 

● If port boards are present, identify this unit as an MAS. You must connect the external 
cables for the port boards as part of server installation. 

● If port boards are not present, this unit might be a supplementary server, or it might be an 
MAS that uses an IP H.323 or IP SIP switch integration. In either case, no external cables 
are needed. For more information, see Identifying Modular Messaging servers on page 14. 

Optional or customer-provided equipment:

Monitor�includes power cord and VGA cable 1 Optional�can be 
customer-provided

Keyboard and mouse�includes cords and Y cable 1 set Optional�can be 
customer-provided

2-port KVM switch for two-server system 1 KVM switch with 
attached cables 

Optional�used for a 
two-server system 

8-port KVM switch for multiple-server 
system�includes 1 power transformer, 1 KVM 
switch cable for each server, and 1 set of rack-mount 
brackets for rack-mount configuration 

1 KVM switch, 
1 cable per server, 
1 power transformer,
1 set mounting 
brackets if needed

Optional�other 
models of switching 
devices can be used 

Uninterruptible power supply (UPS) with required 
power cord�includes 1 set of rack-mount brackets 
and rubber spacers for a stackable desktop 
configuration 

1 Required�model can 
vary 

Extended battery module (EBM) with required power 
cord�includes 1 set of rack-mount brackets and 
rubber spacers for a stackable desktop configuration 

1 to 4 Optional�can be 
ordered with the UPS

Table 6: Required and optional Avaya MAS hardware 

Item Quantity Required/optional
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The Dialogic documents provide details about installing and connecting the port boards. The 
documents are available on the Avaya Modular Messaging Documentation media or from the 
www.avaya.com/support Web site. For instructions on how to obtain Avaya documents, see 
Required documentation and software on page 1. For the latest version of the Dialogic guides, 
see the Quick Install Cards Search Tool on the Intel Telecom Boards Web site.

Note:
Note: The Dialogic documentation describes more setups than the ones used for Avaya 

Modular Messaging. If information in a Dialogic document conflicts with this 
Avaya document, follow the steps in the Avaya documentation. Use the Dialogic 
documentation to locate various items on the board or verify cable connections.

Saving the packing materials
Save the shipping cartons and all packing materials in case any hardware must be returned to 
the manufacturer. If you ordered more than one Avaya MAS, saving one carton and one set of 
packing materials is sufficient. 

Packing materials include: 

● Antistatic bags 

● Cardboard and foam inlays 

Note:
Note: The packing materials might include a plastic bag designed to protect the system 

from moisture during shipment. Discard this bag. It is not reusable. 

Also save the shipping cartons for all peripheral devices. Devices include the monitor, keyboard 
and mouse, all required modems, uninterruptible power system (UPS), and one or more 
optional extended battery modules (EBMs). 

Table 7: Supported MAS port boards�S3500-family servers 

Protocol Ports per 
MAS

Supported port boards Maximum 
number

Dialogic files on 
documentation media

Analog 12 - 24

4 - 8

Dialogic D/120JCT-LS 12-port board

Dialogic D/41JCT-LS 4-port board

2 D/120JCT-LS (PDF)

D/41JCT-LS (PDF) 

Digital Set 
Emulation

8 - 16 Dialogic D/82JCT-U-PCI-UNIV 2 D/82JCT-U PCI Univ (PDF)

E1-QSIG 30 - 60 Dialogic D/600JCT-1E1 2 D/600JCT-1E1 (PDF)

T1-QSIG 23 - 46 Dialogic D/480JCT-1T1 2 D/480JCT-1T1 (PDF)

http://www.avaya.com/support
http://membersresource.intel.com/qic/search.asp
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Installing S3500-family servers 
This section describes how to install system components for Avaya S3500-family message 
server hardware. Optional components are noted in the text. For more information about 
required and optional system components, see Table 6: Required and optional Avaya MAS 
hardware on page 18. 

! CAUTION:
CAUTION: Because an Avaya Modular Messaging installation requires many steps, use the 

new system installation checklist. See Appendix B: Installation and upgrade 
checklists on page 231. Check off items as you complete them to track your 
progress.

Note:
Note: This chapter describes only how to connect new S3500-family server hardware. 

For information about connecting or replacing S3400-family hardware, see Avaya 
Modular Messaging S3400-Family Hardware Maintenance and Additions on the 
documentation media. 

Sample installed system
The Modular Messaging hardware can be installed in the following configurations: 

● Inside one or more customer-provided commercial cabinets. This setup is called a 
rack-mount configuration. 

● Without a commercial cabinet. This setup is called in a stackable desktop configuration. 
This section includes instructions about installing both rack-mount and stackable desktop 
configurations.

Figure 3: Example of a rack-mount system with S3500-family servers�front view on page 22 
shows an example of an installed rack-mount configuration. 

Note:
Note: The sample figure shows the Avaya MAS S3500-family servers with their front 

bezels removed.
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Figure 3: Example of a rack-mount system with S3500-family servers�front view

Figure notes:

1. Customer-provided cabinet. Type 
can vary. For more information, see 
physical requirements in Installation 
area requirements on page 11.

2. EBM�optional. 0 to 4 can be 
installed with a UPS. 

3. UPS�required. Model can vary.

4. Avaya Messaging Application Server (Avaya 
MAS). Up to 10 MASs can be present. 
Additional supplementary servers might 
also be present (not shown). 

5. KVM switch�optional. Model can vary. 
6. External modem. One is required for each 

Avaya MAS. 
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Installing the UPS and optional EBMs 
This section describes how to install an uninterruptible power system (UPS) and one or more 
optional extended battery modules (EBMs). 

Note:
Note: Customers might order a different model of UPS than the one described in this 

section, or they can supply their own. For more information, see the 
documentation provided with the UPS.

● The UPS is a required component for all Avaya Modular Messaging systems. The UPS 
protects the system from most common power problems, including power failures, power 
sags, and power surges. 

● The EBM is an optional component that works in conjunction with the UPS to add 
additional run time for the system. The customer can add up to four EBMs per UPS. For 
more information, see the documentation provided with the EBM and UPS.

To install the UPS and EBMs:

● For a rack-mount configuration, see Installing the UPS and any EBMs into a rack on 
page 23. 

● For a stackable desktop configuration, see Installing the UPS and any EBMs as a 
stackable configuration on page 25.

Installing the UPS and any EBMs into a rack

In a rack-mount configuration, the UPS and EBMs must be positioned in the rack below the 
Avaya Modular Messaging servers. Install the EBM units in the lowest-available position. 

To install the UPS and EBMs into a rack:

1. Gather the necessary rack-mount hardware, including the mounting handles, brackets, and 
screws. 

2. Place the UPS on a flat, stable surface with the front of the UPS towards you.

3. Attach the mounting handle to each bracket using the supplied screws. See Item 1 in 
Figure 4. 

4. Align the mounting brackets with the screw holes on the side of the UPS and secure using 
the supplied screws. See Item 2 in Figure 4.

5. If you are installing one or more EBMs, repeat Steps 1 through 4 for each EBM. 

Note:
Note: You must install any EBMs below the UPS.
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6. Place the EBM into the rack in the lowest-available position. Attach the EBM to the rack 
using customer-provided screws. 

Note:
Note: If you must install additional EBMs into the rack, install them above the first 

installed EBM.

7. Place the UPS into the rack in the lowest-available position above any EBMs. Attach the 
UPS to the rack using customer-provided screws.

8. Continue with Connecting any EBMs to the UPS on page 26.

Figure 4: Attaching mounting handles and bracket for a rack-mount UPS
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Installing the UPS and any EBMs as a stackable configuration

To configure the UPS and any EBMs in a stackable configuration: 

1. If you are installing one or more EBMs: 

a. Remove the adjacent corner screws from the rear panels, as shown in Figure 5. 

b. Install the EBM brackets by aligning each bracket with the screw holes. Secure the 
bracket using the supplied screws. 

c. Repeat Step 1 for each additional EBM, if present.

Note:
Note: If you do not have any EBM units, continue with Step 2. 

2. On the bottom unit, either the UPS or an optional EBM, secure four rubber spacers to the 
bottom of the unit, one at each corner.

3. Set the unit on a stable platform. This unit is the base of the stackable desktop 
configuration.

Figure 5: Attaching connecting brackets between a UPS and EBM�back view
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Connecting any EBMs to the UPS

To connect any EBM units to the UPS: 

1. Connect the EBM cable to the battery connector on the UPS. See Item 3 in Figure 6. 

2. To connect additional EBMs, plug the EBM cable of the second EBM into the battery 
connector on the first EBM. See Item 4 in Figure 6. 

3. Repeat Step 2 for each additional EBM. Up to four EBMs can be present. 

Figure 6: Connecting a UPS and an EBM�back view

Figure notes:

1. UPS. Model can vary. For more 
information, see the documentation 
provided with the UPS.

2. EBM�optional. 0 to 4 can be 
installed.

3. EBM battery cable to UPS. 

4. Battery connectors for additional EBMs if 
needed�optional. 

5. UPS power cable to a grounded AC power 
source�Do not connect yet.
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Installing the S3500-family servers 
This section describes how to install each Avaya S3500-family message server in a 
customer-provided commercial cabinet or in a stackable desktop configuration. 

Attaching the front bezel

The front bezel ships loose to prevent damage during shipment. The bezel curves inward 
slightly to fit snugly to the chassis. You must bend the bezel slightly outwards to attach it. 

Note:
Note: The bezel covers the front USB port on the server. If you want to use this port for 

the USB storage device, attach the bezel at the end of the installation. 

To attach the front bezel to each S3500-family server: 

1. Hook one end of the bezel into the notch near the chassis handle. See Figure 7.

2. Bend the middle of the bezel slightly outwards, and push the other end into place. 
 

Figure 7: Attaching the front bezel on an S3500-family server
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Installing S3500-family servers in a rack-mount or stackable setup

You can install S3500-family servers in a commercial cabinet in a rack-mount configuration. 
Alternatively, you can stack servers on top of each other in a desktop configuration. Continue 
with the appropriate section based on the installation method to be used at this site: 

● Installing servers in a rack-mount configuration on page 28

● Installing servers in a stackable desktop configuration on page 30

! CAUTION:
CAUTION: The Avaya Modular Messaging servers are heavy. Get another person to assist 

you with lifting the servers into place.

Installing servers in a rack-mount configuration
The task describes how to install one or more Avaya S3500-family message servers inside a 
commercial cabinet. This setup is called a rack-mount configuration. 

The S3500-family servers fit into a standard 19-inch (48 cm) cabinet. 

Note:
Note: The first MAS is usually installed directly above the UPS. If more than one MAS is 

present, you usually install each additional MAS above the first MAS. However, 
all the servers in the system do not have to be in the same cabinet.

To install an S3500-family server into a rack:

1. Remove the rail assembly and screws from their packaging. 

Note:
Note: If more than one set of screws is provided, identify the set of 12 screws that fits 

the S3500-family server hardware. Only one set of thick Phillips round head 
screws fits tightly to the rails. Any other screws are not needed. 

2. Release and detach the inner rail from the slide: 

a. Fully extend the rail.

b. Pull the release lock out, the rear arrow tab, forward. See Item 1 in Figure 8: Attaching a 
rack-mount rail assembly on an S3500-family server on page 29. 

c. Separate the inner rail from the slide. 

3. Attach the inner rail to the server: 

a. Place the S3500-family server on a flat, stable surface.

b. Align the inner rail against the side of the server.

Note:
Note: Only four holes in the rail line up with corresponding holes in the server chassis. 
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c. Starting with the hole nearest the front of the server, insert a screw into each of the four 
holes. Because the first hole is not a slot, starting with this hole makes the rail easier to 
attach. See Item 2 in Figure 8. 

4. Attach the slide to the frame of the customer-provided cabinet: 

a. Loosen the two Phillips screws inside the front bracket. Extend the bracket to fit the 
frame. See Item 3 in Figure 8. 

b. Secure the bracket to the front and rear posts in the customer-provided cabinet. Tighten 
all four screws. See Items 4 and 5 in Figure 8. 

c. After the bracket is in place, tighten the two screws inside each rear bracket. See Item 5 
in Figure 8. 

 

! CAUTION:
CAUTION: You need two people for the next step. 

5. Mount the server in the cabinet: 

a. Fully extend the slide out the front of the cabinet. See Item 6 in Figure 8. 

b. Have one person hold up the front of the server. Have a second person help support the 
server, and guide the server onto the slide. 

Figure 8: Attaching a rack-mount rail assembly on an S3500-family server 
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c. Push in the release lock, the front latch, to slide the server into the cabinet. See Item 7 in 
Figure 8. 

6. Repeat Steps 1 through 5 for each server that must be installed.

7. When all servers are mounted, continue with Connecting the system power cables on 
page 31.

Installing servers in a stackable desktop configuration
For a stackable desktop configuration, install four rubber spacers on the bottom on each of the 
servers. The spacers enable you to stack the servers on top of one another. 

! CAUTION:
CAUTION: For safety, do not stack more than two Avaya servers on top of each other. 

Create multiple stacks if needed. 

For a sample desktop configuration, see Figure 9.

To install the servers in a stackable desktop configuration:

1. Gather the rubber spacers shipped with each server.

2. Attach the rubber spacers to the bottom of each of the servers, one at each corner. For an 
example, see Figure 9.

3. Position the UPS, and its attached EBMs if present, in an appropriate location. For more 
information about placement, see Site requirements for Avaya message servers on 
page 10. 

Figure 9: Attaching rubber spacers for a stackable desktop configuration
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Note:
Note: If you have a UPS and an EBM, stack only one server on top of them. Never 

stack servers more than two high. 

4. Place the first MAS on top of the UPS.

5. .If more MASs or supplementary servers are present, create another stack, placing each 
additional server on top of the last one. Create as many stacks as needed, so there are 
never more than two servers in one stack. 

Connecting the system power cables

Attach the power connections on the back of each server. 

To connect the power cables for the Modular Messaging system: 

1. Connect the female end of the server power cable to the male power connector on the back 
of the S3500-family server.

2. Connect the male end of the server power cable to an AC receptacle located on the back of 
the UPS. For a sample configuration, see Figure 10: Attaching power cables to a 
UPS�sample configuration on page 32. 

3. If you have more than one server, repeat Steps 1 and 2 for each MAS.

4. After all equipment is connected, plug the UPS power cable into an appropriate AC power 
outlet. 
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Figure 10: Attaching power cables to a UPS�sample configuration

Figure notes:

1. EBM�optional. 0 to 4 can be 
installed.

2. UPS. Model can vary. For more 
information, see the documentation 
provided with the UPS.

3. AC power cable to each MAS or the 
supplementary server, if present. 

4. AC power cable to other equipment, such as 
the required external modem for each MAS.

5. Additional AC sockets. Use as needed for 
external modems, monitor, optional 8-port 
KVM switch, or any additional servers.

6. UPS power cable to a grounded AC power 
outlet. Plug in this cable last. 

COMM PORT
IOIOI

ISOLATED
ALARM PORT

psvyups2 LAO 081005

2

5

6

1

3 43 4



Installing S3500-family servers

Issue 1 April 2006 33

 

Connecting the MAS port boards, if present

Do this task only if port boards are present in the Avaya MAS. 

Connect any MAS port boards to the PBX (switch). For more information about Dialogic port 
boards, see Identifying MAS port boards on page 19. 

Note:
Note: If this MAS uses an IP H.323 or IP SIP switch integration, no port boards are 

present. Continue with Connecting the Ethernet cable on page 34. 

To connect the MAS port boards to the switch: 

1. Assemble the required cables. 

Note:
Note: Port boards ordered through Avaya ship with the correct cables. 

2. Connect each port on the port boards to the switch (PBX) as required. 

Note:
Note: Check the numbering on the port board faceplate to verify that you are 

connecting the correct cord to the correct port.

● For E1-QSIG or T1-QSIG boards: 
a. Connect the port on the Dialogic T1-QSIG or E1-QSIG board using an RJ-48C Ethernet 

cable. 

b. The other end of the cable must be connected to the QSIG board on the corporate 
switching system. The organization responsible for maintaining the corporate switch 
must make this connection. See the customer contract or the statement of work. 

● For set emulation boards: 
a. Connect each port on the Dialogic set emulation (DSE) board using the D/82U cable 

(Intel part number 86-0155-001). 

b. The other end of the cable must be connected to a 4-wire punch-down block on the 
corporate switching system. The organization responsible for maintaining the corporate 
switch must make this connection. See the customer contract or the statement of work. 

● For analog boards: 
a. Connect each port on the installed analog boards to one end of a standard RJ-11 tip/ring 

cord. You can also use individual tip/ring cables and a 12-port harmonica. Note which 
cables connect to which ports.

b. The other end of the cable must be connected to an analog line on the corporate 
switching system. The organization responsible for maintaining the corporate switch 
must make this connection. See the customer contract or the statement of work. 
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Connecting the Ethernet cable

A standard Ethernet cable ships with each Avaya S3500-family message server. You can use 
this cable or a customer-provided cable to connect each server to the corporate LAN. 

To connect each server to the corporate LAN: 

1. Connect one end of the Ethernet cable to the appropriate RJ45 connector on the back of the 
server. See Figure 11. 

Note:
Note: Verify that you connect the Ethernet cable for the corporate LAN to the correct 

Ethernet interface on the back of the server. The two Ethernet interfaces on an 
S3500-family server operate at different speeds. Use the interface with the 
highest speed to connect to the corporate LAN. 

2. Connect the other end of the Ethernet cable to the corporate LAN. 

Note:
Note: The organization that is responsible for maintaining the corporate LAN must 

make this connection. See the customer contract or the statement of work.

3. Repeat Steps 1 and 2 for each Avaya MAS and supplementary server in the system.

 

 

Figure 11: Connecting an S3500-family MAS to the corporate LAN�back view

Figure notes:

1. Ethernet interface for the corporate LAN 2. Cable to the corporate LAN 
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Installing a KVM switch
You use a keyboard, video, and mouse (KVM) switch to view the different servers in a Modular 
Messaging system. However, the model of KVM switch and the specific monitor, keyboard, and 
mouse used can vary from site to site. For example, some sites might use a flat-panel monitor 
setup instead. 

This section describes how to install two Avaya-provided KVM switches: 

● Installing an 8-port KVM switch on page 35 

● Installing a 2-port KVM switch on page 39

Note:
Note: If this site uses any other model of KVM switch, install it using the instructions 

shipped with the equipment. After the KVM switch installation is complete, 
continue with Connecting the USB modem on the MAS on page 41. 

Installing an 8-port KVM switch 
If this system has more than two servers, you can install an 8-port Belkin KVM switch. For a 
sample multiple-server installation that uses this KVM switch, see Figure 3: Example of a 
rack-mount system with S3500-family servers�front view on page 22.

You can install the Belkin 8-port KVM switch in two configurations: 

● For a stackable desktop configuration: 

a. Place the KVM switch on top of the uppermost MAS, or on any convenient surface 
nearby. Rubber spacers are already in place. 

b. Continue with Connecting the KVM cables on page 36.

● For a rack-mount configuration, continue with Installing the KVM switch in a rack-mount 
configuration on page 35. 

Installing the KVM switch in a rack-mount configuration

To install the 8-port Belkin KVM switch in a commercial cabinet: 

1. Gather the necessary rack-mount hardware, including the adjustable mounting brackets 
and screws. 

2. Select a bracket-hole scheme to determine how far the KVM switch must protrude from the 
rack. 

3. Install the two rack-mount brackets on the KVM switch using the provided screws. See 
Figure 12: Attaching mounting brackets for a rack-mount KVM switch on page 36. 
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4. Install the KVM switch into the rack above the last installed MAS.

Connecting the KVM cables

You must connect the 8-port Belkin KVM switch to the keyboard, monitor, and mouse. You then 
connect the KVM switch to each server, as described in this section. 

Note:
Note: The KVM switch setup for the keyboard, monitor, and mouse can vary from site to 

site, depending on the equipment and cables used. For more information, see the 
documentation for the monitor, keyboard, and mouse. 

To connect a Belkin 8-port KVM switch: 

1. If a new monitor, keyboard, or mouse was ordered for this system, unpack the equipment 
now. Otherwise, continue with Step 2. 

Note:
Note: You can use any 15-inch or larger monitor for a Modular Messaging system.

a. Set up the monitor in the desired location.

b. Connect the keyboard and mouse to the monitor. This setup can vary. 

c. Plug the female end of the monitor power cable into the monitor.

d. Plug the male end of the monitor power cable into a free UPS receptacle if available, or 
into a grounded AC outlet.

Figure 12: Attaching mounting brackets for a rack-mount KVM switch 

brvykvmm LAO 120502
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2. Connect the VGA cable from the monitor to the female port on the back of the KVM switch 
labeled Console VGA. See Item 1 in Figure 13: Connecting an 8-port Belkin KVM switch to 
an MAS�back view on page 38.

3. Tighten the thumbscrews on the video cable connector using your fingers or a small 
flat-blade screwdriver.

4. Connect the PS/2 cables for the mouse and keyboard to their corresponding connectors 
using the Y cable. Use the connectors in the Console section on the back of the KVM 
switch. See Item 2 in Figure 13.

Note:
Note: The mouse connector is color-coded green, and the keyboard connector is 

color-coded purple. 

5. Connect the KVM switch power source: 

a. Attach the KVM power cable to the DC power jack labeled DC 12V, 1A on the rear of the 
KVM switch. See Item 4 in Figure 13. 

b. The other end of the KVM power cable is an AC-to-DC transformer. Connect the 
transformer to a receptacle on the back of the UPS, or to an appropriate AC power outlet.

When power is connected, the LED for port 01 starts flashing. 

6. Push the direct-access port selectors for ports 01 through 08 in order. 

The corresponding LED flashes as each button is pressed, indicating that the port is ready 
for the server connection. 

7. Connect the KVM switch cable to all installed servers: 

a. Connect the KVM switch cable to the appropriate port on the back of the KVM switch. For 
the first MAS, use the port labeled VGA 01. See Item 5 in Figure 13. 

b. Connect the PS/2 keyboard and mouse connectors of the KVM cable to the keyboard 
and mouse ports on the MAS. See Item 6 in Figure 13.

Note:
Note: The mouse connector is color-coded green, and the keyboard connector is 

color-coded purple.

c. Plug the male VGA connector on the KVM switch cable into the VGA port on the first 
MAS. See Item 7 in Figure 13.

8. For a multiple-MAS system, repeat Step 7 for each MAS or supplementary server. Connect 
the servers to port VGA 02, VGA 03 and so on, as needed.

9. Continue with Connecting the USB modem on the MAS on page 41. 
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Figure 13: Connecting an 8-port Belkin KVM switch to an MAS�back view

Figure notes:

1. VGA cord from monitor to Console 
VGA port on KVM switch. 

2. Y cable to combination keyboard 
and mouse for the monitor. Setup 
can vary. 

3. 8-port Belkin KVM switch. 
4. DC power jack for transformer cable.

5. Video/keyboard/mouse cable to the server. 
Connect the first MAS to the first computer 
port VGA 01 as shown. Connect any 
additional servers to the subsequent port 
positions, starting with VGA 02.

6. Keyboard and mouse connectors on server. 
7. Video connector on the server. 
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Installing a 2-port KVM switch 
If this system has only two servers, you can use a 2-port Belkin KVM switch. 

Note:
Note: The KVM switch setup for the keyboard, monitor, and mouse vary from site to 

site, depending on the equipment and cables used. For more information, see the 
documentation for the monitor, keyboard, and mouse. 

To install a 2-port Belkin KVM switch: 

1. If a new monitor, keyboard, or mouse was ordered for this system, unpack the equipment 
now. Otherwise, continue with Step 2. 

Note:
Note: You can use any 15-inch or larger monitor for a Modular Messaging system.

a. Set up the monitor in the desired location.

b. Connect the keyboard and mouse to the monitor.

c. Plug the female end of the monitor power cable into the monitor.

d. Plug the male end of the monitor power cable into a free UPS receptacle if available, or 
into a grounded AC outlet.

2. Connect the VGA cable from the monitor to the female port on the 2-port KVM switch. See 
Item 1 in Figure 14: Connecting two S3500-family MASs using a 2-port KVM switch�back 
view on page 40.

3. Tighten the thumbscrews on the video cable connector. 

4. Using the Y cable, connect the PS/2 cables for the mouse and keyboard to their 
corresponding connectors on the 2-port KVM switch. See Item 2 in Figure 14.

Note:
Note: The mouse connector is color-coded green, and the keyboard connector is 

color-coded purple. 

5. Run one strand of the KVM cable to the first server. The order in which you connect the 
KVM cables to the servers is not important. See Item 4 in Figure 14. 

6. Plug the VGA connector into the VGA port on the server. Tighten the thumbscrews on the 
video cable connector. See Item 5 in Figure 14.

7. Connect the PS/2 keyboard and mouse connectors on the KVM cable to the keyboard and 
mouse ports on the back of the server. See Item 6 in Figure 14. 

8. Repeat Steps 5 through 7 for the second server.
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Figure 14: Connecting two S3500-family MASs using a 2-port KVM switch�back view

Figure notes:

1. VGA cord from monitor to video 
connector on KVM switch

2. Y cable to combination keyboard 
and mouse for the monitor

3. 2-port Belkin KVM switch

4. Video/keyboard/mouse cable to each server 
5. Keyboard and mouse connectors on the 

server 
6. Video connector on the server 
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Connecting the USB modem on the MAS
A USB modem is required for each Avaya MAS. The type of modem varies, depending on the 
installation location. For more information about modem installation, setup, or operation, see the 
documentation provided with the modem. 

This section describes a MultiTech USB modem setup. For an example, see Figure 15.

To connect a USB modem:

1. Attach the rubber spacers to the four marked areas in each corner on the bottom of the 
modem, if spacers are not already in place.

2. Place the USB modem on top of the KVM switch or in a secure location, as required. 

3. Connect one end of the USB cable to the back of the USB modem. 

4. Connect the other end of the USB cable to the back of the MAS. 

5. Connect the RJ-11 cable to the LINE connector on the modem.

6. The other end of the cable must be connected to an analog line on the corporate switching 
system. The organization responsible for maintaining the corporate switch must make this 
connection. See the customer contract or the statement of work. 

7. Repeat Steps 1 through 6 for each Avaya MAS modem.

Figure 15: Connecting a USB modem to an S3500-family MAS�back view

Figure notes:

1. USB modem
2. USB cable to the MAS

3. USB connector on the server 
4. RJ-11 cable to the corporate switch 

UBS PHONE LINE
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Turning on an S3500-family server system
After all hardware components are installed, turn on the Modular Messaging system: 

1. Verify that the power cables for the servers and all peripheral devices are connected. 
Cables might go to the UPS or to an appropriate AC power outlet. For an example, see 
Figure 10: Attaching power cables to a UPS�sample configuration on page 32. 

2. Press the On button on the front of the UPS. The appropriate lamps should light. For more 
information, see the UPS documentation. 

Note:
Note: Always turn on the UPS first.

3. Press the power button on the monitor.

The power lamp on the monitor should light.

4. For each external modem, press the On button, if present. Verify that the appropriate lamps 
light. For more information, see the modem documentation. 

5. Verify that the power lamp for the KVM switch is lit. The Belkin KVM switch does not have 
on/off buttons.

6. Verify that all Avaya S3500-family message servers are running.

The LEDs on the front of the server flash once when power is applied. Afterwards, the LEDs 
light to indicate system power and drive activity. For more information about the different 
LEDs, see Figure 1: S3500-family server�front view with bezel removed on page 16. 

Note:
Note: The S3500-family servers start as soon as they receive AC power. You do not 

need to press the server power button unless the power LED on the front of a 
server is not lit. 

7. To turn on an S3500-family server if needed: 

a. Press the power button on the front of the server. 

b. Verify that the LEDs on the front of the server flash once, and then show system activity. 

c. Wait up to 1 minute for the display to appear on the monitor.

Note:
Note: The Avaya Modular Messaging Configuration Wizard runs automatically when 

you turn on an Avaya MAS. For more information, see Chapter 6: Configuring a 
new Avaya MAS on page 77. However, you must complete the steps in Chapter 
4: Preparing to install Modular Messaging software on page 55 before you 
configure the Modular Messaging software on the Avaya MAS. 
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Chapter 3: Installing Dialogic port boards in a 
customer-provided MAS

This chapter describes how to install Dialogic port boards and their drivers in a 
customer-provided equipment (CPE) server, also called a customer-provided MAS. A customer 
might have several servers that support Avaya Modular Messaging software and services. 

● A server that handles call-processing functions is called a Messaging Application Server 
(MAS). An MAS can contain port boards, depending on the switch integration. 

● A server that handles special services only, such as Tracing Server service, is called a 
supplementary server. A supplementary server never contains port boards. 

! CAUTION:
CAUTION: Use the procedures in this chapter only to install Dialogic port boards into a 

customer-provided equipment (CPE) server that is to handle calls. 

Continue with Chapter 4: Preparing to install Modular Messaging software on page 55 if:

● you are using Avaya-provided hardware, or 

● this Avaya Modular Messaging system is to use an IP H.323 or IP SIP integration. 
These IP switch integration methods do not use port boards. 

! CAUTION:
CAUTION: Avaya does not support Brooktrout port boards for Modular Messaging systems 

that run Release 3 software. Install only the currently supported Dialogic port 
boards in a CPE server. 

Avaya recommends that you connect a modem to each server to support remote dial in. 

Note:
Note: Before you can do the tasks described in this section, you must verify that all 

preinstallation requirements were met. See Chapter 1: Preinstallation 
requirements on page 1. 

Topics in this chapter include:

● Supported MAS port boards on page 44

● Installing MAS port boards on page 45

● Connecting MAS port boards to the switch on page 53

● Completing the hardware installation on page 54
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Supported MAS port boards
Table 8 lists the Dialogic port boards that Avaya supports for all new installations that use 
customer-provided equipment (CPE) servers. The type of port boards required depends on the 
switch integration, but each MAS can have only one type of port board installed. For example, 
all the boards in the server must be T1-QSIG or DSE. 

Note:
Note: To support the capacities shown in Table 8, the minimum CPE server hardware 

specifications must match the specifications for the S3500-family MAS. For more 
information, see the Avaya Modular Messaging Concepts and Planning Guide 
(PDF 2 MB). 

The Dialogic documents provide details about installing and connecting the port boards. The 
documents are available on the Avaya Modular Messaging Documentation media or from the 
www.avaya.com/support Web site. For instructions on how to obtain the documents, see 
Required documentation and software on page 1. For the latest version of the Dialogic guides, 
see the Quick Install Cards Search Tool on the Intel Telecom Boards Web site. 

Note:
Note: The Dialogic documentation describes more setups than the ones used for Avaya 

Modular Messaging. If information in a Dialogic document conflicts with this 
Avaya document, follow the steps in the Avaya documentation. Use the Dialogic 
documentation to locate various items on the board or verify cable connections.

Table 8: Supported MAS port boards for customer-provided servers 

Protocol Ports per 
MAS

Port boards Maximum 
Number

Dialogic files on 
documentation media

Analog 12 - 48 

4 - 16 

Dialogic D/120JCT-LS 12-port board

Dialogic D/41JCT-LS 4-port board

4

4

D/120JCT-LS (PDF)

D/41JCT-LS (PDF)

Digital Set 
Emulation

8 - 32 Dialogic D/82JCT-U-PCI-UNIV 4 D/82JCT-U PCI Univ (PDF)

E1-QSIG 30 - 60 Dialogic D/600JCT-1E1 1 2 D/600JCT-1E1 (PDF)

T1-QSIG 23 - 46 Dialogic D/480JCT-1T1 1 2 D/480JCT-1T1 (PDF)

1. Early D/600JCT-1E1 and D/480JCT-1T1 QSIG port boards have a plug in the unused connector on the 
faceplate. Dialogic D/600JCT-1E1 or D/480JCT-1T1 QSIG port boards that ship after mid-2005 have only 
a single connector. Both types of QSIG boards operate identically. 

http://www.avaya.com/support
http://membersresource.intel.com/qic/search.asp
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Installing MAS port boards
Do this task only on a customer-provided server. 

Before you can install the Modular Messaging software on a customer-provided equipment 
(CPE) server, you must first install any required port boards in each MAS. 

Note:
Note: The number of port boards you can install in a customer-provided MAS depends 

on the type of board and the number of PCI slots in the server. These instructions 
assume that up to six PCI slots are available in the server, and that board 
installation starts with the 6th PCI slot. Modify these instructions as appropriate 
for the server that you are using. 

Preparing for the installation
To install Dialogic port boards in a customer-provided MAS: 

1. Verify that this MAS meets the minimum requirements needed to support Modular 
Messaging software. For more information, see the Avaya Modular Messaging Concepts 
and Planning Guide (PDF). 

2. Print out the appropriate Dialogic PDF file for more information. For a list of the Dialogic 
documents that support each type of board, see Table 8: Supported MAS port boards for 
customer-provided servers on page 44. 

3. If the server is already in operation, you must take it out of service to install the port boards. 
Schedule and publicize a time.

4. When you are ready to start the installation, shut down the system software and turn off the 
server. Unplug the AC power cord for safety. 

! CAUTION:
CAUTION: Electrostatic discharge can severely damage sensitive electronic circuits. Before 

handling any electronic hardware, be sure to wear a grounding wrist strap or 
other static-dissipating device. The antistatic wrist strap must touch your bare 
skin and the strap cable must connect to an earth ground. For complete ESD 
instructions, see "Protecting against ESD damage" on the documentation media. 

5. Open the chassis to access the PCI card slots. 

6. Remove the cover for the PCI slot in which you want to install the new board. Set the 
retaining screw aside. 
● If you are installing multiple boards, remove as many card slot covers as are needed. 

● Note the maximum number of boards of a certain type that you can install in one MAS. 
See Table 8: Supported MAS port boards for customer-provided servers on page 44. 



Installing Dialogic port boards in a customer-provided MAS

46 Avaya Modular Messaging for Microsoft Exchange Release 3 Installation and Upgrades

 

Note:
Note: When you insert boards, start from the right-most slot if possible. For example, if 

six PCI slots are in the server, start with PCI slot 6 to insert the port boards. 

Setting jumpers and switches
Set the jumpers and switches for board position, bus termination, and other features as 
described in this section. For more information about jumper or switch locations, see the 
Dialogic documentation listed in Table 8: Supported MAS port boards for customer-provided 
servers on page 44. 

Note:
Note: The Dialogic documentation describes more setups than the ones used for Avaya 

Modular Messaging. If information in a Dialogic document conflicts with this 
Avaya document, follow the steps in the Avaya documentation. Use the Dialogic 
documentation to locate various items on the board or verify cable connections.

To set the jumpers and switches on each board:

1. Remove the new port board from its packaging. Do not touch the circuit board surface.

2. Set the jumpers and switches as required for this type of board: 

● D/480JCT-1T1 and D/600JCT-1E1 QSIG board settings on page 47

● D/82JCT-U PCI Univ set emulation board settings on page 47 

● D/120JCT-LS 12-port analog board settings on page 48

● D/41JCT-LS 4-port analog board settings on page 49
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D/480JCT-1T1 and D/600JCT-1E1 QSIG board settings

To set up Dialogic T1 or E1 QSIG boards, you must set only the board ID for the port board. 

1. Turn the rotary switch, located on the top of the port board. Set the board ID according to 
the slot number in which the board is installed. 

The Dialogic port boards usually are placed in the PCI slots starting from the right side of 
the cabinet. For the board ID numbers for a 6-PCI slot MAS, see Table 9. 

 

Note:
Note: You do not need to set the Computer Telephony (CT) bus for bus termination if 

more than one QSIG board is installed in an MAS.

2. Continue with Installing the port boards on page 51. 

D/82JCT-U PCI Univ set emulation board settings

To set up Dialogic digital set emulation (DSE) boards, you must set only the bus termination. 

1. If the server contains more than one port board, set the boards on both ends of the 
Computer Telephony (CT) bus for bus termination. Use jumper P8 to set CT bus termination 
as shown in Table 10. 

Table 9: D/480JCT-1T1 and D/600JCT-1E1 QSIG board ID settings

Card number Board ID number PCI slot number 

1 0 6

2 1 5

Table 10: D/82JCT-U set emulation board settings for CT bus termination 

Number of cards P8 jumper CT bus termination

1 OFF Do not terminate bus. 

2 Card 1: ON pins 1 and 2
Card 2: ON pins 1 and 2 

Terminate bus on both boards.

3 Card 1: ON pins 1 and 2 
Card 2: OFF
Card 3: ON pins 1 and 2 

Terminate bus on boards 1 and 3. 

4 Card 1: ON pins 1 and 2 
Card 2: OFF
Card 3: OFF
Card 4: ON pins 1 and 2 

Terminate bus on boards 1 and 4. 
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Figure 16 shows the P8 jumper settings. 

● The setting on the left is ON. Pins 1 and 2 are jumpered. If set, the CT bus is terminated. 

● The setting on the right is OFF. 
 

2. Continue with Installing the port boards on page 51. 

D/120JCT-LS 12-port analog board settings

To set up Dialogic 12-port analog boards: 

1. Set the unique board ID for the port board. Turn the rotary switch, located on the top of the 
board. Set the board ID according to the slot number in which the port board is installed. 

The Dialogic port boards usually are placed in the PCI slots starting from the right side of 
the cabinet. For the board ID numbers for a 6-PCI slot MAS, see Table 11. 

 

Figure 16: D/82JCT-U board settings for CT bus termination: ON or OFF
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Table 11: D/120JCT-LS 12-port analog board ID settings

Card number Board ID number PCI slot number 

1 0 6

2 1 5

3 2 4

4 3 3
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2. Set the hook-switch state of the port board to ON so callers hear a busy signal when the 
board is not initialized. Use the SW1 switch, located at the top of the board, to set the 
hook-switch state. See Figure 17. 

 

3. Continue with Installing the port boards on page 51. 

D/41JCT-LS 4-port analog board settings

To set up Dialogic 4-port analog boards: 

1. Set the unique board ID for the port board. Turn the SW30 rotary switch, located on the top 
of the board. Set the board ID according to the slot number in which the board is installed. 

The Dialogic port boards usually are placed in the PCI slots starting from the right side of 
the cabinet. For the board ID numbers for a 6-PCI slot MAS, see Table 12.

 

2. Set the hook-switch state of the port board to ON so callers hear a busy signal when the 
board is not initialized. Use the red SW4 switch, located near the top of the board, to set the 
hook-switch state. See Figure 18: D/41JCT-LS analog board setting for on-hook switch on 
page 50. 

Figure 17: D/120JCT-LS analog board setting for on-hook switch

jpvysw1 LAO 081803

1 O
N

Table 12: D/41JCT-LS 4-port analog board ID settings

Card number Board ID number PCI slot number 

1 0 6

2 1 5

3 2 4

4 3 3
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3. If the server contains more than one port board, set the boards on both ends of the 
Computer Telephony (CT) bus for bus termination. Use jumper JP2 to set CT bus 
termination as shown in Table 13. 

 

Figure 19 shows the JP2 jumper settings. 

● The setting on the left is ON. Pins 1 and 2 are jumpered. If set, the CT bus is terminated.

● The setting on the right is OFF. 
 

Figure 18: D/41JCT-LS analog board setting for on-hook switch

Table 13: D/41JCT-LS analog board settings for CT bus termination 

Number of cards JP2 jumper CT bus termination

1 OFF Do not terminate bus. 

2 Card 1: ON pins 1 and 2 
Card 2: ON pins 1 and 2 

Terminate bus on both boards.

3 Card 1: ON pins 1 and 2 
Card 2: OFF
Card 3: ON pins 1 and 2 

Terminate bus on boards 1 and 3. 

4 Card 1: ON pins 1 and 2 
Card 2: OFF
Card 3: OFF
Card 4: ON pins 1 and 2 

Terminate bus on boards 1 and 4. 

Figure 19: D/41JCT-LS analog board settings for CT bus termination: ON or OFF
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Installing the port boards 
After you verify that the settings are correct, install the MAS port boards: 

! CAUTION:
CAUTION: Verify that all port boards in an MAS are of the same type. You cannot mix board 

types within the same MAS, such as analog boards with DSE or QSIG. 

1. Slide the slot retainer bracket on the port board into the slot guide on the chassis. 

2. Align the edge connector on the port board with the slot connector. Apply pressure to the 
top of the board only. Push down until the edge connector is firmly seated. See Figure 20. 

. 

3. Replace and tighten the retaining screw for the port board.

4. Repeat Steps 1 through 3 to install any additional port boards. 

Figure 20: Installing a port board in a CPE MAS 

prvycrdr LAO 081103
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5. If the MAS has multiple port boards, attach the Computer Telephony (CT) bus cable to 
connect all the port boards:

a. Position the CT bus cable so the colored stripe on the ribbon cable faces the ports at the 
back of the chassis. 

b. Start with the board in the highest numbered slot. Attach the end connector on the bus 
cable to the CT bus edge connector at the top of the board.

c. Connect the next bus connector to the next port board, and so on.

d. If the cable has extra connectors or loose ribbon cable, tuck down the cable so it does 
not snag when you replace the cover.

6. Replace the chassis cover.

7. Plug in the AC power cord. 

8. Restore power to the server. 

The server boots. 

Disabling the Dialogic hardware
The Microsoft Windows software automatically detects the Dialogic port boards that you just 
installed. You configure these boards later as part of the Modular Messaging software 
installation. Do not install the Dialogic drivers at this time. 

To temporarily disable the Dialogic port boards: 

1. After the server boots, log on using an account that has permission to install software, such 
as the local administrator. 

2. The system runs a Found New Hardware Wizard once for each new Dialogic port board 
installed in the MAS. To complete the wizard: 

a. On the Welcome screen, use the default option to Install the software automatically. 
Click Next. 

b. Wait while the system searches for a driver. 

c. When the wizard reports that it Cannot Install this Hardware, click Finish.

3. Repeat Step 2 for each repetition of the Found New Hardware Wizard. 

Note:
Note: You install the Dialogic drivers later with the rest of the Modular Messaging 

software. 
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Connecting MAS port boards to the switch
Connect the MAS port boards to the PBX (switch), as described in this section. 

To connect MAS port boards to the switch: 

1. Assemble the required cables. 

Note:
Note: Port boards ordered through Avaya ship with the correct cables. 

2. Connect each port on the port boards to the switch (PBX) as required: 

Note:
Note: Check the numbering on the board faceplate to verify that you are connecting the 

correct cable to the correct port. 

● For E1-QSIG or T1-QSIG boards: 
a. Connect the port on the Dialogic E1-QSIG or T1-QSIG board using an RJ-48C Ethernet 

cable. 

b. The other end of the cable must be connected to the QSIG board on the corporate 
switching system. The organization responsible for maintaining the corporate switch 
must make this connection. See the customer contract or the statement of work. 

● For set emulation boards: 
a. Connect each port on the Dialogic set emulation (DSE) board using the D/82U cable 

(Intel part number 86-0155-001). 

b. The other end of the cable must be connected to a 4-wire punch-down block on the 
corporate switching system. The organization responsible for maintaining the corporate 
switch must make this connection. See the customer contract or the statement of work. 

● For analog boards: 
a. Connect each port on the installed analog boards to one end of a standard RJ-11 tip/ring 

cord. You can also use individual tip/ring cables and a 12-port harmonica. Note which 
cables connect to which ports.

b. The other end of the cable must be connected to an analog line on the corporate 
switching system. The organization responsible for maintaining the corporate switch 
must make this connection. See the customer contract or the statement of work. 
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Completing the hardware installation
To complete the hardware installation on a customer-provided equipment (CPE) server:

1. The Dialogic port boards require their own drivers and software for board configuration. You 
install the Dialogic drivers and software as part of the Modular Messaging software 
installation. For more information, see Installing and Running the Modular Messaging 
Configuration Wizard on page 102. 

2. If you intend to access this server remotely using a modem, verify that the modem is 
correctly installed and configured. For example, a remote support center might need to dial 
in to this server for troubleshooting or maintenance. 

a. For information about modem installation, setup, and operation, see the documentation 
provided with the modem. 

b. For information about configuring the Modular Messaging software to use a modem, see 
Chapter 8: Configuring the voice mail system on page 113. 
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Chapter 4: Preparing to install Modular Messaging 
software

This chapter describes how to set up Modular Messaging accounts on the directory server and 
prepare the directory server to support the Modular Messaging software. The steps in this 
chapter must be completed by the directory server administrator or other authorized customer 
personnel before a technician can install Modular Messaging software on the first MAS in the 
system.

Topics in this chapter include:

● Overview on page 56

● Setting up Modular Messaging accounts on page 57

● Creating MAS accounts on page 65

● Setting up each server for remote access on page 66

● Updating the Active Directory and data schema on page 68
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Overview
This chapter describes the following system preparation steps:

1. For all installations, you must create a Modular Messaging security group, customer 
account and technical support account on the directory server and add the correct 
permissions for each account.

2. Depending on local requirements, you must create computer accounts for each MAS in the 
Active Directory and set up each MAS to allow remote access by technical support staff. 

3. You must update the data schema before you install any Modular Messaging software on 
any Messaging Application Server (MAS) in the domain.

Note:
Note: This procedure can be done only on a machine that is running the Windows 2000 

or 2003 Server operating system. These components cannot be installed on a 
workstation OS. 

To complete this update, you must log on to the directory server using an account 
that has permission to do Active Directory and data schema administration. This 
is usually the Windows domain administrator account. The account must have 
both Domain Admin and Schema Admin rights.

! CAUTION:
CAUTION: The directory server requires a reboot after the Modular Messaging software is 

installed if Active Directory Extensions have been added. Schedule down time for 
the directory server before doing the tasks described in Updating the Active 
Directory and data schema on page 68. 

All servers must meet the requirements listed in the Avaya Modular Messaging 
Concepts and Planning Guide (PDF 2 MB), available on the documentation 
media shipped with the system. Review this document to verify that all Exchange 
servers, directory servers, MASs, and client machines are ready to support 
Modular Messaging software.

To successfully set up the Windows system to support the Modular Messaging software, you 
need:

● Access to the Avaya Modular Messaging Messaging Application Server Software media 

● A completed copy of the relevant planning forms listed in Appendix A: System planning 
forms on page 209 including: 

- The Corporate network planning form on page 216 showing the NetBIOS name of each 
MAS, the default (or primary) peer Exchange server, the directory server, and the 
Windows domain.
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- The Modular Messaging logon accounts form on page 221 showing the 
customer-specified Modular Messaging account names and passwords. 

- Switch and messaging information on page 225 showing the test subscribers and 
telephone user interfaces required to test the Modular Messaging software. 

- Customer-provided Microsoft Exchange 2003 System Management Tools

- Microsoft Exchange 2003 Service Pack 2

Setting up Modular Messaging accounts
You must create two Windows domain user accounts on the directory server to support Modular 
Messaging and you must assign sufficient permissions to the accounts.

● Create a customer account to install and administer the Modular Messaging software.

Note:
Note: In previous releases this account was referred to as the service account.

● Create a technical support account to allow remote support staff to access and administer 
the Modular Messaging system. 

At this time you can also optionally create a test subscriber account for each Telephone User 
Interface (TUI) that will be used at this site. The test subscriber accounts are required to support 
acceptance testing after the MAS is configured. For more information about creating accounts, 
see the Microsoft Windows documentation. 

Note:
Note: If you do not create the Modular Messaging accounts using the procedure in this 

section (for example, if the Modular Messaging customer account does not have 
sufficient privileges), you must create the Modular Messaging customer account 
container manually. See Creating the voice mail domain container manually if 
required on page 64. 

Creating Modular Messaging customer and technical support 
accounts

To prepare for creating these accounts, complete the following steps:

Note:
Note: Windows software accommodates more than one way to accomplish the tasks 

described. Consider the following steps guidelines that you might need to modify 
at your site.
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1. Log in to the Active Directory server using an account that has privileges to create new user 
accounts (such as administrator).

2. Click Start > All Programs > Administrative Tools > Active Directory Users and 
Computers.

3. In the Active Directory Users and Computers window, expand the directory for the Windows 
domain you intend to use for Modular Messaging. See Item C10 (Microsoft Windows 
domain) on the Corporate network planning form on page 216.

Creating the Modular Messaging customer account

To create the Modular Messaging customer account, you must first create a new security group 
for the account and then create the account and assign appropriate permissions.

Creating the Modular Messaging customer account group
Create a new security group that will give the Modular Messaging customer account the 
appropriate permissions. For example:

1. In the left pane, right-click Users > New > Group. 

2. In the New Object - Group window, create a new security group as follows:

a. Choose an appropriate name (such as MM Service Permissions). See Item 11 on the 
Modular Messaging System Planning Form on page 213. 

b. Select the group scope appropriate for this site.

c. Select group type Security. Click Next.
d. On the next screen, do not create a mailbox (clear the checkbox if it is checked). Click 

Next.
e. Click Finish. 

3. In the left pane, click Users. 

4. In the right pane, find the new group (such as MM Service Permissions) and double-click it.

5. In the properties window, click the Member Of tab. 

a. Click Add. 

b. In the Select Groups window, add the following groups to assign the necessary 
permissions. Double-click each group to add it to the permissions list: 

● Administrators (required for the domain that contains the Global Catalog servers that 
will be used as peer directory servers for Modular Messaging) 

● Account Operators (required for each domain that will contain user accounts to be 
enabled for Modular Messaging) 

c. Click OK to close this window. 

6. Click OK to close the properties window. 
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Creating the Modular Messaging customer account
Create a new account for installing and administering the Modular Messaging software (this is 
the Modular Messaging customer account). For example:

1. In the left pane, right-click Users > New > User. 
2. In the New Object - User window, create a new Modular Messaging customer account using 

a secure logon name. For example:

a. First name: Customer

b. Last name: Account

c. User logon name: customer-provided (such as mmacct). See Item A12 on the Modular 
Messaging logon accounts form on page 221. 

Note:
Note: Ensure that you are satisfied with the Modular Messaging account names and 

passwords that you choose now. They are not easy to change later.

d. Click Next.
e. Enter and confirm the password. See Item A12 on the Modular Messaging logon 

accounts form on page 221. 

Note:
Note: Passwords for Modular Messaging accounts must be at least 8 characters long. 

Do not create passwords composed of easily guessed words or numeric 
combinations, including sequential or repeated numbers. You must use a 
combination of at least three of the following character types: uppercase and 
lowercase letters, numbers, and special characters or symbols. 

f. You must select Password never expires. 

Note:
Note: If you change the password for a Modular Messaging customer account at some 

point, contact the software-provider for the password-changing procedure.

g. Click Next. 
h. On the following page, clear the checkbox for Create an Exchange mailbox. 

Note:
Note: You do not need to create an Exchange mailbox for a Modular Messaging 

customer account. 

i. Click Next. 
j. When the summary is displayed, click Finish. 

3. In the right pane, locate the new account and double-click it.

4. In the properties window, click the Member Of tab. 

a. Click Add. 
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b. In the Select Groups window, add the Modular Messaging customer account security 
group that you just created (such as MM Service Permissions).

c. Click OK to close this window. 

5. Click OK to close the properties window.

You will assign permissions to the Modular Messaging customer account in Assigning 
permissions to the customer account group on page 62. 

Creating the Modular Messaging technical support account

Create a new account to allow remote support staff to access and administer the Modular 
Messaging system. For example:

1. In the left pane, right-click Users > New > User. 
2. In the New Object - User window, create a new Modular Messaging remote access account 

using a secure logon name. For example:

a. First name: Support 

b. Last name: Account

c. User logon name: customer-provided (such as techacct). See Item A13 on the Modular 
Messaging logon accounts form on page 221.

d. Click Next.
e. Enter and confirm the password. See Item A13 on the Modular Messaging logon 

accounts form on page 221.

f. You must select Password never expires. 

Note:
Note: If you ever change the password for the remote access account, be sure to notify 

the appropriate technical support organization.

g. Click Next. 
h. On the following page, clear the checkbox for Create an Exchange mailbox. 

i. Click Next. 
j. When the summary is displayed, click Finish. 

3. In the right pane, double-click the name of the new account. 

4. In the properties window, click the Member Of tab. 

5. Verify that the Domain Users entry is present. If the Domain Users entry is missing: 

a. Click Add. 

b. In the Select Groups window, add Domain Users to this account. Click OK to close the 
window.

6. Click OK to close the properties window. 
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Creating test subscriber accounts
Create at least one new test subscriber account for each telephone user interface (TUI) that will 
be used at this site. The test subscriber accounts will be used for acceptance testing later in the 
installation. You may need to create up to three account, one for the MM Aria telephone user 
interface (TUI), one for the MM AUDIX TUI, and one for the MM Serenade TUI. For example:

1. In the left pane, right-click Users > New > User. 
2. In the New Object - User window, create a new account, such as:

a. First name: Aria Test

b. Last name: Subscriber

c. User logon name: customer-provided (such as testsub1). See Mailbox and subscriber 
information on page 226.

d. Click Next.
e. Enter and confirm the password for the account (customer-provided). 

f. Set up other parameters as required for this site. 

g. Click Next. 
h. On the third page, verify that Create an Exchange mailbox is selected. 

i. Select the required Server (Exchange organization) and Mailbox Store (Exchange 
server).

j. Click Next. 
k. When the summary is displayed, click Finish. 

A new account is added to the list in the right pane.

Note:
Note: The extension for the test subscriber must be administered on the PBX by the 

appropriate party.

3. Repeat Steps 1 and 2 to set up test subscribers for AUDIX and Serenade if required for this 
site. 

4. Close the Active Directory window.

5. You will need to assign Modular Messaging characteristics to this account after the Modular 
Messaging software is installed. See Adding a test subscriber on page 136.
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Assigning permissions to the customer account group
Use the steps in this section to assign permissions to the Modular Messaging customer account 
by assigning permissions to the customer account group you created in Creating the Modular 
Messaging customer account group on page 58. Sufficient permissions must be assigned to the 
group for the customer account to function as required. For details on permission requirements, 
see Appendix H: Administrator reference on page 305. 

To assign permissions to the group you must:

1. Edit the registry to display the security tab.

2. Add required permissions

Editing the registry

By default, the Security tab for the Exchange organization container and some of the key sub 
containers are not visible using Exchange System Manager or Active Directory Sites and 
Services. The following registry change enables the Security tab at all levels within the 
Microsoft Exchange container. 

To update the registry:

1. Log in as the Microsoft Exchange administrator.

2. Click Start > Run.

3. In the Run window Open field, type regedit and press Enter.
4. In the Registry Editor window, locate the following key: 

HKEY_CURRENT_USER\Software\Microsoft\Exchange\ExAdmin

5. Right-click ExAdmin and select New > DWORD Value. 

6. Enter the following value name: ShowSecurityPage
7. Double-click the ShowSecurityPage value.

8. In the Edit DWORD Value window, set the Value data to 1. 

9. Click OK. 

10. Close the Registry Editor window. 
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Adding permissions

Use Active Directory Sites and Services to add the required permissions. The permissions listed 
in Step 7 are the absolute minimum required for the Modular Messaging software to function. 
For convenience, all the properties should be created at the Exchange Organization level. You 
can choose to apply them at a level lower down the tree if required, but this might affect your 
ability to manage Modular Messaging using Exchange System Manager. 

To assign permissions to the Modular Messaging customer account:

1. Log in to the Active Directory server using an account that has privileges to assign 
permissions to accounts (such as administrator).

2. Click Start > All Programs > Administrative Tools > Active Directory Sites and 
Services.

3. In the left pane, select Active Directory Sites and Services.

4. From the View menu, select Show Services Node (the menu item shows a check mark 
after you select it). 

5. In the left pane, expand Services, expand Microsoft Exchange, and then locate the 
appropriate Exchange Organization object that Modular Messaging will connect to. 
Right-click it and select Properties.

6. In the properties window, click the Security tab. This tab is visible only if you edited the 
registry as directed in the previous procedure. 

a. Click Add. 

b. In the Select Users, Computers, and Groups window, add the Modular Messaging 
customer account group (such as MM Service Permissions).

c. Click OK to close this window. 

7. Under Permissions for the group, Allow only the following permissions. Clear any 
checkboxes that do not apply. For details on these permission requirements, see Appendix 
H: Administrator reference on page 305. 

Note:
Note: You may find it easier to verify the permissions by working from the bottom of the 

list to the top.

● Read

● Execute

● Read permissions

● Create children

● List contents

● Read properties

● Write properties
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● Administer information store

● Create named properties in the information store 

● View information store status

● Receive As

● Send As

8. Click Apply to verify the settings. 

9. Click OK to close the properties window.

10. Close the Active Directory Sites and Services window. 

11. After you change these permissions, to flush the directory cache, you can stop and restart 
all Microsoft Exchange services or wait 10 minutes for it to expire. 

Note:
Note: If you have multiple domain controllers in the forest, it might be necessary to wait 

for directory replication to complete.

To manually restart Microsoft Exchange services:

a. Right-click My Computer and select Manage. In the Computer Management window, 
the left (Tree) pane, expand Services and Applications, and then click Services.

b. In the right pane, scroll down to the Microsoft Exchange services. 

c. Right-click each Microsoft Exchange service in turn and select Restart.

Creating the voice mail domain container manually if required
Do the task in this section only if you did not create the Modular Messaging customer account 
using the procedure in Creating Modular Messaging customer and technical support 
accounts on page 57. 

If you do not assign the permissions Avaya recommends to the Modular Messaging customer 
account for security reasons, you can create the voice mail domain container for the Modular 
Messaging customer account manually and assign it appropriate security settings. Use this 
procedure if the Modular Messaging customer account does not have sufficient privileges to 
create container objects at the voice mail domain base location. 

To use this procedure, you must install ADSIEdit. ADSIEdit is a Microsoft Management Console 
(MMC) snap-in available as part of Microsoft Windows 2000 or 2003 Server and Microsoft 
Windows Advanced 2000 or 2003 Server Support Tools. 

To assign security settings to the voice mail domain container:

1. Run the ADSIEdit Windows support tool.

2. Connect to the Domain NC of the domain containing the Modular Messaging customer 
account.
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3. Locate the base location for the voice mail domain container. 

Note:
Note: If you have not selected a custom location, by default the voice mail domain 

container is the root container of the Microsoft Windows 2000 or 2003 domain.

4. From the Action menu, select New > Object > Container.
5. Give the container the value Octel and click Next. 

Note:
Note: The name of the container is case sensitive. 

6. Display the properties for the new container.

7. Ensure that the Account Operators Group is assigned Full Control in the security settings 
for the new container.

Creating MAS accounts
Before the Modular Messaging software is installed, the domain administrator must create 
computer accounts for each MAS and define the Modular Messaging customer account as a 
user that has permission to join the Windows domain. This procedure facilitates remote access 
setup (see Setting up each server for remote access on page 66) and Modular Messaging 
software installation. 

For example, to add a new computer account to the Active Directory:

1. Log in to the Active Directory server using an account that has privileges to add a computer 
account to a domain (such as Administrator).

2. Click Start > All Programs > Administrative Tools > Active Directory Users and 
Computers.

3. In the Active Directory Users and Computers window, expand the directory for the Windows 
domain that you will use for Modular Messaging. See Item C10 (Microsoft Windows domain) 
on the Corporate network planning form on page 216.

4. To create a new computer account, right-click Computers, and then select New > 
Computer. 
a. In the New Object - Computer window, type the computer name for the MAS. See Item 

C1 on the Corporate network planning form on page 216.

b. Right click on the computer name. Select Properties. On the Properties window select 
the Managed by tab.

c. Click Change to specify that a different user or group can add this computer to the 
domain. 
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d. In the Select User or Group window, double-click the Modular Messaging customer 
account (such as mmacct). See Item A12 on the Modular Messaging logon accounts 
form on page 221

e. Click Next.
f. Do not select �this is a managed computer.� Click Next.

g. Click Finish to close this window. 

5. If more than one MAS is to be installed, repeat Step 4 until all MASs are added. 

Setting up each server for remote access
Remote access allows technical support staff to dial into a system to correct problems and 
perform routine maintenance. Unless other arrangements were made, use the following 
procedure to allow each Modular Messaging server to support remote access calls. 

1. The Active Directory Users and Computers window should already be open. If not, repeat 
Steps 1 through 3 in Creating MAS accounts on page 65 to log in to an account with the 
appropriate privileges and access the Active Directory. 

2. In the left pane of the Active Directory Users and Computers window: 

a. Expand the directory for the domain that will be used for Modular Messaging. See Item 
C10 (Microsoft Windows domain) on the Corporate network planning form on page 216.

b. Click Users. 

3. In the right pane of the window, double-click RAS and IAS Servers to open the properties 
window.

4. In the RAS and IAS Servers Properties window: 

a. Click the Members tab.

b. Click Add.

c. In the Select Users, Contacts, Computers, or Groups window, double-click the entry for 
this server (for example, MYMAS1). It has a blue terminal icon.

d. Verify that the correct computer name is shown underlined in the list box.

e. Repeat Steps c and d to add all Modular Messaging servers to this list. See the 
Corporate network planning form on page 216. 

f. Click OK to close this window.

g. Click OK again to close the RAS and IAS Servers Properties window.

5. In the right pane, double-click the account to be used for remote technical support, such as 
example Services Account or Support Account. See Item A13 on the Modular Messaging 
logon accounts form on page 221
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6. In the properties window for the remote access account: 

a. Click the Dial-in tab.

b. Under Remote Access Permission (Dial-in or VPN), select Allow access. 

c. Leave CallBack Options set at No Callback.

d. Click OK to close this window.

7. If Avaya is to support this Modular Messaging system: Enable reversibly encrypted 
passwords in the domain as follows: 

8. In the left pane of the Active Directory window, right-click the domain name (such as 
zodiac.loc.avaya.com), and then select Properties. 

a. In the domain properties window, on the Group Policy tab, click Default Domain Policy, 
and then click Edit. 

b. In the Group Policy console tree, navigate to and then click Password Policy as follows: 
Computer Configuration > Windows Settings > Security Settings > Account 
Policies > Password Policy. 

c. In the right pane, double-click Store password using reversible encryption for all 
users in the domain. 

d. In the Security Policy Setting window, select Enabled, and then click OK.

e. Close the Group Policy window. 

f. Close the domain properties window.

9. Close the Active Directory Users and Computers window. 
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Updating the Active Directory and data schema
Complete this task only once per Windows domain, on the directory server domain controller, 
before installing the Modular Messaging software on any MAS. 

The Active Directory must be updated as described in this section. 

Note:
Note: This procedure can be done only on a machine that is running the Windows 2000 

or 2003 Server operating system. These components cannot be installed on a 
workstation OS. 

Note:
Note: To complete this update, you must log on to the directory server using an account 

that has permission to do Active Directory and data schema administration. This 
is usually the Windows domain administrator account. The account must have 
both Domain Admin and Schema Admin rights.

If you are running Windows 2000 or 2003 with Active Directory, the data schema must be 
updated before you install any Modular Messaging software on any Messaging Application 
Server (MAS) in the domain. The schema defines the objects and properties stored in Active 
Directory, and contains definitions of object attributes. The schema is updated only once in the 
forest. 

For details about the changes made to the schema for a Modular Messaging software update, 
see Appendix H: Administrator reference on page 305. 

! CAUTION:
CAUTION: If you do not update the schema first when required, the Modular Messaging 

software will not install correctly. It will have to be completely removed and then 
reinstalled following an Active Directory schema update.

Logging in and preparing to update
To update the Active Directory for Modular Messaging:

1. Log on to the directory server using an account that has permission for Domain 
Administration and Schema Administration. 

● This account is usually the Windows domain administrator account. For an Exchange 
2000 or 2003 system, this account requires both Domain Administration and Schema 
Administration rights.

● If you are updating the messaging software in a child domain, the account must have 
Domain Admin rights for both the parent domain and the child domain. If the Active 
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Directory update is executed from the child domain controller, enter the account name in 
the format: Parent Domain\Domain Admin.

● If you are using Octel Analog Networking, this procedure must be performed on the 
domain controller that is acting as the schema master. 

2. Close applications or stop monitoring as follows:

● Close the Active Directory Users and Computers application or the Microsoft Exchange 
Administrator application, depending on the application that is installed to support this 
version of Exchange. 

● Close any open windows for other applications. 

● Stop any monitoring tools that are running, such as anti-virus software. 

Running the Modular Messaging installation wizard
When all preparations are complete, run the Modular Messaging Installation Wizard as follows: 

1. Insert the Avaya Modular Messaging Messaging Application Server Software media (disk 1) 
into the DVD drive of the directory server. 

Note:
Note: If the directory server does not contain a DVD drive, the Avaya Modular 

Messaging Messaging Application Server Software media can be inserted into 
the shared DVD drive of another machine, and then mapped as a network drive 
on this server. 

2. Run the Modular Messaging Installation Wizard as follows:

a. In Windows Explorer, navigate to the DVD drive (such as D:).

b. Navigate to the Install directory.

c. Double-click the file Setup.exe. 

3. On the main screen, verify that the Configuration drop-down box shows Microsoft 
Exchange. 

4. Click the Read Me button to review the Readme file for recent notices.

Updating the Active Directory
To update the Active Directory and data schema (if required) on this machine: 

1. Click the plus sign (+) to expand the Active Directory updates folder. 

Note:
Note: Do this task only once per Windows domain. 
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2. Select the following checkboxes to install the appropriate software components to support 
Modular Messaging:

● Enable Modular Messaging: Click this box to enable extension data replication among 
Active Directory servers. This allows Modular Messaging to store subscriber 
configuration information and support the correct operation of and access to client 
applications. 

● Enable Octel Analog Networking: If Octel Analog Networking is used at this site, click this 
box to add the appropriate classes and attributes to the schema. This causes a Modular 
Messaging Octel Analog Networking tab to appear in the Microsoft Exchange 
administration program. 

● Enable User Administration: Click this box to enable objects that will appear on the 
Modular Messaging tab in the Active Directory. This allows administrators to use 
Microsoft Exchange administration to enable Modular Messaging features for users, 
groups, or contacts. 

Note:
Note: Although Octel Analog Networking is an optional feature, you might choose to 

install it at this time in case Octel Analog Networking is ever added to the system. 
The other software components are always required.

3. When all required components are selected, click Install.
4. Each component you select causes a Modular Messaging Active Directory installation 

wizard to run. Complete each wizard as follows:

a. On the welcome screen, click Next.
b. If prompted, enter the name and password of an account that has both Domain Admin 

and Schema Admin rights. (For example, windowsdomain\schemaAdmin and password.) 
Click Next. 

c. After the Active Directory registration process is complete, click Next.
d. To complete the wizard, click Finish.

e. Repeat Steps a through d for each occurrence of the wizard. 

Note:
Note: The Octel Analog Networking component causes two installation wizards to run. 

5. When component installation is complete, click Close.

6. Continue with Chapter 5: Adding Exchange extensions for Modular Messaging on page 71. 
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Chapter 5: Adding Exchange extensions for 
Modular Messaging

This chapter describes how to install the Microsoft Exchange extensions that support user 
administration for Modular Messaging software. Installing the extensions creates a Modular 
Messaging tab in the Active Directory, however, the page is not functional until the Modular 
Messaging software is installed and operational.

Do this task on any machine that you will use for administering subscribers (such as the 
Exchange server, an MAS, or a client machine). You can do this task multiple times per 
network. 

Note:
Note: For new installations, you must have successfully completed the tasks in Chapter 

4: Preparing to install Modular Messaging software on page 55 before you can do 
the tasks described in this section. 

You will not be able to add the extensions to an MAS until the MAS has been 
installed. For an MAS, you will install the extensions when you install the Modular 
Messaging software. See Chapter 6: Configuring a new Avaya MAS on page 77, 
or Chapter 7: Configuring a customer-provided server on page 91. 

Topics in this chapter include:

● Overview on page 72

● Adding the Exchange extensions on page 74
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Overview
This task assumes that you have already created a Modular Messaging customer account and 
updated the directory server as described in Chapter 4: Preparing to install Modular Messaging 
software on page 55. 

! CAUTION:
CAUTION: If the directory server has not been updated as described in Chapter 4: Preparing 

to install Modular Messaging software on page 55, do not proceed with the steps 
in this chapter. The Modular Messaging software will not install correctly, and it 
will have to be completely removed and reinstalled after the Active Directory 
updates have been made. 

To successfully install the Modular Messaging Microsoft Exchange extensions, you need: 

● Access to the Avaya Modular Messaging Messaging Application Server Software media 
(disk 1) 

● Downtime scheduled for the Microsoft Exchange server 

- Exchange 2000 or 2003 server: This release of Exchange does not require the 
Subscriber Administration extensions or Octel Analog Networking Administration 
component to be installed on the Exchange server. If you choose to install them on the 
Exchange machine, the Exchange server does need to be rebooted (see the following 
note). 

Note:
Note: You can install the Modular Messaging Subscriber Administration extensions 

component on any machine that has the Microsoft Exchange System 
Management Tools installed. The Subscriber Administration extensions add a tab 
to the Active Directory Users and Computers property page that is used for 
Modular Messaging subscriber administration. Any machine on which you install 
the Subscriber Administration extensions always requires a reboot.

To use the Modular Messaging Active Directory Extensions for administration, 
you must have sufficient rights on the Active Directory to modify users.

Note:
Note: If Octel Analog Networking is used at this site, you can install the Octel Analog 

Networking Administration component on any machine where the Microsoft 
Exchange System Management Tools are installed. 

Octel Analog Networking is not supported with the IP H.323 switch integration.
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! CAUTION:
CAUTION: All servers must meet the requirements listed in the Avaya Modular Messaging 

Concepts and Planning Guide (PDF 2 MB), available on the documentation 
media shipped with the system. Review this document to verify that all Exchange 
servers, directory servers, MASs, and client machines are ready to support 
Modular Messaging software. 

Note that the Microsoft Exchange System Management Tools must be installed 
on the machine where you install the Modular Messaging Exchange extensions. 
For details, see Running the Modular Messaging Configuration Wizard on 
page 81 for an Avaya MAS, or Installing and Running the Modular Messaging 
Configuration Wizard on page 102 for CPE.
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Adding the Exchange extensions
Complete this task for any machine that you will use for administering subscribers (such as the 
Exchange server, or a client machine). You can do this task multiple times per network. 

Update the Microsoft Exchange extensions as follows:

● For new installations: Install these tools on the Exchange server, or other machine where 
they are required. 

● For upgrades: Update the Exchange extensions software on any machines where it is 
installed.

Note:
Note: Review the conditions for installing these Modular Messaging software 

components in the Overview on page 72. For an MAS, you will install the 
Subscriber Administration extensions component when you install the rest of the 
Modular Messaging software. See Chapter 6: Configuring a new Avaya MAS on 
page 77, or Chapter 7: Configuring a customer-provided server on page 91. 

Although this procedure creates a Modular Messaging tab in the Active Directory, 
the page will not be functional until after the rest of the Modular Messaging 
software is installed and operational. 

Logging in and preparing to update
To update the Microsoft Exchange extensions for Modular Messaging:

1. Log in to the appropriate machine using an account that has permission to install software. 

2. Close applications and stop monitoring on this machine as follows:

● Close the Active Directory Users and Computers window or the Microsoft Exchange 
Administrator, if either application is installed on this machine. 

Note:
Note: At some sites, the same server might be running both Active Directory and the 

Exchange software. Close all Exchange and Active Directory windows before 
installing the Exchange extensions software. 

● Close any open Exchange applications including the Microsoft Exchange System 
Management Tools. 

● Close any open windows for other applications. 

● Stop any monitoring tools that are running, such as anti-virus software. 
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Running the Modular Messaging installation wizard
When all preparations are complete, run the Modular Messaging Installation Wizard: 

1. Insert the Avaya Modular Messaging Messaging Application Server Software media (disk 1) 
into the DVD drive of this machine. 

Note:
Note: If this machine does not contain a DVD drive, the Avaya Modular Messaging 

Messaging Application Server Software media can be inserted into the shared 
DVD drive of another machine, and then mapped as a network drive on this 
machine. 

2. To run the Modular Messaging Installation Wizard:

a. In Windows Explorer, navigate to the DVD drive (such as D:).

b. Navigate to the Install directory.

c. Double-click the file Setup.exe. 

3. On the main screen, verify that the Configuration drop-down box shows Microsoft 
Exchange. 

4. Click the Read Me button to review the Readme file for recent notices.

Adding the Exchange extensions
To add the Exchange extensions tools to this machine: 

1. Click the plus sign (+) to expand the appropriate Exchange extensions folder. Select the 
correct extensions for the version of Exchange that is installed on this machine: 

● Active Directory / Exchange 2000 extensions (also used for Exchange 2003 systems) 

2. To install the Modular Messaging software components required for Microsoft Exchange 
systems on this server, select the appropriate checkbox:

● Octel Analog Networking Administration: If Octel Analog Networking is used at this site, 
click this box to allow administrators to administer an Octel Analog Networking gateway. 
This allows Modular Messaging subscribers to exchange voice messages with any other 
Octel Analog Networking-enabled voice mail system. 

● Subscriber Administration: Click this box to add a Modular Messaging property page in 
Active Directory Users and Computers for each user that is assigned a mailbox. This tool 
allows administrators to set up and administer Modular Messaging accounts, configure 
subscriber properties, and run the MM Client software (the Subscriber Options package). 

3. When all required components are selected, click Install.
4. When all components finish installing, click Close.
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5. If you are prompted to restart the system, click Restart to complete the software installation. 

Note:
Note: After the Exchange extensions are installed a Modular Messaging tab will be 

present, however, it will not be functional until the installation of the MAS is 
complete.
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Chapter 6: Configuring a new Avaya MAS

This chapter applies only to an Avaya-provided Messaging Application Server (Avaya 
MAS) installation. It describes how to set up an Avaya MAS to support Avaya Modular 
Messaging software.

If you are installing a customer-provided MAS, do not use the procedures in this chapter, see 
Chapter 7: Configuring a customer-provided server on page 91. 

! CAUTION:
CAUTION: Before you can proceed with the tasks described in this section, a system 

administrator must have successfully completed the tasks in Chapter 
4: Preparing to install Modular Messaging software on page 55. 

Topics in this chapter include:

● Overview on page 78

● Running the Modular Messaging Configuration Wizard on page 81

● Completing server setup on page 87
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Overview
You must configure each new Avaya Messaging Application Server (Avaya MAS) for local 
operating settings and to work correctly on the corporate local area network (LAN) as described 
in this section. In addition, you must prepare it to operate correctly in the Microsoft Windows and 
Exchange environment. 

The majority of the MAS configuration is automated by the Modular Messaging Configuration 
Wizard (MMCW). The MMCW configures the MAS from information in a site-specific 
configuration file. This file is created using the Data Collection Tool (DCT). Typically the DCT file 
is created prior to the installation by the project manager, customer administrator and other 
experts responsible for the installation. However, the DCT file also can be created at the time of 
installation by the installer provided all system planning forms have been completed prior to the 
start of installation. See, Appendix A: System planning forms on page 209.

See the Data Collection Tool Online Help or its printed version, Avaya Modular Messaging Data 
Collection Tool Help, for a complete description of the procedure and specifications for creating 
a DCT file prior to an installation. 

Note:
Note: Always check the Avaya Support Web site at http://www.avaya.com/support for 

recent updates to the DCT program. 

To successfully set up an Avaya MAS, you need:

● A completed Data Collection Tool configuration file, or a completed copy of all the forms in 
Appendix A: System planning forms on page 209. Required forms are:

- Modular Messaging System Planning Form on page 213

- Corporate Network Planning Form on page 215

- Modular Messaging logon accounts form on page 221.

- MAS Services and Features Form on page 223

- Switch and Messaging Information Form on page 225

- Support information on page 227

! CAUTION:
CAUTION: If using the completed planning forms from Appendix A: System planning 

forms on page 209 enter the correct values exactly as they are recorded in the 
forms. Do not guess at the values or use the examples shown in this guide. If you 
do, the operation of the customer LAN might be damaged. 

● All required hardware installed as described in Chapter 2: Installing Avaya-provided 
hardware on page 9. 
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● A printout of the Avaya MAS installation checklist (see New Modular Messaging 
installation on an Avaya MAS on page 237). Check off steps as you complete them to 
track your progress.

● The following software from the Avaya Support Web site at http://www.avaya.com/support. 
For more information about how to access these items on the Web site, see Required 
documentation and software on page 1. 

- Avaya software updates that are required to bring the Modular Messaging software up to 
date after an installation. Download this software to a USB storage device. For more 
information about downloading the updates, see Updating Modular Messaging 
software on page 279.

- The latest copy of the Data Collection Tool. Download the DCT update file, 
MMDCTDistribute.exe, from the Avaya support Web site. Download it to a USB storage 
device. If a DCT file was created for this installation, download the 
MMDCTDistribute.exe to the same USB storage device as the DCT file.

● Customer-provided Microsoft Exchange 2003 System Management Tools

● Microsoft Exchange 2003 Service Pack 2

Switching the monitor to show the correct server
Use whatever method is required at this site to have the monitor display the Avaya MAS that 
you are installing. 

For an 8-port Belkin KVM: the KVM switch is usually connected to the first Avaya MAS (MAS#1) 
through the first computer port (VGA 01). Subsequent MASs (if present) are connected to 
computer ports VGA 02, VGA 03, and so on. 

To show a different server on the monitor:

1. Slowly press Scroll Lock, then Scroll Lock again, and then the up (or down) arrow key to 
change to the server connected to a higher (or lower) port number. 

Alternatively you can type the port number instead of pressing the up or down arrow key 
(such as 01 for port 1). For complete user instructions, see the KVM switch documentation.

2. If you cannot access the correct server, see Connecting the KVM cables on page 36 and 
verify that the cable connections are correct. To correct cable problems, power down the 
system and correct the cable connections. Then turn on the system again.

For complete user and troubleshooting instructions, see the KVM switch documentation. 

Note:
Note: You might see the error message System Event Log Full when the system 

boots. You can ignore this message. Modular Messaging does not use this log. 

http://www.avaya.com/support


Configuring a new Avaya MAS

80 Avaya Modular Messaging for Microsoft Exchange Release 3 Installation and Upgrades

 

Starting up the system
If a DCT file has been created for this installation and the DCT file is stored on a USB storage 
device, be sure that the USB storage device is inserted in a USB port on the server before 
starting the system. This USB storage device should also hold the MMDCTDistribute.exe file 
for the latest Data Collection Tool.

● You can use any of the available USB ports on the back of the server.

● You must remove the front bezel to access the USB port on the front of the Avaya 
S3500-family message server.

See Selecting or creating a DCT file on page 81 for additional information.

The Avaya MAS starts to boot after you turn it on. 

1. The S3500-family message servers turn on as soon as they receive AC power. However, if 
the power LED is not lit on the server you are configuring, press the power button on the 
front of the server. For more information, see Turning on an S3500-family server system on 
page 42. 

2. Optional: When the system starts to boot, you can:

a. Press Esc when the splash screen is displayed.

b. Press the space bar to skip the memory check. 
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Running the Modular Messaging Configuration Wizard
The Modular Messaging Configuration Wizard (MMCW) launches automatically when the 
system starts. The MMCW controls the next steps in the installation process. In running the 
Modular Messaging Configuration Wizard you must complete the following procedures:

1. Selecting or creating a DCT file on page 81

2. Installing third party software on page 85

3. Completing the MMCW Configuration on page 86

Selecting or creating a DCT file
If you have a DCT file already created for this installation, be sure that it is accessible to the 
MAS that you are installing. In most cases this means inserting a USB storage device with the 
file into a USB port 1 on the S3500 server prior to starting the system. If you do not have a DCT 
file already created, you will be able to create one during the installation when completing step 6 
of this procedure.

Complete the following steps to configure the MAS from the DCT file:

1. Verifying that the USB storage device with the DCT file and DCT tool update is inserted in 
the USB port.

2. Copy the DCT data file from the USB storage device to the C:\Avaya_Support directory. 
Some servers will not recognize a USB drive after a system restart.To copy the DCT data 
file to the server: 

a. Navigate to the USB drive, Removable Disk (E:). 
b. Right-click the most current DCT file for this site, such as sitefile.mmdct.

c. Copy the .mmdct file to the C:\Avaya_Support folder.

d. Verify that the correct DCT file is listed in the C:\Avaya_Support directory. 

3. Update the Data Collection Tool. To update the tool:

a. Navigate to the USB drive, Removable Disk (E:)
b. Copy the MMDCTDistribute.exe file from the USB storage device to a folder on the 

server, such as C:\Avaya_Support.

c. Double-click the executable file MMDCTDistribute.exe and then click Unzip.

4. When the Modular Messaging Configuration Wizard (MMCW) launches, the Modular 
Messaging Welcome screen is displayed. Click Next.

5. If you have a DCT file already created for this installation, complete the following steps and 
proceed to step 7. If you don�t have a DCT file go to step 6.
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a. On the Locate Configuration Data screen, highlight the DCT file for this installation. If the 
file is not displayed, click Browse and browse to the directory where the DCT file is 
stored. By default, the MMCW searches the directory for all files with the file type 
*.mmdct.

b. After selecting the DCT file that was created for this installation, click Next. You will be 
prompted to verify the file selection. Click Yes, to select the file.

c. The Data Collection Tool launches with the file you selected. Review and make any 
necessary changes to the file.

d. On the last screen, click complete and then save the file again if you have made any 
changes. 

e. Proceed to Step 7

6. If you need to create a DCT file from completed planning forms, complete the following 
steps.

a. On the Locate Configuration Data screen, check the box to Create a new configuration 
file. Click Next. 

b. When the system prompts you to create a new configuration file, click Yes. The Data 
Collection Tool launches. 

c. Use the information in the Planning forms to enter data for each screen in the DCT. As 
you progress through the pages, a green check mark (✓) indicates screens with 
complete and valid information. A red x indicates screens with incomplete or invalid data.

See the Data Collection Tool online help or its printed version, Avaya Modular Messaging 
Data Collection Tool Help for a complete description of all fields on each screen. The 
following table maps fields in the Data Collection Tool to the planning forms in Appendix 
A: System planning forms on page 209.

DCT Field Name Planning Form Location

Company name Item 1, Table 14: Modular Messaging System 
Planning Form on page 213

Organization name Item 2, Table 14: Modular Messaging System 
Planning Form on page 213

Time Zone Not in planning form

Keyboard input language Not in planning form

Message store Item 3, Table 14: Modular Messaging System 
Planning Form on page 213

Contact Information for message store 
administrator

Item 5, Table 14: Modular Messaging System 
Planning Form on page 213
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Name (Voice Mail Domain) Item 6, Table 14: Modular Messaging System 
Planning Form on page 213

Number of MASs in the VMD Item 7, Table 14: Modular Messaging System 
Planning Form on page 213

Connect to corporate network (DHCP or static) Item 8, Table 14: Modular Messaging System 
Planning Form on page 213

Subnet mask Item C3, Table 15: Corporate network planning 
form on page 216

Full computer name (for MAS) Item C4, Table 15: Corporate network planning 
form on page 216

IP address (for MAS) Item C5, Table 15: Corporate network planning 
form on page 216

Register DNS suffix in DNS Item C15, Table 15: Corporate network planning 
form on page 216

Register IP address in DNS Item C15, Table 15: Corporate network planning 
form on page 216

DNS Servers IP addresses, in order of use Item C6, Table 15: Corporate network planning 
form on page 216

Search order of DNS domains Item C7, Table 15: Corporate network planning 
form on page 216

Default gateway IP address Item C8, Table 15: Corporate network planning 
form on page 216

WINS (if required) IP addresses Item C9, Table 15: Corporate network planning 
form on page 216

Microsoft Windows domain Item C10, Table 15: Corporate network planning 
form on page 216

Peer Exchange server Item C11, Table 15: Corporate network planning 
form on page 216

Peer directory server Item C12, Table 15: Corporate network planning 
form on page 216

Container if default not used Item C13, Table 15: Corporate network planning 
form on page 216

Software installation path Item C14, Table 15: Corporate network planning 
form on page 216

DCT Field Name Planning Form Location



Configuring a new Avaya MAS

84 Avaya Modular Messaging for Microsoft Exchange Release 3 Installation and Upgrades

 

d. On the last screen, click complete and then save the file. 

7. After saving the DCT file, click complete to continue, which returns you to the MMCW.

8. On the Messaging Application Server Number screen, in the MAS Number field, select the 
number of the MAS that you are installing and click Next.
The MAS configuration starts, the Sysprep window opens, then the server reboots.

9. After the reboot starts, a Windows Setup wizard runs. To complete the wizard: 

a. On the License Agreement screen, select I accept this agreement. Click Next. 
b. On the Your Product Key screen, type the Windows product key for this server. 

Note:
Note: Each Windows computer has a unique product key for the Windows 2003 

operating system. Enter the number exactly as shown. 

On a new S3500-family server, the product key sticker is located inside the empty 
drive tray on the lower-left of the server chassis. You can remove the drive tray to 
easily read the sticker. Record the Windows product key in Table 23: Windows 
product keys for MASs on page 228. 

Local administrator accounts names and 
passwords

Table 18: Modular Messaging logon accounts 
form on page 221

Technical support name and password Item A13, Table 18: Modular Messaging logon 
accounts form on page 221

Customer account name and password Item A12, Table 18: Modular Messaging logon 
accounts form on page 221

Announcement languages Table 19: MAS services and features form on 
page 224

TTS languages and sessions Table 19: MAS services and features form on 
page 224

MM service selections Table 19: MAS services and features form on 
page 224

Switch integration Item 9, Table 14: Modular Messaging System 
Planning Form on page 213

DCT Field Name Planning Form Location
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c. Click Next.
The MMCW proceeds with the installation of the specified MAS based on information 
contained in the DCT file. 

Information contained in the DCT file is validated against the system at this time. This may 
result in errors that will require you to correct the data in the file or make system corrections 
and begin the configuration again. If you receive an error, see the screen-specific help for 
information about field parameters and conditions that may result in errors or warnings.

The progress of the installation is displayed by informational messages on the MMCW 
screen. 

Installing third party software
After the reboot, the MMCW will prompt you to install third party software.

When installing third party software, install the following components:

● Exchange 2003 System Management Tools

● Exchange Server 2003 Service Pack 2

● MSDE install

● Anti-virus software

1. When prompted to install third party software, install the Exchange 2003 System 
Management Tools.

Note:
Note: The Microsoft Exchange 2003 System Management Tools must be installed on 

any MAS that will have any of the following services installed on it: 

- Messaging Application Server

- Call Me Server

- Message Waiting Indicator (MWI) Server. 

Exchange 2003 System Management Tools are required, Exchange 2000 System 
Management Tools are not supported.

a. Insert the customer-provided Microsoft Exchange 2003 Server media in the MAS drive.

b. Install the Management tools by completing the Microsoft Exchange Installation Wizard.

c. If you receive a compatibility warning, click Continue.

d. For details about this procedure, see the Microsoft Exchange documentation.

2. Follow site-specific procedures to install Exchange Server 2003 Service Pack 2.

3. To install MSDE, complete the following steps:

a. Insert the Modular Messaging Application media (disk 1) in the MAS DVD drive.



Configuring a new Avaya MAS

86 Avaya Modular Messaging for Microsoft Exchange Release 3 Installation and Upgrades

 

b. In Explorer navigate to the Install\System Upgrade\MSDE directory.

c. Double click on the MSDE.bat file.

d. After the utility runs, close the explorer window.

4. Install anti-virus software that is specified by your local site requirements and 
implementation. Avaya strongly recommends that you install anti-virus software on any 
Microsoft Windows computer that runs Avaya Modular Messaging software. For more 
information about anti-virus software on an Avaya MAS, see Administering anti-virus 
software on page 87.

Completing the MMCW Configuration
After third party software is installed continue with the following steps to complete the 
configuration

1. Verify that the Avaya Modular Messaging Messaging Application Server Software media 
(disk 1) is in the MAS DVD drive. Then, click Continue with installation after installing 
3rd party software on the third party dialog box. The MMCW resumes with the following 
sequence of events:

● The Setup screen displays and proceeds directly to the System Upgrade screen.

● The system reboots without user intervention

● MMCW restarts automatically and runs the MM Application Setup, installing all MM 
services

● After another reboot and auto log on, the MMCW continues the system configuration, 
displaying informational messages as each component, such as dialogic drivers or 
remote access is configured.

2. When MAS configuration is complete, the progress bar stretches across the window and 
the Next button becomes active. Click Next.

3. On the Modular Messaging Wizard Completed screen, click Finish.

4. To complete setup of the Modular Messaging server, proceed to Completing server 
setup on page 87
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Completing server setup
To complete setup of the server complete the following tasks as necessary:

● Administering anti-virus software on page 87

● Installing software updates on page 88

● Updating Microsoft Windows on page 88

● Disable private LAN on page 89

● Configuring port boards if needed on page 89

● Continuing the installation on page 89

When you have completed the procedures required for your system, proceed to Chapter 
8: Configuring the voice mail system on page 113

Administering anti-virus software
Avaya strongly recommends that anti-virus software be installed on any Microsoft Windows 
computer that runs Avaya Modular Messaging software. The type of virus-checking software 
used and the method of installation depends on customer requirements and the local 
implementation. 

Guidelines for using anti-virus software on a computer that is running Avaya Modular 
Messaging software include:

● Consider the impact that anti-virus scanning has on the performance of the Avaya 
messaging servers. Avaya recommends the use of �on-demand� scanning, where scans 
are run at scheduled intervals. Avoid using a message-scanning method that could 
drastically impact the performance of the Avaya servers. For example, do not use �on 
access� scanning. This type of scan runs whenever a file changes, and can have a 
negative impact on server performance. 

Note:
Note: Some anti-virus software applications default to scan on startup. Disable this 

feature, or it increases the time that it takes a system to come back online after a 
reboot.

● Avaya recommends administering the anti-virus software as follows: 

- Scan the hard disk at least once per week during off peak hours. Avaya recommends a 
daily scan. You can run scans on multiple Modular Messaging servers at the same time. 
However, avoid scheduling the anti-virus scan at the same time as when a scheduled 
backup occurs on the MAS.

- Schedule virus definition updates to occur automatically at least once per week. The 
updates must occur before the next scheduled scan time to ensure that the latest data 
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(DAT) files are used during the scan. However, do not schedule updates to occur during 
a virus scan.

- If the anti-virus software locates a virus, it should first attempt to clean the file. If that fails, 
the software should move the file to a different directory.

Information about anti-virus interoperability of Avaya Modular Messaging software with various 
anti-virus products and performance testing is available. The information addresses security 
issues such as reporting concerns and receiving notifications. For more information, see 
Anti-Virus Software on Microsoft Windows-based Avaya Messaging Products.

Installing software updates
A new Modular Messaging system ships with the most current software that is available at the 
time. However, the software must be updated after an installation or upgrade to include the 
latest changes. The updates might be in the form of an Avaya Service Pack (SP) or a software 
patch (hot fix). 

To determine if a Modular Messaging software update is needed: 

1. Locate any relevant Avaya software updates on the Avaya Support Web site at http://
www.avaya.com/support. For complete steps, see Obtaining software updates from the 
Web on page 279. 

Note:
Note: If you followed the procedure for Obtaining software updates on the Web on 

page 3, you already downloaded any required software updates. 

2. If the Modular Messaging system requires a software update, complete the update 
procedure now before you do acceptance testing. Follow the instructions in Appendix 
E: Updating Modular Messaging software on page 279 to update the system with the latest 
changes. 

Updating Microsoft Windows
A new Avaya MAS contains the most current Microsoft Windows software at the time it is 
shipped. After installation, you must install the latest Microsoft Windows system updates, 
security patches, and hot fixes to protect the operating system from known security 
weaknesses. Check with the appropriate Windows administrator for the software update 
procedures to use at this site. 

Note:
Note: Avaya technical support representatives must follow their specified internal 

procedures for verifying the software that is installed. If required, they must 
update the software with the latest patches as instructed. 

http://www.avaya.com/support
http://www.avaya.com/support
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Disable private LAN
The Modular Messaging private LAN is not used with the Microsoft Exchange configurations. 
Disable the LAN by completing the following steps:

1. On the desktop, right click on the Network Places icon. Select Properties.

2. In the Network Connections window, highlight either Intel(R) PRO100M Network 
Connection, or Intel(R) 100+ PCI Adapter, whichever appears in the window. Right click 
on your selection. From the drop-down list, select disable.

3. In the Network Connections window, from the toolbar menu, select Advanced > Advanced 
Settings. Verify that the corporate LAN is listed at the top of the list of connections. If not, 
highlight the name of the corporate LAN and use the arrows to move it up in the list. When 
finished, click OK to close the Advanced Settings window. Close the Network Connections 
window.

Configuring port boards if needed
The Avaya Modular Messaging Configuration Wizard automatically configures any installed 
Dialogic port boards for several switch integrations, including: 

● Avaya CM (IP SIP) 

● Avaya (IP H323)

● Avaya (QSIG)

● Cisco (QSIG)

● Nortel NT M-1 (QSIG)

● Siemens Hipath (QSIG)

If this MAS contains Dialogic port boards that do not use one of the automatic-configuration 
switch integrations, you must configure the port boards manually. 

1. Continue with Appendix D: Configuring and testing port boards on page 263. 

2. After you configure and test the Dialogic port boards, continue with Configuring the voice 
mail system on page 113. 

Continuing the installation
When you have finished installing the MAS, you must continue with configuring the voice mail 
system. See Configuring the voice mail system on page 113.
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Chapter 7: Configuring a customer-provided server

This chapter applies only to a customer-provided equipment (CPE) server installation. It 
describes how to set up a customer-provided server to support Avaya Modular Messaging 
software or supplementary services. 

If you are installing an Avaya S3500 MAS, do not use the procedures in this chapter, see 
Chapter 6: Configuring a new Avaya MAS on page 77.

Note:
Note: Before you can proceed with the tasks described in this section, a system 

administrator must have successfully completed the tasks in Chapter 
4: Preparing to install Modular Messaging software on page 55. 

Topics in this chapter include: 

● Overview on page 92

● Preparing the CPE server on page 94

● Setting up the server for Modular Messaging on page 94

● Adding Modular Messaging accounts to the local Administrators group on page 97

● Installing Windows prerequisite software on page 99

● Installing and Running the Modular Messaging Configuration Wizard on page 102

● Completing server setup on page 109
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Overview
You can use a customer-provided equipment (CPE) server to support Modular Messaging 
software and supplementary services. However, you must first configure the server to support 
Modular Messaging in an Microsoft Exchange environment. To do this, you must complete the 
following tasks described in this section:

● Prepare the CPE server by configuring a network card and running disk checks. See 
Preparing the CPE server on page 94.

● Join the server to the Windows domain that will contain the Modular Messaging system. 
See Joining the Windows domain on page 95

● Adjust the server system values to accommodate Modular Messaging. See Adjusting 
system values on page 96.

● Add the Modular Messaging customer and technical support accounts to the local 
administrators group. See Adding Modular Messaging accounts to the local Administrators 
group on page 97.

● Install and enable required Microsoft Windows software and services. See Installing 
Windows prerequisite software on page 99.

After completing these steps, the majority of the Modular Messaging server configuration is 
completed by the Modular Messaging Configuration Wizard (MMCW). The MMCW configures 
the MAS from information in a site-specific configuration file. This file is created using the Data 
Collection Tool (DCT). Typically the DCT file is created prior to the installation by the project 
manager, customer administrator and other experts responsible for the installation. However, 
the DCT file also can be created at the time of installation by the installer provided the all system 
planning forms have been completed prior to the start of installation. See, Appendix A: System 
planning forms on page 209.

See the Data Collection Tool Online Help or its printed version, Avaya Modular Messaging Data 
Collection Tool Help, for a complete description of the procedure and specifications for creating 
a DCT file prior to an installation. 

To successfully set up a customer-provided server, you need:

● A completed Data Collection Tool configuration file, or a completed copy of all the forms in 
Appendix A: System planning forms on page 209. Required forms are: 

- Modular Messaging System Planning Form on page 213 

- Corporate network planning form on page 216

- Modular Messaging logon accounts form on page 221

- MAS services and features form on page 224

- Switch and messaging information on page 225

- Support information on page 227
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! CAUTION:
CAUTION: If using the completed planning forms from Appendix A: System planning 

forms on page 209 enter the correct values exactly as they are recorded in the 
forms. Do not guess at the values or use the examples shown in this guide. If you 
do, the operation of the customer LAN might be damaged.

● All required hardware installed as described in Chapter 3: Installing Dialogic port boards in 
a customer-provided MAS on page 43. 

● A printout of the customer-provided MAS installation checklist. See New Modular 
Messaging installation on a customer-provided MAS on page 231. Check off steps as you 
complete them to track your progress.

● The following software from the Avaya Support Web site at http://www.avaya.com/support. 
For more information about how to access these items on the Web site, see Required 
documentation and software on page 1. 

- Avaya software updates that are required to bring the Modular Messaging software up to 
date after an installation. Download this software to a USB storage device. For more 
information about downloading the updates, see Updating Modular Messaging 
software on page 279.

- The latest copy of the Data Collection Tool. Download the DCT update file, 
MMDCTDistribute.exe, from the Avaya support Web site. Download it to a USB storage 
device. If a DCT file was created for this installation, download the 
MMDCTDistribute.exe to the same USB storage device as the DCT file.

● Customer-provided Microsoft Exchange 2003 System Management Tools

● Microsoft Exchange 2003 Service Pack 2

● Microsoft Windows Service Pack 1, if not previously installed.

http://www.avaya.com/support


Configuring a customer-provided server

94 Avaya Modular Messaging for Microsoft Exchange Release 3 Installation and Upgrades

 

Preparing the CPE server
Complete the following procedures to set up this customer-provided equipment (CPE) server to 
support Avaya Modular Messaging services. 

Configuring the network card
For each customer-provided server, you must configure a network card to support a corporate 
LAN connection. 

Use the completed Corporate network planning form on page 216 to assign IP addresses and 
other TCP/IP properties for the corporate LAN interface that this MAS will use. 

! CAUTION:
CAUTION: Use the completed planning forms from Appendix A: System planning forms on 

page 209 to enter the correct values. Do not guess at the values or use the 
examples shown in this guide. If you do, you can damage the operation of the 
customer LAN. 

Running recommended disk checks
Avaya recommends that the hard disk drive in the server be maintained to prevent possible 
problems. The system administrator must run the following on a regular basis: 

● Disk Defragmenter system tool 

● chkdsk command 

If this server is in service and has not been recently maintained, run the two recommended 
procedures. 

Setting up the server for Modular Messaging
You must set up the customer-provided server to support Modular Messaging software as 
described in this section.
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Joining the Windows domain
You must manually add this server to the appropriate Windows domain for this Modular 
Messaging system: 

1. Switch the monitor to show this server. 

Use whatever method is required at this site to have the monitor display the MAS that you 
are administering. 

2. Log in to the local administrator account for this server: 

a. In the Log On to Windows window, change the user name to the local administrator 
account name, such as mas1-admin. See the Modular Messaging logon accounts 
form on page 221 for the local administrator account names and passwords. 

b. Enter the password for this account.

c. If the Log in to: field shows a different domain, use the drop-down box to select this 
server.

d. Press Enter or click OK.

3. Right-click My Computer and select Properties. 

4. In the System Properties window:

a. Click the Computer Name tab.

b. Click Change. 

5. In the Computer Name Changes window: 

a. Under Member of, select Domain.

b. Type the name for the corporate Windows domain. See Item C10 on the Corporate 
network planning form on page 216.

Note:
Note: Depending on the local configuration, you might need to enter the fully qualified 

name here. The FQDN is a combination of Items C2 and C10 on the Corporate 
network planning form on page 216. 

c. Click OK.

d. Another Computer Name Changes window might open. If it does:

1. Enter the name of an account that has permissions to join the Windows domain. You 
usually use the Modular Messaging customer account, if the domain administrator has 
set up the account as described in Creating Modular Messaging customer and 
technical support accounts on page 57. The account name must be in the format 
domain\account name, such as domain1\mmacct. 

2. Enter the password for this account. Click OK.

6. If a Welcome to the domain message is displayed, click OK.
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7. When prompted to restart, click OK. 

8. Click OK to close the System Properties window. 

9. If you are prompted to restart the server, click No. 

Adjusting system values
You must adjust some default values on the server to support Modular Messaging. Verify the 
following settings, and adjust them if needed: 

1. Adjust the values for the Event Viewer: 

a. Right-click My Computer and select Manage. 

b. In the Computer Management window, in the left pane, expand Event Viewer. 
c. Adjust the application log values: 

1. Right-click Application and select Properties.

2. On the General tab of the Application Properties window, under Log size, adjust the 
following values: 

- Avaya recommends that you set Maximum log size to at least 102400 KB. 

- Select Overwrite events as needed. 

3. Click OK to close the properties window. 

d. Adjust the system log values: 

1. In the right pane, right-click System and select Properties.

2. On the General tab of the System Properties window, under Log size, adjust the 
following values: 

- Set Maximum log size to at least 4032 KB. 

- Select Overwrite events as needed. 

3. Click OK to close the properties window. 

e. Close the Computer Management window. 

2. Right click Start and select Explore. Adjust File and Printer Sharing properties: 

a. Right-click My Network Places and select Properties. 

b. In the Network Connections window, right-click Local Area Connection and select 
Properties. 

c. In the Local Area Connection Properties window, select File and Printer Sharing for 
Microsoft Networks in the list box. Click Properties. 

d. In the properties window, on the Server Optimization tab, select Maximize data 
throughput for network applications. 
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e. Click OK to close the properties window.

f. Close the Local Area Connection Properties window.

g. Close the Network Connections window. 

3. Adjust the Windows 2003 Server operating system values:

a. Right-click My Computer and select Properties. 

b. In the System Properties window, click the Advanced tab. 

c. Under Performance, click Settings. 

d. In the Performance Options window, click the Advanced tab. 

1. Under Processor Scheduling, select Background services. 

2. Under Virtual memory, click Change. 

3. In the Virtual Memory window, the Initial size and Maximum size fields for the 
Paging file size for sected drive value vary by machine. Tailor these fields by adding 
11 to the default value that is displayed as follows:

- Under Paging file size for selected drive, set both the Initial size and Maximum 
size to the default value plus 11 MB. 

- Click Set.
- Click OK to close the Virtual Memory window. 

4. Click OK to close the Performance Options window.

e. On the Advanced tab of the System Properties window, under Startup and Recovery, 
click Settings. 

f. In the Startup and Recovery window, under System Failure, verify that the checkbox to 
Automatically restart is checked. Click OK. 

g. Click OK to close the System Properties window. 

Adding Modular Messaging accounts to the local 
Administrators group

For the accounts to work correctly, you must add the Modular Messaging customer account and 
the technical support account to the local administrators group:

1. Log in to the local administrator account for this server. For details, see Joining the 
Windows domain on page 95. 

2. Click Start > Control Panel. In the Control Panel window, double click Administrative 
Tools. In the Administrative Tools window, double click Computer Management.
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3. In the Computer Management window, under System Tools, expand Local Users and 
Groups, and then click Groups. 

4. Double-click the Administrators group in the right pane.

5. In the Administrators Properties window, click Add.

6. In the Enter object names to select pane, enter the names of the customer account and 
technical support remote access account. The account names must be in the format 
domain\account name (such as domain1\mmacct). 

Note:
Note: You can search for the accounts by entering a portion of the name in the Enter 

the object names to select pane, and clicking the Check Names button.

a. After names are entered, click OK.

7. Click OK to close the Administrators Properties window.

8. Close the Computer Management and Administrative Tools windows.

9. Restart the server before continuing: 

● If you are prompted to restart the server, click Yes. 

● If the system does not prompt you, manually restart the server now. For example:

a. Press Ctrl + Alt + Del, and then click Shut Down. 

b. Select Restart from the drop-down list and click OK. 

The server restarts. 
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Installing Windows prerequisite software
Microsoft Windows Service Pack 1 (SP1) and specific Windows services must be installed on 
each customer-provided MAS that will handle voice calls. 

Note:
Note: You must install the required Windows software before installing the required 

Microsoft Exchange software in the next section. 

Installing Microsoft Windows SP1
Microsoft Windows Service Pack 1 (SP1) must be installed before you can install the other 
required Windows services. 

SP1 might already be installed on this computer. To verify the service pack version and install 
an update if needed:

1. Verify the Microsoft Windows service pack version that is installed:

a. Right-click My Computer and select Explore.

b. In Windows Explorer, click Help > About Windows. 

c. In the version description, verify that Service Pack 1 is installed. 

d. Click OK to close this window. 

2. If needed, install Microsoft Windows Service Pack 1 on this MAS. Check with the Windows 
administrator for the appropriate software update procedures to use at this site. For details 
about this procedure, see the Microsoft Exchange documentation.

Installing and enabling required Microsoft Windows services
You must install and enable the Microsoft Windows services described in this section on this 
MAS. 

● If this MAS will have the Messaging Application Server service installed on it (see MAS 
services and features form on page 224), you must install and enable the IIS Admin and 
WWW Server Microsoft Windows services to support Modular Messaging Release 3. 

● If you must install the Microsoft Exchange System Management Tools for an Exchange 
2000 or 2003 system on this MAS (see Installing and Running the Modular Messaging 
Configuration Wizard on page 102), you must install and enable the required Microsoft 
Windows NNTP and SMTP services as described before you install the Microsoft 
Exchange software. 
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● If this MAS will have the Messaging Application Server service installed on it, and if Simple 
Network Management Protocol (SNMP) will be used for alarming at this site (see Support 
information on page 227), you must install and enable the appropriate Microsoft Windows 
services to support SNMP. 

To install and enable all required Windows services:

1. Log in to an account that has permissions to install software on this computer, such as the 
local administrator account. 

2. Insert the Microsoft Windows Operating System CD in the MAS drive.

3. Click Start > Control Panel > Add or Remove Programs.

4. In the Add or Remove Programs window, in the left column, click Add/Remove Windows 
Components. 

5. To install Microsoft Windows services: 

a. In the Windows Components Wizard window, highlight Application Server. Click 
Details. 

b. In the Application Server window, verify that the following items show a check mark, or 
enable them if necessary.

● Application Server Console

● ASP.NET

● Enable COM+ access

c. In the same window, highlight Internet Information Services (IIS), but do not check the 
box if the checkbox is clear. 

d. Click Details. 

e. In the Internet Information Services (IIS) window, verify that the following items show a 
check mark:

● Common Files

● Internet Information Services Manager

● World Wide Web Server

Note:
Note: The Internet Information Services items listed above are always required. If you 

plan to install the Microsoft Exchange 2003 System Management Tools, click the 
checkboxes to select NNTP Service and SMTP Service. The SMTP Service 
automatically selects other required components as needed.

f. In the same window, highlight World Wide Web Server and click Details. Verify that 
World Wide Web Services is checked.

g. Click OK to close the World Wide Web Service window. 

h. Click OK to close the Internet Information Services (IIS) window.
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i. Click OK a third time to close the Application Server window. 

6. Install the Windows services to support SNMP: 

a. In the Windows Components Wizard window, highlight Management and Monitoring 
Tools and click Details.

b. In the Management and Monitoring Tools window, click the checkbox to select Simple 
Network Management Protocol. Click OK. 

7. Complete the wizard to install the selected services.

Note:
Note: If the required services were already installed (all the appropriate boxes were 

checked), click Cancel to close the wizard.

8. When the installation is complete, close the Add or Remove Programs window.

9. After the software is installed, enable each installed service as follows: 

a. Right-click My Computer and select Manage. In the Computer Management window, 
the left (Tree) pane, expand Services and Applications, and then click Services.

b. In the right pane, scroll down to the first new service that you installed. Double-click the 
service to open the properties window. 

c. In the properties window: 

1. On the General tab, verify that the Startup type is set to Automatic. Set to automatic 
if it is not.

2. Click Apply. 

3. Under Service status, click Start. 
4. Wait for service to start, and then click OK to close this window.

d. Repeat Steps b and c to enable each of the services you installed. Note that only a 
subset of these services might be present on a particular MAS.

10. When all services are enabled, close all open windows. 

11. After the required Windows services are installed and enabled, apply any Windows system 
updates, security patches, and hot fixes to the update the new services. Check with the 
Windows administrator for the appropriate software update procedures to use at this site.
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Installing and Running the Modular Messaging 
Configuration Wizard

The Modular Messaging Configuration Wizard controls the next steps in the installation process. 
In installing and running the Modular Messaging Configuration Wizard you must complete the 
following procedures:

1. Installing and launching the Modular Messaging Configuration Wizard on page 102

2. Selecting or creating a DCT file on page 103

3. Installing third party software on page 107

4. Completing the MMCW Configuration on page 108

Installation procedures for Dialogic drivers and the RealSpeak engine differ if you have chosen 
to install modular messaging to a drive other than the default C: drive. Differences are described 
in each procedure. The drive location for the Modular Messaging installation is set in the DCT 
file.

Installing and launching the Modular Messaging Configuration 
Wizard

If you have a DCT file already created for this installation, be sure that it is accessible to the 
MAS that you are installing. In most cases this means inserting a USB storage device with the 
file into a USB port on the server. If you do not have a DCT file already created, you will be able 
to create one during the installation when completing step 3 in Selecting or creating a DCT 
file on page 103.

Complete the following steps to install the Modular Messaging Configuration Wizard:

1. Verifying that the USB storage device with the DCT file and DCT tool update is inserted in 
the USB port.

2. Turn the server on. 

3. Login to the MAS using the Modular Messaging customer account created in Creating 
Modular Messaging customer and technical support accounts on page 57.

4. Copy the DCT data file from the USB storage device to the C:\Avaya_Support directory. 
Some servers will not recognize a USB drive after a system restart.To copy the DCT data 
file to the server: 

a. Navigate to the USB drive, Removable Disk (E:). 
b. Right-click the most current DCT file for this site, such as sitefile.mmdct.

c. Copy the .mmdct file to the C:\Avaya_Support folder.
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d. Verify that the correct DCT file is listed in the C:\Avaya_Support directory. 

5. Update the Data Collection Tool. To update the tool:

a. Navigate to the USB drive, Removable Disk (E:)
b. Copy the MMDCTDistribute.exe file from the USB storage device to a folder on the 

server, such as C:\Avaya_Support.

c. Double-click the executable file MMDCTDistribute.exe and then click Unzip.

6. Insert the Avaya Modular Messaging Messaging Application Server Software media (disk 1) 
in the MAS DVD drive.

7. On the DVD drive, navigate to the Install\MISCM directory. Double click the 
MMConfigurationWizard.msi file. Enable the checkbox that will launch the MMCW. This will 
install the configuration wizard to the C:\Program Files\Avaya Modular Messaging\Install\
MISCM directory.

Selecting or creating a DCT file
Complete the following steps to configure the MAS from the DCT file:

1. On the Modular Messaging Welcome screen, click Next.
2. If you have a DCT file already created for this installation, complete the following steps and 

then proceed to step 4. If you don�t have a file go to step 3.

a. On the Locate Configuration Data screen, highlight the DCT file for this installation. If the 
file is not displayed, click Browse and browse to the directory where the DCT file is 
stored. By default, the Modular Messaging Configuration Wizard searches the directory 
for all files with the file type *.mmdct.

b. After selecting the DCT file that was created for this installation, click Next. You will be 
prompted to verify the file selection. Click Yes, to select the file.

c. The Data Collection Tool launches with the file you selected. Review and make any 
necessary changes to the file.

d. On the last screen, click complete and then save the file again if you have made any 
changes.

3. If you need to create a DCT file from completed planning forms, complete the following 
steps.

a. On the Locate Configuration Data screen, check the box to Create a new configuration 
file. Click Next. 

b. When the system prompts you to create a new configuration file, click Yes. The Data 
Collection Tool launches. 
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c. Use the information in the Planning forms to enter data for each screen in the DCT. As 
you progress through the pages, a green check mark (✓) indicates screens with 
complete and valid information. A red x indicates screens with incomplete or invalid data.

See the Data Collection Tool online help or its printed version, Avaya Modular Messaging 
Data Collection Tool Help for a complete description of all of the fields on each screen. The 
following table maps fields in the Data Collection Tool to the planning forms in Appendix 
A: System planning forms on page 209.

DCT Field Name Planning Form Location

Company name Item 1, Table 14: Modular Messaging System 
Planning Form on page 213

Organization name Item 2, Table 14: Modular Messaging System 
Planning Form on page 213

Time Zone Not in planning form

Keyboard input language Not in planning form

Message store Item 3, Table 14: Modular Messaging System 
Planning Form on page 213

Contact Information for message store 
administrator

Item 5, Table 14: Modular Messaging System 
Planning Form on page 213

Name (Voice Mail Domain) Item 6, Table 14: Modular Messaging System 
Planning Form on page 213

Number of MASs in the VMD Item 7, Table 14: Modular Messaging System 
Planning Form on page 213

Connect to corporate network (DHCP or static) Item 8, Table 14: Modular Messaging System 
Planning Form on page 213

Subnet mask Item C3, Table 15: Corporate network planning 
form on page 216

Full computer name (for MAS) Item C4, Table 15: Corporate network planning 
form on page 216

IP address (for MAS) Item C5, Table 15: Corporate network planning 
form on page 216

Register DNS suffix in DNS Item C15, Table 15: Corporate network planning 
form on page 216

Register IP address in DNS Item C15, Table 15: Corporate network planning 
form on page 216



Installing and Running the Modular Messaging Configuration Wizard

Issue 1 April 2006 105

 

DNS Servers IP addresses, in order of use Item C6, Table 15: Corporate network planning 
form on page 216

Search order of DNS domains Item C7, Table 15: Corporate network planning 
form on page 216

Default gateway IP address Item C8, Table 15: Corporate network planning 
form on page 216

WINS (if required) IP addresses Item C9, Table 15: Corporate network planning 
form on page 216

Microsoft Windows domain Item C10, Table 15: Corporate network planning 
form on page 216

Peer Exchange server Item C11, Table 15: Corporate network planning 
form on page 216

Peer directory server Item C12, Table 15: Corporate network planning 
form on page 216

Container if default not used Item C13, Table 15: Corporate network planning 
form on page 216

Software installation path Item C14, Table 15: Corporate network planning 
form on page 216

Local administrator accounts names and 
passwords

Table 18: Modular Messaging logon accounts 
form on page 221

Technical support name and password Item A13, Table 18: Modular Messaging logon 
accounts form on page 221

Customer account name and password Item A12, Table 18: Modular Messaging logon 
accounts form on page 221

Announcement languages Table 19: MAS services and features form on 
page 224

TTS languages and sessions Table 19: MAS services and features form on 
page 224

MM service selections Table 19: MAS services and features form on 
page 224

Switch integration Item 9, Table 14: Modular Messaging System 
Planning Form on page 213

DCT Field Name Planning Form Location
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d. On the last screen, click complete and then save the file.

4. After saving the DCT file, click complete to continue.

5. On the Messaging Application Server Number screen, in the MAS Number field, select the 
number of the MAS that you are installing and click Next.
The MMCW proceeds with the installation of the specified MAS unit based on information 
contained in the DCT file. 

Information contained in the DCT file is validated against the system at this time. This may 
result in errors that will require you to correct the data in the file or make system corrections 
and begin the configuration again. If you receive an error, see the screen-specific help for 
information about field parameters and conditions that may result in errors or warnings.

The progress of the installation is displayed by informational messages on the MMCW 
screen. 

6. The MMCW launches the dialogic driver installation for all switch integrations, except IP 
H.323 or IP SIP. When the MMCW launches the dialogic driver installation wizard, if you are 
installing Modular Messaging to the default C: drive, complete the wizard by accepting all 
default values. If you are installing Modular Messaging on an alternate drive, complete the 
following steps:

a. Move through the dialogic driver installation wizard until you see the Choose 
Destination Location screen.

b. On the Choose Destination Location screen click Browse.

c. On the Choose Folder screen in the Path: field, change the letter of the drive to match 
the drive where Modular Messaging is being installed. This drive is set in the DCT file. Do 
not browse to find the new location. The path will read <drive letter>:\Program Files\
Dialogic.

d. Click Next and continue to accept default values to complete the wizard.

7. When prompted on the Setup Complete screen, select No, I will restart my computer 
later, and click Finish.

8. Cancel out of the remote shutdown dialog window.

The installation continues. After awhile an Open window appears with InstallRSEngine.bat 
displayed in the File name field.

9. Insert disk 2 of the Avaya Modular Messaging Messaging Application Server Software 
media into the DVD drive to install the RealSpeak engine and languages. Click Open.

The RealSpeak 4.0 InstallShield Wizard starts.

10. If you are installing Modular Messaging to the default C: drive, complete the wizard by 
accepting all default values. If you are installing Modular Messaging on an alternate drive, 
complete the following steps:

a. Move through the RealSpeak installation wizard accepting defaults until you see the 
Custom Setup screen.
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b. On the Custom Setup screen, highlight RealSpeak Common Components. Click the 
arrow next to RealSpeak Common Components and select This feature and all 
subfeatures will be installed on local hard drive. Click Change.

c. On the Change Current Destination Folder screen, in the Folder name: field change 
the letter of the drive to match the drive where Modular Messaging is being installed. This 
drive is set in the DCT file. Do not browse to find the new location. The path will read 
<drive letter>:\Program Files\ScanSoft\RealSpeak 4.0\. 

d. Click OK and continue to accept default values to complete the wizard.

11. After the RealSpeak engine is installed, you will be prompted to reboot the system. Choose 
to reboot.

12. After the system reboots, log in using the customer account, for example mm_acct.

13. Continue with installing third party software.

Installing third party software
When installing third party software, install the following components:

● Exchange 2003 System Management Tools

● Exchange Server 2003 Service Pack 2

● MSDE install

● Anti-virus software

When prompted continue the installation by installing third party software.

1. When prompted to install third party software, install the Exchange 2003 System 
Management Tools by completing the following steps:

Note:
Note: The Microsoft Exchange 2003 System Management Tools must be installed on 

any MAS that will have any of the following services installed on it: 

- Messaging Application Server

- Call Me Server

- Message Waiting Indicator (MWI) Server. 

Exchange 2003 System Management Tools are required, Exchange 2000 System 
Management Tools are not supported.

a. Insert the customer-provided Microsoft Exchange 2003 Server media in the MAS drive.

b. Install the Management tools by completing the Microsoft Exchange Installation Wizard.

c. If you receive a compatibility warning, click Continue.

d. For details about this procedure, see the Microsoft Exchange documentation.
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2. Follow site-specific procedures to install Exchange Server 2003 Service Pack 2.

3. To install MSDE, complete the following steps:

a. Insert the Avaya Modular Messaging Messaging Application Server Software media (disk 
1) in the MAS DVD drive.

b. In Explorer navigate to the Install\System Upgrade\MSDE directory.

c. Double click on the MSDE.bat file.

d. After the utility runs, close the explorer window.

4. Install anti-virus software that is specified by your local site requirements and 
implementation. Avaya strongly recommends that you install anti-virus software on any 
Microsoft Windows computer that runs Avaya Modular Messaging software. For more 
information about anti-virus software on the MAS, see Administering anti-virus software on 
page 110.

Completing the MMCW Configuration
After third party software is installed continue with the following steps to complete the 
configuration

1. Verify that the Avaya Modular Messaging Messaging Application Server Software media 
(disk 1) is still in the MAS DVD drive. Then, click OK on the third party dialog box. The 
MMCW resumes with the following sequence of events:

● The Setup screen displays and proceeds directly to the System Upgrade screen.

● The system reboots without user intervention

● MMCW restarts automatically and runs the MM Application Setup, installing all MM 
services

● After another reboot and auto log on, the MMCW continues the system configuration, 
displaying informational messages as each component, such as dialogic drives or 
remote access is configured.

2. When MAS configuration is complete, the progress bar stretches across the window and 
the Next button becomes active. Click Next.

3. On the Modular Messaging Wizard Completed screen, click Finish.

4. To complete setup of the Modular Messaging server, proceed to Completing server 
setup on page 109
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Completing server setup
To complete setup of the server complete the following task as necessary:

● Installing software updates on page 109

● Setting logging location on page 110

● Administering anti-virus software on page 110

● Configuring port boards on page 111

● Setting up remote access on page 112

● Continuing the installation on page 112

When you have completed the procedures required for your system, proceed to Chapter 
8: Configuring the voice mail system on page 113

Installing software updates
A new Modular Messaging system ships with the most current software that is available at the 
time. However, the software must be updated after an installation or upgrade to include the 
latest changes. The updates might be in the form of an Avaya Service Pack (SP) or a software 
patch (hot fix). 

To determine if a Modular Messaging software update is needed: 

1. Locate any relevant Avaya software updates on the Avaya Support Web site at http://
www.avaya.com/support. For complete steps, see Obtaining software updates from the 
Web on page 279. 

Note:
Note: If you followed the procedure for Obtaining software updates on the Web on 

page 3, you already downloaded any required software updates. 

2. If the Modular Messaging system requires a software update, complete the update 
procedure now before you do acceptance testing. Follow the instructions in Appendix 
E: Updating Modular Messaging software on page 279 to update the system with the latest 
changes. 

http://www.avaya.com/support
http://www.avaya.com/support
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Setting logging location

! CAUTION:
CAUTION: You must have adequate space on the drive where your logs are located. If you 

do not, your system may fail to operate correctly. Check the location where your 
system is recording logs to be sure you don�t overrun your allotted space.

You may want to change the default location for recording logs if you do not have adequate 
space on the default C: drive location. Likewise, if you installed Modular Messaging to a drive 
other than the default C: drive, the logging location is not automatically changed. In this case 
you may want to change the location for recording logs to the same drive as the software 
installation.

To change the location for recording logs, complete the following steps:

1. Navigate to the following location on the drive where Modular Messaging was installed: 
<drive letter>:\Avaya_Support\Tools

2. Double-click the MM_Logging.exe file.

The Modular Messaging Verbose Logging Window opens.

3. Complete the following steps for each type of log displayed at the top of the screen with the 
exception of the Client.
a. Click the log-type button.

b. In the Folder for Log Files: field, edit the drive letter to the drive where you want logs 
stored. If you have installed Modular Messaging to an alternate drive, edit the field to 
show the drive where Modular Messaging was installed.

c. Click Apply at the bottom of the screen.

4. When the log location has been changed for all log types, click Close at the bottom of the 
screen.

Administering anti-virus software
Avaya strongly recommends that anti-virus software be installed on any Microsoft Windows 
computer that runs Avaya Modular Messaging software. The type of virus-checking software 
used and the method of installation depends on customer requirements and the local 
implementation. 

Guidelines for using anti-virus software on a computer that is running Avaya Modular 
Messaging software include:

● Consider the impact that anti-virus scanning has on the performance of the Avaya 
messaging servers. Avaya recommends the use of �on-demand� scanning, where scans 
are run at scheduled intervals. Avoid using a message-scanning method that could 
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drastically impact the performance of the Avaya servers. For example, do not use �on 
access� scanning. This type of scan runs whenever a file changes, and can have a 
negative impact on server performance. 

Note:
Note: Some anti-virus software applications default to scan on startup. Disable this 

feature, or it increases the time that it takes a system to come back online after a 
reboot.

● Avaya recommends administering the anti-virus software as follows: 

- Scan the hard disk at least once per week during off peak hours. Avaya recommends a 
daily scan. You can run scans on multiple Modular Messaging servers at the same time. 
However, avoid scheduling the anti-virus scan at the same time as when a scheduled 
backup occurs on the MAS. 

- Schedule virus definition updates to occur automatically at least once per week. The 
updates must occur before the next scheduled scan time to ensure that the latest data 
(DAT) files are used during the scan. However, do not schedule updates to occur during 
a virus scan.

- If the anti-virus software locates a virus, it should first attempt to clean the file. If that fails, 
the software should move the file to a different directory.

Information about anti-virus interoperability of Avaya Modular Messaging software with various 
anti-virus products and performance testing is available. The information addresses security 
issues such as reporting concerns and receiving notifications. For more information, see 
Anti-Virus Software on Microsoft Windows-based Avaya Messaging Products.

Configuring port boards
The Avaya Modular Messaging Configuration Wizard automatically configures any installed 
Dialogic port boards for several switch integrations, including: 

● Avaya CM (IP SIP) 

● Avaya (IP H323)

● Avaya (QSIG)

● Cisco (QSIG)

● Nortel NT M-1 (QSIG)

● Siemens Hipath (QSIG)
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If this MAS contains Dialogic port boards that do not use one of the automatic-configuration 
switch integrations, you must configure the port boards manually. 

1. Continue with Appendix D: Configuring and testing port boards on page 263. 

2. After you configure and test the Dialogic port boards, continue with Setting up remote 
access on page 112. 

Setting up remote access
Remote access allows technical support staff to dial into a system to correct problems and 
perform routine maintenance. You must provide a method for remote services to access the 
system. Follow site-specific requirements to set up remote access.

Continuing the installation
When you have finished installing the MAS, you must continue with configuring the voice mail 
system. See Configuring the voice mail system on page 113.
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Chapter 8: Configuring the voice mail system

This chapter describes how to configure the basic Voice Mail System Configuration (VMSC) 
parameters and complete initial Modular Messaging software administration.

Note:
Note: Before you can successfully complete the tasks described in this section, you 

must have completed the tasks in Chapter 6: Configuring a new Avaya MAS on 
page 77, Chapter 7: Configuring a customer-provided server on page 91, or 
Upgrading Modular Messaging software on an Avaya MAS on page 151. 
Additionally, if port boards are installed on the MAS and they are not 
automatically configured by the Modular Messaging Configuration Wizard 
(MMCW) you must complete the tasks in Appendix D: Configuring and testing 
port boards on page 263 before configuring the voice mail system. See When to 
configure port boards on page 263 for a list of automatically configured 
integrations.

Topics in this chapter include:

● Overview on page 113

● Configuring the voice mail system on page 114

● Verifying basic operation of this MAS on page 131

● Continuing the installation on page 133

Overview
To successfully complete voice mail configuration, you need:

● A completed copy of the forms in Appendix A: System planning forms on page 209, 
specifically:

- Modular Messaging System Planning Form on page 213

- Corporate Network Planning Form on page 215

- Modular Messaging logon accounts form on page 221 

- MAS services and features form on page 224

- Switch and messaging information on page 225

- Support information on page 227

● The configuration notes for this PBX or switch. For instructions on how to obtain these, see 
Required documentation and software on page 1. 
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Configuring the voice mail system 
Voice mail system configuration falls into three areas:

1. Domain-wide administration that must be done once for each new installation. You usually 
do these procedures on MAS#1, although you can adjust them later if needed. 

2. Administration of domain-wide features that can be installed on any MAS, such as Call Me 
or Message Waiting Indicator (MWI). 

3. Configuration information specific to each MAS, such as INADS alarming or port board 
administration. 

This section guides you through the configuration of key parameters that are required to get a 
new system operational. 

Note:
Note: Complete the tasks in this section to get the Modular Messaging system up and 

running with the basic required features. After the installation is complete, Avaya 
encourages customers to tailor the Voice Mail System Configuration (VMSC) 
parameters for their site. For more information, see the Avaya Modular 
Messaging Software Messaging Application Server Administration Guide (PDF 4 
MB), located on the documentation media. 

! CAUTION:
CAUTION: Some procedures in this section can only be completed by using the required 

configuration notes for this PBX or switch. For instructions on obtaining the 
configuration notes, see Required documentation and software on page 1.

Configuring required domain-wide features
This section describes how to configure domain-wide features that are required for each 
Modular Messaging system. Required features are:

● Specifying languages and verifying that service is started on page 115

● Configuring TUI and access settings on page 116

● Configuring the broadcast mailbox on page 117

● Configuring the PBX type on page 117

● Configuring serviceability settings on page 118

● Obtaining and installing a license on MAS#1 on page 120
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Note:
Note: For a new installation, do these procedures on the first MAS that is installed to 

ensure the configuration of all required system features. However, with the 
exception of initial PBX administration, most domain-wide features can be 
configured on any MAS.

Specifying languages and verifying that service is started

Specify the preferred language and verify that Modular Messaging service is started before you 
try to configure the voice mail system:

1. Specify the preferred language for this MAS:

a. Click Start > All Programs > Avaya Modular Messaging > Languages.

b. In the Modular Messaging User Properties window, select the Preferred language from 
the drop-down list.

c. Click OK. 

2. Verify that Modular Messaging service is started: 

a. Right-click My Computer and select Manage. In the Computer Management window, 
the left (Tree) pane, expand Services and Applications, and then click Services.

b. In the right pane, scroll down to MM Messaging Application Server.
c. Check the Status column.

1. If the status is Started, continue with Configuring TUI and access settings on 
page 116.

If service is not started, right-click MM Messaging Application Server and select 
Start.

The system starts the messaging service. 

Note:
Note: When you restart messaging service, the window immediately shows a status of 

Started. However, service might actually take several minutes to start, depending 
on the number of port boards installed and the integration method. 

d. Track the startup progress as follows:

1. In the Computer Management window, in the left pane, expand System Tools, and 
then Event Viewer. 

2. In the left (Tree) pane, click Application. 

3. Refresh the window display periodically until you see Telephony User Interface event 
1241, TUI service has been enabled. You can then proceed.
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Note:
Note: If an FEDB resynchronization occurs, the Modular Messaging system will not 

accept incoming calls during the FEDB resynchronization.

e. Minimize this window. You will use it later. 

Configuring TUI and access settings

You must configure the settings in this section once for each Modular Messaging system. 

1. Click Start > All Programs > Avaya Modular Messaging > Voice Mail System 
Configuration. 

The Voice Mail System Configuration window opens. All MASs present in the messaging 
system are listed under the voice mail domain.

Note:
Note: Do the steps in this section for entries under the voice mail domain, such as 

vmdom. Do not click the similar entries for a specific MAS under Message 
Application Servers at this time. 

2. Under the voice mail domain name, double-click Telephone User Interface.

a. On the General tab, set Number of Digits in a Mailbox to match the number of digits in 
the extension numbers on the customer PBX. See Table 20: Switch and messaging 
information on page 225. 

b. Click the Class of Service tab. 

c. Set up classes of service (COS) for subscribers as follows. See Switch and Messaging 
Information Form on page 225. 

1. Select the COS Number.
2. Update the COS Name to reflect this type of telephone user interface (such as Aria 

TUI, AUDIX TUI, or Serenade TUI). 

3. Select any required features for this COS and TUI.

4. Select the appropriate TUI type for this COS (Aria, AUDIX, or Serenade). 

5. Repeat Steps 1 through 4 to set up multiple COSs. Create at least one class of service 
for each TUI that will be used at this site.

Note:
Note: To set up a mixed environment of Aria, AUDIX, and Serenade TUIs, just assign 

the appropriate TUI to each COS. 

d. When finished, click OK to close this window.

e. If the system notifies you that the extension number changes will invalidate all previous 
mailboxes, click Yes to continue. 
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Note:
Note: Although the system prompts you to restart service several times during this 

procedure, you actually must restart service only as directed in this guide. You 
must restart service before entering the port board extension numbers in 
Configuring MAS-specific parameters on page 125. You restart service again at 
the end, when configuration is complete.

Configuring the broadcast mailbox

Enter a numeric address you will use to send a message to a broadcast list.

Note:
Note: You must complete this procedure on a machine where you have installed the 

Modular Messaging Active Directory extensions. For information about installing 
the Modular Messaging extensions, see Adding the Exchange extensions on 
page 74.

1. Click Start > All Programs > Microsoft Exchange> Active Directory Users and 
Computers.

2. In the Active Directory Users and Computers window, highlight the Windows domain used 
for Modular Messaging. See Item C10 (Microsoft Windows domain) on the Modular 
Messaging System Planning Form on page 213.

3. Select View and then select Advanced Features.

4. In the right-hand pane, double click Octel.
5. In the right-hand pane, double click the BDL group.

6. Select the Modular Messaging tab.

7. Type the numeric address for the broadcast mailbox.

8. Click OK to close the window.

Configuring the PBX type

Note:
Note: When you are upgrading a Modular Messaging system, you must complete the 

upgrade with the same PBX integration used for the previous release. Changes 
to the PBX integration can be made following the upgrade.

You must configure the PBX service settings for each Modular Messaging system using the 
configuration notes. 

1. In the Voice Mail System Configuration window, expand the PBXs item under the voice mail 
domain, such as vmdom. 

2. The Modular Messaging Configuration Wizard automatically configures many settings for 
the following switch integrations: 
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● Avaya CM (IP SIP) 

● Avaya (IP H323)

● Avaya (QSIG)

● Cisco (QSIG)

● Nortel NT M-1 (QSIG)

● Siemens Hipath (QSIG)

If you are using one of these switch types, the appropriate entry is already listed under 
PBXs. Proceed as appropriate:

● If a PBX type already exists, continue with Step 4.

● If no PBX type is listed, continue with Step 3.

3. Right-click PBXs and select Add New PBX Type.

a. For Telephony Type, select the type of port board that is installed in this MAS, such as 
Dialogic Set Emulation.

b. In the PBXs list box, select the type of switch integration that you have, such as Avaya 
G3 Set Emulation. 

c. Click OK to close this window.

d. In the Voice Mail System Configuration window, expand PBXs.

4. Double-click the PBX entry under PBXs.

5. Using the configuration notes for this PBX or switch, set up the specific PBX parameters 
required for this integration of the system. 

Configuring serviceability settings

You must set up serviceability (alarming) settings once for each Modular Messaging system. 

1. In the Voice Mail System Configuration window, double-click Serviceability. 

2. In the Serviceability - Voice Mail Domain window: 

a. On the General tab, select the type of alarming to be used for the Modular Messaging 
system: INADS, SNMP, or none. 

Note:
Note: The MAS must have a modem for you to select INADS alarming. 

b. If alarming is activated, enter the unique MAS product ID for this system. For this 
number, see Support information on page 227. 

Note:
Note: If Avaya is to support this system, you must enter the product ID that the Avaya 

Automatic Registration Tool (ART) provides. 
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c. Unless directed otherwise, you can accept the default values for the following 
parameters: 

● The conditions for sending an alarm notification

● The alarm level at which notification is to be sent: minor or major

● The system behavior for stopping Modular Messaging service

d. If you selected SNMP alarming, click the SNMP tab. To find out the required values, see 
SNMP alarming information on page 229. 

● For Network Management Station, specify the corporate network management 
system (NMS) that is to monitor the Modular Messaging system for alarm notifications 
(traps). Type either the IP address or the fully qualified domain name for the NMS in 
the field. Alternatively, you can click Browse to navigate to and select the correct 
NMS.

● For Context (community), enter the name of the context or community to which the 
NMS belongs, such as public.

●  For Acknowledgement type:

- Select Return trap to have the system actively acknowledge traps. 

- Select Ping surround to send a ping to the NMS before and after the system sends 
a trap to assume trap receipt. 

If you select Return trap acknowledgement, you must enable the required Windows 
service and set it to restart automatically:

1. Restore the Monitor window if you minimized it, or double-click the Monitor icon on 
the desktop.

2. Click Services (Local) in the left pane, if the item is not already selected.

3. In the right pane, scroll down to SNMP Trap Service. Double-click it to open the 
properties window. 

4. On the General tab, set the Startup type to Automatic. 

5. Click Apply. 

6. Under Service status, click Start. 
7. Wait for service to start, and then click OK to close this window.

8. Minimize the Monitor window for later use. 

e. Click OK to close the Serviceability - Voice Mail Domain window.
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Obtaining and installing a license on MAS#1

You must obtain and install a license for each Modular Messaging system. 

Note:
Note: You must use Remote Feature Activation (RFA) to obtain a license for all new 

systems. For the latest information, go to the http://rfa.avaya.com Web site. For 
complete licensing steps and contact information for RFA assistance, see Getting 
Started with RFA for Modular Messaging on the RFA Web site. 

If the Modular Messaging system is being implemented with an Avaya 
Communication Manager server, and if a T1-QSIG, E1-QSIG, or IP H.323 switch 
integration is used, the person who requests the Modular Messaging RFA license 
must also request the QSIG Supplementary Services package. The QSIG 
Supplementary Services package is an entitlement captured within the 
Communication Manager RFA license. It must be set to ON and uploaded to the 
Communication Manager server, separate from the Modular Messaging RFA 
License. Contact your Avaya representative for more information. 

Obtaining the license
To obtain a license for this system. 

1. An authorized person who is trained and registered must generate a license request for the 
new system using RFA. The request must include all the required information described in 
Getting Started with RFA for Modular Messaging. The exact procedure varies per location. 
However, the on-site installer must provide the voice mail domain identifier (VMD ID) to 
complete a license request.

2. You must obtain the unique VMD ID that identifies this particular system to complete a 
license request. To obtain the VMD ID: 

a. In the Voice Mail System Configuration window, right-click Licensing and select Copy 
Host ID to clipboard. 

b. Open the document where you want to record this information. For example, use a 
text-editor application such as Notepad. 

! CAUTION:
CAUTION: Use the copy-and-paste method of recording the VMD ID if possible. If you try to 

manually enter the VMD ID, it is easy to make mistakes. The VMD ID in the 
generated license must exactly match that of the target system, or the license 
fails to install. 

c. Right-click and select Paste to copy the VMD ID from the clipboard to the document.

d. Save the file. For example, save the file into My Documents as mymas1-vmdid.txt. 

e. Transmit the file that contains the VMD ID to a location that can access the Internet or 
e-mail location. Use any method that is required, such as FTP, memory stick, and so on. 

http://rfa.avaya.com
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Send the file to the RFA-authorized party, or use the file yourself to complete the RFA 
license request through the RFA Web site. Procedures vary per location. 

3. The authorized person completes the license request using RFA. The person then 
downloads or sends the license file by e-mail to the appropriate location. 

4. If another party must complete the license request, you can continue with the installation 
until you receive a valid license file. At that time, return to Installing the license on page 121.

! CAUTION:
CAUTION: For most switch integrations, you can continue the installation through 

acceptance testing using a dummy license that supports up to ten subscribers. 
For IP SIP integrations, however, you must receive and install a valid license 
before you can add any test subscribers and do acceptance testing. 

Installing the license
After the license file is obtained, install the license as follows: 

1. Transmit the license file, such as wlmNNNNNlicense.xml, to the MAS using the preferred 
customer method, such as FTP, memory stick, and so on. The recommended location for 
the license file is on MAS#1 in the C:\Avaya_Support directory. 

2. To install the license, in the Voice Mail System Configuration window, right-click Licensing 
and select Import License. 

3. On the License Import Wizard welcome screen, click Next. 
4. On the Importing the license screen, click Browse. 

5. Navigate to the location where the license file is stored, such as C:\Avaya_Support. 

6. Double-click the appropriate *.xml license file. If more than one file is present, verify that you 
select the correct one. 

7. Click Next to install the license.

8. When the procedure is complete, click Finish. 

! CAUTION:
CAUTION: If an error message states that the license is not valid, you must obtain a new 

license file. The event log on the MAS on which the license import failed might 
contain additional information about the failure reason. Verify that the license 
request contains the correct VMD ID for this system. Return to Step 2 and submit 
a new license request through RFA.

9. Continue with Verifying license installation and specifying TTS sessions on page 121. 

Verifying license installation and specifying TTS sessions 
After the license file is installed, verify the license installation. Next, set up the TTS sessions per 
MAS: 

1. In the Voice Mail System Configuration window, double-click Licensing. 
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2. In the Licensing - Voice Mail Domain window, on the General tab, verify that the system 
displays the correct values, according to the license agreement.

3. Click the Text-to-Speech tab. Each MAS in the voice mail domain is listed. 

a. For each MAS, double-click the TTS engine to set up, such as Text to speech, 
ScanSoft RealSpeak, Any Language. 

b. In the Edit Sessions window, enter the number of TTS sessions required for this MAS. 
See Table 19: MAS services and features form on page 224. Click OK. 

c. Repeat Step 3 for each licensed TTS engine. 

4. Click OK to close the Licensing window.

Note:
Note: After you complete the licensing procedure, you must restart service for the 

changes to take effect. 

Configuring specific features as needed
In a multiple-MAS setup, you must spread the Modular Messaging features among the servers 
in the system to improve performance. To determine what features you must configure for a 
particular MAS or supplementary server, see Table 19: MAS services and features form on 
page 224. 

Note:
Note: Do the appropriate procedures in this section on each MAS or supplementary 

server as required. 

Tip:
Tip: In a multiple-MAS system, configure specific features only after you complete 

basic configuration of all MASs in the system. Some features, such as MWI, TTS, 
and offline access to messages, require all MASs in the VMD to be working.

To configure specific features for this MAS: 

1. Use the Voice Mail System Configuration program. 

If this window is not already open, click Start > Programs > Avaya Modular Messaging > 
Voice Mail System Configuration. 

2. Using Table 19: MAS services and features form on page 224, configure the features that 
are required for this MAS or supplementary server. 

● Configuring Call Me service on page 123

● Configuring MWI service on page 123

● Configuring languages or TTS on page 124

● Configuring offline access to messages on page 124



Configuring the voice mail system

Issue 1 April 2006 123

 

Configuring Call Me service

To enable the Call Me Server on this server: 

1. Under the voice mail domain, such as vmdom, double-click Call Me.

2. In the Call Me - Voice Mail Domain window, on the General tab, click the checkbox to 
Enable Call Me.

3. For MAS Call Me server, specify the MAS on which the Call Me software is installed (such 
as MYMAS1). If this field is blank, type the server name, or:

1. Click the ... button next to the field.

2. In the Select Computer window, double-click the name of the MAS that has Call Me 
installed (such as MYMAS1).

3. Click OK to close this window.

Note:
Note: Because the Call Me server and Message Waiting Indicator (MWI) Server both 

use the Mailbox Monitor Server, they must be installed on the same MAS. 

Configuring MWI service

To enable the Message Waiting Indicator (MWI) Server on this server: 

1. Under the voice mail domain, such as vmdom, double-click Message Waiting Indicator.
2. In the Message Waiting Indicator - Voice Mail Domain window, on the General tab, click the 

checkbox to Enable Message Waiting Indicator (MWI). 
3. For MAS MWI server, specify the MAS on which the MWI Server is installed, such as 

MYMAS1. If this field is blank, type the server name, or:

a. Click the ... button next to the field.

b. In the Select Computer window, double-click the name of the MAS that has MWI service 
installed, such as MYMAS1.

4. For the Limit requests and Maximum requests per minute fields, use the values 
specified in the configuration notes for your PBX integration type. 

5. In the Messaging Application Servers that support MWI box, list all MASs that have a 
port group set up to support MWI. To add a server name:

a. Double-click inside the top of the big list box, or click the Add button just above the list 
box. The Add button looks like a dashed box. 

b. The list box displays a data entry field and a ... button. Click the ... button. 

c. In the Select Computer window, double-click the name of each MAS that has ports 
allocated to support MWI, such as MYMAS1. 

d. Repeat Steps b and c to add any other MASs that support MWI, such as MYMAS2.
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e. Click OK to close the Select Computer window. 

Note:
Note: The arrow icons move the selected MAS up or down the list. MWI requests start 

with the first MAS in the list, and continue to each additional MAS if needed.

6. Click OK to close the Message Waiting Indicator - Voice Mail Domain window.

Configuring languages or TTS

To configure multiple languages or the optional Text-to-Speech feature: 

1. Under the voice mail domain, such as vmdom, double-click Languages.

2. In the Languages - Voice Mail Domain window: 

a. For Primary Language, select the primary announcement language (prompt set) that is 
to be used at this site. See Table 19: MAS services and features form on page 224. 

b. If the Text-to-Speech (TTS) feature is used at this site: 

1. Click the checkbox to Enable Multilingual Text to Speech. 

2. In the list box, select all the languages to use for TTS at this site. See Table 19: MAS 
services and features form on page 224.

3. Click OK to close this window.

Configuring offline access to messages

! CAUTION:
CAUTION: Set up offline access only after all servers in the system are configured, including 

the supplementary server, if used.

To configure offline access to subscriber messages: 

1. Under the voice mail domain, such as vmdom, double-click Messaging.

2. In the Messaging - Voice Mail Domain window, click the Offline Access tab. 

3. Click the checkbox to Enable offline access to messages. 

4. If this system has multiple MASs:

a. Click the checkbox to Synchronize offline messages with remote store. 

b. Click Browse to select an existing, shared directory in the domain for the remote offline 
message store. See Item 10 in Table 14: Modular Messaging System Planning Form on 
page 213. 

The name must use the format \\locationname\sharename, such as \\mymas2\
OfflineStore. 
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5. Alter any other parameters in this window as needed. For more information, see the Avaya 
Modular Messaging Software Messaging Application Server Administration Guide (PDF 4 
MB) on the documentation media. 

6. Click OK to close this window. 

Configuring MAS-specific parameters
After the domain-wide parameters are configured, complete the configuration of this specific 
MAS in the VMSC. Do the procedures in this section under the specific entry for this MAS, and 
not under the voice mail domain. For a list of MAS names, see Item C1 in Table 15: Corporate 
network planning form on page 216. 

Note:
Note: Complete the tasks in this section on each MAS as required. 

MAS-specific procedures include: 

● Configuring INADS alarming, if used on page 125

● Configuring port boards and switch integration on page 126

When you configure some MAS-specific parameters, you will need to select the MAS in the 
Voice Mail System Configuration window. If the MAS you are configuring does not appear in this 
window, complete the following procedure:

1. In the Voice Mail System Configuration window, click the voice mail domain.

2. Click Message Application Servers.

3. Click the Edit>Add Message Application Server menu or use the right-click menu. The 
system displays the Add New Message Application Server dialog box.

4. Enter the name of the MAS in the Message Application Server field or use the Browse 
button to select it.

5. Click OK.

Configuring INADS alarming, if used

If this MAS uses INADS alarming, configure the service now. You must administer INADS 
alarming individually for each server that uses it. The server requires a modem and the 
Messaging Application Server service to be installed for INADS alarming to work. 

To set up INADS alarming on this MAS: 

1. In the Voice Mail System Configuration window, expand Message Application Servers. 
For MAS names, see Item C1 on the Corporate network planning form on page 216.

2. Expand the entry for this MAS, such as MYMAS1. 
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3. Double-click Serviceability to set up dial-out information for this MAS. See INADS alarming 
information on page 229. 

4. In the Serviceability window: 

a. For COM port, select the communications port that the modem is to use to make calls for 
alarm notification. This is usually COM3 on an Avaya MAS if you used recommended 
USB port A. For more information with an Avaya MAS, see Connecting the USB modem 
on the MAS on page 41. 

b. For Phone number, enter the complete telephone number that the modem must dial to 
place an alarm notification with the remote service center. Include any special characters 
needed. For example, to access an outside line, insert pauses, and so on. 

c. For Modem setup, enter the modem initialization (setup) string if one is required for the 
modem to make alarm notification calls. 

5. Click OK to close this window. 

6. When prompted restart service.

Configuring port boards and switch integration

The Modular Messaging Configuration Wizard might have automatically configured many of the 
port board and PBX settings for this MAS. However, you must always verify the configuration 
settings against the current configuration notes. 

The Modular Messaging Configuration Wizard automatically configures the MAS settings for the 
following switch integrations: 

● Avaya CM (IP SIP) 

● Avaya (IP H323)

● Avaya (QSIG)

● Cisco (QSIG)

● Nortel NT M-1 (QSIG)

● Siemens Hipath (QSIG)

If you are using one of these switch types: 

1. Verify the MAS settings against the configuration notes in case of changes. 

2. Administer all required settings on the switch. 

If you specified Other for the switch integration type, you must always configure both the MAS 
settings and the switch settings for each MAS. 
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Note:
Note: The configuration notes for this PBX or switch might include some of these steps. 

However, read through this section first to get an overview of the whole 
configuration procedure. Some of the configuration notes contain some of these 
steps, while others do not. It does not hurt to repeat steps and verify the setup. 
You can also update or change this information later if required. 

To set up the basic PBX integration details for each MAS in this domain: 

1. In the Voice Mail System Configuration window, expand Message Application Servers. 

2. Expand the entry for this MAS, such as MYMAS1. For MAS names, see Item C1 in 
Table 15: Corporate network planning form on page 216. 

3. Right-click the server name, and then select Telephony Configuration Wizard. 

4. Complete all steps in the wizard, as prompted. Use the configuration notes as required. 

5. After you complete the wizard, you must restart messaging service so you can configure the 
voice ports:

a. Restore the Monitor window if you minimized it, or access the window to monitor services 
using one of these methods:

● Double-click the Monitor icon on the desktop (if present). In the left pane, click 
Services if it is not already selected.

● Right-click My Computer and select Manage. In the Computer Management window, 
the left (Tree) pane, expand Services and Applications, and then click Services.

b. Click Service (Local) in the left pane, if the item is not already selected.

c. In the right pane, scroll down to MM Messaging Application Server. Right-click it and 
select Stop. 

d. When service is stopped, right-click MM Messaging Application Server again and 
select Start.
The system restarts the messaging service. 

Note:
Note: When you restart messaging service, the window immediately shows a status of 

Started. However, service might actually take several minutes to start, depending 
on the number of port boards installed and the integration type.

e. Track the startup progress as follows:

1. Access the event viewer using one of these methods:

- In the Monitor window, in the left pane, expand Event Viewer (Local). 
- In the Computer Management window, in the left pane, expand System Tools, and 

then Event Viewer. 
2. In the left (Tree) pane, click Application. 
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3. Refresh the window display periodically until you see Telephony User Interface event 
1241, TUI service has been enabled. You can then proceed.

Note:
Note: If an FEDB resynchronization occurs, the Modular Messaging system will not 

accept incoming calls during the FEDB resynchronization.

f. When service is restarted, minimize this window.

6. In the Voice Mail System Configuration window, expand Message Application Servers. 

Note:
Note: Some values might already be set. Follow the configuration notes for this PBX 

integration.

a. Expand the entry for the server name (such as MYMAS1). 

b. Double-click Telephony Interface. Configure the port boards in this MAS. Use the 
configuration notes. For port board extensions, see Table 20: Switch and messaging 
information on page 225.

c. Double-click PBX Type. Select the same type of PBX service as you did in Configuring 
the PBX type on page 117. Verify that the entry in the PBXs box is highlighted, and click 
OK. 

d. If multiple port groups are used, double-click Port Groups. For example, you might use a 
unique group to support MWI. For more information, see Table 20: Switch and 
messaging information on page 225. 

e. Double-click PBX Integration and configure the integration type for this system. Use the 
configuration notes to specify or confirm the settings this switch integration requires. 

Note:
Note: To determine the maximum number of MWI sessions to specify at one time, see 

MAS Services and Features Form on page 223.

Restarting service
When all configuration for this server is complete, restart messaging service: 

1. Restore the Monitor window if you minimized it, or access the window to monitor services 
using one of these methods:

● Double-click the Monitor icon on the desktop (if present). In the left pane, click 
Services if it is not already selected.

● Right-click My Computer and select Manage. In the Computer Management window, 
the left (Tree) pane, expand Services and Applications, and then click Services.

2. Click Service (Local) in the left pane, if the item is not already selected.
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3. For a supplementary server, continue with Step 4. For an MAS, restart messaging service to 
accept any changes you made in the VMSC: 

a. In the right pane of the Monitor window, scroll down to MM Messaging Application 
Server. Right-click it and select Stop. 

b. When service is stopped, right-click MM Messaging Application Server again and 
select Start.
The system restarts the messaging service. 

Note:
Note: When you restart messaging service, the Monitor window immediately shows a 

status of Started. However, service might actually take several minutes to start, 
depending on the number of port boards installed and the integration method. 

c. Track the startup progress as follows: 

1. Access the event viewer using one of these methods:

- In the Monitor window, in the left pane, expand Event Viewer (Local). 
- In the Computer Management window, in the left pane, expand System Tools, and 

then Event Viewer. 
2. In the left (Tree) pane, click Application. 

3. Refresh the window display periodically until you see Telephony User Interface event 
1241, TUI service has been enabled. You can then proceed.

Note:
Note: If an FEDB resynchronization occurs, the Modular Messaging system will not 

accept incoming calls during the FEDB resynchronization.

4. Verify that all messaging services required for this MAS are started: 

a. In the Monitor window, click Services (Local) in the left pane, if the item is not already 
selected.

b. In the right pane, scroll down to the list of Modular Messaging services. All services start 
with the abbreviation MM. Verify that the Status column shows the correct state for each 
messaging service: 

● Services that are required for this server must show Started and a startup type of 
Automatic. See Table 19: MAS services and features form on page 224. 

● Services that are not required on this server must show a blank status and a startup 
type of Disabled. 

Complete the following steps if necessary to change the status.

c. If the Startup Type for any MM service that is not required for this server is Manual: 
1. Double-click the service to open the Properties window. 

2. Set the Startup type to Disabled. 
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3. Click OK. 

4. Refresh the screen to verify that all MM services not required for this server are 
Disabled. Repeat Step c as needed. 

! CAUTION:
CAUTION: All MM services that are not required for this server must be set to Disabled 

before you do Step d. Serious problems occur if you activate a service that is 
supposed to run on only one server in the VMD on multiple servers. 

d. If the Status for any MM service that is required for this server is Stopped or blank: 

1. Click Start > Run to open the Run window. 

2. In the Open field, type the following and press Enter: 
C:\Avaya_Support\Scripts\serverrecovery.vbs 

The script takes a few seconds to run. The program sets up all MM services correctly. 

3. Refresh the screen to verify that all MM services required for this server are Started 
and set to Automatic.

4. If any MM services are not set up correctly, repeat Step d. 

5. When configuration is complete, close all open windows. 

6. For a multiple-MAS system, after you configure the last MAS and install the license file, you 
must restart service on all servers in the VMD. The following properties require a restart of 
all servers in the voice mail domain: 

● Languages

● Licensing

● Messaging

● Offline Access

● PBXs

● Per MAS features including Telephony Interface, Port Groups, PBX Integrations, PBX 
Type, and Tracing File Size. 

Note:
Note: Any feature that you alter in the VMSC that produces a prompt to restart voice 

service requires a restart of all servers in the VMD. For convenience, you can 
restart all the MASs in the VMD once at the end of the installation. 

To restart service on all MASs in the voice mail domain: 

a. Switch the monitor to show the next MAS in the system. 

b. Repeat Steps 3 and 4 to restart service. 

c. Repeat this procedure for each MAS in the system. 
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Verifying basic operation of this MAS
Complete the following tests to verify the basic functionality of this MAS.

● Verifying call-handling capability on page 131

● Verifying alarming setup on page 131

● Verifying Tracing Service operation on page 132

Verifying call-handling capability
Do this task on any MAS that is set up to handle calls. 

This test confirms basic connectivity between the MAS and the switch.

1. If this MAS is in a multiple-MAS system, display the port monitor to ensure that the test call 
comes in on this MAS. For this procedure, see Setting up the port monitor on page 138. 

2. From a telephone on the system, dial the message retrieval number for the Modular 
Messaging system.

3. Listen for the Modular Messaging system to answer.

4. Hang up. 

Verifying alarming setup 
Do this task on any MAS that is set up for INADS or SNMP alarming. This test will not work if the 
alarming service is not installed or if alarming is set to None. To confirm the serviceability 
settings used at this site, see Configuring serviceability settings on page 118. 

This test requires the receiving computer, either INADS or SNMP, to be set up by the 
appropriate party and ready to receive alarms. 

To verify that alarm notification is working:

1. Click Start > Run.

2. In the Run window Open field, type cmd and press Enter.
3. In the command prompt window, type the following and press Enter:

testaom -v
The test shows the type of alarming that is set up (INADS or SNMP), the product ID for the 
MAS, and the alarming settings. The test takes about 1 minute to run. 
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4. Verify that the last line of the test reads:

Alarm origination test successful 
Continue with Step 6. 

5. If the alarm test fails, the last line of the test reads: 

Negative acknowledgement of transmission
If the test fails, check your alarming settings, and then run the test again: 

● For all systems, see Configuring serviceability settings on page 118. 

● For systems that use INADS, also check Configuring INADS alarming, if used on 
page 125. 

6. Type exit and press Enter to close this window. 

Note:
Note: For instructions on accessing the MAS alarm or error logs, see the Avaya 

Modular Messaging Software Messaging Application Server Administration 
Guide (PDF 3 MB) on the documentation media. 

Verifying Tracing Service operation 
If you enabled the Tracing Server software on an MAS or a supplementary Tracing server, test 
the Tracing System operation as follows: 

1. Click Start > Programs > Avaya Modular Messaging > Operational History Viewer.
2. Set up a live mode session for all MASs in the voice mail domain (VMD):

a. In the history viewer window, click File > New. 

b. In the Session Properties window, verify that Message Application Server shows 
All Servers is selected. 

c. Click the checkbox for Live Mode. 

d. Verify that all the Select Types checkboxes are checked.

e. Under Selection Activities, verify that the All Activities checkbox is checked. 

f. Click OK. 

3. Confirm that the Tracing Server can connect to all MASs in the VMD.

4. Confirm that the Operation History (OPH) viewer displays the collected OPH events.

5. You can close the OPH Viewer, or keep it open to monitor acceptance tests. For more 
information, see Using the Operational History Viewer on page 138. 

6. If you close the OPH Viewer, the system might prompt you to save the session. Click No. 
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Note:
Note: For more information about using the Operation History Viewer, see the Avaya 

Modular Messaging Software Messaging Application Server Administration 
Guide (PDF 4 MB) on the documentation media. 

Continuing the installation
If you have additional MASs to configure return to Configuring a new Avaya MAS on page 77 or 
Configuring a customer-provided server on page 91.

If you have configured all MASs, continue to Testing and backing up the system on page 135.
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Chapter 9: Testing and backing up the system

This chapter describes how to perform acceptance tests to verify that the Modular Messaging 
system is providing full service. After functionality is verified, back up the system to protect the 
Modular Messaging configuration data. 

Note:
Note: Before you can successfully complete the tasks described in this section, you 

must have successfully completed the tasks in Chapter 8: Configuring the voice 
mail system on page 113.

Topics in this chapter include:

● Adding a test subscriber on page 136

● Setting up monitoring tools�optional on page 138

● Performing acceptance tests on page 140

● Removing the test subscribers on page 145

● Backing up the system on page 147

● Turning over the system to the customer on page 149
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Adding a test subscriber
For a new installation, the directory server administrator previously created test subscriber 
accounts for each telephone user interface. See Creating test subscriber accounts on page 61. 
Before you can complete the acceptance tests, the administrator must assign Modular 
Messaging characteristics to these accounts. 

Note:
Note: If you are performing tests following a Modular Messaging software upgrade, you 

might want to test the system using subscribers that are already administered. 

For details on administering Modular Messaging features, see Chapter 15, �Creating subscriber 
accounts for Microsoft Exchange," in the Avaya Modular Messaging Software Messaging 
Application Server Administration Guide (PDF 3 MB) on the documentation media.

Complete the following sets to set up the test subscribers. 

1. Log in to the Active Directory server using an account that has privileges to create new user 
accounts (such as administrator). 

Note:
Note: The Modular Messaging Active Directory Extensions must have been installed on 

the server before you can administer any subscribers. For additional information 
about the Modular Messaging Extensions, see Adding the Exchange 
extensions on page 74.

2. Click Start > All Programs > Microsoft Exchange> Active Directory Users and 
Computers.

3. In the Active Directory Users and Computers window, expand the directory for the Windows 
domain you used for Modular Messaging. See Item C10 on the Table 15: Corporate 
network planning form on page 216.

4. In the left pane, click Users. 

5. In the right pane, double-click a test subscriber account, such as Aria Test Subscriber 
(testsub1), to open the properties window.

6. Click the Modular Messaging tab. 

Note:
Note: The first time you access this tab, you might see a Choose Message Application 

Server window. Enter the name of an MAS (or click Browse to select it), and then 
click OK. 

There might be a delay as the server logs in.

7. Set up the test subscriber with Modular Messaging features as follows: 

a. Click the checkbox to Enable Modular Messaging. 
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b. Verify the voice mail domain (VMD). See Item 6 on the Table 14: Modular Messaging 
System Planning Form on page 213. 

c. Enter the extension number, mailbox number, numeric address, and TUI password. See 
Mailbox and subscriber information on page 226. 

Note:
Note: The numeric address must be unique among all the addresses in the messaging 

network. For example, you could prepend a 1 or the area code to the mailbox 
number. 

All extensions for the test subscribers must be administered on the PBX by the 
appropriate party. See Mailbox and subscriber information on page 226.

d. Click Advanced. In the Advanced Properties window: 

1. Select the appropriate Class of service for this test subscriber (for example, Aria TUI, 
AUDIX TUI, or Serenade TUI). 

2. In the Capabilities list box, under Message assistant, click the checkbox to Allow 
Message Waiting Indicator.

3. Click the appropriate checkboxes to activate any other features that you have installed 
and must test at this site.

4. Click OK to close the Advanced Properties window. 

e. When finished setting up this test subscriber, click OK.

8. To set up another test subscriber (for example, to test the MM AUDIX or MM Serenade 
telephone user interface), repeat Steps 5 through 7. 

9. Although Message Waiting Indicator has been allowed, it must also be enabled for each test 
subscriber.

a. Right-click My Computer and select Manage. 

b. In the Computer Management window, in the left pane, expand Event Viewer. 
c. Refresh the window display periodically until you see a 1027 event. You must see the 

1027 event before you can proceed.

d. In the Active Directory Users and Computers window, double-click the first test 
subscribers.

e. Select the Modular Messaging tab.

f. On the Modular Messaging tab, click User Options.

g. In the Assistant window, click the Message Waiting Indicator box and the box for any 
other capabilities that you have previous activated and that you intend to test.

h. Click OK to close the window.

i. Repeat steps d through h for each test subscriber.

10. When finished, close the Active Directory Users and Computers window. 
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Setting up monitoring tools�optional
You can use the monitoring aids described in this section to help you complete the acceptance 
tests. 

Using the Operational History Viewer
You can use the Operational History Viewer to monitor call progress for any MAS. The viewer 
can help to identify the cause of the problem if errors occurs during testing. 

To open the Operational History Viewer: 

1. Click Start > Programs > Avaya Modular Messaging > Operational History Viewer.
2. Set up a live mode session for all MASs in the voice mail domain (VMD):

a. In the history viewer window, click File > New. 

b. In the Session Properties window, verify that Message Application Server shows 
All Servers is selected. 

c. Click the checkbox for Live Mode. 

d. Verify that all the Select Types checkboxes are checked.

e. Under Selection Activities, verify that the All Activities checkbox is checked. 

f. Click OK. 

3. During testing, monitor Operation History (OPH) events in the OPH Viewer. The OPH 
Viewer displays events as they happen on the system. 

4. After testing is complete, close the OPH Viewer. 

5. If the system prompts you to save the session, click No. 

Setting up the port monitor
This task is optional for a one-MAS system, but is recommended for a system that has multiple 
MASs that are set up to take calls. 

Tests calls can come in through the ports on various MASs in the system, depending on how the 
hunt group is set up on the PBX. If the Modular Messaging system has more than one MAS, 
use the port monitor to verify that the test calls you make are coming in on the ports of the MAS 
that you want to test.

To display the port monitor: 

1. Click Start > All Programs > Avaya Modular Messaging > Port Monitor.
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2. When the system prompts for the Message Application Server, select the MAS that you 
want to test (such as MYMAS1). Click Select.
The Port Monitor window for this MAS is displayed. 

3. You can repeat Steps 1 and 2 to bring up Port Monitor windows for multiple MASs if desired. 

4. When you dial the Modular Messaging system message retrieval number during the 
acceptance tests, check the Port Monitor window to verify that the call is coming in on a port 
of the MAS that you want to test. 

5. If the Port Monitor does not show that the test call is coming in on the desired MAS, hang up 
and dial the Modular Messaging system message retrieval number again. 

The number of times you might have to dial depends on the switch administration. For 
example, the hunt group might be administered to send each new call to the next MAS in 
the system, or it might be administered to send all the calls to one MAS before it moves on 
to a subsequent MAS. 
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Performing acceptance tests
Complete the following tests on each MAS that is set up to handle calls. 

! CAUTION:
CAUTION: Wait 5 minutes after completing the tasks in Chapter 8: Configuring the voice mail 

system on page 113 to give the system time to update all servers in the voice 
mail and Windows domains with the correct Modular Messaging information. 

Creating and sending a call answer message
The following test works only if call-coverage has been assigned on the switch to route 
unanswered calls to the extension for the test subscriber.

To create and send a call answer test message:

1. Call the MM Aria test-subscriber extension from any other telephone. Allow the Modular 
Messaging system to answer.

2. Speak into the telephone and record the following or a similar test message after the tone:

"This is a test call answer message."

3. Hang up the telephone to disconnect. 

4. Repeat Steps 1 through 3 for each TUI that you are testing.

Retrieving test messages in integrated mode
Test the fully integrated operation of the system as directed. You need access to the actual 
telephone whose extension number is assigned to the test-subscriber mailbox to perform this 
test. 

To verify the receipt of the test messages in integrated mode:

1. If MWI is installed: Check the message waiting indicator (MWI) on the test-subscriber 
telephone. The MWI can be a light, a screen display, or a dial-tone stutter that you hear 
when you pick up the phone. 

Note:
Note: The message-waiting lamp might take up to 1 minute to light on the appropriate 

telephone after a test message is sent.

If the MWI does not indicate that a call was received:
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a. Verify that the Mailbox Monitor and MWI services are started.

1. Access the window to monitor services using one of these methods:

- Double-click the Monitor icon on the desktop (if present). In the left pane, click 
Services if it is not already selected. 

- Right-click My Computer and select Manage. In the Computer Management 
window, the left (Tree) pane, expand Services and Applications, and then click 
Services.

2. In the right pane, scroll down to the Modular Messaging (MM) services. Verify that the 
Status column shows that service is Started for each installed messaging service.

3. If service is stopped or if the Status column is blank, right-click the appropriate MM 
service and select Start.

4. When finished, close this window.

b. If service is started, check for a problem with the test subscriber administration, the 
switch integration or switch integration software, or the switch number administration for 
the test telephone. 

2. From the test-subscriber telephone, dial the Modular Messaging system message retrieval 
number.

3. Enter the password for this mailbox and press #

The system voices the name of the test subscriber.

4. The first time you access this mailbox, you answer a series of prompts to set up the mailbox 
for operation. Answer all voice prompts as directed.

5. After the mailbox is set up, retrieve the test message.

The system uses different commands to retrieve messages depending on whether you are 
using the Aria or AUDIX user interface.

To retrieve a test message using the MM Aria interface:
1. After the mailbox is set up: 

a. Press 1 to review the new messages.

b. Press 1 to retrieve a voice message.

c. Listen to the message. If the message does not play properly, contact the remote support 
center.

d. Press 7 to erase this message.

e. Repeat Steps c and d to review the next message (if any), or press * to return to the main 
menu.

2. Hang up the telephone to disconnect when finished.

3. If MWI is installed, check the MWI on the test-subscriber telephone. The MWI should be off. 
If it is not off, check the MWI administration on the MAS and the PBX. 
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To retrieve a test message using the MM AUDIX interface:
1. After the mailbox is set up: 

a. Press 2 to review the new messages.

b. Press 0 to listen to the test message. If the message does not play properly, contact the 
remote support center.

c. Press * D (or * 3) to erase this message.

d. Repeat Steps b and c to review the next message (if any), or press 
* R (or * 7) to return to the main menu.

2. Hang up the telephone to disconnect when finished.

3. If MWI is installed: Check the MWI on the test-subscriber telephone. The MWI should be off. 
If it is not off, check the MWI administration on the MAS and the PBX. 

To retrieve a test message using the MM Serenade interface:
1. After the mailbox is set up: 

a. Press 5 to review the new messages.

b. Listen to the test message. If the message does not play properly, contact the remote 
support center.

c. Press 3 to erase this message.

d. Repeat Steps b and c to review the next message, if any. 

e. Press the pound key (#) to return to the Ready menu.

Creating and sending a test message in nonintegrated mode
The system uses slightly different commands, depending on the telephone user interface you 
have. Differences are noted in the text. 

To create and send a test message in nonintegrated mode: 

1. Dial the Modular Messaging system message retrieval number from any telephone that is 
not administered on the system.

The system voices the "Welcome to Avaya Messaging" prompt.

2. Press # to skip the system introduction. 

3. Enter the extension number for test-subscriber mailbox.

4. Enter the password for this mailbox and press #. 

The system voices the name of the test subscriber.

5. To create a new message:
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● On the MM Aria interface, press 2.

● On the MM AUDIX interface, press 1.

● On the MM Serenade interface, press 6. 

6. Speaking into the telephone, record the following or a similar test message after the tone: 
"This is a test voice mail message."

7. Press # to approve the message.

8. When the system prompts you, enter the mailbox number for any other test subscriber 
when prompted for the extension. Then press #.

The system voices the name of the test subscriber.

9. To approve the message and address list:

● On the MM Aria interface, press # twice (as prompted).

● On the MM AUDIX interface, press #.

● On the MM Serenade interface, press the pound key (#) twice.

10. Press # again to send the test message to the test-subscriber mailbox.

11. Hang up the telephone to disconnect. 

12. Retrieve the message as described in Retrieving test messages in integrated mode on 
page 140.

Testing the outcalling capability
Test the outcalling capability of the system using the Modular Messaging (MM) Client software, 
also known as the Avaya Modular Messaging Subscriber Options package. 

To test system outcalling:

1. Run this test from any machine where the Subscriber Administration extensions are 
installed. For details, see Adding the Exchange extensions on page 74.

2. Click Start > All Programs > Microsoft Exchange> Active Directory Users and 
Computers.

3. In the Active Directory Users and Computers window, expand the directory for the Windows 
domain you used for Modular Messaging. See Item C10 on the Table 15: Corporate 
network planning form on page 216.

4. In the left pane, click Users. 

5. In the right pane, double-click a test subscriber account and open the properties window. 
For complete steps, see Steps 3 through 5 in Adding a test subscriber on page 136. 

6. Click the Modular Messaging tab. 
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Note:
Note: The first time you access this tab, you might see a Choose Message Application 

Server window. Enter the name of this MAS (or click Browse to select it), and 
then click OK. 

There might be a delay as the server logs in.

7. Click User Options to run the Modular Messaging client software. 

8. Click the Media Setup tab. 

9. Set up the recording and playback options to use a telephone near you:

a. For When composing voice messages, select Telephone.

b. Click Configure.

c. In the Telephone Properties window, enter the extension number of a telephone near 
you. 

d. Select or enter the name of this MAS if needed. Click OK. 

e. For When reviewing voice messages, select Telephone. 

f. Repeat Steps b through d to set up telephone playback. 

10. Verify that a name is recorded, and record one if needed. For example: 

a. On an Exchange 2000 or 2003 system: In the Modular Messaging User Properties 
window, click the Record Greetings tab. 

b. Verify that the telephone will be used for recording and playback:

1. Check the icon to the left of the status display. If it shows a telephone, continue with 
Step c.

2. If the icon shows a terminal, right-click and select Telephone. The icon changes to 
show a telephone. Continue with Step c.

c. Under Standard Greetings, select Spoken Name. 

● If a green indicator is displayed next to this option, a name is already recorded. Go to 
Step 11. 

● If a name is not recorded: 

1. Click Record (the red circle) on the player near the bottom of the window.

2. When the telephone rings, answer it and record a name for the test subscriber after 
the tone. 

3. When finished, click Stop (the black square) on the player. 

4. Click OK. 

11. Play back the spoken name to test outcalling, as follows:

a. Click the Play button (large black single arrow) on the player near the bottom of the 
window. 
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b. Answer the telephone when it rings. 

The picture of the phone changes to become off-hook. 

c. Listen for the system to play the spoken name of the test subscriber. 

d. Hang up the telephone. 

The picture of the phone changes back to being on-hook (this might take a couple of 
seconds).

e. Click OK to close the Modular Messaging User Properties window. 

12. When finished, close all open windows. 

Running additional tests
You might want to run additional tests to verify the correct operation of features that are 
particularly important to the customer. For example:

● Automated Attendant

● Call Me

● Find Me

● Octel Analog Networking

To test these or other features, see the Avaya Modular Messaging Software Messaging 
Application Server Administration Guide (PDF 3 MB) on the documentation media for feature 
setup and operation instructions. 

Removing the test subscribers
When acceptance testing is complete, remove any test subscribers using the normal 
procedures for this version of Microsoft Exchange. For example:

1. Log in to the directory server using an account that has privileges to delete user accounts 
(such as administrator).

2. Access Active Directory Users and Computers.

3. Expand the directory for the Windows domain you used for Modular Messaging.

4. In the left pane, click Users or Recipients as required.

5. In the right pane, right-click each test subscriber and select Delete. 
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Verifying creation of external caller objects
Complete the following procedures to validate proxy addresses and mailbox rights.

Validating proxy addresses
To validate proxy addresses:

1. Log in to the Active Directory server.

2. Click Start > All Programs > Administrative Tools > Active Directory Users and 
Computers.

3. In the Active Directory Users and Computers window, select Advanced Features from the 
View menu.

4. Double-click the Octel container.

5. In the right-hand panel, double-click ExternalCaller.
6. Select the Email Addresses tab.

You should see at least an SMTP proxy address defined for the object.

7. If a proxy address is not defined:

● If you know the exact value, enter it here by clicking New, selecting a type, and entering 
an address.

● If you do not know the exact value, use the Exchange tasks wizard to fix the mailbox.

Validating mailbox rights
To validate mailbox rights:

1. Log in to the Active Directory server.

2. Click Start > All Programs > Administrative Tools > Active Directory Users and 
Computers.

3. In the Active Directory Users and Computers window, select Advanced Features from the 
View menu.

4. Double-click the Octel container.

5. In the right-hand panel, double-click ExternalCaller.
6. Select the Exchange Advanced tab.
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7. Click the Mailbox Rights button.

The ACL displayed should contain the inherited rights from the Exchange message store 
where the mailbox is located. If it contains the single ACE for the SELF identity, the mailbox 
creation is not complete. In this case:

● Wait for the mailbox creation to complete

● Or, log on to the user object and use Outlook to prompt the Exchange server to populate 
the ACL.

Backing up the system 
As a final installation task, set up the system to perform regular, scheduled backups of 
MAS-specific information using the normal backup procedures for this site. Avaya recommends 
that you do an attended backup now on each MAS to preserve the configuration information 
and to verify the backup function. 

Customers should consider the following when designing their backup program:

● DCT file: Be sure to include the most recent DCT file in your regular backups. Periodically 
analyze your system with the Data Collection Tool, to create a new updated file to use in 
case of a disk failure. This is particularly important when changes are made to the Modular 
Messaging system. See the Data Collection Tool Online Help or its printed version, Avaya 
Modular Messaging Data Collection Tool Help, for a complete description of the procedure 
to analyze a system with the DCT.

● Customized Tone Files: If analog port boards are installed in any MAS and you have 
created customized tone files, keep a copy of the tone files (*.tsf for Dialogic boards) in a 
network location where they are part of the normal backup procedure. Avaya suggests that 
all tone files be stored in the \Avaya_Support\Tone_Files directory. You might choose to 
back up this location or store a copy of the tone files elsewhere for backup.

● Customized Prompt Files: Keep a copy of customized prompt files stored in the 
CustomPrompts.ovf and CustomPrompts_G711.ovf files. The files are stored in the path 
c:\program files\avaya modular messaging\vserver.

● Caller Applications: Caller Applications (*.uma files), once deployed, are stored on each 
MAS within a folder that has a GUID. The location for this folder is \Program Files\Avaya 
Modular Messaging\VServer\CallerApps. Avaya recommends that you back up a copy of 
this folder as follows: 

Deployed caller applications cannot be backed up using NTBackup while the Modular 
Messaging (MM) Messaging Application Server service is running. However, you can make 
a copy of the CallerApps folder while this service is running, and then make a backup of that 
(you could choose to create scripts to carry out this function).
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● Licensing Files: Keep a backup of the licensing files (*.xml) safe on another device or in 
another location. 

● System State: Avaya suggests that you back up the system state of each MAS on a 
regular basis. The registry contains settings particular to this MAS.

● SIP certificates : For SIP implementations only, backup certificates and related files. From 
\Program Files\Avaya Modular Messaging\OpenSSL, backup the following files:

- AVA\dh1024.pem, certchain.crt, and certchain.key

- CommonTrust\AvayaRoot\avayaprca.crt and sip_product_root.crt.

- CommonTrust\CaHash\465bb314.0 and ffbc7d70.0

● WSO: Backup \Program Files\Avaya Modular Messaging\Web Subscriber Options\
masinfo.cfg.

● Spool: The directory \Program Files\Avaya Modular Messaging\Vserver\Spool stores 
messages that are sent while the MAS is offline from the message store. You should back 
up the Spool directory on each MAS. 

Running periodic checks
Perform scheduled maintenance on the MAS routinely to keep the hard disk in good condition. 
Run the following on a regular basis: 

● Disk Defragmenter system tool 

● chkdsk command 
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Turning over the system to the customer
At this point, the system is considered ready for handoff to the customer. Handoff 
considerations include: 

1. Update and turn over the planning information and DCT data file: 

a. Ensure that the planning forms accurately reflect the information on the system. Make a 
copy for the project planner and the organization that is to remotely support the system. 
Return the planning forms to the customer to be filed in a safe place.

b. Send a copy of the DCT data file to the appropriate technical support group. Afterwards, 
erase the copy of the DCT data file from your USB storage device. 

2. Advise the customer about the initial administration that was completed. The customer 
might want to customize features such as:

a. Any feature parameters in the Voice Mail System Configuration (VMSC) program. 

b. The classes of service to use for subscribers might need to be updated or expanded. 

3. Advise the customer about the ongoing administration that is required, such as customizing 
parameters, installing client packages, and maintaining the system. For more information, 
direct the customer to the administration topics on the documentation media. 

The system is set up to send alarming information and receive incoming technical support calls. 
Customers who do not want this service in place must disconnect the USB modem from the 
MAS.
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Chapter 10: Upgrading Modular Messaging software 
on an Avaya MAS

This chapter describes how to upgrade an Avaya MAS that is running Modular Messaging 
Release 1.1 software to Modular Messaging Release 3 software.

Note:
Note: Complete the tasks in this section only if you are upgrading a system that is 

running Modular Messaging Release 1.1 software. 

Any systems that are running Unified Messenger Release 5.0 software must 
upgrade to Modular Messaging Release 1.1 software before upgrading to 
Modular Messaging Release 3 software. 

Topics in this chapter include:

● Overview on page 152

● Completing pre-upgrade tasks on page 155

● Preparing the MAS for the upgrade on page 162

● Upgrading Modular Messaging Software on page 174

● Completing the upgrade on page 177

● Upgrading to an S3500 server on page 182

● Updating client software on page 185
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Overview
This chapter describes how to upgrade a Modular Messaging system that is running Modular 
Messaging Release 1.1 software to Modular Messaging Release 3.

Note:
Note: A Modular Messaging software upgrade requires several server restarts. Plan to 

do the software upgrade during low-usage hours. 

To upgrade the system to Modular Messaging Release 3:

1. Review the configuration notes for any changes that might be needed in the areas of board 
configuration, switch programming, and application configuration. For more information, see 
Upgrade requirements on page 153. 

2. Complete tasks to save data and busy out ports. For more information, see Completing 
pre-upgrade tasks on page 155.

3. Analyze each MAS that will be upgraded using the Data Collection Tool. Include in the 
analysis any S3400 MASs that will be replaced with S3500 MASs. For more information, 
see Creating a Data Collection Tool File on page 156 for details.

Note:
Note: If you are replacing Brooktrout boards with new Dialogic port boards, you must 

replace the boards before you analyze the MAS.

4. Prepare the MAS for the upgrade by installing a replacement disk drive or reloading the 
boot image software. For more information, see Preparing the MAS for the upgrade on 
page 162. If you are replacing an S3400 server with an S3500 server, see Upgrading to an 
S3500 server on page 182.

5. Upgrade the software on each MAS and configure new features as needed. For more 
information, see detailed steps in Upgrading Modular Messaging Software on page 174

Note:
Note: Completely upgrade and test one MAS first, and let it run for 15 minutes before 

upgrading any additional MASs. The MASs can be upgraded in any order.

6. Update the client software and the Exchange extensions on each MAS and any other 
computer where Modular Messaging was previously installed (such as administrator 
machines or the Exchange server). See detailed steps in Completing the upgrade on 
page 177 and Updating client software on page 185.

Note:
Note: Schedule downtime for the Microsoft Exchange server if the Exchange 

extensions must be updated. See Chapter 5: Adding Exchange extensions for 
Modular Messaging on page 71. 

7. Perform acceptance tests on the entire system. See Completing the upgrade on page 177.
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8. Back up the new data. See Completing the upgrade on page 177.

Because an upgrade includes many steps, print the upgrade checklist from Appendix 
B: Installation and upgrade checklists on page 231 and use it to track your progress. 

! CAUTION:
CAUTION: All servers must meet the requirements listed in the Avaya Modular Messaging 

Concepts and Planning Guide (PDF 2 MB), available on the documentation 
media shipped with the system. Review this document to verify that all Exchange 
servers, directory servers, MASs, and client machines are ready to support 
Modular Messaging software.

Considerations for multiple-MAS upgrades
In a multiple-MAS configuration, Avaya strongly recommends that all MASs that are running 
Release 1.1 software be upgraded to Modular Messaging Release 3 software as soon as 
possible. During an upgrade MASs in the same Voice Mail Domain can run different releases of 
Modular Messaging. However, at the completion of an upgrade, all MASs in the Voice Mail 
Domain must be running release 3. 

All MASs in the voice mail domain must be upgraded to the same release of Modular 
Messaging software before you can enable the new Release 3 features. 
If you are adding a new Modular Messaging machine to a multiple-MAS configuration, it cannot 
join an existing voice mail domain that only has Release 1.1 voice servers in it. You must first 
upgrade one or more of the existing servers, leave the system running for at least 15 minutes, 
and then add the new Avaya Modular Messaging server. 

Upgrade requirements
To successfully upgrade a system to Modular Messaging Release 3, you need:

● One of the following:

- A replacement hard disk drive with preloaded Avaya Modular Messaging Application 
Server (MAS) and boot software.

- If a replacement drive is not available, the Avaya Modular Messaging Avaya Messaging 
Application Server and Boot Software for Microsoft Exchange media 

● Release 3 of the Modular Messaging application software. 

- Avaya Modular Messaging Messaging Application Server Software media 

- Avaya Modular Messaging Documentation
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● The following information and software from the Avaya Support Web site at http://
www.avaya.com/support. For more information about how to access these items on the 
Web site, see Required documentation and software on page 1. 

- The most current copy of the configuration notes for this switch integration. 

- Avaya software updates that are required to bring the Avaya Modular Messaging 
software up to date after an upgrade. Download this software to a USB storage device. 
For more information about downloading the updates, see Updating Modular Messaging 
software on page 279.

- The latest copy of the Data Collection Tool. Download the DCT update file, 
MMDCTDistribute.exe, from the Avaya support site. Download it to a USB storage 
device.

● A completed copy of all relevant forms in Appendix A: System planning forms on page 209 
and a printed copy of the upgrade checklist for an Avaya MAS. See Modular Messaging 
upgrade on an Avaya MAS on page 247.

Note:
Note: For Release 1.1 upgrades, a completed copy of the planning forms should be on 

file from the previous installation. For all upgrades, review the new version of the 
forms in Appendix A: System planning forms on page 209 before beginning the 
software upgrade. Verify that all fields required for any new Release 3 features 
are completed. 

● Modular Messaging Release 3 requires Microsoft Exchange 2003 System Management 
Tools. If you need to upgrade your Microsoft Exchange System Management Tools at this 
time, you will require a copy of the customer-provided Microsoft Exchange 2003 media or 
equivalent access to the 2003 System Management Tools upgrade and the Microsoft 
Exchange 2003 Service Pack 2.

Switching the monitor to show the correct server
Use whatever method is required at this site to have the monitor display the Avaya MAS that 
you are installing. 

For an 8-port Belkin KVM: the KVM switch is usually connected to the first Avaya MAS (MAS#1) 
through the first computer port (VGA 01). Subsequent MASs (if present) are connected to 
computer ports VGA 02, VGA 03, and so on. 

To show a different server on the monitor:

1. Slowly press Scroll Lock, then Scroll Lock again, and then the up (or down) arrow key to 
change to the server connected to a higher (or lower) port number. 

Alternatively you can type the port number instead of pressing the up or down arrow key 
(such as 01 for port 1). For complete user instructions, see the KVM switch documentation.

http://www.avaya.com/support
http://www.avaya.com/support
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2. If you cannot access the correct server, see Connecting the KVM cables on page 36 and 
verify that the cable connections are correct. To correct cable problems, power down the 
system and correct the cable connections. Then turn on the system again.

For complete user and troubleshooting instructions, see the KVM switch documentation.

Completing pre-upgrade tasks
It is crucial that you record all critical system settings and back up all data in advance. All 
information is erased from the servers during the software upgrade.

Do the following tasks to prepare the Modular Messaging system for an upgrade: 

● Verifying and saving data on page 155

● Creating a Data Collection Tool File on page 156

● Busying out ports on page 161

● Backing up the MAS on page 161

Verifying and saving data
Complete the following tasks before you start a Release 3 upgrade: 

1. Using the latest copy of the planning forms, verify key settings on the MAS, including:

● Switch integration settings

● Port board settings and extensions

● Domain information

● Basic system setup 

● Modular Messaging service account and group

● Exchange settings

Ensure that you record the following items: 

● Under Routing and Remote Access, record the IP addresses for the MAS modems in 
the remote access service (RAS) group. See Table 22: RAS IP addresses for each 
MAS on page 227. 

2. If you use this MAS to create, administer and deploy Caller Apps, backup all your working 
files to a location other than the MAS. Additionally, on the MAS you must have a current 
backup of the Caller Apps folder that contains the deployed caller applications that the MAS 
uses when it is running. For example, you might have a backup of C:\Program Files\Avaya 



Upgrading Modular Messaging software on an Avaya MAS

156 Avaya Modular Messaging for Microsoft Exchange Release 3 Installation and Upgrades

 

Modular Messaging\vserver\callerapps. Make a copy of the entire callerapps directory. The 
entire folder and it�s structure must be restored.

If you do not have the original versions of the caller apps files that were used to administer 
caller apps, you can use a copy of the deployed *.uma files found in the CallerApps folder. 
However, never administer caller applications files directly from the deployed location C:\
Program Files\Avaya Modular Messaging\vserver\callerapps.

3. Make a complete backup of all Caller Applications, customized tone files and customized 
prompt files. See Backing up the system on page 147 for information about where to locate 
these files on your system.

4. Review the configuration notes for any changes that might be needed regarding board 
configuration, switch programming, and application configuration. Make any necessary 
changes as part of the upgrade. 

Creating a Data Collection Tool File

Note:
Note: Always check the Avaya Support Web site at http://www.avaya.com/support for 

recent updates to the DCT program. 

To create the DCT file: 

1. Verify that the Modular Messaging system is working normally. All MASs and the Exchange 
message store must be running. 

2. Switch the monitor to show MAS#1. For more information, see Switching the monitor to 
show the correct server on page 154. 

3. Verify that the messaging services on the MAS are running:

a. Double-click the Monitor icon on the desktop. 

b. Click Services (Local) in the left pane, if the item is not already selected.

c. In the right pane, scroll down to the list of Modular Messaging services. All services start 
with the abbreviation MM. 

d. Verify that the Status column shows that service is Started for each messaging service 
that belongs on this MAS. For a list of required services, see Table 19: MAS services 
and features form on page 224. 

e. If service is not started for a required messaging service, right-click that MM service and 
select Start.
The system starts the messaging service. 

4. Insert the USB storage device with the DCT update file MMDCTDistribute.exe into a USB 
port on MAS#1. You can use any of the available USB ports.

5. Unzip the Data Collection Tool. 
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a. Navigate to the USB drive, Removable Disk (E:)
b. Double-click the executable file MMDCTDistribute.exe and then click Unzip.

c. If this is a multiple-MAS upgrade, be sure a copy of the updated MMDCT.exe file is on 
your USB storage device.

6. Navigate to the location where you stored the DCT executable file (MMDCT.exe). Double 
click the MMDCT.exe file. 

7. On the first screen Select the DCT Configuration to use, select Analyze existing 
system. Click OK. 

8. When asked if you want to use an existing DCT file, click No. 

9. On the MM System Analysis screen, select the first MAS from the dropdown list at the 
bottom of the window. Click Start.
The system displays the process of the data collection.

10. When analysis is complete, you see the message �information has been successfully 
collected,� The DCT displays the newly created file.

11. Save the DCT file to a location that is accessible to the MAS that you are upgrading and to 
additional MAS�s in the domain. Usually, save the file to a USB storage device. Do not save 
the file to the MAS.

12. In a multiple MAS system, update the Collection Tool (DCT) file with information from 
additional MAS�s.

a. Insert a USB storage device with the DCT file you created for MAS 1and the updated 
DCT into the USB port on the next MAS you are going to analyze.

b. Navigate to the updated MMDCT.exe file on the USB storage device.

c. Launch the Data Collection Tool by double clicking the MMDCT. exe file.

d. On the first screen Select the DCT Configuration to use, select Analyze existing 
system. Click OK. 

e. When asked if you want to use an existing DCT file, click Yes.

f. Navigate to the location where you saved the DCT file you created for the first MAS. 

g. Double click this file to select it.

h. On the MM System Analysis window, choose the number of the MAS you are analyzing 
from the dropdown list at the bottom of the window. Click Start. 
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Note:
Note: Analyze the MASs in numeric order, first to last.

Analyze MASs you plan to replace with new S3500 servers.

When upgrading to an S3500 server, you can decrease the number of MASs in 
the voice mail domain (VMD). When decreasing the number of MASs, analyze 
only those MASs that you plan to upgrade. When the upgrade is complete, you 
must move the Modular Messaging services that are on MASs that were not 
upgraded to an MAS that was upgraded. For more information about moving MM 
services, see Modular Messaging S3500-Family Hardware Maintenance and 
Additions.

At the completion of the upgrade all MASs in the VMD must be running Modular 
Messaging Release 3. If you do not upgrade an MAS, do not include it in the 
VMD.

The system displays the process of the data collection.

i. When analysis is complete, you see the message that �information has been 
successfully collected.� The DCT displays the newly updated file.

j. Save the DCT file by overwriting the previous file.

! CAUTION:
CAUTION: In multiple MAS systems, review and revise the DCT file after analyzing all MASs 

that will be upgraded. Information that is manually entered before the final 
analysis might be overwritten in the analysis of subsequent MASs.

Do not change any data that was populated by the DCT system analysis. There 
is only one exception to this rule. You can revise the default account names and 
passwords on the MAS accounts and passwords screen.

13. Review the completed file. Enter information in empty fields. To complete information, if 
necessary, use the planning forms from Appendix A: System planning forms on page 209.

Note:
Note: Verify that there are no red x�s next to the DCT screen names in the left panel. 

The red x�s indicate data that is incomplete or not valid. Information must be 
complete and valid before you can proceed with the upgrade.

The following table maps the DCT fields to entries in the planning forms. Use it only if you need 
to enter data in empty fields.
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DCT Field Name Planning Form Location

Company name Item 1, Table 14: Modular Messaging System 
Planning Form on page 213

Organization name Item 2, Table 14: Modular Messaging System 
Planning Form on page 213

Time Zone Not in planning form

Keyboard input language Not in planning form

Message store Item 3, Table 14: Modular Messaging System 
Planning Form on page 213

Contact Information for message store 
administrator

Item 5, Table 14: Modular Messaging System 
Planning Form on page 213

Name (Voice Mail Domain) Item 6, Table 14: Modular Messaging System 
Planning Form on page 213

Number of MASs in the VMD Item 7, Table 14: Modular Messaging System 
Planning Form on page 213

Connect to corporate network (DHCP or static) Item 8, Table 14: Modular Messaging System 
Planning Form on page 213

Subnet mask Item C3, Table 15: Corporate network planning 
form on page 216

Full computer name (for MAS) Item C4, Table 15: Corporate network planning 
form on page 216

IP address (for MAS) Item C5, Table 15: Corporate network planning 
form on page 216

Register DNS suffix in DNS Item C15, Table 15: Corporate network planning 
form on page 216

Register IP address in DNS Item C15, Table 15: Corporate network planning 
form on page 216

DNS Servers IP addresses, in order of use Item C6, Table 15: Corporate network planning 
form on page 216

Search order of DNS domains Item C7, Table 15: Corporate network planning 
form on page 216

Default gateway IP address Item C8, Table 15: Corporate network planning 
form on page 216

WINS (if required) IP addresses Item C9, Table 15: Corporate network planning 
form on page 216
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Microsoft Windows domain Item C10, Table 15: Corporate network planning 
form on page 216

Peer Exchange server Item C11, Table 15: Corporate network planning 
form on page 216

Peer directory server Item C12, Table 15: Corporate network planning 
form on page 216

Container if default not used Item C13, Table 15: Corporate network planning 
form on page 216

Software installation path Item C14, Table 15: Corporate network planning 
form on page 216

Local administrator accounts names and 
passwords

Table 18: Modular Messaging logon accounts 
form on page 221

Technical support name and password Item A13, Table 18: Modular Messaging logon 
accounts form on page 221

Customer account name and password Item A12, Table 18: Modular Messaging logon 
accounts form on page 221

Announcement languages Table 19: MAS services and features form on 
page 224

TTS languages and sessions Table 19: MAS services and features form on 
page 224

MM service selections Table 19: MAS services and features form on 
page 224

Switch integration Item 9, Table 14: Modular Messaging System 
Planning Form on page 213

DCT Field Name Planning Form Location
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14. When all fields in the DCT are complete, click Complete at the bottom of the DCT screen. 
Save the DCT file to a location that will be accessible to the MAS that you are upgrading. 
Usually, save the file to a USB storage device. Do not save the file to the MAS.

Busying out ports 
Busyout the ports on the MAS you are upgrading and on the switch before you start the 
upgrade. Otherwise, messages will spool on the MAS, and add to the upgrade time. 

To busyout the ports: 

1. The PBX administrator must use the procedures appropriate for this PBX to busyout the 
ports. Depending on the switch integration, the administrator might be able to temporarily 
reroute calls to other MASs. If an MAS is unavailable, callers into the system might hear 
ring-no answer or a busy signal. 

2. Switch the monitor to show the MAS. For more information, see Switching the monitor to 
show the correct server on page 154.

3. Use the Port Monitor to disable the MAS ports: 

a. Click Start > Programs > Avaya Modular Messaging > Port Monitor. 
b. In the Port Monitor window, hold down the Shift key or Control (Ctrl) key and click to 

select all the ports. 

c. Right-click the port list and select Disable. 

d. Verify that the status of all ports is Disabled.

e. Close the Port Monitor window.

Backing up the MAS 
Before beginning the software upgrade, make a current backup of the important system files, 
including any customized tone files and the DCT file you just created. For this procedure, see 
Backing up the system on page 147. 
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Preparing the MAS for the upgrade
The Modular Messaging Release 3 software requires a new operating system and application 
software on each MAS. You must preform one of the following procedures to prepare the MAS 
for the Modular Messaging software upgrade.

● If you have a new hard disk drive with the Modular Messaging boot image already 
installed, you must replace the existing hard drive with the new one. For more information, 
see Replacing an MAS drive in an S3400-family server on page 162.

● If you do not have a replacement hard disk drive, you must install the new Avaya boot 
image on the existing hard drive. For more information, see Install new Avaya boot 
image on page 171.

Note:
Note: If you are replacing an S3400 server with an S3500 server, see Upgrading to an 

S3500 server on page 182.

After completing either the installation of the new drive, or the reload of the boot image, continue 
with Continuing the upgrade on page 172.

Replacing an MAS drive in an S3400-family server
Follow the procedures in this section only if you received a replacement hard disk drive for the 
upgrade. If you did not receive a replacement drive, see Install new Avaya boot image on 
page 171. Complete the following procedures to replace the IDE hard disk drive in an MAS that 
uses Avaya S3400-family server hardware. For more information about S3400-family server 
hardware, see: 

● Avaya Modular Messaging S3400-Family Hardware Maintenance and Additions (PDF) 

● the Maintenance section on the Avaya Modular Messaging Documentation media 

Note:
Note: If you experience problems and must back out of the upgrade, you can recover 

temporarily by reinstalling the old drive back into the MAS. Contact your Avaya or 
business partner support organization for assistance with completing the 
upgrade.

Gathering the required tools

You must have the following tools on site to work on a Avaya S3500-family message server: 

● A medium-width flatblade screwdriver 

● A No. 2 Phillips screwdriver 
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● A small pair of needlenose pliers 

● A small pair of wire cutters 

● A sharp, pointed instrument, such as a ballpoint pen

! CAUTION:
CAUTION: Do not use the point of a lead pencil to operate the system reset switch. The 

graphite can damage a circuit board and cause problems, such as electrical 
shorts. 

Removing AC power

Do the following for every hard disk drive that is being replaced: 

1. Verify that the replacement equipment is on site. 

2. Verify that the green power lamp on the front of the server is off. If the lamp is lit, press and 
hold the power button to turn off the server.

Note:
Note: In the United Kingdom, if a modem is attached to the server, disconnect the 

telephone line before you unplug the power cord.

3. Unplug the power cord from the AC connector on the back of the server. 

Removing the front bezel and top cover

Remove the front bezel and top cover to access the internal components: 

1. For a stackable desktop setup, remove any units stacked on top of the server that you must 
access. 

2. Remove the bezel, the plastic cover, on the front of the chassis. 

a. Press down on the two tabs on the top of the bezel. 

b. Tilt the bezel forward, and then lift it out. 

3. Loosen the screw latch for the top cover, located on the back of the chassis. 

4. For a rack-mount setup, slide the server forward. 

Note:
Note: To get sufficient cable slack, you might need to unplug the cables on the back of 

the MAS. You can then slide the server all the way forward.

5. Slide the top cover towards the front of the server, and then lift the cover off the chassis.
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Removing the drive cage

! CAUTION:
CAUTION: Observe proper electrostatic discharge (ESD) precautions when you handle 

computer components. Wear an antistatic wrist strap that touches your bare skin 
and connect the strap cable to an earth ground. For more information, see 
�Protecting against ESD damage� on the documentation media. 

To remove the drive cage: 

1. Disconnect the signal and power cables to all drives in the cage assembly. The connections 
vary per model of MAS. See the appropriate figure: 

● Integrated video and LAN model: See Figure 21: S3400-family MAS drive cage 
cables�integrated video and LAN on page 165. 

● Nonintegrated video and LAN model: See Figure 22: S3400-family MAS drive cage 
cables�nonintegrated video and LAN on page 166.

To disconnect the drive cables: 

a. Unplug the power connectors from the DVD player and lower drive (hda). 

b. Unplug the 80-pin IDE ribbon cable from the DVD and the lower drive. 

2. Remove the drive cage retaining screws. See Figure 23: Removing or replacing the 
S3400-family drive cage on page 167. 

a. Remove the 4 screws from the front of the drive cage. 

b. Remove the 2 flathead screws from the side of the chassis, located about 6 inches from 
the front of the cage.

Note:
Note: For rack-mount setups, you might need to loosen or remove some of the screws 

that attach the rail handle to the server. Then you can slide out the drive cage.

3. Gently slide the drive cage assembly forward and out of the server. 

4. Place the drive cage assembly on a clean, static-free surface. 

melectro.htm
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Figure 21: S3400-family MAS drive cage cables�integrated video and LAN 
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Figure notes:

1. Disk drive and DVD player 
power connectors 

2. 80-pin IDE ribbon cable to the DVD and hard 
disk drive (hda), and the primary IDE connector 
PRI IDE on the motherboard 
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Figure 22: S3400-family MAS drive cage cables�nonintegrated video and LAN
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Figure notes:

1. Disk drive and DVD player 
power connectors 

2. 80-pin IDE ribbon cable to the DVD and hard 
disk drive (hda), and the primary IDE connector 
PRI IDE on the motherboard 
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Replacing the hard disk drive

To replace the IDE drive: 

1. Place the drive cage assembly on a clean, static-free surface.

! CAUTION:
CAUTION: Support the drive when you remove the screws. Otherwise, the drive might drop 

when it comes loose.

2. Remove the 4 mounting screws that secure the disk drive to the bottom of the drive cage. 
See Figure 24: Removing or replacing an S3400-family IDE drive on page 168. 

3. Configure the replacement drive as the IDE bus master. 

Figure 23: Removing or replacing the S3400-family drive cage 
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a. Locate the 9-pin master/slave connector on the back of the drive. See Figure 25: IDE 
drive jumper settings on page 169. 

b. Place a jumper over the set of pins at either end of this connector to set up this drive as a 
master. Figures on the drive identify the different jumper settings. 

4. Insert the new IDE drive in the drive cage. The connector on the disk drive must face the 
back of the cage. 

5. Reattach the 4 mounting screws to secure the drive to the bottom of the cage. 

Figure 24: Removing or replacing an S3400-family IDE drive 
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Note:
Note: Always set the IDE drive to be the bus master as shown by the shaded jumpers. 

Reinstalling the drive cage

To reinstall the drive cage: 

1. Position the drive cage assembly in front of the chassis. The slot on the bottom of the cage 
must align with the guide rail inside the chassis. 

2. Gently slide the drive cage assembly into the server. 

a. Lift up the assembly to slide the angled foot on the left side of the drive cage into the 
slotted tab on the chassis. 

b. The drive cage is properly seated when it is flush with the front of the chassis. 

3. Reconnect the signal and power cables to all drives in the cage. See the appropriate figure 
for your model of MAS: 

● Integrated video and LAN model: See Figure 21: S3400-family MAS drive cage 
cables�integrated video and LAN on page 165. 

● Nonintegrated video and LAN model: See Figure 22: S3400-family MAS drive cage 
cables�nonintegrated video and LAN on page 166.

To reconnect the drive cables: 

a. Plug the 80-pin IDE ribbon cable to the DVD player and the lower drive (hda) into the 
primary connector PRI IDE on the motherboard. 

b. Plug in the power connectors to the DVD and lower drive.

Note:
Note: The harness has an extra 4-pin power connector for an optional hard disk. You 

can plug either connector into the IDE drive. The DVD drive always uses the 
terminating connector.

Figure 25: IDE drive jumper settings 
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4. Verify that all cables are neatly dressed, either in the power harness or under the tie-down 
strap for the IDE ribbon cables as appropriate. 

5. Reattach the drive cage retaining screws. See Figure 23: Removing or replacing the 
S3400-family drive cage on page 167. 

a. Reattach the 4 screws to the front of the drive cage. 

b. Reattach the 2 flathead screws to the holes in the side of the chassis, about 6 inches 
from the front of the cage. 

c. For rack-mount setups, if you loosened or removed some of the screws that attach the 
rail handle to the MAS, replace or tighten the screws. 

Replacing the top cover and front bezel

To replace the chassis cover and bezel: 

1. Position the top cover so that the latch hook is in back, and the rail hooks face toward the 
back of the server. 

2. Set the cover on the chassis so the cover is aligned with the sides and slightly overhangs 
the front of the server. 

3. Slide the cover towards the back of the server until the cover is flush with the chassis. 

4. For a rack-mount setup, slide the server back into the cabinet. 

5. Tighten the screw latch on the back of the chassis to secure the top cover. 

6. Replace the bezel on the front of the chassis. 

a. Insert the tabs on the bottom of the bezel into the chassis. 

b. Push the bezel upright until the two upper tabs snap into place under the top cover. 

7. For a stackable desktop setup, replace any units that were stacked on top of this server. 

Restoring power to the system

To restore power to the system: 

1. For a rack-mount setup, reattach any cables you unplugged from the back of the server.

2. Plug the AC power cord back into the power outlet on the server. 

3. Press the power button on the front of the server. 

The green power lamp on the front of the server should light. 

4. When the server boots, continue with Continuing the upgrade on page 172.

Note:
Note: Leave the old hard disk drive with the customer.
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Install new Avaya boot image
Follow the procedures in this section only if you did not receive a replacement hard disk drive 
for the upgrade. If you did receive a replacement drive, see Replacing an MAS drive in an 
S3400-family server on page 162.

You must reload the boot image on each S3400-family server MAS and Avaya-provided 
supplementary server to upgrade the server to the Microsoft Windows operating system. New 
application software is installed as part of the software reload.

! CAUTION:
CAUTION: You must have a current and complete DCT file before you reload the boot 

image.

To copy new software to the Avaya Messaging Application Server (Avaya MAS) or 
Avaya-provided supplementary server:

1. If the server is not on, turn on the server by pressing the power button on the front of the 
server. 

2. Verify that the monitor is showing the correct server.

3. Insert Disk 1 of the Avaya Modular Messaging Avaya Messaging Application Server and 
Boot Software for Microsoft Exchange media into the DVD drive.

Wait for green LED on the drive to go out. 

4. Press Ctrl + Alt + Del to reboot the system.

a. In the Windows Security window, click Shut Down...
b. In the Shut Down Windows window, select Restart and click OK.

5. When the computer starts to boot, the system displays a warning that the hard drive 
contents will be overwritten. 

a. Press any key to continue. 

A message confirms that the hard drive will be overwritten.

b. Press any key to continue. 

The MAS starts to copy the disk image to the hard disk. The entire copy procedure takes up 
to 30 minutes per DVD. 

6. When the system prompts you, insert the next disk. When the DVD drive light turns dark, 
click OK.

7. Repeat step 6 for disk 3.

8. When prompted, remove the media before the system reboots. 
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Continuing the upgrade
Continue the upgrade by completing the following procedures:

Running the Windows Setup Wizard on page 172

Copying the DCT data file and updating the DCT on page 173

Running the setup program on page 173

Running the Windows Setup Wizard

Continue with the following steps to complete the Windows setup wizard and activate Windows:

1. After the system reboots, press any key to continue.

The system reboots and runs the Windows Setup program.

2. If a modem is connected, a Hardware Installation window opens. Click Yes to continue the 
installation.

3. The Windows Setup wizard runs. To complete the wizard:

a. On the Welcome screen, click Next. 
b. On the License Agreement screen, choose I accept this agreement. Click Next.
c. On the Your Product Key screen, type the Windows product key for this server. 

Note:
Note: Each Windows computer has a unique product key for the Windows 2003 

operating system. Enter the number exactly as shown. 

Record the Windows product key in Table 23: Windows product keys for 
MASs on page 228. 

For a Release 3 upgrade, the Windows 2003 sticker ships with the software. 
Paste this sticker onto the server. Do not enter the old Windows 2000 product 
key.

d. Click Next.
The server automatically reboots. 

Note:
Note: You might see the error message System Event Log Full when the system 

boots. You can ignore this message. Modular Messaging does not use this log. 

4. When the system prompts you to log on:

a. Press Ctrl+Alt+Del. 
b. In the Log On to Windows window, leave the user name as Administrator. 
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c. Leave the password field blank. 

d. Press Enter or click OK. 

5. You must activate the Microsoft Windows operating system before you restart the server. 
Use the site-specific procedures to activate Windows. For more information, see Activating 
Microsoft Windows on page 286.

Copying the DCT data file and updating the DCT

You must copy the Data Collection Tool (DCT) data file to the hard disk on the server before you 
continue the upgrade. 

! CAUTION:
CAUTION: Copy the DCT data file to the hard disk on the server before the next reboot. 

Some S3400-family servers fail to recognize a USB storage device after the 
server reboots. 

1. Insert the USB storage device that contains the final DCT file for this system. You can use 
any of the available USB ports on the server.

2. To copy the DCT data file to the server: 

a. Navigate to the USB drive, Removable Disk (E:). 
b. Right-click the most current DCT file for this site, such as sitefile.mmdct.

c. Copy the .mmdct file to the C:\Avaya_Support folder.

d. Verify that the correct DCT file is listed in the C:\Avaya_Support directory. 

3. Update the DCT file on the MAS.

a. Copy the MMDCTDistribute.exe file from the USB storage device to a folder on the 
server, such as C:\Avaya_Support.

b. Double-click the executable file MMDCTDistribute.exe and then click Unzip.

The new DCT program replaces the MMDCT.exe file in C:\Program Files\Avaya Modular 
Messaging\Install\MISCM.

Running the setup program

Complete the following steps to run MM_Setup.exe.

1. To complete the software reload, double-click the MM_Setup icon on the desktop. 

An MM_Setup window opens. 

a. When the system prompts you, press any key to continue. 

The program reports that Modular Messaging configuration will start after the server 
reboots. 
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b. Press any key to continue. 

After the MM_Setup utility runs, the server shuts down. 

2. Continue with Upgrading Modular Messaging Software on page 174.

Upgrading Modular Messaging Software
To upgrade the Modular Messaging software, you must complete the following procedures 
described in this section:

1. Running the Modular Messaging Configuration Wizard on page 174

2. Installing third party software on page 175

3. Completing the MMCW Configuration on page 176

Running the Modular Messaging Configuration Wizard
Physically power up the MAS. The Modular Messaging Configuration Wizard (MMCW) 
launches automatically when the system starts. The MMCW controls the next steps in the 
installation process. 

Complete the following steps to configure the MAS from the DCT file:

1. When the Modular Messaging Configuration Wizard (MMCW) launches, the Modular 
Messaging Welcome screen is displayed. Click Next.

2. On the Locate Configuration Data screen, highlight the DCT file you created for this 
upgrade by analyzing the MAS, or click Browse and browse to the directory where the DCT 
file is stored. By default, the MMCW searches the directory for all files with the file type 
*.mmdct.

3. After selecting the DCT file that was created for this upgrade, click Next. You will be 
prompted to verify the file selection. Click Yes, to select the file.

4. The Data Collection Tool launches with the file you selected. Review the file and enter data 
in empty fields.

Note:
Note: Verify that there are no red x�s next to the DCT screen names in the left panel. 

The red x�s indicate data that is incomplete or not valid. Information must be 
complete and valid before you can proceed with the installation.

5. On the last screen, click complete and then save the file again if you have made any 
additions.



Upgrading Modular Messaging Software

Issue 1 April 2006 175

 

6. After saving the DCT file, click complete.

7. On the Messaging Application Server Number screen, in the MAS Number field, select 
the number of the MAS that you are installing and click Next.
The MAS configuration starts, the Sysprep window opens, then the server reboots.

8. After the reboot starts, a Windows Setup wizard runs. To complete the wizard: 

a. On the License Agreement screen, select I accept this agreement. Click Next. 
b. On the Your Product Key screen, type the Windows product key for this server. 

Note:
Note: Each Windows computer has a unique product key for the Windows 2003 

operating system. Enter the number exactly as shown. 

On a new S3500-family server, the product key sticker is located inside the empty 
drive tray on the lower-left of the server chassis. You can remove the drive tray to 
easily read the sticker. Record the Windows product key in Table 23: Windows 
product keys for MASs on page 228. 

c. Click Next.
The MMCW proceeds with the installation of the specified MAS unit based on information 
contained in the DCT file. 

Information contained in the DCT file is validated against the system at this time. This may 
result in errors that will require you to correct the data in the file or make system corrections 
and begin the configuration again. If you receive an error, see the Data Collection Tool 
screen-specific help for information about field parameters and conditions that may result in 
errors or warnings.

The progress of the installation is displayed by informational messages on the MMCW 
screen.

Installing third party software
After the reboot, the MMCW will prompt you to install third party software.

When installing third party software, install the following components:

● Exchange 2003 System Management Tools

● Exchange Server 2003 Service Pack 2

● MSDE install

● Anti-virus software

1. When prompted to install third party software, install the Exchange 2003 System 
Management Tools.
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Note:
Note: The Microsoft Exchange 2003 System Management Tools must be installed on 

any MAS that will have any of the following services installed on it: 

- Messaging Application Server

- Call Me Server

- Message Waiting Indicator (MWI) Server. 

Exchange 2003 System Management Tools are required, Exchange 2000 System 
Management Tools are not supported.

a. Insert the customer-provided Microsoft Exchange 2003 Server media in the MAS drive.

b. Install the Management tools by completing the Microsoft Exchange Installation Wizard.

c. If you receive a compatibility warning, click Continue.

d. For details about this procedure, see the Microsoft Exchange documentation.

2. Follow site-specific procedures to install Exchange Server 2003 Service Pack 2.

3. To install MSDE, complete the following steps:

a. Insert the Modular Messaging Application media (disk 1) in the MAS DVD drive.

b. In Explorer navigate to the Install\System Upgrade\MSDE directory.

c. Double click on the MSDE.bat file.

d. After the utility runs, close the explorer window.

4. Install anti-virus software that is specified by your local site requirements and 
implementation. Avaya strongly recommends that you install anti-virus software on any 
Microsoft Windows computer that runs Avaya Modular Messaging software. For more 
information about anti-virus software on an Avaya MAS, see Administering anti-virus 
software on page 87.

Completing the MMCW Configuration
After third party software is installed continue with the following steps to complete the 
configuration.

1. Verify that the Avaya Modular Messaging Messaging Application Server Software media 
(disk 1) is in the MAS DVD drive. Then, click OK on the third party dialog box. The MMCW 
resumes with the following sequence of events:

● The Setup screen displays and proceeds directly to the System Upgrade screen.

● The system reboots without user intervention

● MMCW restarts automatically and runs the MM Application Setup, installing all MM 
services
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● After another reboot and auto log on, the MMCW continues the system configuration, 
displaying informational messages as each component, such as dialogic drivers or 
remote access is configured.

2. When MAS configuration is complete, the progress bar stretches across the window and 
the Next button becomes active. Click Next.

3. On the Modular Messaging Wizard Completed screen, click Finish.

Completing the upgrade
To complete the upgrade you will need to complete the server setup, resynchronize the FEDB, 
restore customer data and configure the voice mail system. See:

1. Completing server setup on page 178

2. Restoring customer data on page 181

After you have completed these procedures, continue the Modular Messaging software upgrade 
as appropriate:

1. If you have more than one MAS: 

a. For the first MAS upgraded only, let the Modular Messaging software run for 15 
minutes so that it can update shared data across the voice mail domain. Return to 
Verifying and saving data on page 155 to begin upgrading the next MAS.

b. Repeat the Modular Messaging software upgrade procedure until all MASs are 
upgraded. 

2. Configure the voice mail system. For more information, see Configuring the voice mail 
system on page 113.

3. You must update the Modular Messaging Active Directory Exchange extensions software 
on any machines where it is installed. This might include Exchange servers and client 
machines used for subscriber administration (any Exchange extensions on an MAS were 
updated with the rest of the Modular Messaging software). See Adding the Exchange 
extensions on page 74. 

4. Implement additional TUI�s if necessary. See Implementing additional TUIs on page 184.

5. Update the client software on any non-MAS machines where it is installed. See Updating 
client software on page 185. 

6. Set up test subscribers and perform all acceptance tests that are relevant to the system. 
See Testing and backing up the system on page 135. 

7. When acceptance tests are complete, back up each MAS using the regular backup 
procedures for this site. For guidelines, see Backing up the system on page 147. 
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8. When finished with each MAS, verify that the MAS disk is in good condition by running the 
following: 

● Disk Defragmenter system tool 

● chkdsk command 

9. If you are upgrading an S3400 MAS to an S3500 server, see Upgrading to an S3500 
server on page 182.

10. If you are adding a new MAS to this system, begin the installation now. 

● To install a new Avaya Messaging Application Server (Avaya MAS), begin with Chapter 
2: Installing Avaya-provided hardware on page 9. 

● To install a new customer-provided MAS, begin with Chapter 3: Installing Dialogic port 
boards in a customer-provided MAS on page 43. 

Print the appropriate checklist from Appendix B: Installation and upgrade checklists on 
page 231 and use it as a guide.

11. When finished, save all planning forms in a safe place. 

Completing server setup
To complete setup of the server complete the following tasks as necessary:

● Administering anti-virus software on page 178

● Installing software updates on page 179

● Updating Microsoft Windows on page 180

● Disable private LAN on page 180

● Configuring port boards on page 180

● Resynchronizing the FEDB on page 181

When you have completed the procedures required for your system, proceed to Chapter 
8: Configuring the voice mail system on page 113

Administering anti-virus software

Avaya strongly recommends that anti-virus software be installed on any Microsoft Windows 
computer that runs Avaya Modular Messaging software. The type of virus-checking software 
used and the method of installation depends on customer requirements and the local 
implementation. 

Guidelines for using anti-virus software on a computer that is running Avaya Modular 
Messaging software include:
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● Consider the impact that anti-virus scanning has on the performance of the Avaya 
messaging servers. Avaya recommends the use of �on-demand� scanning, where scans 
are run at scheduled intervals. Avoid using a message-scanning method that could 
drastically impact the performance of the Avaya servers. For example, do not use �on 
access� scanning. This type of scan runs whenever a file changes, and can have a 
negative impact on server performance. 

Note:
Note: Some anti-virus software applications default to scan on startup. Disable this 

feature, or it increases the time that it takes a system to come back online after a 
reboot.

● Avaya recommends administering the anti-virus software as follows: 

- Scan the hard disk at least once per week during off peak hours. Avaya recommends a 
daily scan. You can run scans on multiple Modular Messaging servers at the same time. 
However, avoid scheduling the anti-virus scan at the same time as when a scheduled 
backup occurs on the MAS. 

- Schedule virus definition updates to occur automatically at least once per week. The 
updates must occur before the next scheduled scan time to ensure that the latest data 
(DAT) files are used during the scan. However, do not schedule updates to occur during 
a virus scan.

- If the anti-virus software locates a virus, it should first attempt to clean the file. If that fails, 
the software should move the file to a different directory.

Information about anti-virus interoperability of Avaya Modular Messaging software with various 
anti-virus products and performance testing is available. The information addresses security 
issues such as reporting concerns and receiving notifications. For more information, see 
Anti-Virus Software on Microsoft Windows-based Avaya Messaging Products.

Installing software updates

A new Modular Messaging system ships with the most current software that is available at the 
time. However, the software must be updated after an installation or upgrade to include the 
latest changes. The updates might be in the form of an Avaya Service Pack (SP) or a software 
patch (hot fix). 

To determine if a Modular Messaging software update is needed: 

1. Locate any relevant Avaya software updates on the Avaya Support Web site at http://
www.avaya.com/support. For complete steps, see Obtaining software updates from the 
Web on page 279. 

Note:
Note: If you followed the procedure for Obtaining software updates on the Web on 

page 3, you already downloaded any required software updates. 

http://www.avaya.com/support
http://www.avaya.com/support
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2. If the Modular Messaging system requires a software update, complete the update 
procedure now before you do acceptance testing. Follow the instructions in Appendix 
E: Updating Modular Messaging software on page 279 to update the system with the latest 
changes. 

Updating Microsoft Windows

A new Avaya MAS contains the most current Microsoft Windows software at the time it is 
shipped. After installation, you must install the latest Microsoft Windows system updates, 
security patches, and hot fixes to protect the operating system from known security 
weaknesses. Check with the appropriate Windows administrator for the software update 
procedures to use at this site. 

Note:
Note: Avaya technical support representatives must follow their specified internal 

procedures for verifying the software that is installed. If required, they must 
update the software with the latest patches as instructed. 

Disable private LAN

The Modular Messaging private LAN is not used with the Microsoft Exchange configurations. 
Disable the LAN by completing the following steps:

1. On the desktop, right click on the Network Places icon. Select Properties.

2. In the Network Connections window, highlight either Intel(R) PRO100M Network 
Connection, or Intel(R) 100+ PCI Adapter, whichever appears in the window. Right click 
on your selection. From the drop-down list, select disable.

3. In the Network Connections window, from the toolbar menu, select Advanced > Advanced 
Settings. Verify that the corporate LAN is listed at the top of the list of connections. If not, 
highlight the name of the corporate LAN and use the arrows to move it up in the list. When 
finished, click OK to close the Advanced Settings window. Close the Network Connections 
window.

Configuring port boards

The Avaya Modular Messaging Configuration Wizard automatically configures any installed 
Dialogic port boards for several switch integrations, including: 

● Avaya CM (IP SIP) 

● Avaya (IP H323)

● Avaya (QSIG)

● Cisco (QSIG)

● Nortel NT M-1 (QSIG)
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● Siemens Hipath (QSIG)

If this MAS contains Dialogic port boards that do not use one of the automatic-configuration 
switch integrations, you must configure the port boards manually. Continue with Appendix 
D: Configuring and testing port boards on page 263. 

Resynchronizing the FEDB

After you configure each MAS, the system automatically starts to synchronize the front end 
database (FEDB). The system might take 1 hour to several hours to synchronize the data, 
depending on the number of subscribers that are administered. The VMSC on all MASs is 
unavailable during the time of the FEDB resynchronization. 

To monitor the progress of the FEDB resynchronization: 

1. In the Computer Management window, in the left pane, expand System Tools, and then 
Event Viewer. 

2. In the left (Tree) pane, click Application. 

3. The gv_server event 1030 indicates that a full FEDB resynchronization started. 

Note:
Note: If the FEDB resynchronization does not start automatically, restart the 

MM Messaging Application Server. 
4. Refresh the window display periodically until you see gv_server event 1027, The FEDB 

resynchronization completed. 

Restoring customer data 
After the new operating system is installed, you must restore the customer data to the system. 
From your backup location, restore the customized tone files, customized prompt files, and 
caller applications to the following locations on the Modular Messaging system.

● restore tone files to: \Avaya_Support\Tone_Files
● restore the CustomPrompts.ovf and CustomPrompts_G711.ovf prompt files to: \

Program Files\Avaya Modular Messaging\Vserver
● restore caller applications to: \Program Files\Avaya Modular Messaging\VServer\

CallerApps. Refer to Avaya Modular Messaging Software Messaging Application Server 
Administration Guide for instructions for restoring caller applications.
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Upgrading to an S3500 server
Use these procedures to replace an existing S3400 server with an S3500 server. Do not install 
any additional new servers now. You can replace the existing hardware, but you must install 
additional servers only after the upgrade is complete. 

Removing Hardware
Complete the following steps to remove the server:

1. Shut down the server software. Click Start > Shut Down, and then click OK.

2. Turn off the S3400-family server. 

3. Label and unplug all cables to the server. 

4. Remove the S3400-family MAS from the stacked configuration or customer cabinet. 

Note:
Note: For complete instructions about replacing an S3400-family MAS, see Avaya 

Modular Messaging S3400-Family Hardware Maintenance and Additions on the 
documentation media. 

Transferring port boards
If the MAS contains Dialogic port boards, you must transfer the port boards from the 
S3400-family server to the S3500-family server:

! CAUTION:
CAUTION: If the MAS contains Dialogic port boards, you must transfer the port boards from 

the S3400-family server to the S3500-family server. Observe proper electrostatic 
discharge (ESD) precautions when you handle computer components. Wear an 
antistatic wrist strap that touches your bare skin and connect the strap cable to 
an earth ground. 

Complete the following steps to transfer port boards to the new server:

1. Open the S3400-family MAS and remove the port boards. 

2. If multiple boards are present, identify which board is first. You might need to adjust the 
option settings if you have more than two boards and must install them in a new server. 

3. Remove the handle from the port board, or the board cannot fit into the PCI card cage in the 
S3500-family server. 
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4. Remove the top cover of the S3500-family server. Push on the blue release buttons and 
slide the cover towards the back.

5. Remove the PCI card cage by pulling straight up on the lifting straps. 

6. Remove the retaining bracket on the card cage by loosening the thumb screw. 

7. Install a maximum of two port boards into the PCI card cage. Use the two upper slots, PCI2 
and PCI3. To install only one port board in the server, use the middle slot, PCI2.

8. If two boards are present, connect the boards using the CT bus cable from the old server.

Continuing the S3500 Upgrade
See Installing S3500-family servers on page 21 for instructions for installing the S3500 server 
into the messaging system.

After installing the hardware, you must configure the MAS using the DCT analyze file created 
during the upgrade. For instructions for creating this file, see Creating a Data Collection Tool 
File on page 156.

If you are using Dialogic port boards, you must first complete the following steps to prepare the 
DCT file for use in configuring the S3500 server.

1. Download the following tool from the support site, MMS3500DialogicUpgrade.exe.

2. Copy the file to the same directory as your DCT file.

3. Access a command line prompt:

a. Click start-Run

b. In the Open window, type cmd

c. Click OK

4. Navigate to the directory where you saved the MMS3500DialogicUpgrade.exe file.

5. Type MMS3500DialogicUpgrade.exe <dctfilename.mmdct>, where 
<dctfilename.mmdct> is the name of the file created when you analyzed the MAS.

6. Press Enter.
The tool creates a new DCT file adding S3500 to the file name. Use this file to configure the 
S3500. Go to Continuing the upgrade on page 172 to continue the configuration.
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Implementing additional TUIs
This task applies to systems that are running only the Aria TUI on S3400-family servers. 

A Release 1.1 Modular Messaging system always uses S3400-family hardware. If the current 
system runs only the MM Aria TUI, the customer might want to implement additional Telephone 
User Interfaces (TUIs) after the upgrade. Before you can add new TUIs, you must verify that the 
MAS port maximums are within prescribed limits. If any MAS does not have the capacity to 
support the additional TUIs, you must take the steps described in this section.

To verify that the system can support additional TUIs: 

1. Verify that MAS port maximums are within prescribed limits. For more information, see 
Table 24: Supported MAS port boards�S3400-family and CPE server upgrades on 
page 264. If any MAS that has more than 30 ports: 

a. Remove any extra port boards from the over-capacity MAS. Install the boards in another 
MAS if possible. You can use either an under-capacity MAS that is already on-site, or a 
new MAS if one was purchased for this purpose. 

● For more information about hardware procedures, see Avaya Modular Messaging 
S3400-Family Hardware Maintenance and Additions on the documentation media. 

● For procedures to bring the moved port boards into service, see Appendix 
D: Configuring and testing port boards on page 263. 

b. If no additional MASs are available to accommodate the extra ports, the customer must 
either: 

● Refrain from deploying the additional TUIs until additional MASs are installed. 

● Remove the extra port boards and operate at reduced capacity until additional MASs 
are installed. 

2. The PBX administrator must reallocate the port administration on the switch to reflect the 
changes made to the Modular Messaging system. 
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Updating client software 
Note:

Note: If you are not updating to the new release of Subscriber Options, see Changing 
security setting on page 185.

Do this task on each subscriber machine where client software is installed. 

The Modular Messaging client software packages (such as Subscriber Options) must be 
updated on each subscriber machine where they are already installed. 

To update the client software to the latest release:

1. Log in to each subscriber machine where a Modular Messaging client software package 
from the previous release is installed. You must use an account with administrator rights to 
install software (such as the local administrator account for the client machine). 

2. Install a new version of the client software using the normal software installation procedures 
for this site. For example, to reinstall the client software from the Modular Messaging 
software media: 

a. Insert the Avaya Modular Messaging Messaging Application Server Software media (disk 
1) in the machine�s drive, or into the shared DVD drive of another machine that is 
mapped as a network drive on this machine.

b. Navigate to the Install\Client Distrib directory on the appropriate drive (such as D:). 

c. Double-click the setup.exe file. 

d. The Avaya Modular Messaging Client Installation Wizard runs. Follow the prompts. 

The reinstallation process removes the old software and installs the newest version.

3. Repeat this procedure until all existing versions of client software have been replaced with 
the version for the newest release. 

For details on installing or using a client software package, see the appropriate user guide, 
listed in the reference section on the documentation media. 

Changing security setting
If you are not updating Subscriber Options to the new release, you must edit the security setting 
to enable Subscriber Options to work with Modular Messaging Release 3. Complete the 
following steps to edit the setting.

1. Click Start > Run.

2. In the Run window Open field, type regedit and press Enter.
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3. In the Registry Editor window, in the left pane expand the following key: 

HKEY_LOCAL_MACHINE
4. Expand SOFTWARE.

5. Expand Octel.
6. In the right-hand panel, double-click SecurityFlags.

7. In the Edit DWORD Value window in the Value data field, change the value from 1 to 2. 
Click OK.

8. Close the Registry Editor window.

9. Reboot the system.
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Chapter 11: Upgrading Modular Messaging software 
on a customer-provided server

This chapter describes how to upgrade a customer-provided server that is running Modular 
Messaging Release 1.1 software to Modular Messaging Release 3 software.

Note:
Note: Complete the tasks in this section only if you are upgrading a system that is 

running Modular Messaging Release 1.1 software. 

Any systems that are running Unified Messenger Release 5.0 or Modular 
Messaging Release 1.0 software must upgrade to Modular Messaging 
Release 1.1 software before upgrading to Modular Messaging Release 3 
software. 

Topics in this chapter include:

● Overview on page 188

● Preparing the MAS for the upgrade on page 190

● Updating the Dialogic port board drivers on page 200

● Upgrading Realspeak software on page 201

● Upgrading software components on the MAS on page 202

● Completing the upgrade on page 204

● Updating client software on page 206
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Overview
This chapter describes how to upgrade a Modular Messaging system that is running Modular 
Messaging Release 1.1 software to Modular Messaging Release 3.

Note:
Note: A Modular Messaging software upgrade requires several server restarts. Plan to 

do the software upgrade during low-usage hours.

To upgrade the system to Modular Messaging Release 3:

1. Review the configuration notes for any changes that might be needed in the areas of board 
configuration, switch programming, and application configuration. Make any necessary 
changes as you do the update. 

2. Update the software on each MAS and configure new features as needed. See detailed 
steps in Preparing the MAS for the upgrade on page 190, Updating the Dialogic port board 
drivers on page 200, Upgrading Realspeak software on page 201, and Upgrading software 
components on the MAS on page 202

Note:
Note: Completely upgrade and test one MAS first, and let it run for 15 minutes before 

upgrading any additional MASs. The MASs can be upgraded in any order.

3. Update the client software and the Exchange extensions on each MAS and any other 
computer where Modular Messaging was previously installed (such as administrator 
machines or the Exchange server). See detailed steps in Updating client software on 
page 206

Note:
Note: Schedule downtime for the Microsoft Exchange server if the Exchange 

extensions must be updated. See Chapter 5: Adding Exchange extensions for 
Modular Messaging on page 71. 

4. Perform acceptance tests on the entire system. See Completing the upgrade on page 204.

5. Back up the new data. See Completing the upgrade on page 204.

Because an upgrade includes many steps, print the upgrade checklist from Appendix 
B: Installation and upgrade checklists on page 231 and use it to track your progress. 

! CAUTION:
CAUTION: All servers must meet the requirements listed in the Avaya Modular Messaging 

Concepts and Planning Guide (PDF 2 MB), available on the documentation 
media shipped with the system. Review this document to verify that all Exchange 
servers, directory servers, MASs, and client machines are ready to support 
Modular Messaging software.
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Considerations for multiple-MAS upgrades
In a multiple-MAS configuration, Avaya strongly recommends that all MASs that are running 
Release 1.1 software be upgraded to Modular Messaging Release 3 software as soon as 
possible. During an upgrade MASs in the same Voice Mail Domain (VMD) can run different 
releases of Modular Messaging. However, at the completion of an upgrade, all MASs in the 
Voice Mail Domain must be running release 3. 

All MASs in the VMD must be upgraded to the same release of Modular Messaging software 
before you can enable the new Release 3 features. 
If you are adding a new Modular Messaging machine to a multiple-MAS configuration, it cannot 
join an existing VMD that only has Release 1.1 voice servers in it. You must first upgrade one or 
more of the existing servers, leave the system running for at least 15 minutes, and then add the 
new Avaya Modular Messaging server. 

Upgrade requirements
To successfully upgrade a system to Modular Messaging Release 3, you need:

● Release 3 of the Modular Messaging application software. 

- Avaya Modular Messaging Messaging Application Server Software media 

- Avaya Modular Messaging Documentation

● The following information and software from the Avaya Support Web site at http://
www.avaya.com/support. For more information about how to access these items on the 
Web site, see Required documentation and software on page 1. 

- The most current copy of the configuration notes for this switch integration. 

- Avaya software updates that are required to bring the Avaya Modular Messaging 
software up to date after an upgrade. Download this software to a USB storage device. 
For more information about downloading the updates, see Updating Modular Messaging 
software on page 279.

- The latest copy of the Data Collection Tool. Download the DCT update file, 
MMDCTDistribute.exe, from the Avaya support site. Download it to a USB storage 
device.

● A completed copy of all relevant forms in Appendix A: System planning forms on page 209 
and a printed copy of the upgrade checklist for a customer-provided MAS. See Modular 
Messaging upgrade on a Customer-provided server on page 243.

http://www.avaya.com/support
http://www.avaya.com/support
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Note:
Note: For Release 1.1 upgrades, a completed copy of the planning forms should be on 

file from the previous installation. For all upgrades, review the new version of the 
forms in Appendix A: System planning forms on page 209 before beginning the 
software upgrade. Verify that all fields required for any new Release 3 features 
are completed. 

● Modular Messaging Release 3 requires Microsoft Exchange 2003 System Management 
Tools. If you need to upgrade your Microsoft Exchange System Management Tools at this 
time, you will require a copy of the customer-provided Microsoft Exchange 2003 media or 
equivalent access to the 2003 System Management Tools upgrade and the Microsoft 
Exchange 2003 Service Pack 2.

Switching the monitor to show the correct server
Use whatever method is required at this site to have the monitor display the MAS that you are 
upgrading. If you are using the Belkin KVM switch, for complete user and troubleshooting 
instructions, see the KVM switch documentation.

Preparing the MAS for the upgrade
It is important that you record all critical system settings and back up all data in advance. 

Complete the following tasks to prepare the Modular Messaging system for an upgrade:

Completing pre-upgrade tasks on page 191

Running recommended disk checks on page 191

Creating a Data Collection Tool File on page 192

Backing up the MAS on page 194

Busying out ports on page 194

Stop and reset Modular Messaging services on page 195

Upgrading and installing Microsoft Windows software on page 195

Install MSDE upgrade on page 199
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Completing pre-upgrade tasks
Complete the following tasks before you start a Release 3 upgrade. (Record and copy 
information in the event that the upgrade fails and a new installation of the software is required.)

1. Using the latest copy of the planning forms, verify key settings on the MAS, including:

● Switch integration settings

● Port board settings and extensions

● Domain information

● Basic system setup 

● Modular Messaging service account and group

● Exchange settings

Ensure that you record the following items: 

● In the VMSC for each MAS, record any non-default port groups and their names, such as 
the MWI port group. 

● Under Routing and Remote Access, record the IP addresses for the MAS modems in 
the remote access service (RAS) group. See Table 22: RAS IP addresses for each 
MAS on page 227. 

2. If the site has Caller Applications, ensure that a copy of all editable files is on a separate 
computer, not the MAS. 

3. Review the configuration notes for any changes that might be needed regarding board 
configuration, switch programming, and application configuration. Make any necessary 
changes as part of the upgrade. 

Running recommended disk checks
Avaya recommends that the hard disk drive in the server be maintained to prevent possible 
problems. The system administrator must run the following on a regular basis: 

● Disk Defragmenter system tool 

● chkdsk command 

If this server is in service and has not been recently maintained, run the two recommended 
procedures before the upgrade. 
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Creating a Data Collection Tool File

Note:
Note: Always check the Avaya Support Web site at http://www.avaya.com/support for 

recent updates to the DCT program. 

A Data Collection Tool file is not required for the upgrade. However, create one prior to the 
upgrade to save important system information for backup. 

1. Verify that the Modular Messaging system is working properly. All MASs and the Exchange 
message store must be running. 

2. Switch the monitor to show the first MAS. 

3. Verify that the messaging services on the MAS are running:

a. Double-click the Monitor icon on the desktop. 

b. Click Services (Local) in the left pane, if the item is not already selected.

c. In the right pane, scroll down to the list of Modular Messaging services. All services start 
with the abbreviation MM. 

d. Verify that the Status column shows that service is Started for each messaging service 
that belongs on this MAS. For a list of required services, see Table 19: MAS services 
and features form on page 224. 

e. If service is not started for a required messaging service, right-click that MM service and 
select Start.

4. Insert the USB storage device with the DCT update file MMDCTDistribute.exe into a USB 
port on MAS#1. You can use any of the available USB ports.

5. Unzip the Data Collection Tool. 

a. Navigate to the USB drive, Removable Disk (E:)
b. Double-click the executable file MMDCTDistribute.exe and then click Unzip.

c. If this is a multiple-MAS upgrade, be sure a copy of the updated MMDCT.exe file is on 
your USB storage device.

6. Navigate to the location where you stored the DCT executable file (MMDCT.exe). Double 
click the MMDCT.exe file. 

7. On the first screen Select the DCT Configuration to use, select Analyze existing 
system. Click OK. 

8. When asked if you want to use an existing DCT file, click No. 

9. On the MM System Analysis screen, select the first MAS from the dropdown list at the 
bottom of the window. Click Start. 
The system displays the process of the data collection.
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10. When analysis is complete, you see the message �information has been successfully 
collected,� The DCT displays the newly created file.

11. For a single MAS upgrade, proceed to step 13. In a multiple MAS system, save the DCT file 
to a USB storage device. 

12. In a multiple MAS system, update the Collection Tool (DCT) file with information from 
additional MAS�s.

a. Insert a USB storage device with the DCT file you created for MAS 1 into the USB port on 
the MAS you are going to analyze.

b. Navigate to the updated MMDCT.exe file on the USB storage device.

c. Launch the Data Collection Tool by double clicking the MMDCT. exe file.

d. On the first screen Select the DCT Configuration to use, select Analyze existing 
system. Click OK. 

e. When asked if you want to use an existing DCT file, click Yes.

f. Navigate to the location where you saved the DCT file you created for the first MAS. 

g. Double click this file to select it.

h. On the MM System Analysis window, choose the number of the MAS you are analyzing 
from the dropdown list at the bottom of the window. Click Start.

Note:
Note: Analyze the MASs in numeric order, first to last.

When upgrading to an S3500 server, you can decrease the number of MASs in 
the voice mail domain (VMD). Analyze only those MASs that you plan to upgrade. 
When the upgrade is complete, you must move the Modular Messaging services 
that are on MASs that were not upgraded to an MAS that was upgraded. For 
more information about moving MM services, see Modular Messaging S3500-Family 
Hardware Maintenance and Additions.

At the completion of the upgrade all MASs in the VMD must be running Modular 
Messaging Release 3. If you do not upgrade an MAS, do not include it in the 
VMD.

The system displays the process of the data collection.

i. When analysis is complete, you see the message �information has been successfully 
collected.� The DCT displays the newly updated file.

j. Save the DCT file by overwriting the previous file.
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! CAUTION:
CAUTION: In multiple MAS systems, review and revise the DCT file after analyzing all MASs 

that will be upgraded. Information that is manually entered before the final 
analysis might be overwritten in the analysis of subsequent MASs.

Do not change any data that was populated by the DCT system analysis. There 
is only one exception to this rule. You can revise the default account names on 
the MAS accounts and passwords screen.

13. Review the completed file. Enter information in empty fields. To complete information, if 
necessary, use the planning forms from Appendix A: System planning forms on page 209.

Note:
Note: Verify that there are no red x�s next to the DCT screen names in the left panel. 

The red x�s indicate data that is incomplete or not valid. Information must be 
complete and valid before you can use this file for a recovery, if needed.

14. When all fields in the DCT are complete, click Complete at the bottom of the DCT screen. 
Save the DCT file to a location that will be included in a system backup. This DCT file will 
not be used during the upgrade, but is an important backup.

Backing up the MAS 
Before beginning the software upgrade, make a current backup of the important system files, 
including customized tone files, and the DCT file you just created. For this procedure, see 
Backing up the system on page 147. 

Busying out ports 
Busyout the ports on the MAS you are upgrading and on the switch before you start the 
upgrade. Otherwise, messages will spool on the MAS, and add to the upgrade time. 

To busyout the ports: 

1. The PBX administrator must use the procedures appropriate for this PBX to busyout the 
ports. Depending on the switch integration, the administrator might be able to temporarily 
reroute calls to other MASs. If an MAS is unavailable, callers into the system might hear 
ring-no answer or a busy signal. 

2. Switch the monitor to show the MAS. 

3. Use the Port Monitor to disable the MAS ports: 

a. Click Start > Programs > Avaya Modular Messaging > Port Monitor. 
b. In the Port Monitor window, hold down the Shift key or Control (Ctrl) key and click to 

select all the ports. 
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c. Right-click the port list and select Disable. 

d. Verify that the status of all ports is Disabled.

e. Close the Port Monitor window.

Stop and reset Modular Messaging services
Stop and reset all Modular Messaging (MM) services as follows: 

1. Insert the Avaya Modular Messaging Messaging Application Server Software media (disk 1) 
in the DVD drive of the MAS.

2. Navigate to the Install\MISCM directory on the media.

3. Double click the StopMMServices.exe file.

4. The StopMMServices tool stops all Modular Messaging services and resets their startup 
type to manual.

Upgrading and installing Microsoft Windows software
To Upgrade and install prerequisite Microsoft Windows software, you must complete the 
following procedures described in this section: 

1. Upgrade Microsoft Windows operating system to Microsoft Windows Server 2003, if 
operating system is not already upgraded. See Upgrading Microsoft Windows operating 
system on page 195.

2. Install and enable Microsoft Windows software components. See Installing and enabling 
Microsoft Windows software components on page 196.

3. Apply Microsoft Windows Server 2003 Service Pack 1, if not already applied. See Apply 
Microsoft Windows Server 2003 Service Pack 1 on page 198.

4. Install Microsoft Exchange 2003 System Management Tools. See Installing Microsoft 
Exchange 2003 System Management Tools on page 198.

5. Apply Microsoft Exchange 2003 Service Pack 2, if not already applied. See Applying 
Microsoft Exchange 2003 Service Pack 2 on page 199.

6. Verify that anti-virus software is current. See Verifying anti-virus software on page 199.

Upgrading Microsoft Windows operating system

All MASs in the Voice Mail Domain must be running Microsoft Windows Server 2003 for 
Modular Messaging Release 3. Check with the Windows administrator for site-specific 
procedures to upgrade the operating system.
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You can use the following procedure to check the current operating system running on the 
server.

1. Right-click My Computer and select Explore.

2. In Windows Explorer, click Help > About Windows. 

3. Verify that Windows Server 2003 is installed. 

4. Click OK to close this window. 

Installing and enabling Microsoft Windows software components

You must install and enable the Microsoft Windows services described in this section on this 
MAS. 

● If this MAS will have the Messaging Application Server service installed on it (see MAS 
services and features form on page 224), you must install and enable the IIS Admin and 
WWW Server Microsoft Windows services to support Modular Messaging Release 3. 

● If you must install the Microsoft Exchange System Management Tools for an Exchange 
2003 system on this MAS (see Installing Microsoft Exchange 2003 System Management 
Tools on page 198), you must install and enable the required Microsoft Windows NNTP 
and SMTP services as described before you install the Microsoft Exchange software. 

● If this MAS will have the Messaging Application Server service installed on it, and if Simple 
Network Management Protocol (SNMP) will be used for alarming at this site (see Support 
information on page 227), you must install and enable the appropriate Microsoft Windows 
services to support SNMP. 

To install and enable all required Windows services:

1. Log in to an account that has permissions to install software on this computer, such as the 
local administrator account. 

2. Insert the Microsoft Windows Operating System CD in the MAS drive.

3. Click Start > Control Panel > Add or Remove Programs.

4. In the Add or Remove Programs window, in the left column, click Add/Remove Windows 
Components. 

5. To install Microsoft Windows services: 

a. In the Windows Components Wizard window, highlight Application Server. Click 
Details. 

b. In the Application Server window, verify that the following items show a check mark, or 
enable them if necessary.

● Application Server Console

● ASP.NET

● Enable COM+ access
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c. In the same window, highlight Internet Information Services (IIS), but do not check the 
box if the checkbox is clear. 

d. Click Details. 

e. In the Internet Information Services (IIS) window, verify that the following items show a 
check mark:

● Common Files

● Internet Information Services Manager

● World Wide Web Server

Note:
Note: The Internet Information Services items listed above are always required. If you 

plan to install the Microsoft Exchange 2003 System Management Tools, click the 
checkboxes to select NNTP Service and SMTP Service. The SMTP Service 
automatically selects other required components as needed.

f. In the same window, highlight World Wide Web Server and click Details. Verify that 
World Wide Web Services is checked.

g. Click OK. 

h. Click OK a second time to close the Application Server window. 

6. If SNMP alarming is required on this MAS, install the Windows services to support SNMP: 

a. In the Windows Components Wizard window, click the checkbox to select Management 
and Monitoring Tools, highlight the selection and click Details.

b. In the Management and Monitoring Tools window, click the checkbox to select Simple 
Network Management Protocol. Click OK. 

7. Complete the wizard to install the selected services.

Note:
Note: If the required services were already installed (all the appropriate boxes were 

checked), click Cancel to close the wizard.

8. When the installation is complete, close the Add or Remove Programs window.

9. After the software is installed, enable each installed service as follows: 

a. Right-click My Computer and select Manage. In the Computer Management window, 
the left (Tree) pane, expand Services and Applications, and then click Services.

b. In the right pane, scroll down to the first new service that you installed. Double-click the 
service to open the properties window. 

c. In the properties window: 

1. On the General tab, verify that the Startup type is set to Automatic. Set to automatic 
if it is not.

2. Click Apply. 
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3. Under Service status, click Start. 
4. Wait for service to start, and then click OK to close this window.

d. Repeat Steps b and c to enable each of the services you installed. Note that only a 
subset of these services might be present on a particular MAS.

10. When all services are enabled, close all open windows. 

Changing the IIS mode
Complete the following steps to install the components

1. Select Start>All Programs>Microsoft Exchange>Internet Information Services (IIS) 
Manager 

2. Expand the local computer 

3. Right click Web Sites and choose properties 

4. Select the Service tab and uncheck the run www service in IIS5.0 isolation mode 
checkbox.

Apply Microsoft Windows Server 2003 Service Pack 1

SP1 might already be installed on this computer. To verify the service pack version and install 
an update if needed:

1. Verify the Microsoft Windows service pack version that is installed:

a. Right-click My Computer and select Explore.

b. In Windows Explorer, click Help > About Windows. 

c. In the version description, verify that Service Pack 1 is installed. 

d. Click OK to close this window. 

2. If needed, install Microsoft Windows Service Pack 1 on this MAS. Check with the Windows 
administrator for the appropriate software update procedures to use at this site. For details 
about this procedure, see the Microsoft Exchange documentation.

Installing Microsoft Exchange 2003 System Management Tools

Complete the following steps to install Exchange 2003 System Management Tools.

Note:
Note: The Microsoft Exchange 2003 System Management Tools must be installed on 

any MAS that will have any of the following services installed on it: 

- Messaging Application Server

- Call Me Server
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- Message Waiting Indicator (MWI) Server. 

Exchange 2003 System Management Tools are required, Exchange 2000 System 
Management Tools are not supported.

a. Insert the customer-provided Microsoft Exchange 2003 Server media in the MAS drive.

b. Install the Management tools by completing the Microsoft Exchange Installation Wizard.

c. If you receive a compatibility warning, click Continue.

d. For details about this procedure, see the Microsoft Exchange documentation.

Applying Microsoft Exchange 2003 Service Pack 2

If needed, install Microsoft Exchange2003 Service Pack 1 on this MAS. Check with the 
Windows administrator for the appropriate software update procedures to use at this site. For 
details about this procedure, see the Microsoft Exchange documentation.

At this time, also apply any additional Microsoft Windows system updates, security patches, and 
hot fixes needed to update the system according to site update procedures.

Verifying anti-virus software

Verify that the anti-virus software is current. The virus-checking software used and the update 
methods required vary per local implementation. 

Install MSDE upgrade

Install the MSDE upgrade to convert the FEDB database to SQL. To install the MSDE upgrade, 
complete the following steps:

1. Insert the Avaya Modular Messaging Messaging Application Server Software media (disk 1) 
in the MAS DVD drive.

2. In Explorer navigate to the Install\System Upgrade\MSDE directory.

3. Double click on the MSDE.bat file.

4. After the utility runs, close the explorer window.
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Updating the Dialogic port board drivers
Do this task on each MAS that contains Dialogic port boards. 

This section describes how to update the drivers for the Dialogic port boards as part of a 
Release 3 software upgrade. 

Note:
Note: If this MAS uses an IP H.323 or IP SIP switch integration, you do not need to 

update the Dialogic drivers. Continue with Upgrading software components on 
the MAS on page 202. 

Updating the drivers on a Release 1.1 system
This section describes how to update the Dialogic drivers on an MAS that is running Modular 
Messaging Release 1.1 software. 

1. Uninstall Dialogic drivers

a. Insert the Avaya Modular Messaging Messaging Application Server Software media (disk 
1) in the DVD drive of the MAS.

b. In Windows Explorer, navigate to the Dialogic Drivers directory on the media.

c. Double click the MMDialogicUninstall.bat file. 

d. If you receive a Remote Shutdown dialog warning box, enter a reason for a restart.

If you do not receive the warning, the system restarts automatically.

2. Reinstall Dialogic drivers

a. After the restart, log back into the server.

b. In Windows Explorer, navigate to the Dialogic Drivers directory on the media.

c. Double click the MMDialogicInstall.bat file. The Dialogic Setup wizard launches.

d. Complete the wizard accepting all default selections.

e. On the final screen of the wizard, choose to restart the computer.

3. Upgrade Dialogic drivers

a. After the restart, log back into the server.

b. In Windows Explorer, navigate to the Dialogic Drivers directory on the media.

c. Double click the MMDialogicUpgrade.bat file.

When the upgrade utility completes, the Dialogic update is finished.
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Upgrading Realspeak software
This section describes how to update the Realspeak driver and languages as part of a Release 
3 software upgrade. 

To upgrade Realspeak Software, complete the following steps:

1. Uninstall Realspeak software

a. Insert the Avaya Modular Messaging Messaging Application Server Software media (disk 
2) in the DVD drive of the MAS.

b. Navigate to the Realspeak directory on the media.

c. Double click the uninstallRS3.bat file.

2. Reinstall the Realspeak software

a. In the Realspeak directory on the media, double click the installRSEngine.bat file.

When the installation is complete, the system automatically reboots.

3. Reinstall the Realspeak languages

a. After the restart, log back into the server.

b. In Windows Explorer, navigate to the Realspeak directory on the media.

c. Double click the installRSLangs.bat file.

4. After languages are updated, leave the Modular Messaging Applications directory window 
open.
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Upgrading software components on the MAS
Do this task on each MAS. 

This section describes how to upgrade required application software on the Messaging 
Application Server (MAS). 

To Upgrade application software, you must complete the following procedures described in this 
section: 

● Upgrading Modular Messaging software on page 202.

● Installing software updates on page 204.

● Completing the upgrade on page 204.

Upgrading Modular Messaging software

Note:
Note: If anti-virus software is installed, Avaya recommends that you disable it while you 

upgrade the Modular Messaging software to prevent possible negative 
interactions. Enable the virus-checking software again after the upgrade is 
complete.

To upgrade the software on this MAS to Modular Messaging Release 3:

1. Run the Modular Messaging Installation Wizard as follows:

a. In Windows Explorer, navigate to the Install directory on the Avaya Modular Messaging 
Messaging Application Server Software media (disk 1).

b. Double-click the Setup.exe file. 

The Avaya Modular Messaging Installation Wizard launches. All components that were 
previously installed on this machine, and the Diagnostic tools, are automatically selected. 
These selections cannot be changed. The currently installed version is displayed to the 
right of the specific tool or application. The version that will be installed is displayed at the 
top of the page following the Avaya Modular Messaging title.

c. Check the box for Snapshot Utility, Web Subscriber Options and any additional 
components that are necessary for this MAS and click Install

2. In the System Upgrade window, click Run System Upgrade. 

3. When prompted, click Restart to continue the upgrade.
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4. When the reboot is complete, log in as the Modular Messaging customer account (such as 
mmacct). See Item A12 on the Modular Messaging logon accounts form on page 221.

5. When prompted, enter the name and password for the account that Modular Messaging 
Services will use. This is the name of the Modular Messaging customer account, such as 
mmacct. See Item A12 on the Modular Messaging logon accounts form on page 221. Do 
not select the Local System Account default. 

The new Modular Messaging software is installed.

6. When the Installation Wizard reappears with the flashing warning that the installation is not 
complete, restart windows.

7. When the reboot is complete, log in as the Modular Messaging customer account (such as 
mmacct). See Item A12 on the Modular Messaging logon accounts form on page 221.

After you log in, the Messaging Application Server Configuration Wizard launches the Front 
End Database Update. 

8. Click Next to continue. 

Note:
Note: This step might take several minutes for a large database or global address list 

(GAL). 

9. The upgrade procedure compares the prompts installed on the MAS with the existing voice 
mail domain prompts. If any prompts are absent, the Missing Prompts screen is displayed 
showing a list of the prompts that must be installed before the installation can continue. To 
do this:

a. On the Missing Prompts screen, note the missing prompt sets. The configuration wizard 
automatically attempts to locate the installation packages for these prompts.

b. If any installation packages cannot be found, a Locate Installation Package message is 
displayed. Click the text, and then click Browse. 

c. In the Browse for Folder window, navigate to the Prompts directory.

d. Select the folder containing the missing prompts, and click OK. 

e. Repeat Steps b through d for all prompts that cannot be found. 

f. When finished, click Next. (This button is not enabled until all the prompt installations are 
found.) 

10. Click Finish when the update is complete.

11. Remove the media from the DVD drive. 

12. If you disabled the anti-virus software on this MAS, enable it again now. 
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Installing software updates
A new Modular Messaging system ships with the most current software that is available at the 
time. However, the software must be updated after an installation or upgrade to include the 
latest changes. The updates might be in the form of an Avaya Service Pack (SP) or a software 
patch (hot fix). 

To determine if a Modular Messaging software update is needed: 

1. Locate any relevant Avaya software updates on the Avaya Support Web site at http://
www.avaya.com/support. For complete steps, see Obtaining software updates from the 
Web on page 279. 

Note:
Note: If you followed the procedure for Obtaining software updates on the Web on 

page 3, you already downloaded any required software updates. 

2. If the Modular Messaging system requires a software update, complete the update 
procedure now before you do acceptance testing. Follow the instructions in Appendix 
E: Updating Modular Messaging software on page 279 to update the system with the latest 
changes. 

Completing the upgrade
Continue the Modular Messaging software upgrade as appropriate:

1. If you have more than one MAS: 

a. For the first MAS installed only, let the Modular Messaging software run for 15 minutes 
so that it can update shared data across the voice mail domain. Return to Upgrading and 
installing Microsoft Windows software on page 195 to begin upgrading the next MAS.

b. Repeat the Modular Messaging software upgrade procedure until all MASs are 
upgraded. 

2. You must update the Modular Messaging Active Directory Exchange extensions software 
on any machines where it is installed. This might include Exchange servers and client 
machines used for subscriber administration (any Exchange extensions on an MAS were 
updated with the rest of the Modular Messaging software). See Adding the Exchange 
extensions on page 74. 

http://www.avaya.com/support
http://www.avaya.com/support
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Note:
Note: The Modular Messaging Active Directory Exchange extensions are updated 

along with any other Modular Messaging software that is installed on this 
machine (multiple Modular Messaging software component checkboxes might be 
checked). This ensures that all currently installed components are upgraded. The 
components are installed in the correct order when you click Install. 

3. Configure new Release 3 features. For more information, see Configuring new features for 
Release 3 on page 206.

4. Update the client software on any non-MAS machines where it is installed. See Updating 
client software on page 206.

5. For any MAS that does not have Web Subscriber Options installed, close TCP port 80 to 
increase system security. For complete instructions for closing the port, see your Microsoft 
documentation. For information about how Modular Messaging uses TCP/IP ports, contact 
your Avaya or business partner account team.

6. Set up test subscribers and perform all acceptance tests that are relevant to the system. 
See Testing and backing up the system on page 135. 

7. When acceptance tests are complete, back up each MAS using the regular backup 
procedures for this site. For guidelines, see Backing up the system on page 147. 

8. When finished with each MAS, verify that the MAS is in good condition by running the Disk 
Defragmenter system tool.

9. If you are adding a new MAS to this system, begin the installation now. 

● To install a new Avaya Messaging Application Server (Avaya MAS), begin with Chapter 
2: Installing Avaya-provided hardware on page 9. 

● To install a new customer-provided MAS, begin with Chapter 3: Installing Dialogic port 
boards in a customer-provided MAS on page 43. 

Print the appropriate checklist from Appendix B: Installation and upgrade checklists on 
page 231 and use it as a guide.

10. When finished, save all planning forms in a safe place. 
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Configuring new features for Release 3
Configure and activate new features for this release using the Voice Mail System Configuration 
program after the new Modular Messaging software is configured: 

1. Verify that all services are started: 

a. Right-click My Computer and select Manage. In the Computer Management window, 
the left (Tree) pane, expand Services and Applications, and then click Services.

b. In the right pane, scroll down to the list of Modular Messaging (MM) services. Verify that 
the Status column shows that service is Started for each installed messaging service.

c. If service is stopped or if the Status column is blank, right-click the appropriate MM 
service and select Start.

2. When finished, close all open windows.

Updating client software 
Note:

Note: If you are not updating to the new release of Subscriber Options, see Changing 
security setting on page 207.

Do this task on each subscriber machine where client software is installed. 

The Modular Messaging client software packages (such as Subscriber Options) must be 
updated on each subscriber machine where they are already installed. 

To update the client software to the latest release:

1. Log in to each subscriber machine where a Modular Messaging client software package 
from the previous release is installed. You must use an account with administrator rights to 
install software (such as the local administrator account for the client machine). 

2. Install a new version of the client software using the normal software installation procedures 
for this site. For example, to reinstall the client software from the Modular Messaging 
software media: 

a. Insert the Avaya Modular Messaging Messaging Application Server Software media (disk 
1) in the machine�s drive, or into the shared DVD drive of another machine that is 
mapped as a network drive on this machine.

b. Navigate to the Install\Client Distrib directory on the appropriate drive (such as D:). 

c. Double-click the Setup.exe file. 

d. The Avaya Modular Messaging Client Installation Wizard runs. Follow the prompts. 

The reinstallation process removes the old software and installs the newest version.



Updating client software

Issue 1 April 2006 207

 

3. Repeat this procedure until all existing versions of client software have been replaced with 
the version for the newest release. 

For details on installing or using a client software package, see the appropriate user guide, 
listed in the reference section on the documentation media. 

Changing security setting
If you are not updating Subscriber Options to the new release, you must edit the security setting 
to enable Subscriber Options to work with Modular Messaging Release 3. Complete the 
following steps to edit the setting.

1. Click Start > Run.

2. In the Run window Open field, type regedit and press Enter.
3. In the Registry Editor window, in the left pane expand the following key: 

HKEY_LOCAL_MACHINE
4. Expand SOFTWARE.

5. Expand Octel.
6. In the right-hand panel, double-click SecurityFlags.

7. In the Edit DWORD Value window in the Value data field, change the value from 1 to 2. 
Click OK.

8. Close the Registry Editor window.

9. Reboot the system.
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Appendix A: System planning forms

The Installation of a new Modular Messaging system requires careful network planning. Server 
names, IP addresses, domain names, accounts, extensions, and passwords must be 
administered correctly on each of the servers in the system. The customer must provide some 
of the information in advance, or the installation cannot proceed. 

! CAUTION:
CAUTION: Use each set of planning forms only with the same issue of the document that 

they support. Fields are added or changed between software releases. The 
planning forms that support this issue of the Installation and Upgrades guide are 
different from planning forms that supported earlier releases. 

You must license new systems using Remote Access Feature Activation (RFA). Authorized 
personnel must be trained in RFA and registered for Avaya Modular Messaging before they can 
request a license. For complete licensing steps and contact information for RFA assistance, see 
Getting Started with RFA for Modular Messaging on the http://rfa.avaya.com Web site.

Reviewing the planning forms and DCT data file
Check with your regional representative about the procedures you must use to submit and 
review the planning forms and the Data Collection Tool (DCT) data file. Avaya strongly 
recommends that an expert reviews this information before any installation or upgrade. 

● In North America, the Solution Support Organization (SSO) Tier III group must review the 
planning information for accuracy and thoroughness. Send the completed set of planning 
forms and the DCT data file by e-mail to mmtac@avaya.com. Title the e-mail MM Planning 
Forms for Tier III Review. An SSO Tier III engineer reviews the information, notes any 
changes, and returns the forms and data file to the field contact. 

● Avaya recommends that Business Partners also use the MMTAC organization to review 
their planning forms and DCT data files. 

! CAUTION:
CAUTION: Installers update or complete the planning forms and DCT data file as part of a 

normal installation or upgrade. Ensure that you return any updated copies to the 
customer, the project planner, and the appropriate remote support organization. 

Avaya recommends that Business Partners file their final, approved planning forms and DCT 
data files with the MMTAC organization. This action provides a backup of vital system 
information. However, Avaya advises Business Partners to specify that MMTAC representatives 
not dial in to systems that Business Partners maintain, unless previously authorized. 

http://rfa.avaya.com
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Note:
Note: You can use the DCT to help complete the information on the planning forms. 

The DCT program validates many entries and has online help. For more 
information, see the screen-specific help section of the DCT online help system 
or its printed version, Avaya Modular Messaging Data Collection Tool Help. 

! CAUTION:
CAUTION: For Release 3 upgrades, compare the new planning forms against the planning 

forms that are on file. Update any fields are needed. Verify all information against 
the actual system administration if possible. The upgrade erases all existing data.

Completing additional planning forms 
You might need to complete additional planning forms for certain adjuncts. For the latest version 
of the planning forms, see the Avaya Support Web site at http://www.avaya.com/support: 

● If the Modular Messaging system is to be networked to any legacy messaging systems 
through the Avaya Message Networking system, complete the corresponding Message 
Networking Planning Form. The network planning form is available on the documentation 
media for the Message Networking product. 

● If a Unified Communication Center Speech Access (UCC SA) server is to be part of the 
system configuration, complete the planning forms for that server. See the appendix of the 
Avaya Unified Communication Center Speech Access (UCC SA) Release 2.0.2 Site 
Preparation Guide at http://support.avaya.com/elmodocs2/ucc/R2.0/SPGuide.pdf. 

http://www.avaya.com/support
http://support.avaya.com/elmodocs2/ucc/R2.0/SPGuide.pdf
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Terminology
The following terminology applies to the LAN administration process. 

Avaya MAS. A Messaging Application Server (MAS) where the hardware is provided by Avaya 
Inc., often with other optional peripheral devices. The port boards and much of the required 
software are pre-installed on an Avaya MAS.

Corporate IP LAN and interface. Each MAS is connected to the LAN infrastructure 
constructed and maintained by the enterprise that purchased the system. The LAN is the 
corporate IP LAN, and might be identified as Local Area Connection 2 or Corporate LAC on an 
Avaya MAS. This LAN gives the MAS access to other machines and users.

Default IP gateway. The IP gateway to use if no other specified gateway is available. Each 
MAS has at most one default gateway connected to the corporate IP LAN. 

Directory server. A server that contains the subscriber mailboxes, such as Active Directory or 
the Microsoft Exchange Administrator application. 

Domain name. A unique designator used to identify a group of related computers on the 
internet (for example, avaya.com). Domain names are hierarchical, and the labels go from more 
specific on the left to more general on the right. There can be any number of levels in the 
hierarchy. 

Domain Name Service (DNS). An Internet protocol service most often used to resolve 
symbolic names to IP addresses. The DNS service is constructed on hierarchical domains with 
different sets of servers serving each hierarchical layer.

DNS server. A machine that has the DNS service active. Such a machine can resolve symbolic 
names for the DNS domain it serves to an IP address. 

Exchange server. A server that is running a compatible release of Microsoft Exchange 
software. 

Fully Qualified Domain Name (FQDN). A domain name that identifies an individual computer 
and the network on which the computer resides, such as mymas1.loc.avaya.com. The leftmost 
label is the primary name of the computer. This name is usually the host name, but not always. 

Host name. The unique name of the machine. In Microsoft Windows terminology, this is often 
called the NetBIOS machine name. 

Initialization and Administration System (INADS). The Avaya remote service support 
program for monitoring alarms and maintaining installed systems. 

IP address. A value used to identify a computer connected to a network. If a machine has 
multiple network interfaces, it will have multiple IP addresses, one for each connection to a 
different network. IP addresses are usually specified as four numbers separated by a period (for 
example, 10.9.55.183).

IP gateway. An IP address where IP packets are routed if the specified IP address is not on the 
network directly connected to an interface on the machine. An IP gateway is usually an interface 
on a router.
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Messaging Application Server (MAS). Any Microsoft Windows-based machine that is running 
Avaya Modular Messaging software. A customer-provided MAS has some different prerequisite 
hardware and software requirements than an Avaya MAS (for example, the port boards and 
additional Windows software must be installed), but the software installation and administration 
is nearly identical for both platforms. 

NetBIOS domain. A Microsoft Windows domain that is not fully qualified (has no periods). For 
example, zodiac.

NetBIOS name. The Microsoft Windows term for a host name, also called a NetBIOS machine 
name.

Point-to-Point Protocol (PPP). An Internet standard protocol used for serial line connections, 
such as dial-up modems.

Subnet mask. A value used to tell which bits of an associated IP address are the network 
portion and which bits identify the specific host on the network. Each network interface has an 
IP address and an associated subnet mask.

Voice Mail Domain (VMD). A group of one or more messaging application servers. Messaging 
(or voice) servers in a VMD share configuration properties of the VMD and subscribers to the 
VMD.

Windows domain. A grouping of network objects, such as users, groups, and computers. All 
objects in a domain are stored on the directory server, such as Active Directory. A directory can 
reside on one or more domain controllers within a domain.
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Modular Messaging System Planning Form
For complete information about fields on this form, see the screen-specific help section of the 
DCT online help system or its printed version, Avaya Modular Messaging Data Collection Tool 
Help. 

 
Table 14: Modular Messaging System Planning Form

# Item Value Notes

1 Company name The system logon 
screen shows this 
information.

2 Organization name

3 Message store�choose one ___Microsoft Exchange using 
own hardware
___Microsoft Exchange using 
Avaya hardware

4 Contact information for 
Windows domain 
administrator*

5 Contact information for 
message store (Microsoft 
Exchange) administrator

6 Voice mail domain name

7 Number of MASs in the VMD

8 Corporate network 
connection�choose one

___Connect to corporate 
network using specified 
(static) IP addresses
___Connect to corporate 
network and obtain IP 
addresses automatically using 
DHCP

9 Switch integration�choose 
one

___ Avaya CM (IP SIP) 
___ Avaya (IP H323)
___ Avaya (QSIG)
___ Cisco (QSIG)
___ Nortel NT M-1 (QSIG)
___ Siemens Hipath (QSIG)
___ Other�specify: __________
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10 Folder for offline access to 
messages�specify the MAS 
and folder name

11 Modular Messaging customer 
account group name: 

12 Active Directory users or groups who require system administration access: 

Active Directory users or groups who require subscriber administration access: 

Table 14: Modular Messaging System Planning Form

# Item Value Notes
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Corporate Network Planning Form
For complete information about fields on this form, see the screen-specific help section of the 
DCT online help system or its printed version, Avaya Modular Messaging Data Collection Tool 
Help. The fields in this form are ordered to correspond with the process of entering data in the 
Data Collection Tool.

Copy this form as many times as needed to cover all MASs. 

! CAUTION:
CAUTION: You must coordinate the IP addresses that will be used on the Modular 

Messaging servers with those on the corporate LAN. If you specify an Ethernet 
address for an Avaya server that conflicts with another Ethernet endpoint, the 
resulting traffic problems on the local area network can be extremely difficult to 
diagnose and solve. Work with the LAN administrator to identify and correct any 
potential addressing problems or conflicts.

To complete Table 15: Corporate network planning form on page 216:

1. Item C1: Choose unique NetBIOS machine (host) names for all MASs, such as mymas1, 
and mymas2. You must keep track of what server you are administering. In this guide, 
mymas1 is MAS#1, and mymas2 is a subsequent MAS.

Avaya recommends host (machine) names shorter than 10 characters long for ease in 
entering information online. The host name and domain name can each be 1 to 15 
characters long. The complete computer name plus domain name must be 64 or fewer 
characters long, such as mymas1.loc.avaya.com. The computer host and domain names 
can be any unique term that complies with local conventions.

! CAUTION:
CAUTION: Use only numbers and lowercase characters for computer host names and 

domain names. Do not use any special characters except a hyphen (-). The first 
character cannot be a numeric character. 

2. Items C2 through C10: Enter the required corporate network information. The corporate IP 
or LAN administrator must supply these values. Corporate information includes:

● The full corporate computer name for each server, also called the Fully Qualified Domain 
Name (FQDN)

● All required IP addresses and domain names

● Windows Internet Name Service (WINS) information, if used

Note:
Note: The corporate IP administrator must supply the IP address for any required DNS 

or WINS servers on the corporate LAN. 

Follow these guidelines to complete the corporate information:
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● The MASs in a Modular Messaging system can use Dynamic Host Configuration 
Protocol (DHCP) to obtain IP addresses automatically. If this site uses DHCP, do not 
enter IP addresses for Items C3 and C5.

● The corporate LAN administrator must supply the domain search order and any domain 
names in the required order. The LAN administrator must also provide any aliases for the 
Modular Messaging computers, if required for the corporate interface. The alias might be 
the host name of the computer, such as mymas1. An alias might also be some other 
NetBIOS name, such as primname.loc.avaya.com, depending on the corporate setup. 

Note:
Note: All Modular Messaging servers must be in the same Windows domain and on the 

same LAN segment, whether provided by the customer or Avaya Inc. LAN 
personnel must configure IP addresses on the corporate DNS servers in keeping 
with local policy and practices. Customers must also register the corporate 
FQDNs for each MAS on any relevant corporate DNS servers. 

Table 15: Corporate network planning form

# Item MAS #1 MAS #2

C1 Host name
(machine or Windows NetBIOS 
name)

C2 Corporate domain name

C3 Subnet mask
(for corporate LAN interface)

C4 Full computer name
(MAS Fully Qualified Domain Name)

C5 IP address
(MAS IP address on corporate LAN)

C6 DNS server IP addresses in order of 
use

C7 Search order of DNS domains

C8 Default gateway IP address

C9 WINS IP address (if required)

C10 Microsoft Windows domain

C11 Peer Exchange server
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! CAUTION:
CAUTION: The following planning form shows a completed example for a two-MAS system. 

These sample values are used in this guide for illustration purposes only. Do not 
use these values in your system

C12 Peer directory server

C13 Non-default Active Directory container 
for Modular Messaging service 
accounts (if needed). 

C14 Non-default software installation path

C15 Register the IP address for this 
connection in the DNS? 
Register the DNS suffix in the DNS?

C16 Static IP addresses for remote access 
(2 required per MAS) 

Table 15: Corporate network planning form

# Item MAS #1 MAS #2

Table 16: Corporate network planning form (completed example)

# Item MAS #1 MAS #2

C1 Host name
(machine or Windows NetBIOS 
name)

mymas1 mymas2

C2 Corporate domain name loc.avaya.com loc.avaya.com

C3 Subnet mask
(for corporate LAN interface)

255.255.255.0 255.255.255.0

C4 Full computer name
(MAS Fully Qualified Domain 
Name)

mymas1.loc.avaya.com mymas2.loc.avaya.com

C5 IP address
(MAS IP address on corporate 
LAN)

10.9.83.72 10.9.83.73

C6 DNS server IP addresses in 
order of use

10.9.1.39
10.9.1.2

10.9.1.39
10.9.1.2
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C7 Search order of DNS domains loc.avaya.com
avaya.com

loc.avaya.com
avaya.com

C8 Default gateway IP address 10.9.83.254 10.9.83.254

C9 WINS IP address (if required) 10.9.62.39 10.9.62.39

C10 Microsoft Windows domain domain1 domain1

C11 Peer Exchange server exchange1 exchange1

C12 Peer directory server directory1 directory1

C13 Non-default Active Directory 
container for Modular 
Messaging service accounts (if 
needed). 

CN=Octel,DC=looney,DC=rnd,DC=avaya,DC=com

C14 Non-default software installation 
path

D:\Program Files\Avaya Modular Messaging

C15 Register the IP address for this connection in the DNS? yes
Register the DNS suffix in the DNS? yes

C16 Static IP addresses for remote 
access 
(2 required per MAS) 

10.152.5.24
10.9.6.8

10.152.5.24
10.9.6.8

Table 16: Corporate network planning form (completed example)

# Item MAS #1 MAS #2
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Clients and optional applications form
Make a checkmark next to the client packages and other optional applications that you want to 
use at this site. You must install all required client software after an installation or upgrade. 

Table 17: Client and software applications for this site

Client or software application Notes 

Avaya Modular Messaging Subscriber Options, 
also known as Modular Messaging (MM) Client

Automatically installed with Active Directory 
extensions.

Modular Messaging Web Subscriber Options ___ Install on its own server
___ Install on an MAS, see Table 19: MAS 
services and features form on page 224

IBM Lotus Notes Client

Microsoft Outlook Client

Unified Communication Center Speech Access

Networked Modular Messaging or Message 
Networking 

Avaya Site or Multi-site Administration
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MAS Logon Accounts Form
For complete information about fields on this form, see the screen-specific help section of the 
DCT online help system or its printed version, Avaya Modular Messaging Data Collection Tool 
Help. 

Account logon names and passwords should be site-specific for security reasons.

! CAUTION:
CAUTION: Passwords for Modular Messaging accounts must be at least 8 characters long. 

Do not create passwords composed of easily guessed words or numeric 
combinations, including sequential or repeated numbers. You must use a 
combination of at least three of the following character types: uppercase and 
lowercase letters, numbers, and special characters or symbols 

● Account names: MAS account names must be between 7 and 32 characters long. In 
addition to alphanumeric characters, you can use the special characters underscore 
(_), period (.), and dash (-) in account names, but not the symbols �/ \ [ ] : ; | = , + * ? < 
> or space. The account name for each MAS must be unique. Avoid using the word 
�craft� in the in the Technical Support account name or �cust� in the Customer account 
name. See the DCT online help for more specific rules for account names and 
passwords.

● Passwords: MAS passwords must be between 8 and 32 characters long. At least one 
of the first 7 characters should be a symbol or a punctuation mark. Do not use a pound 
sign (#) as the first character. Do not use a percent symbol (%) anywhere in the 
password. 

● Ensure that you are satisfied with Modular Messaging account names and passwords 
before you administer them. They are not easy to change later. 

● Do not use the examples shown in this guide as the actual MAS account names. They 
are provided for example purposes only. 

Note:
Note: For upgrades, you might have to change the existing account names and 

passwords to comply with the Release 3 rules. You cannot proceed with the 
upgrade unless you enter compliant account names and passwords into the DCT. 
The account names and passwords are the only fields you can change in a DCT 
file after analyzing an MAS.

Using the Data Collection Tool

You must enter MAS passwords and account names into the Avaya Modular Messaging Data 
Collection Tool (DCT) to do an installation or Avaya MAS upgrade. The DCT follows the rules 
describes in this section. The tool flags discouraged entries with a yellow highlight and marks 
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invalid entries with a red border. You must change invalid entries before you can configure the 
system.

For more information about creating or editing account names and passwords, see the help 
system for the Avaya Modular Messaging Data Collection Tool (DCT). This information is also 
available in a printed document Avaya Modular Messaging Data Collection Tool Help.

The DCT is contained in a single executable file named MMDCT.exe. Obtain an updated copy 
of the DCT from the Avaya Support Web site at http://www.avaya.com/support.

Note:
Note: You must enter the MAS passwords and account names into the Modular 

Messaging Data Collection Tool for a new installation or upgrade. The Data 
Collection Tool follows the rules described in this section. The tool flags 
discouraged entries with a yellow (caution) highlight, and marks invalid entries in 
red. You must change any invalid entries before you can configure the system. 

Table 18: Modular Messaging logon accounts form

# Account Logon name 
(customer specified)

Password Used for

A1 Local administrator 
account for
MAS#1 (required)

customer specified 
(for example, 
mas1-admin)

Local 
administration 
for this MAS

A2 Local administrator 
account for 
MAS #2 (if present)

customer specified 
(for example, 
mas2-admin)

Local 
administration 
for this MAS

A3 Local administrator 
account for 
MAS #3 (if present)

customer specified 
(for example, 
mas3-admin)

Local 
administration 
for this MAS

A4 Local administrator 
account for 
MAS #4 (if present)

customer specified 
(for example, 
mas4-admin)

Local 
administration 
for this MAS

A5 Local administrator 
account for 
MAS #5 (if present)

customer specified 
(for example, 
mas5-admin)

Local 
administration 
for this MAS

A6 Local administrator 
account for 
MAS #6 (if present)

customer specified 
(for example, 
mas6-admin)

Local 
administration 
for this MAS
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A7 Local administrator 
account for 
MAS #7 (if present)

customer specified 
(for example, 
mas7-admin)

Local 
administration 
for this MAS

A8 Local administrator 
account for 
MAS #8 (if present)

customer specified 
(for example, 
mas8-admin)

Local 
administration 
for this MAS

A9 Local administrator 
account for 
MAS #9 (if present)

customer specified 
(for example, 
mas9-admin)

Local 
administration 
for this MAS

A10 Local administrator 
account for 
MAS #10 (if present)

customer specified 
(for example, 
mas10-admin)

Local 
administration 
for this MAS

A11 Local administrator 
account for 
MAS #11 (if present)

customer specified 
(for example, 
mas11-admin)

Local 
administration 
for this MAS

A12 Customer account1 customer specified 
(for example, mmacct) 

Customer 
administration 
account

A13 Technical support 
account

customer specified 
(for example, 
techacct)

Maintenance 
remote access 
account 

1. The customer account was previously referred to as the service account. It is the account used to install and 
administer the Modular Messaging system.

Table 18: Modular Messaging logon accounts form

# Account Logon name 
(customer specified)

Password Used for
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MAS Services and Features Form
Working with the customer, fill out the following table to specify the Modular Messaging services 
and optional features to install on each MAS. 

Note:
Note: In a multiple-MAS system the following services must be enabled and running on 

only one MAS in the voice mail domain: MM Call Me Server, MM Mailbox 
Monitor Server, MM Message Waiting Indicator Server and MM Tracing 
Server.

Follow these guidelines: 

● If only one MAS is installed, put all required services on that computer. Check off the 
features to install in the MAS#1 column. 

● If more than one MAS is installed: 

- If both Call Me and Message Waiting Indicator (MWI) service are to be installed at this 
site, they must be on the same MAS. 

● Install these services on the MAS with the fewest ports if possible. 

● Install these services on the MAS with the second fewest ports if the Tracing Server is 
to be installed. The Tracing Server places the greatest demand on an MAS. 

● If this system uses a supplementary Tracing server, you can place the Call Me and 
MWI services on the supplementary server. 

- Always put the Tracing Server on the MAS with the fewest ports, or on its own computer.

Note:
Note: For the recommended distribution of Modular Messaging services based on the 

number of MASs, see the Avaya Modular Messaging Concepts and Planning 
Guide (PDF 2 MB). The planning guide is available on the documentation media 
and from the Avaya Support Web site at http://www.avaya.com/support.

The Modular Messaging configuration program automatically installs the Caller 
Applications Editor on each MAS.

Up to ten MASs can handle calls. An additional supplementary server can provide special 
services like Call Me, MWI, or Tracing Server service. Although the supplementary server is 
sometimes called an MAS, the server cannot handle calls. A supplementary server can use 
Avaya or customer-provided hardware.

For complete information about fields on this form, see the screen-specific help section of the 
DCT online help system or its printed version, Avaya Modular Messaging Data Collection Tool 
Help. 

http://www.avaya.com/support
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Table 19: MAS services and features form

Messaging service to install Max. # of 
sessions:1

MAS assigned to:

1 2 3 4 5 6 7 8 9 10 11

Message Waiting Indicator (MWI) Server 

Call Me Server

Both MWI and Call Me use the Mailbox 
Monitor Server. All three servers must be on 
the same MAS if any are installed. Activate 
these services on only one MAS per voice 
mail domain (VMD).

N/A N/A

N/A

Web Subscriber Options2 N/A

Tracing Server (Install only once per 
VMD.)

N/A

Text-to-Speech (If required, note 
languages to use. Specify up to 12 
sessions for each MAS.)

N/A

Messaging Application Server

Prompt Files
(One set is required for each MAS that will 
run the Messaging Application Server 
software. List the default file set first and 
any additional prompt file sets if needed.)

N/A N/A

Language Packs
(Specify additional languages to install if 
needed. List the desired default language 
first. Install the same set of languages on 
each MAS.)

N/A Default language:

List all languages to install:

1. Specify the maximum number of concurrent sessions for a feature based on expected usage. For guidelines, see the 
configuration notes and the Avaya Modular Messaging Concepts and Planning Guide.

2. The Web Subscriber Options application can reside on its own server or co-resident on an MAS. If Web Subscriber 
Options (WSO) is to be installed on an MAS, indicate which server. 
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Switch and Messaging Information Form
Collect the required information from the relevant administrator before installation. Always 
obtain the latest configuration notes for this particular switch (PBX) and integration. For more 
information, see Required documentation and software on page 1.  

Table 20: Switch and messaging information

Item Value Notes

Type of switch or PBX: 
Integration method: 
Example: Avaya Definity G3, T1 QSIG.

Configuration note used 
for this integration: 
Number:
Version: 
Date:

Record required switch integration information. Use the 
configuration note to determine required items, such as:

IP address for IP SIP, IP H.323, and CLAN integrations. 

Switch trunk, signal, or hunt groups and routing pattern.

IP address for SIP Enablement Services (SES) proxy 
server, required for IP SIP integrations 

If required for this integration, list the extension 
numbers for the ports on the MAS, and the switch ports 
to which they connect.

Note: For greater reliability, distribute the port board 
extensions over several switch boards if possible. 

You might need to obtain the required information from 
the telephone system vendor. 

Use format: 
cabinet carrier slot port 

Connects to extension 
number: 

Direct Inward Dialing (DID) numbers for: 
● MM hunt group for messaging services: 
● MAS modem dial-in number�one for each MAS
● MAS#2, if present
● MAS#3, if present, and so on for up to the 11 

MAS limit in the VMD

Note: Provide complete dial-in number for each item.
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Note:
Note: You can expand Table 21 to include additional mailboxes that must be set up at 

time of installation. For example, you might include mailbox, password, 
community ID, class of service (cos), and other required information for: 

● System broadcast mailbox

● Other features or restrictions required for this site, such as Caller Applications.

Numeric Address

Number of digits in dial plan: ______

Are port groups required? Use configuration notes. 
If yes, supply group name, use, and number of ports. 
Example: MWI outgoing only, 2 ports.

Port group 1 (Default): 

Number of ports: 

Port group 2: 

Number of ports: 

Table 20: Switch and messaging information

Item Value Notes

Table 21: Mailbox and subscriber information

Item Value

Telephone user interfaces required: MM Aria (y/n)___ MM AUDIX (y/n)___ MM Serenade (y/n)___ 

Test subscriber name for MM Aria: 
● Extension number to test telephone with DID
● Password�must be numeric 
● Class of service (cos) to use 

Test subscriber name for MM AUDIX: 
● Extension number to test telephone with DID
● Password�must be numeric 
● Class of service (cos) to use

Test subscriber name for MM Serenade: 
● Extension number to test telephone with DID
● Password�must be numeric 
● Class of service (cos) to use

Additional mailboxes, if needed: 

Broadcast Mailbox
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Support information 
Fill out the appropriate section, depending on how alarming will be implemented at this site: 
either through the Avaya Initialization and Administration System (INADS) or through the 
corporate Simple Network Management Protocol (SNMP) system. 

Note:
Note: If SNMP alarming is used, it is the responsibility of the customer to provide and 

provision the SNMP network management system, and to configure it to receive 
(and optionally acknowledge) the traps generated by the Modular Messaging 
system. 

General alarming information
Technical support information required for each installation includes:

● Alarming notification used at this site (INADS, SNMP, or none): _______

● Product ID number: _________________________________________

Note:
Note: Product IDs must be ten numeric digits (0 through 9) long. The Avaya Automatic 

Registration Tool (ART) generates product IDs for Avaya servers when you 
register the system. 

To enable remote support, record the RAS IP addresses for each MAS in the system. Complete 
Table 22 before an upgrade, or after you register a new system in ART. 

 
Table 22: RAS IP addresses for each MAS

Modular Messaging Server Starting IP address 1 Ending IP address

MAS#1 

MAS#2 

MAS#3 

MAS#4 

MAS#5 

MAS#6

MAS#7

MAS#8
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! CAUTION:
CAUTION: Each MAS has a unique product key for the Windows 2003 operating system. 

Enter the number exactly as shown. 

Note:
Note: On a new S3500-family server, the product key sticker is located inside the empty 

drive tray on the lower-left of the server chassis. You can remove the drive tray to 
easily read the sticker.

Complete Table 23 at the time of the installation or upgrade, using the labels on the servers: 
 

MAS#9

MAS#10

MAS#11
1. For systems that Avaya maintains, use the ART-assigned IP address for the Start value, 

such as 10.27.00.29. Add 1 to create the End value, such as 10.27.00.30. 

Table 23: Windows product keys for MASs

Server Windows Server Product key or MSS serial number

MAS#1 Windows product key 

MAS#2 Windows product key

MAS#3 Windows product key

MAS#4 Windows product key

MAS#5 Windows product key

MAS#6 Windows product key 

MAS#7 Windows product key

MAS#8 Windows product key

MAS#9 Windows product key

MAS#10 Windows product key

MAS#11 Windows product key

Table 22: RAS IP addresses for each MAS
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INADS alarming information
If INADS alarming is to be used at this site, supply the following information to allow the MAS 
modem to make outgoing calls: 

● Communications (COM) port that each modem is to use to make alarm notification calls. 
This is COM3 for the recommended USB port A on the MAS: _________________

● Complete alarm destination telephone number: _________________

Note:
Note: For a complete list of Avaya support numbers for all regions, see the Global Call 

Routing Guide at http://toolsa.sd.avaya.com/directories/index.php?mode=crg. 
For example, in North America, the INADS number is 1-800-535-3573. 

● Modem setup (initialization) string required for the modem to make the alarm notification 
calls. For details, see the documentation included with the modem: 
_______________________________________

SNMP alarming information
Supply the following information if SNMP alarming is to be used at this site: 

● Network Management Station IP address or fully qualified domain name for the corporate 
network management system (NMS) that will monitor the Modular Messaging system for 
alarm notifications (traps): 
_______________________________________________________

● Context (community) to which the NMS belongs. For details, see the SNMP NMS 
documentation: _____________________________

● Acknowledgement type: choose either Return Trap (to have traps actively acknowledged 
by the NMS) or Ping Surround (to have the MAS send a ping to the NMS before and after 
sending a trap. If the pings succeed, the NMS is assumed to have received the trap): 
_______________________________________________________ 

Note:
Note: If SNMP alarming is used, the customer is responsible for providing and 

provisioning the SNMP network management system. The customer must 
configure the SNMP system to receive and optionally acknowledge the traps that 
the Modular Messaging system generates. 

http://toolsa.sd.avaya.com/directories/index.php?mode=crg
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Customer environment
Answer the following questions about the customer environment.

Is this a single Windows domain environment?______________________________________

Which Microsoft Exchange version are you using?____________________________________

Is this a single Microsoft Exchange environment?____________________________________
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Appendix B: Installation and upgrade checklists

This appendix contains checklists to help guide you through the various installation and 
upgrade tasks. 

● Before starting a new Modular Messaging installation or upgrade, print the checklist 
relevant to the procedure that you must do. 

● Check off the steps as you complete them to ensure that you do not overlook any 
important tasks. 

Note:
Note: If you are adding a new MAS to an existing Modular Messaging system, complete 

the software upgrade first, if an upgrade is required. After the upgrade is 
complete, install the new MAS using the new installation checklist. 

Checklists include:

● New Modular Messaging installation on a customer-provided MAS on page 231

● New Modular Messaging installation on an Avaya MAS on page 237

● Modular Messaging upgrade on a Customer-provided server on page 243 

● Modular Messaging upgrade on an Avaya MAS on page 247

New Modular Messaging installation on a customer-provided MAS
Use this checklist to install a new Modular Messaging system on a customer-provided MAS. As 
you complete a task, make a check mark in the " �column.

Modular Messaging on a customer-provided MAS installation checklist 

Description Page Comments

Complete preinstallation planning:

Complete the planning forms in Appendix A. 
Requires customer input from LAN, messaging, 
switch, and system administrators. Also complete 
any other relevant planning forms for Message 
Networking or UCC SA. 

209 See the appropriate 
administrators. Planning 
forms are available from 
www.avaya.com/
support.

1 of 6

http://www.avaya.com/support
http://www.avaya.com/support
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If Avaya is to maintain this system, pre-register the 
system in ART. The registration process produces 
product IDs for the servers and IP addresses for 
remote access.

You can obtain all 
required information for 
each MAS in advance. 

Assemble and review the required documentation. 1 Web access required.

Download required Avaya software updates. This 
includes the latest version of the Data Collection 
Tool.

3 Web access required.

Obtain the DCT data file for this site, if available. 

Review security issues. 4

Obtain the Exchange System Management Tools 
2003 and Service Pack 2 from the customer.

Obtain virus-checking software for the MAS if 
required. 

4 Customer obtains. 

Arrange for LAN administration of the MAS system. 
Register MAS corporate FQDNs on the DNS if 
required.
Note: Avaya Inc. is not responsible for the 
installation, administration, or test of 
communications between customer PCs and the 
LAN. 

6 See LAN administrator.

Time of administration 
and site requirements 
vary. 

Verify that the PBX or switch is administered. 6 See switch 
administrator.

Arrange for the Active Directory data schema 
update. Schedule downtime for the directory 
server, and for the Exchange server if required.

N/A Review requirements in 
Chapters 4 and 5. 

Gather the necessary tools and test equipment. 5

Collect any software media that is needed for the 
installation, such as Microsoft Windows updates or 
anti-virus software. 

92 Leave customer CDs 
and DVDs on-site. 

Prepare to install the Modular Messaging software:
Note: The customer Active Directory administrator may be required to perform these tasks.

Set up the Modular Messaging customer account 
security group.

58 Do this on the directory 
server.

Modular Messaging on a customer-provided MAS installation checklist 

Description Page Comments

2 of 6
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Set up the required Modular Messaging customer 
account.

59 Do this on the directory 
server.

Setup the technical support account for remote 
access.

60 Do this on the directory 
server.

Set up test subscribers. Set up at least one for 
each TUI used on the site.

61 Do this on the directory 
server.

Assign permissions to the customer account 
security group. 

62 Procedure can vary. 

Add a computer account for each MAS to the 
Active Directory. 

65 Do this on directory 
server.

Set up each MAS to support remote access. 66 Do this on directory 
server.

Update the Active Directory and data schema if 
required for Windows 2000 or 2003 with Active 
Directory. 

68 Do this before installing 
other Modular 
Messaging software. 
System restart required. 

Update the Modular Messaging Active Directory 
Exchange extensions on any machine used to 
administer subscribers (and on Exchange server if 
required). 

74 Most extension updates 
require a system restart. 
You will have to wait to 
update the extensions 
on the MAS until the MM 
software is being 
installed.

Install any required hardware:

Install the Dialogic port boards, including:
● Prepare for the installation.
● Set jumpers and switches.
● Install the Dialogic software and drivers.

45 For details, see the 
Dialogic documentation.

IP H.323 or IP SIP 
switch integrations skip 
this step. 

Connect the MAS port boards to the switch or PBX. 53 Do as required. 

Install and configure the modem for each MAS. 54 Do as required. 

Set up the MAS for Modular Messaging: 
Note: The customer domain administrator may be required to perform these tasks.

Configure the network card on the MAS if needed. 94

Modular Messaging on a customer-provided MAS installation checklist 

Description Page Comments

3 of 6
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Run MAS disk checks (chkdsk and defragmenter 
tool).

94 Do as required. 

Join the MAS to the Microsoft Windows domain. 95

Adjust system values on the MAS for Modular 
Messaging. Adjust:

● Event Viewer values
● File and Printer Sharing properties
● Windows 2003 Server operating system 

values

96

Add the Modular Messaging customer and 
technical support accounts to the local 
administrators group for this MAS. 

97

Install Microsoft Windows SP1 if it is not already on 
the server.

99 Requires Microsoft 
Windows media. 

Install and enable required Microsoft Windows 
services.

99

Install and configure the Modular Messaging software:

Verify that the USB storage device with the DCT 
data file and DCT tool update is inserted in the USB 
port.

103

Copy the DCT file to a directory on the MAS. 102

Update the Data Collection Tool. 103

Install and launch the Modular Messaging 
Configuration wizard.

102

Select a DCT file, or create one, if necessary. 103

Install Exchange 2003 System Management Tools. 107

Install Exchange Server 2003 SP2. 107

Install MSDE. 107

Install Anti-virus software. 107

Complete the Modular Messaging software 
installation.

108

Modular Messaging on a customer-provided MAS installation checklist 

Description Page Comments

4 of 6
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Install updates to Modular Messaging software. 109

Set logging location if other than default. 110

Administer anti-virus software. 110

Configure port boards, if needed. 111

Disable unused Microsoft Windows services on this 
MAS. 

Optional. 

Set up remote access on each MAS. 112

If multiple languages are installed, specify 
preferred language. 

115 If required. 

Verify that Modular Messaging service is started. 115

Use the Voice Mail System Configuration program 
to:

● Configure TUI and access settings.
● Configure broadcast mailbox
● Configure the PBX type.
● Configure serviceability settings

116 Configuration notes 
required.

Obtain and install a license for this system. 120 Local procedures vary. 

Configure specific features as needed, including:
● Call Me service
● MWI service
● Languages or TTS
● Offline access to messages

122

Configure MAS-specific parameters:
● INADS alarming, if used
● Port boards
● Switch integration

125

Restart service. 128

Verify call handling. 131  

Verify the alarming setup on the MAS. 131

Verify tracing service operation. 132

Test and back up the system:

Modular Messaging on a customer-provided MAS installation checklist 

Description Page Comments

5 of 6
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Enable a test subscriber for each TUI used at this 
site.

136 Do this on the directory 
server. MM Aria is the 
default.

Set up monitoring tools � optional, including:
● Operational History Viewer
● Port Monitor

138

Perform acceptance tests, including:
● Create and receive test messages in both 

integrated and nonintegrated mode. 
● Test TUIs as required. 
● Test system outcalling using the MM client 

software. 
● Test additional features if required for this 

site. 

140

Verify creation of external caller objects including:
● Validate proxy addresses
● Validate mailbox rights

146

Install and configure each subsequent MAS. Repeat steps as 
needed.

Remove any test subscribers. 145 Do this on the directory 
server.

Back up the data on each MAS. 147 Use local procedures. 

Schedule routine disk maintenance for the MAS. 148 Use local procedures. 

Save the planning forms and DCT file in a safe 
place.

Modular Messaging on a customer-provided MAS installation checklist 

Description Page Comments

6 of 6
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New Modular Messaging installation on an Avaya MAS
This checklist applies to a new Modular Messaging installation using an Avaya Messaging 
Application Server (Avaya MAS). As you complete a procedure, make a check mark in the " " 
column. 

Modular Messaging on an Avaya MAS installation checklist 

Description Page Comments

Complete preinstallation planning:

Complete the planning forms in Appendix A. 
Requires customer input from LAN, messaging, 
switch, and system administrators. Also complete 
any other relevant planning forms for Message 
Networking or UCC SA. 

209 See the appropriate 
administrators. Planning 
forms are available from 
www.avaya.com/
support.

If Avaya is to maintain this system, pre-register the 
system in ART. The registration process produces 
product IDs for the servers and IP addresses for 
remote access.

You can obtain all 
required information for 
each MAS in advance. 

Assemble and review the required documentation. 1 Web access required.

Download required Avaya software updates. This 
includes the latest version of the Data Collection 
Tool.

3 Web access required.

Obtain the DCT data file for this site, if available.

Review security issues. 4

Obtain the Exchange System Management Tools 
2003 and Service Pack 2 from the customer.

Obtain virus-checking software for the MAS if 
required. 

4 Customer obtains. 

Arrange for LAN administration of the Avaya MAS 
system. 
Register MAS corporate FQDNs on the DNS if 
required.
Note: Avaya Inc. is not responsible for the 
installation, administration, or test of 
communications between customer PCs and the 
LAN. 

6 See LAN administrator.

Time of administration 
and site requirements 
vary. 

1 of 6

http://www.avaya.com/support
http://www.avaya.com/support
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Verify that the PBX or switch is administered. 6 See switch 
administrator.

Arrange for the Active Directory data schema 
update. Schedule downtime for the directory server 
and for the Exchange server if required.

N/A Review requirements in 
Chapters 4 and 5. 

Gather the necessary tools and test equipment. 5

Collect any software media that is needed for the 
installation, such as Microsoft Windows updates or 
anti-virus software. 

78 Leave customer CDs 
and DVDs on-site. 

Prepare to install the Modular Messaging software:
Note: The customer Active Directory administrator may be required to perform these tasks.

Set up the Modular Messaging customer account 
security group.

58

Set up the required Modular Messaging customer 
account.

58 Do this on the directory 
server.

Set up the technical support account for remote 
access.

60 Do this on the directory 
server.

Set up test subscribers. Set up at least one for each 
TUI used on the site.

61 Do this on the directory 
server.

Assign permissions to the customer account 
security group. 

62 Procedure can vary. 

Add a computer account for each MAS to the Active 
Directory. 

65 Do this on directory 
server.

Set up each MAS to support remote access. 66

Update the Active Directory and data schema if 
required for Windows 2000 or 2003 with Active 
Directory. 

68 Do this before installing 
other Modular 
Messaging software. 
System restart required. 

Update the Modular Messaging Active Directory 
Exchange extensions on any machine used to 
administer subscribers (and on Exchange server if 
required). 

74 Most extension updates 
require a system restart. 

Modular Messaging on an Avaya MAS installation checklist 

Description Page Comments

2 of 6
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Install the hardware:

Review preinstallation site requirements, including:
● Environmental requirements
● Weight and space requirements
● Customer-provided cabinet requirements
● Installation area requirements
● Power and grounding requirements
● Demarcation points 

10

Identify each S3500-family server in the system. Check and mark the 
label on each server. 

Unpack the Modular Messaging system hardware 
and peripheral components.

18 Open boxes as 
instructed to reuse 
packing materials.

Attach mounting brackets and handles to UPS and 
any EBM units as needed, and then cable the units 
together.

23 Optional. Do if UPS and 
any EBMs are present.

Attach the front bezel to each MAS. 27

Attach rails for rack-mount or rubber spacers for 
stackable configuration to each MAS.

28 Use appropriate method 
for this site. 

Connect the system power cables. 31

Connect the MAS port boards, if present, to the 
switch (PBX).

33 See Dialogic 
documentation. 

Connect each MAS to the corporate LAN. 34

Install the KVM switch, if used. Steps include:
● Attach mounting brackets to KVM switch (if 

needed).
● Connect KVM switch to the monitor, 

keyboard, and mouse.
● Connect the KVM switch to each MAS.

35 Optional. Procedure 
varies, depending on 
type of KVM switch 
purchased.

Set up the external modem for each MAS. 41

Set up the Avaya MAS:

Switch the monitor to show the correct MAS. 79

Modular Messaging on an Avaya MAS installation checklist 
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Verify that the USB storage device with the DCT 
data file and DCT tool update is inserted in the USB 
port.

80

Start up the system. 80

Install and configure the Modular Messaging software:

Copy the DCT file to the Avaya_Support directory. 81

Update the Data Collection Tool. 81

Run the Modular Messaging Configuration Wizard 
when it launches.

81

Select a previously-created DCT file, or create a 
new one.

81

Install Windows product key. 81

Install Exchange 2003 System Management Tools. 85

Install Exchange Server 2003 SP2. 85

Install MSDE. 85

Install Anti-virus software. 85

Complete the Modular Messaging software 
installation.

86

Administer anti-virus software. 87

Install Modular Messaging software updates. 88

Update Windows software, if needed. 88

Disable private LAN. 89

Configure port boards, if needed. 89

If multiple languages are installed, specify preferred 
language. 

115 If required. 

Verify that Modular Messaging service is started. 115

Modular Messaging on an Avaya MAS installation checklist 
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Use the Voice Mail System Configuration program 
to:

● Configure TUI and access settings.
● Configure broadcast mailbox
● Configure the PBX type.
● Configure serviceability settings

116 Configuration notes 
required.

Obtain and install a license for this system. 120 Local procedures vary. 

Configure specific features as needed, including:
● Call Me service
● MWI service
● Languages or TTS
● Offline access to messages

122

Configure MAS-specific parameters:
● INADS alarming, if used
● Port boards
● Switch integration

125

Restart service. 128

Verify call handling. 131  

Verify the alarming setup on the MAS. 131

Verify tracing service operation. 132

Test and back up the system:

Enable a test subscriber for each TUI used at this 
site.

136 Do this on the directory 
server. MM Aria is the 
default.

Set up monitoring tools � optional, including:
● Operational History Viewer
● Port Monitor

138

Modular Messaging on an Avaya MAS installation checklist 
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Perform acceptance tests, including:
● Create and receive test messages in both 

integrated and nonintegrated mode. 
● Test TUIs as required. 
● Test system outcalling using the MM client 

software. 
● Test additional features if required for this 

site. 

140

Verify creation of external caller objects including:
● Validate proxy addresses
● Validate mailbox rights

146

Install and configure each subsequent MAS. Repeat steps as 
needed.

Remove any test subscribers. 145 Do this on the directory 
server.

Back up the data on each MAS. 147 Use local procedures. 

Schedule routine disk maintenance for the MAS. 148 Use local procedures. 

Save the planning forms and DCT file in a safe 
place.

Modular Messaging on an Avaya MAS installation checklist 
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Modular Messaging upgrade on a Customer-provided server
Use this checklist when you upgrade a system with a customer-provided server that is running 
Modular Messaging Release 1.1 software to Modular Messaging Release 3. As you complete a 
procedure, make a check mark in the " " column. 

Note:
Note: If you are adding a new MAS to an existing Modular Messaging system, do the 

software upgrade first if an upgrade is required. When the upgrade is complete, 
install the new MAS using the appropriate new installation checklist. 

Modular Messaging CPE server upgrade checklist 

Description Page Comments

Plan for the upgrade:

Complete or update the planning forms in 
Appendix A. 
Requires customer input from LAN, messaging, 
switch, and system administrators. Also update 
any other relevant planning forms for Message 
Networking or UCC SA. 

209 See the appropriate 
administrators. 

Schedule downtime for the Exchange server if the 
Exchange extensions must be updated. 

72 If required.

Assemble and review the required documentation. 188 Web access required.

Download required Avaya software updates. This 
includes the latest version of the Data Collection 
Tool.

3 Web access required.

Collect any software media that is needed for the 
upgrade, such as Microsoft Windows updates or 
anti-virus software. 

188 Leave customer CDs and 
DVDs on-site.

Obtain the Exchange System Management Tools 
2003 and Service Pack 2 from the customer.

Verify key settings on the MAS, such as switch 
integration, port board settings, and domain 
information. 

● Record non-default port groups and their 
names

● Record RAS IP addresses for each MAS. 
● Back up Caller Applications files on a 

non-MAS PC. 

191 Use the planning forms. 

1 of 4
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Obtain and review the configuration notes for any 
changes. 

Web access required.

Prepare the system for the upgrade:

Run the Disk Defragmenter system tool and 
chkdsk command.

191

Unzip the Data Collection Tool (DCT) update file 
downloaded from the web. Use the DCT to 
analyze each MAS.

191 DCT file serves as a 
backup but is not required 
for the upgrade.

All MASs and Exchange 
message store must be 
running normally.

Back up important system files, including any 
customized tone files, customized prompt files and 
the DCT file. 

147 

Start the upgrade:

Busy-out and, if possible, reroute the ports for this 
MAS. 

194 Use PBX procedures.

Stop and reset all Modular Messaging services. 195

Upgrade the Windows operating system, if 
necessary.

195

Install and enable Windows software components, 
as needed:

● Application Server Console
● ASP.NET
● Enable COM+ access
● IIS 
● Common Files
● Internet Information Services Manager
● World Wide Web Server
● SNMP
● NNTP
● SMTP

196

Change the IIS mode. 198

Apply Windows Server 2003 Service Pack 1, if 
necessary.

198

Modular Messaging CPE server upgrade checklist 
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Install Microsoft Exchange 2003 System 
Management Tools.

198

Apply Microsoft Exchange 2003 Service Pack 2. 199

Verify that the anti-virus software on the MAS is 
current. 

199

Install the MSDE upgrade. 199

Update the Dialogic port board drivers. This 
includes:

● Uninstall Dialogic drivers.
● Reinstall Dialogic drivers
● Upgrade Dialogic drivers from .bat file

200

Upgrade Realspeak software. This includes:
● Uninstall Realspeak
● Reinstall Realspeak engine
● Reinstall Realspeak languages

201

Upgrade and configure the Modular Messaging software:

Disable anti-virus software on the MAS for 
Modular Messaging software installation. 

Optional but 
recommended. 

Run the Modular Messaging Installation Wizard to 
upgrade existing and install new Modular 
Messaging software components. 

202

Complete the Messaging Application Server 
Configuration Wizard to update the database. 

202

Install Modular Messaging software updates. 204

Enable the virus-checking software on the MAS. As required. 

Disable unused Microsoft Windows services on 
this MAS. 

Optional. 

Allow the first installed MAS to run for 15 minutes. For MAS#1 only. 

Upgrade each additional MAS. Repeat these steps as 
needed.

Configure new Release 3 features. 204

Complete the upgrade:

Modular Messaging CPE server upgrade checklist 
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Update the Modular Messaging Active Directory 
Exchange extensions on any machine used to 
administer subscribers (and on Exchange server if 
required). 

74 Most extension updates 
require a system restart. 

Update client software on all subscriber machines. 206 As required. 

If subscriber options is not being updated to new 
release, change the security setting.

207

Perform acceptance tests, including:
● Create and receive test messages in both 

integrated and nonintegrated mode. 
● Test each TUI used on this site. 
● Test system outcalling using the MM client 

software. 
● Test additional features if required for this 

site. 

140

Verify creation of external caller objects including:
● Validate proxy addresses
● Validate mailbox rights

146

Back up the data on each MAS. 147 Use local procedures. 

Run MAS disk checks (chkdsk and defragmenter 
tool).

As required. 

Add any new MASs to this system if required. Use the new system 
installation checklist. 

Save the planning forms and DCT file in a safe 
place.

Modular Messaging CPE server upgrade checklist 
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Modular Messaging upgrade on an Avaya MAS
Use this checklist when you upgrade a system with an Avaya MAS that is running Modular 
Messaging Release 1.1 software to Modular Messaging Release 3. As you complete a 
procedure, make a check mark in the " " column. 

Note:
Note: If you are adding a new MAS to an existing Modular Messaging system, do the 

software upgrade first if an upgrade is required. When the upgrade is complete, 
install the new MAS using the appropriate new installation checklist. 

Modular Messaging Avaya MAS upgrade checklist 

Description Page Comments

Plan for the upgrade:

Complete or update the planning forms in 
Appendix A. 
Requires customer input from LAN, messaging, 
switch, and system administrators. Also update 
any other relevant planning forms for Message 
Networking or UCC SA.

209 See the appropriate 
administrators. 

Schedule downtime for the Exchange server if the 
Exchange extensions must be updated. 

72 If required.

Download required Avaya software updates. This 
includes the latest Data Collection Tool.

3 Web access required.

Collect any software media that is needed for the 
upgrade, such as Microsoft Windows updates or 
anti-virus software. 

152 Leave customer CDs and 
DVDs on-site.

Obtain the Exchange System Management Tools 
2003 and Service Pack 2 from the customer.

Verify key settings on the MAS, such as switch 
integration, port board settings, and domain 
information. 

● Record RAS IP addresses for each MAS. 
● Back up Caller Applications files on a 

non-MAS PC. 

155 Use the planning forms. 

Assemble and review the required documentation. 152 Web access required.

Obtain and review the configuration notes for any 
changes. 

Web access required.

1 of 5
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Prepare the system for the upgrade:

Unzip the Data Collection Tool (DCT) update file 
downloaded from the web. Use the DCT to 
analyze each MAS.

156

Busy-out and, if possible, reroute the ports for this 
MAS. 

161 Use PBX procedures.

Back up important system files, including any 
customized tone files, customized prompt files and 
the DCT file. 

147 

If you have a pre-loaded replacement disk for this 
upgrade, replace the hard disk drive. If not, 
proceed to next step.

162

If you do not have a pre-loaded replacement disk, 
install a new Avaya boot image on the existing 
drive.

171

NOTE: If you are upgrading an S3400 server to an 
S3500 server, complete the hardware upgrade 
and then install as a new system with a modified 
DCT file.

182

Start the upgrade:

Install the Windows license. 172

Activate the Windows operating system. 172

Copy the DCT file to the MAS. 173

Update the Data Collection Tool on the MAS. 173

Run the Modular Messaging setup utility. 173

Upgrade and configure the Modular Messaging software:

Run the Modular Messaging Configuration Wizard 
when it launches.

174

Access the previously-created DCT file. 174

Install Exchange 2003 System Management 
Tools.

175

Install Exchange Server 2003 SP2. 175

Modular Messaging Avaya MAS upgrade checklist 
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Install MSDE. 175

Install anti-virus software. 175

Complete the Modular Messaging Configuration 
Wizard.

176

Complete the upgrade:

Administer anti-virus software. 178

Install Modular Messaging software updates. 179

Update Microsoft Windows. 180

Disable private LAN. 180

Configure port boards, if needed. 180

Resynchronize the FEDB. 181

Restore customer data. 181

Disable unused Microsoft Windows services on 
this MAS. 

Optional. 

If multiple languages are installed, specify 
preferred language. 

115 If required. 

Verify that Modular Messaging service is started. 115

Use the Voice Mail System Configuration program 
to:

● Configure TUI and access settings.
● Configure broadcast mailbox
● Configure the PBX type.
● Configure serviceability settings

116 Configuration notes 
required.

Obtain and install a license for this system. 120

Configure specific features as needed, including:
● Call Me service
● MWI service
● Languages or TTS
● Offline access to messages

122

Modular Messaging Avaya MAS upgrade checklist 
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Configure MAS-specific parameters:
● INADS alarming, if used
● Port boards
● Switch integration

125

Restart service. 128

Verify call handling. 131

Verify the alarming setup on the MAS. 131

Verify tracing service operation. 132

Allow 15 minutes for the upgrade information to be 
shared. 

For MAS#1 only. 

Upgrade each additional MAS. 177 Repeat these steps as 
needed.

Update the Modular Messaging Active Directory 
Exchange extensions on any machine used to 
administer subscribers (and on Exchange server if 
required). 

74 Most extension updates 
require a system restart. 

Implement additional TUIs, if necessary. 184

Update client software on all subscriber machines. 181 As required. 

If subscriber options is not being updated to new 
release, change the security setting.

185

Perform acceptance tests, including:
● Create and receive test messages in both 

integrated and nonintegrated mode. 
● Test TUIs as required for this site. 
● Test system outcalling using the MM client 

software. 
● Test additional features if required for this 

site. 

140

Verify creation of external caller objects including:
Validate proxy addresses
Validate mailbox rights

146

Back up the data on each MAS. 147 Use local procedures. 

Run MAS disk checks (chkdsk and defragmenter 
tool).

As required. 

Modular Messaging Avaya MAS upgrade checklist 
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Add any new MASs to this system if required. Use the new system 
installation checklist. 

Save the planning forms and DCT file in a safe 
place.

Modular Messaging Avaya MAS upgrade checklist 

Description Page Comments
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Appendix C: Creating a new tone file

This appendix describes how to build a tone file for Dialogic analog port boards by using the 
PBXpert utility to learn PBX tones. 

Do this procedure after the port boards are administered on the switch, but before you configure 
them using the Intel Dialogic product Configuration Manager. For more information, see 
Configuring analog port boards on page 271. 

! CAUTION:
CAUTION: Use the configuration notes for this particular PBX or switch integration to 

administer the port boards. For instructions on obtaining the configuration notes, 
see Required documentation and software on page 1. The port boards must be 
administered on the switch before you can proceed. 

PBXpert learns the call progress tones for this PBX and store them in a Tone Set File (TSF). 
Many tone sets can be stored in a single TSF file. 

You can use the PBXpert utility either automatically or manually: 

● Automatic Learning: PBXpert uses two different channels on the Dialogic port board to set 
up tones and learn the resulting call progress tones automatically. To use this procedure, 
see Learning tones automatically on page 254.

● Manual Learning: PBXpert uses one channel on the Dialogic port board and a telephone to 
set up tones and learn the resulting call progress tones manually. PBXpert prompts you 
how and when to use the telephone. To use this procedure, see Learning tones 
manually on page 259. 

Note:
Note: If only one line is connected to the Dialogic port board, you must use Manual 

Learning.
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Learning tones automatically
This section describes:

● Running the PBXpert wizard on page 254 

● Consolidating and saving the TSF file on page 258

● Using the new TSF in Dialogic Configuration Manager on page 258

Running the PBXpert wizard
The PBXpert wizard guides you through learning the tones used by this PBX and saving the 
information as a TSF file. PBXpert can learn the following tones: 

● Dial tone

● Ringback

● Busy

● Reorder (fast busy)

● Disconnect

To run the PBXpert wizard: 

1. Start the Dialogic port boards: 

a. The Intel Dialogic product Configuration Manager window must be open. 

To open the DCM application, click Start > Programs > Intel Dialogic System Release 
> Configuration Manager - DCM. 

b. Click the green Start button on the button bar. 

When service is started, the Stop button becomes active and the installed boards show a 
green light. 

2. Click Start > Programs > Intel Dialogic System Release > PBX Expert.
The PBXpert main window opens. Most fields are blank until tones are learned. For an 
example, see Figure 26. 

● If you are using PBXpert for the first time after installation, the PBXpert wizard starts 
automatically.

● If the PBXpert wizard does not start automatically, click Tones > Tone Wizard. 
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Note:
Note: You can change the default settings in the wizard if you are familiar with this PBX 

environment and the Dialogic API. The program saves any settings that you 
change when you exit PBXpert. For help on a particular screen, click the Help 
button in the wizard.

After the PBXpert Wizard window opens, complete the screens as follows: 

1. On the Welcome screen, click Next. 
2. On the PBX Information screen:

● Under PBX, enter the name of the Manufacturer, such as Mitel. 

● Enter the Model of the PBX, such as SX-2000.

● You can use the automatically created Tone Set File name shown on the screen, or alter 
the file name as desired.

● Click Next.
3. On the Select a Board screen:

● Select the port board to use.

● Click Next.
4. On the Select the Calling Resource screen, for the Line A (Calling Channel): 

● For Select the Channel, enter the port number or channel to use.

Figure 26: PBXpert main window
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● For Phone Number, enter the extension number of this port. For port board extensions, 
see Switch and messaging information on page 225.

● Click Next.
5. On the Select the Called Resource screen, for the Line B (Called Channel): 

● For Select the Channel, enter a port number or channel that is different from Line A.

● For Phone Number, enter the extension number of this port. 

● Click Next.
6. On the Settings Confirmation screen:

● Verify the settings. Click Back if you need to change anything.

● Verify that the Run Wizard Auto-Test box is checked.

● Click Next.
7. The Auto Line Test window opens while PBXpert verifies the connection between the two 

specified channels. 

● If you see a Test finished successfully! message, click OK. Close this window and 
proceed.

● If the line test fails: 

a. Click OK. Close this window. 

b. Click Back on the wizard, adjust the settings, and try the test again.

8. On the Learning Tones screen, click Next to start learning tones automatically.

The Learn Tones window opens. For an example, see Figure 27. 

Note:
Note: You can click Cancel at any time during the test to stop automated learning.
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9. When PBXpert completes learning, choose to keep or discard the data.

● If the tones were learned without errors, select Keep Data. The Learn Tones window 
closes and you can proceed.

● If errors occurred, select Discard Data. The window closes. 

- Click Back on the wizard, adjust the settings, and try to learn the tones again. 

- You cannot test or save the tone file if it contains errors. 

10. On the Verifying the Learn screen, click Next to test the learned tones.

● If the test succeeds, click OK to close the test window and proceed.

● If the test fails, click OK to close this window. Click Back on the wizard, adjust the 
settings, and try the test again. 

11. The Summary of Results screen shows the final wizard status and tone definitions. Click 
Finish.

The PBXpert main window displays the tone definitions. 

Figure 27: Learn Tones window�learning in progress



Creating a new tone file

258 Avaya Modular Messaging for Microsoft Exchange Release 3 Installation and Upgrades

 

Consolidating and saving the TSF file
You must consolidate and save the new TSF file so you can use it with the Dialogic voice driver. 
To do this:

1. Click Tones > Consolidate.

2. After consolidation is complete, click File > Save to save the new TSF file.

a. In the Save As window, navigate to the following directory to ensure that the file is 
backed up: C:\Avaya_Support\Tone_Files 

Note:
Note: If you use the default DATA directory, the system will not back up the customized 

tone file automatically. 

b. Specify a file name with file type of TSF, such as Mitel-SX-2000.tsf.

Using the new TSF in Dialogic Configuration Manager
To use the new TSF that you just created: 

1. Return to the Intel Dialogic product Configuration Manager window. 

2. Click the red Stop button on the button bar.

3. Return to Step 4 in Configuring analog port boards on page 271 and complete board 
configuration and testing.
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Learning tones manually
This section describes:

● Running PBXpert on page 259 

● Adding a new tone set on page 260 

● Learning tone definitions on page 260 

● Testing the tone set on page 262

● Consolidating and saving the TSF file on page 262 

● Using the new TSF in Dialogic Configuration Manager on page 262 

Running PBXpert
To run PBXpert manually: 

1. Start the Dialogic port boards. 

a. The Intel Dialogic product Configuration Manager window must be open. 

To open the DCM application, click Start > Programs > Intel Dialogic System Release 
> Configuration Manager - DCM. 

b. Click the green Start button on the button bar. 

When service is started, the Stop button becomes active and the installed boards show a 
green light. 

2. Click Start > Programs > Intel Dialogic System Release > PBX Expert.
The PBXpert main window opens. Most fields are blank until tones are learned. For an 
example, see Figure 26: PBXpert main window on page 255. 

3. If you are using PBXpert for the first time after installation, the PBXpert wizard starts 
automatically. If the PBXpert Wizard starts, click the Don�t run wizard at startup checkbox 
and click the Cancel button.

A new, empty TSF is now active.

4. In the PBXpert main window, click Settings on the button bar.

5. In the Settings window, on the Dialing tab:

a. Under Line A, enter the Board Number, such as 1.

b. Enter the Channel Number or Port number.
c. Verify that the Manual mode checkbox is checked. 
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d. For Phone Number, enter the extension for this port or channel. For port board 
extensions, see Switch and messaging information on page 225. 

You can use the default values for all the other fields in this window. Click Help for more 
information if needed.

e. Repeat Steps a through d for Line B. 

Note:
Note: If you are familiar with this PBX environment and the Dialogic API, you can 

change these default settings. The program saves any settings that you change 
when you exit PBXpert.

f. Click OK.

Adding a new tone set
To add a new tone set to a TSF:

1. From the PBXpert main window, click Edit > New Tone Set.
2. In the New Toneset window:

a. Enter the PBX Manufacturer, such as Mitel, and the Model name, such as SX-2000.

b. Click OK.

The PBXpert main window shows the manufacturer and model names you entered. The 
tone definitions are set to zero.

Learning tone definitions
To add tone definitions to the new tone set:

1. From the PBXpert main window, click Tones > Learn.

2. On the Start Learn window:

a. Select the tones for the Dialogic boards to learn. The default is all tones. 

b. Click Start Learn to have PBXpert start learning tones.

The Learn Tones window opens. For an example, see Figure 28. 

Note:
Note: Click Cancel at any time to stop learning.
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3. The system prompts you to listen for ringing, and to pick up or replace the telephone 
handset, during the test. When a message box pops up, do the requested action, and then 
click OK. 

4. When the learning process is complete, the system displays the tone definitions in the 
Learn Tones window. Choose to keep or discard the data:

● If the tones were learned without errors, select Keep Data. The Learn Tones window 
closes and you can proceed.

● If errors occurred, select Discard Data. The window closes. 

- Click Back on the wizard, adjust the settings, and try to learn the tones again. 

- You cannot test or save the tone file if it contains errors. 

The Learn Tone window closes. The PBXpert main window displays the new tone 
definitions.

Figure 28: Learn Tones window�learning complete
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Testing the tone set
The Test function verifies that the consolidated tone set in the active TSF works correctly with 
Perfect Call, a call progress analysis utility. 

To test the newly learned tones:

1. In the main PBXpert window, click Tones > Test.
2. A Test window opens. 

When testing is complete, the Test window displays the test results. 

3. Verify that the tone definitions of the learned tones are correct.

Consolidating and saving the TSF file
You must consolidate and save the new TSF file so you can use it with the Dialogic voice driver. 
To do this:

1. Click Tones > Consolidate.

2. Click File > Save to save the new TSF file.

a. In the Save As window, navigate to the following directory to ensure that the file is 
backed up: C:\Avaya_Support\Tone_Files 

Note:
Note: If you use the default DATA directory, the system will not back up the customized 

tone file automatically. 

b. Specify a file name with file type of TSF, such as Mitel-SX-2000.tsf.

Using the new TSF in Dialogic Configuration Manager
To use the new TSF that you just created: 

1. Return to the Intel Dialogic product Configuration Manager window. 

2. Click the red Stop button on the button bar.

3. Return to Step 4 in Configuring analog port boards on page 271 and complete board 
configuration and testing.
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Appendix D: Configuring and testing port boards

Overview
This appendix describes how to configure and test Dialogic port boards. Dialogic port boards 
are installed in some MASs, depending on the switch integration. 

Note:
Note: An MAS that uses an IP H.323 or IP SIP switch integration has no port boards. 

You do all configuration for these switch integrations using the Voice Mail System 
Configuration (VMSC) program. For more information, see Configuring port 
boards and switch integration on page 126. 

When to configure port boards 
In Release 3, you must configure Dialogic port boards only if: 

● Dialogic port boards are installed in this MAS and

● The Avaya Modular Messaging Configuration Wizard does not automatically configure the 
Dialogic port boards. 

The Avaya Modular Messaging Configuration Wizard automatically configures any installed 
Dialogic port boards for several switch integrations, including: 

● Avaya CM (IP SIP) 

● Avaya (IP H323)

● Avaya (QSIG)

● Cisco (QSIG)

● Nortel NT M-1 (QSIG)

● Siemens Hipath (QSIG)

To verify if a particular switch integration supports automatic configuration of the Dialogic port 
boards, open the Avaya Modular Messaging Data Collection Tool (DCT). 

1. On the MAS, navigate to the directory 
C:\Program Files\Avaya Modular Messaging\Install\MISCM 

2. Double-click the file MMDCT.exe to open the Avaya Modular Messaging Data Collection 
Tool window. 

3. Click the Switch integration screen to see the list of supported switch integrations. 

4. Cancel out of the DCT program, and close all open windows. 
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Supported port boards 
The number and type of supported port boards varies, depending on the hardware used and the 
release during which the port boards were installed. 

● Systems with Avaya MASs that were upgraded from an earlier release might use either 
customer-provided or S3400-family server hardware. Upgraded MASs can have a varying 
number of port boards installed. The number of port boards depends on the original 
software release when the boards were installed, and the number of TUIs in use. Table 24 
lists supported Dialogic port boards for CPE and S3400-family message servers. 

.
Table 24: Supported MAS port boards�S3400-family and CPE server upgrades

Protocol Ports per MAS Supported port boards Maximum 
number

Dialogic files on 
documentation media

Analog 12 - 48 (Aria)
12 - 24 (other) 1

4 - 16 or
4 - 20 (any TUI) 2

Dialogic D/120JCT-LS 12-port 
board

Dialogic D/41JCT-LS 4-port 
board

4
or 2

4
or 5 2

D/120JCT-LS (PDF)

D/41JCT-LS (PDF)

Digital Set 
Emulation

8 - 32 (Aria) 
8 - 24 (other) 1

8 - 32 or 
8 - 40 (Aria) 2 

Dialogic 
D/82JCT-U-PCI-UNIV

or 
Dialogic D/82JCT-U 

4
or 3

4
or 5 2

D/82JCT-U PCI Univ (PDF)

D/82JCT-U (PDF) 
Supported for upgrades only. 
CPE servers support up to 6. 3

E1-QSIG 30 (any TUI) 4 Dialogic D/600JCT-1E1 5

Dialogic D/300JCT-E1 

1 D/600JCT-1E1 (PDF)

D/300JCT-E1 (PDF) Supported 
for CPE upgrades only.

T1-QSIG 46 (Aria)
23 (other) 4

Dialogic D/480JCT-1T1 5 

Dialogic D/240JCT-T1

2
or 1

D/480JCT-1T1 (PDF)

D/240JCT-T1 (PDF) Supported 
for CPE upgrades only.

1. The number of ports supported per MAS varies depending on the telephone user interface (TUI). 
Systems that use only the MM Aria TUI support more ports. Systems that use the MM AUDIX TUI, 
MM Serenade TUI, or any combination of TUIs support fewer ports per MAS. 

2. The maximum number of 4-port analog boards and DSE boards varies. All Release 2 or later systems 
support up to four (4) port boards per MAS, if S3400-family hardware is used. For Release 1 upgrades 
only, each MAS can have up to five (5) port boards, if five boards were installed before the upgrade. 

3. A CPE server can support up to six (6) DSE boards for 48 ports, if the server has sufficient PCI slots.

4. The S3500-family server supports two (2) QSIG port boards per MAS. If the server you are upgrading 
has S3400-family server specifications, you must upgrade from the S3400-family server or equivalent 
CPE server to an S3500-family server or equivalent CPE server to get greater QSIG port capacity. 

5. Early D/600JCT-1E1 and D/480JCT-1T1 QSIG port boards have a plug in the unused connector on the 
faceplate. Dialogic D/600JCT-1E1 or D/480JCT-1T1 QSIG port boards that ship after mid-2005 have only 
a single connector. Both types of QSIG boards operate identically. 
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● New Release 3 systems can use the following hardware: 

- New Avaya-provided MASs always use S3500-family server hardware. All S3500-family 
MASs support a maximum of two port boards each. For more information, see 
Table 7: Supported MAS port boards�S3500-family servers on page 20. 

- New Release 3 systems that use a customer-provided server might support a larger 
number of port boards per MAS. The number depends on the board type and the number 
of PCI slots available in the CPE server. For more information about CPE servers, see 
Table 8: Supported MAS port boards for customer-provided servers on page 44. 

The Dialogic documents provide details about installing and connecting the port boards. The 
documents are available on the Avaya Modular Messaging Documentation media or from the 
Avaya Support Web site at http://www.avaya.com/support. For instructions on obtaining Avaya 
documents, see Required documentation and software on page 1. For the latest version of the 
Dialogic guides, see the Quick Install Cards Search Tool on the Intel Telecom Boards Web site. 

Note:
Note: Avaya does not support Brooktrout port boards for Modular Messaging systems 

that run Release 3 software. All servers must use Dialogic port boards. 

Configuring port boards
Manual port board configuration involves three phases: 

1. The appropriate party must administer the switch for the port boards using the configuration 
notes for this particular switch (PBX) integration. For instructions on obtaining the most 
recent configuration notes, see Obtaining information on the Web on page 1.

! CAUTION:
CAUTION: You can only install this system by using the required configuration notes for this 

switch or PBX. The PBX administrator must have administered the ports on the 
switch before you can proceed.

2. Configure and test the port boards as described in this section. Some steps require you to 
use the configuration notes.

3. You must complete the port board configuration as described in Chapter 8: Configuring the 
voice mail system on page 113. 

Continue based on the type of port boards installed in this MAS:

● Configuring T1-QSIG or E1-QSIG boards on page 266

● Configuring set emulation boards on page 269

● Configuring analog port boards on page 271

http://www.avaya.com/support
http://membersresource.intel.com/qic/search.asp
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! CAUTION:
CAUTION: If the window displays no port boards when you run the Dialogic Configuration 

Manager, you might need to reseat or replace some of the boards. For more 
information, see the appropriate maintenance information for this Modular 
Messaging system on the documentation media: 

● For S3500-family servers, see Avaya Modular Messaging S3500-Family Hardware 
Maintenance and Additions (PDF) 

● For S3400-family servers, see �Circuit card replacement" in the Maintenance section 
on the Avaya Modular Messaging Documentation media 

Configuring T1-QSIG or E1-QSIG boards 
Either of the following QSIG port boards might be installed in an MAS:

● Dialogic D/480JCT-1T1 board 

● Dialogic D/600JCT-1E1 board 

Note:
Note: Avaya supports the D/240JCT-T1 and D/300JCT-E1 QSIG boards only for CPE 

upgrades from Release 1. Avaya-provided servers do not support these boards

The maximum number of port boards per MAS varies, depending on the server hardware. For 
more information, see Supported port boards on page 264. 

To configure QSIG boards:

1. Click Start > Programs > Intel Dialogic System Release > Configuration Manager - 
DCM.

The Intel Dialogic product Configuration Manager window opens. 

2. If a popup window opens, connect to the MAS as follows: 

a. In the Computer Name window, verify that Local is selected and that the correct server 
name is shown, such as MYMAS1.

b. Click Connect. 

Note:
Note: The system displays this window only the first time that you access the Dialogic 

Configuration Manager application. 

The Dialogic software locates any installed port boards. 

3. Verify that all Dialogic services are stopped. All boards should show a red icon. 

Note:
Note: If the board icon shows an X, the board is disabled. To enable it, right-click the 

board and select Enable device(s). 
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4. Under Configured Devices, double-click the name of the first Dialogic board, such as #0. 

5. In the Intel Dialogic product Configuration Manager - Properties window: 

a. Click the Interface tab and select the ISDNProtocol parameter.

b. Select the correct value for this board from the pull-down list:

● For E1-QSIG: select QTE
● For T1-QSIG: select QTU

c. Click the Telephony Bus tab and select the PCMEncoding parameter.

d. Select the correct value for the installed board from the pull-down list:

● For E1-QSIG: select A-Law for most countries, particularly Europe

● For T1-QSIG: select µ-Law (mu-Law) for the United States and Japan

e. Click the Misc tab. For the FirmwareFile parameter, verify that the value is default.
f. Click the Country tab and select the Country parameter.

g. On the pull-down list of values, always use United States for either type of board. 

h. Click OK to close the properties window.

6. Repeat Steps 4 and 5 for any other installed Dialogic boards, such as #1.
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7. After all boards are configured, click the green Start button on the button bar.

Wait for service to start. When service is started, the Stop button becomes active and the 
installed boards show a green light. For an example, see Figure 29.

8. Verify that the port boards are operating correctly. 

a. Check the LED display on the Dialogic board faceplate. 

● A red status LED lights on the back of the port board during driver startup.

● If the drivers start successfully, the board whose port is connected to the PBX shows a 
green LED within 30 seconds. LEDs on the other boards remain red.

b. If a problem occurs, check the board configuration, the physical connections between the 
board and the PBX, or the PBX configuration. Repeat Steps 4 through 8 as needed. 

9. Close the Intel Dialogic product Configuration Manager window.

10. Continue with Testing the port boards on page 274. 

Figure 29: Sample Dialogic Configuration Manager window�QSIG boards
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Configuring set emulation boards 
An MAS supports 8-port Dialogic Digital Set Emulation (DSE) boards. The maximum number of 
port boards per MAS varies, depending on the server hardware. For more information, see 
Supported port boards on page 264. 

Note:
Note: Avaya supports the non-universal D/82JCT-U board for upgrades only. 

To configure digital set emulation boards: 

1. Click Start > Programs > Intel Dialogic System Release > Configuration Manager - 
DCM.

The Intel Dialogic product Configuration Manager window opens. 

2. If a popup window opens, connect to the MAS as follows: 

a. In the Computer Name window, verify that Local is selected and that the correct server 
name is shown, such as MYMAS1.

b. Click Connect. 

Note:
Note: The system displays this window only the first time that you access the Dialogic 

Configuration Manager application. 

The Dialogic software locates any installed port boards. 

3. Verify that all Dialogic services are stopped. All boards should show a red icon. 

Note:
Note: If the board icon shows an X, the board is disabled. To enable it, right-click the 

board and select Enable device(s). 
4. Under Configured Devices, double-click the name of the first Dialogic board, such as #0. 

5. In the Intel Dialogic product Configuration Manager - Properties window: 

a. Click the Telephony Bus tab and select the PCMEncoding parameter. On the pull-down 
list of values, select either A-Law or µ-Law, depending on your location. Usually, A-Law 
is Europe and µ-Law (mu-Law) is United States and Japan.

b. Click the Misc tab and select the PBXSwitch parameter. On the pull-down list of values, 
select the name of the PBX. For example, use Lucent 2-wire for an Avaya G3 switch.

c. Click the Country tab and select the Country parameter. On the pull-down list of values, 
select the country.

d. Click OK to close the Intel Dialogic product Configuration Manager Properties window.

6. Repeat Steps 4 and 5 for any other installed Dialogic boards, such as #1.
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! CAUTION:
CAUTION: If the DSE boards are connected to a Nortel (NTM-1) PBX, you must reboot the 

MAS before you start the Dialogic drivers. Close the DCM and reboot the system 
now. When the reboot is complete, log back in and reopen the DCM as in Step 1, 
and then continue with Step 7.

7. After all boards are configured, click the green Start button on the button bar.

Wait for service to start. When service is started, the Stop button becomes active and the 
installed boards show a green light. For an example, see Figure 30. 

8. Verify that the port boards are operating correctly. 

a. Check the LED display on the Dialogic board faceplate. Verify the code for each port:

● Ports that are connected to a telephone line and functioning correctly show 0 and the 
port number, such as 00 or 01. 

● Ports that are not connected to a telephone line or not functioning correctly show En, 
where n is the port number. For example, the display reads E3 if port 3 has an error.

b. If any En error codes are present, check the board configuration, the physical 
connections between the board and the PBX, or the PBX configuration. For example, 
verify that you configured the correct PBX. Repeat Steps 4 through 8 as needed.

9. Close the Intel Dialogic product Configuration Manager window.

10. Continue with Testing the port boards on page 274.

Figure 30: Sample Dialogic Configuration Manager window�DSE boards
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Configuring analog port boards 
The following analog port boards might be installed in an MAS: 

● Dialogic D/41JCT-LS 4-port Tip/Ring board

● Dialogic D/120JCT-LS 12-port Tip/Ring board

The maximum number of port boards per MAS varies, depending on the server hardware. For 
more information, see Supported port boards on page 264. 

To configure either of these analog boards:

1. Click Start > Programs > Intel Dialogic System Release > Configuration Manager - 
DCM.

The Intel Dialogic product Configuration Manager window opens. 

2. If a popup window opens, connect to the MAS as follows: 

a. In the Computer Name window, verify that Local is selected and that the correct server 
name is shown, such as MYMAS1.

b. Click Connect. 

Note:
Note: The system displays this window only the first time that you access the Dialogic 

Configuration Manager application. 

The Dialogic software locates any installed port boards. 

3. Verify that all Dialogic services are stopped. All boards should show a red icon. 

Note:
Note: If the board icon shows an X, the board is disabled. To enable it, right-click the 

board and select Enable device(s). 
4. Under Configured Devices, double-click the name of the first Dialogic board, such as #0. 

! CAUTION:
CAUTION: If you cannot find a suitable TSF file for this PBX, you must build an appropriate 

tone file now or the integration will not work. Click Cancel in this window, and see 
Appendix C: Creating a new tone file on page 253. 

5. In the Intel Dialogic product Configuration Manager - Properties window: 

a. Click the Files tab.

b. Select the TSFFileName parameter, if it is not already selected. 

Note:
Note: For a D/41JCT-LS board, you must highlight the Configured Devices parameter 

on the DCM display when you select Configure Device. You can then view the 
TSFFileName parameter.
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c. Locate the prerecorded TSF file for this PBX or switch:

1. Click the ... button to browse. In the Look in field, navigate to the 
C:\Avaya_Support\Tone_Files directory. 

2. In the Search File window, select a TSF file that is appropriate for the PBX to which 
you are connecting, such as Avaya-G3-US.tsf. Double-click the file name. 

The system displays the appropriate TSF file in the Value field.

Note:
Note: You can type in the Value field. This field is editable.

6. After an appropriate TSF file is selected, click the Misc tab. 

a. Click the TSFFileSupport parameter. 

! CAUTION:
CAUTION: You must have selected an appropriate TSF file for this PBX before you set the 

TSFFileSupport value to Yes, or errors might occur.

b. From the Value drop-down list, select Yes. 

c. Click the DisconnectTone parameter. From the Value drop-down list, select Yes.

d. Click OK to close the properties window.

7. Repeat Steps 4 through 6 for any other installed Dialogic boards, such as #1. Verify that the 
settings are correct, and set any values if needed. 

8. After all boards are configured, click the green Start button on the button bar.

Wait for service to start. When service is started, the Stop button becomes active and the 
installed boards show a green light. For an example, see Figure 31: Sample Dialogic 
Configuration Manager window�Analog boards on page 273. 

9. Close the Intel Dialogic product Configuration Manager window.

10. Continue with Testing the port boards on page 274. 
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Figure 31: Sample Dialogic Configuration Manager window�Analog boards
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Testing the port boards 
Test all port boards and channels to verify that they can send and receive calls. 

Note:
Note: Sometimes after you apply settings to a port board, the board comes up in a bad 

state. The Dialogic drivers consistently fail to start, and the Event Viewer shows 
dlgc_log errors. If this problem occurs, take the power off the boards. Turn off 
the server, and then turn on the server again. The power cycle corrects the port 
board problems. 

Preparing for the test
Prepare for port board testing as follows: 

1. Stop Modular Messaging voice service:

a. Access the window to monitor services using one of these methods:

● Double-click the Monitor icon on the desktop, if present. In the left pane, click 
Services, if the item is not already selected. 

● Right-click My Computer and select Manage. In the Computer Management window, 
in the left (Tree) pane, expand Services and Applications, and then click Services.

b. In the right pane, scroll down to MM Messaging Application Server.
c. Right-click MM Messaging Application Server and select Stop.

2. For software-only upgrades, the Dialogic Line Tester program is not yet installed. Access 
the test program on the application media as follows: 

a. Insert Disk 1 of the Avaya Modular Messaging Messaging Application Server Software 
media into the MAS drive. 

b. Close the drive door and wait for the green LED to go out. Click OK. 

c. In Windows Explorer, navigate to the MAS drive, such as D:.

d. Navigate to the Install directory, and then to the DLTest subdirectory. 

e. Double-click the file DLTest.exe.

The Dialogic Line Test Application window opens. 

3. For T1-QSIG or E1-QSIG boards, set up the test options as follows: 

a. Click Start > Programs > Avaya Modular Messaging > Dialogic Line Tester. 
b. In the Dialogic Line Test Application window, click Tools > Options. 



Testing the port boards

Issue 1 April 2006 275

 

c. In the Options window, select the correct values for each field. Use the configuration 
notes to identify the correct values: 

● For Layer 1 Protocol, select the required ISDN protocol from the drop-down list.

● For Number Type, select the destination number type.

● For Number Plan, select the destination number plan. 

Note:
Note: The values you select here must be the same as those entered on the PBX or 

switch. Check the configuration notes.

d. After you select the correct values, click OK. 

Testing the ports
To test Dialogic port board functionality: 

1. Access the Dialogic Line Test application using one of these methods: 

● Click Start > Programs > Avaya Modular Messaging > Dialogic Line Tester. 
● For software-only upgrades, access the Dialogic Line Tester program from the 

applications media. For this procedure, see Step 2 in Preparing for the test on page 274. 

The Dialogic QSIG - Line Test Application (or DLTest) window opens. The name of the 
window varies, depending on the type of port boards installed. 
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2. Verify that all port numbers and channel designations are listed. For an example, see 
Figure 32. 

3. Test the incoming call connectivity of all ports as follows:

a. From a handset on the same PBX, dial each port individually.

● For QSIG boards, repeatedly dial the number for that group of ports. The switch 
connects to the next port in the list for each new call.

● For analog and set emulation boards, use the individual port extensions from Switch 
and messaging information on page 225.

b. Check the Status column. 

● Verify that each port shows Received call followed by Connected. 

● For different status conditions, see Table 25: Status messages for Dialogic Line 
Test on page 277.

The system should answer each connected call with a standard welcome message. 

Figure 32: Sample Dialogic QSIG - Line Test Application window
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4. Test the outcalling capability of all ports. For a sample configuration, see Figure 32: Sample 
Dialogic QSIG - Line Test Application window on page 276: 

a. Select a port in the Dialogic Line Test Application window under Port Number. 
b. Type the number of an extension on this PBX in the Dial Number field.

c. Click Dial Number.
d. When the dialed extension rings, answer the call and hang up.

e. Select the next port number, and click Dial Number again. 

f. Repeat Steps d and e until all ports are tested.

5. After testing is complete, close the Dialogic Line Test Application window.

6. If a problem occurs, check: 

● the board configuration

● the physical connections between the board and the PBX

● the PBX configuration itself

Table 25: Status messages for Dialogic Line Test

Status Description Highlight

Channel starting� The channel is being started. Normal

Channels idle� The channel is idle. Normal

Waiting for call� The channel is waiting for an incoming call. Normal

Received call� An incoming call is being processed. Normal

Dialling number� A number is being dialed to make an outgoing call. Normal

Resetting� The user reset the channel. Normal

Line Busy. An outgoing call was made, but a busy tone was detected. Normal

No Answer. An outgoing call was made, but the call was not answered. Normal

Connected. An incoming or outgoing call was answered, so the call is 
now connected.

Normal

Call was 
disconnected.

An incoming or outgoing call was disconnected. Normal

Error. A general error with the channel occurred. Error

Error, No Dial tone 
detected.

An outgoing call was made, but no dial tone was detected 
before dialing.

Error
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For example, verify that you have configured the correct PBX type and administered the 
values according to the current configuration notes. 

7. After port board testing is complete, continue as appropriate: 

● For a customer-provided MAS, continue with Setting up remote access on page 112. 

● For an Avaya MAS, continue with Chapter 8: Configuring the voice mail system on 
page 113. 
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Appendix E: Updating Modular Messaging software

You must update the Avaya Modular Messaging software after an installation or upgrade to 
bring it up to date with the latest changes. Software updates might include the latest Avaya 
Service Pack (SP) or Avaya software patches (hotfixes). 

Topics in this appendix include: 

● Obtaining software updates from the Web on page 279

● Installing software updates on each MAS on page 280

Considerations for applying updates include: 

● You can apply multiple hotfixes to a system. 

● Modular Messaging components can have multiple updates applied to them. 

● If you apply a Service Pack, the program automatically uninstalls all previously applied 
hotfixes, patches, and Service Packs. 

Obtaining software updates from the Web
Obtain the latest Avaya software updates from the Web. 

To obtain any Avaya software updates for this system: 

1. Use a computer that can access the Internet. 

2. Go to the Avaya Support Web site at http://www.avaya.com/support. 

a. Click the link to Find documentation and downloads by product name. 

b. Under M, click Modular Messaging. 

c. On the Modular Messaging page, select Release 3.0 from the drop-down list. 

3. Click Downloads.

a. Download any files needed to update the Modular Messaging system. 

Note:
Note: Ensure that you download both the software files and any instructions required to 

install the Service Pack or software patch.

b. Copy the downloaded files to a USB storage device.

c. The files are often bundled in a compressed archive, such as a zip file. Use the 
appropriate tools on your computer to extract the files into an appropriate directory. 

http://www.avaya.com/support
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Installing software updates on each MAS
To start the update procedure, you must copy the Avaya software updates to each MAS. You 
then run an installation wizard to install the updates. 

Copying files to the MAS
To copy the Avaya software updates to an MAS: 

1. Switch the monitor to show the appropriate MAS. 

2. Insert the USB drive into any USB port on the server. 

● You can use any of the available USB ports on the back of the server. 

● You must remove the front bezel to access the USB port on the front of an Avaya 
S3500-family message server. 

3. Copy the software update files to the MAS:

a. Open Windows Explorer. 

b. Navigate to the appropriate directory on the USB storage device, Removable Disk (E:). 
c. Right-click the software update file that you downloaded in Obtaining software updates 

from the Web on page 279. For example, file MAS300100.exe. Select Copy. 

d. Navigate to the C:\Avaya_Support directory. 

e. Right-click in a blank area in the right pane, and select Paste. 

f. Verify that the correct file is listed in the C:\Avaya_Support directory. 

g. If you downloaded more than one file, repeat Steps c through f to copy all the software 
files and the update instructions. to the MAS. 

4. Safely remove the USB drive from the server: 

a. Double-click the icon on the task bar to Safely Remove Hardware.

b. Follow the prompts to safely remove the USB drive. 

5. Repeat Steps 1 through 4 for each MAS in the system. 

6. Open and review the installation instructions for this specific software update. If needed, 
modify the instructions in this guide to complete the update.
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Installing the updates on each MAS
To install the Avaya software updates on this MAS: 

1. Double-click the software update file the MAS, such as MAS300100.exe. 

The program unpacks the file, and then runs the Modular Messaging Installation Wizard. 

2. In the Modular Messaging Installation Wizard window: 

a. Verify that all applicable patches for this system are selected. 

b. Click Install. 
If the Install button is not active, you do not need to apply these software updates to the 
system. Continue with Step 6. 

Note:
Note: For installation procedures and a description of components that can be installed, 

click the Help button on the installation wizard window.

3. If you are installing a Service Pack (SP), an Installation Wizard - Update Warning window 
opens. The window displays the hotfixes and Service Packs that the program must uninstall 
before the update can proceed. Click Continue. 

Note:
Note: If hotfixes are applied to the system that are not included in the SP update, the 

program lists them with a warning.

4. If this system does not have the correct version of Windows Installer, you must install it now. 
Otherwise, continue with Step 5: 

a. The Open File - Security Warning window prompts you to install a WindowsInstaller 
application from Microsoft Corporation. Click Run. 

b. Follow any additional prompts to install the new Windows Installer application. If the 
program prompts you to restart the server, reboot the system. 

c. If the new version of Windows Installer fails to install, you must install the updated 
WindowsInstaller application before you can proceed. For example, you might need to 
download the application separately, and install it using the local administrator account 
for this MAS. 

5. After you click Install, monitor the software update progress: 

a. In the Services window, the Modular Messaging Installation Wizard stops all appropriate 
Modular Messaging and related services. 

b. Windows Installer then installs all relevant software updates on the MAS.

c. In the Services window, click Continue with installation. You do not have to wait for all 
services to restart.

d. After the installation is complete, click Close. 
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6. To verify the software updates that are installed on this MAS: 

a. Click Start > Settings > Control Panel.
b. From the Control Panel window, double-click Add/Remove Programs.

c. In the Add/Remove Programs window, click Show updates. 

d. Scroll down the list of installed programs to locate the Modular Messaging components 
installed on this computer. Modular Messaging components start with MM. 

e. Locate the software updates by name and installation date. For example: 

● MM Caller Applications Editor Service Pack 7 
● MM Mailbox Monitor Server Patch 200-7953 
● MM Messaging Application Server Hotfix 1

f. Click any update to show support information, or to remove the update. 

7. After installation and verification is complete, close all open windows. 
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Appendix F: Reloading software on an Avaya MAS 

This appendix describes how to reload the operating system and application software on an 
Avaya Messaging Application Server (Avaya MAS) or an Avaya-provided supplementary server. 
You might install new software after a hard disk is replaced or as part of the upgrade of an 
Avaya MAS. 

If a replacement disk drive is not provided, you will need to reload the operating system and 
application software for an Avaya MAS upgrade. See Upgrading Modular Messaging 
Software on page 174 for more information.

Loading new MAS software
To copy new software to the Avaya Messaging Application Server (Avaya MAS) or 
Avaya-provided supplementary server:

1. If the server is not on, turn on the server now by pressing the power button on the front of 
the server. For more information, see Turning on an S3500-family server system on 
page 42. 

2. Verify that the monitor is showing the correct server.

● For a 2-port Belkin KVM switch, the MAS is connected to one of the two computer ports. 

● For an 8-port Belkin KVM switch, the first MAS port is labeled VGA 02. Subsequent 
MASs and any supplementary servers, if present, are connected to computer ports 
VGA 03, VGA 04, and so on. 

3. If the monitor displays a different server, toggle the ports to show the correct server. 

● To have a 2-port Belkin KVM switch show a different server:

a. Slowly press Scroll Lock twice. 

The LED on top of the Belkin KVM switch starts to blink.

b. Type the port number on the keyboard. For example, type 2 for port 2. 

● To have an 8-port Belkin KVM switch show a different server: 

a. Slowly press Scroll Lock twice within 2 seconds.

b. Select the server to display using one of these methods: 

- Press the up (or down) arrow key to change to the server connected to a higher (or 
lower) port number. 

- Type the port number on the keyboard. For example, type 2 for port 2. 

For complete user and troubleshooting instructions, see the KVM switch documentation. 
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Loading the new software
To load the new software:

1. Insert Disk 1 of the Avaya Modular Messaging Avaya Messaging Application Server and 
Boot Software for Microsoft Exchange media into the DVD drive.

Wait for green LED on the drive to go out. 

2. Press Ctrl + Alt + Del to reboot the system.

a. In the Windows Security window, click Shut Down...
b. In the Shut Down Windows window, select Restart and click OK.

3. When the computer starts to boot, the system displays a warning that the hard drive 
contents will be overwritten. 

a. Press any key to continue. 

A message confirms that the hard drive will be overwritten.

b. Press any key to continue. 

The MAS starts to copy the disk image to the hard disk. The entire copy procedure takes up 
to 30 minutes per DVD. 

4. When the system prompts you, insert the next disk. When the DVD drive light turns dark, 
click OK.

5. Repeat step 4 for disk 3.

6. When prompted, remove the media before the system reboots. Press any key to continue.

The system reboots and runs the Windows Setup program.

7. If a modem is connected, a Hardware Installation window opens. Click Yes to continue the 
installation.

8. The Windows Setup wizard runs. To complete the wizard:

a. On the Welcome screen, click Next. 
b. On the License Agreement screen, choose I accept this agreement. Click Next.
c. On the Your Product Key screen, type the Windows product key for this server. 

Note:
Note: Each Windows computer has a unique product key for the Windows 2003 

operating system. Enter the number exactly as shown. 

Record the Windows product key in Table 23: Windows product keys for 
MASs on page 228. 
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- For a new S3500-family server, the product key sticker is located inside the empty 
drive tray on the lower-left of the server chassis. You can remove the drive tray to 
easily read the sticker.

- For a Release 3 upgrade, the Windows 2003 sticker ships with the software. Paste 
this sticker onto the server. Do not enter the old Windows 2000 product key.

d. Click Next.
The server automatically reboots. 

Note:
Note: On servers that use the latest motherboard, you might see the error message 

System Event Log Full when the system boots. You can ignore this message. 
Modular Messaging does not use this log. 

Preparing the server to boot
You must load all required information and active the operating system before you activate the 
server configuration program:

1. When the system prompts you to log on:

a. Press Ctrl+Alt+Del. 
b. In the Log On to Windows window, leave the user name as Administrator. 
c. Leave the password field blank. 

d. Press Enter or click OK. 

2. You must activate the Microsoft Windows operating system before you restart the server. 
Use the site-specific procedures to activate Windows. 

! CAUTION:
CAUTION: You must copy the latest DCT data file to the C:\Avaya_Support directory now. 

Some servers do not recognize a USB drive after a system restart.

3. You must activate the Microsoft Windows operating system before you restart the server. 
For more information, see Activating Microsoft Windows on page 286.

4. To complete the software reload, double-click the MM_Setup icon on the desktop. 

An MM_Setup window opens. 

a. When the system prompts you, press any key to continue. 

The program reports that Modular Messaging configuration will start after the server 
reboots. 

b. Press any key to continue. 

The computer stores the information and shuts down. 
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5. To bring the MAS into service, continue with the appropriate procedure:

● For an Avaya MAS upgrade, see Running the Modular Messaging Configuration 
Wizard on page 174. 

● For an Avaya MAS disk failure recovery, see Appendix G: Disk Failure Recovery on 
page 289.

Activating Microsoft Windows
You must activate the Microsoft Windows operating system whenever you reload the operating 
system. You must activate the Windows operating system before you restart the MAS. 

The Microsoft Windows activation procedure requires you to use either the Internet or a 
telephone. Use the most appropriate method for the customer site: 

● For Internet activation, continue with Activating Microsoft Windows through the Internet on 
page 286. 

● For telephone activation, continue with Activating Microsoft Windows using a telephone on 
page 287. 

Activating Microsoft Windows through the Internet

To activate the Microsoft Windows operating system through the Internet: 

1. Double-click the Internet Explorer icon on the desktop. 

2. At the Enhanced Security message, click OK. 

3. In the Internet Explorer window, click Tools > Internet Options. 

a. In the Internet Options window, click the Connections tab. 

b. Click LAN Settings. 

c. In the Local Area Connection (LAN) Settings window, specify the settings to use for this 
site. Click OK. 

d. Click OK to close the Internet Options window. 

e. Close Internet Explorer. 

4. Click Start > Activate Windows.

5. In the Activate Windows window:

a. Click Yes, let�s activate Windows over the Internet now.

b. Click Next. 
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c. When the system prompts you to register the system, click No. 

The program checks for Internet connectivity. If connectivity fails, you can set up or adjust 
the Internet connections. Complete the screen and click Next to continue. 

6. On the Thank you screen, click OK. 

Activating Microsoft Windows using a telephone

To activate the Microsoft Windows operating system using a telephone: 

1. Click Start > Activate Windows.

2. In the Activate Windows window:

a. Click Yes, I want to telephone a customer service representative to activate 
Windows.

b. Click Next. 
The program generates a new installation ID. 

3. On the Activate Windows by phone screen: 

a. Select the country in which this Modular Messaging system is installed. 

b. Call the appropriate telephone number shown on the screen. 

c. Follow the voice prompts or the directions from the customer service representative to 
provide the unique installation ID shown on the screen. 

d. Enter the confirmation ID that the automated system or customer service representative 
gives you. 

e. Click Next. 
4. On the confirmation screen, click Finish.
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Appendix G: Disk Failure Recovery

This appendix describes the procedure for recovering from a catastrophic disk failure on a 
system that is running Modular Messaging Release 3 software. See the checklist that is 
appropriate for your MAS:

For an Avaya MAS, see Recovering from a catastrophic disk failure on an Avaya MAS on 
page 290.

For a customer-provided MAS, see Recovering from a catastrophic disk failure on a 
customer-provided MAS on page 296.

If this MAS contained the Offline Folder Share, you must recreate the folder manually. When 
you reach that point in the procedure, see Creating the offline message share, if needed on 
page 302
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Recovering from a catastrophic disk failure on an Avaya 
MAS

Overview
In summary, to restore an Avaya MAS you will need to:

1. Replace the failed drive

2. Install a new Avaya boot image

3. Run the Modular Messaging setup utility

4. Run the Modular Messaging Configuration wizard

5. Administer anti-virus software

6. Install Modular Messaging Active Directory Exchange extensions

7. Restore customer data

8. Configure the voice mail system

9. Configure services

10. Perform acceptance tests on the entire system

11. Back up the restored system and hand it off to the customer

Table 26: Avaya MAS restore procedure on page 292 lists the steps necessary to restore an 
Avaya MAS. It contains page references to detailed instructions for each step.

Requirements for restore of Avaya MAS
To successfully restore a system to Modular Messaging Release 3, you need:

● A replacement hard disk drive.

● Release 3 of the Modular Messaging application software. 

- Avaya Modular Messaging Avaya Messaging Application Server and Boot Software for 
Microsoft Exchange media 

- Avaya Modular Messaging Messaging Application Server Software media 

- Avaya Modular Messaging Documentation

● The following information and software from the Avaya Support Web site at http://
www.avaya.com/support. For more information about how to access these items on the 
Web site, see Required documentation and software on page 1. 

http://www.avaya.com/support
http://www.avaya.com/support
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- The most current copy of the configuration notes for this switch integration. 

- Avaya software updates that are required to bring the Avaya Modular Messaging 
software up to date after a restore. Download this software to a USB storage device. For 
more information about downloading the updates, see Updating Modular Messaging 
software on page 279.

- The latest copy of the Data Collection Tool. Download the DCT update file, 
MMDCTDistribute.exe, from the Avaya support site. Download it to a USB storage 
device.

● A completed copy of all relevant forms in Appendix A: System planning forms on page 209 
and a printed copy of Table 26: Avaya MAS restore procedure on page 292. 

Note:
Note: A completed copy of the planning forms should be on file from the previous 

installation. Review these forms and verify that all fields are completed. 

● A copy of the customer-provided Microsoft Exchange 2003 media or equivalent access to 
the 2003 System Management Tools and the Microsoft Exchange 2003 Service Pack 2.

● Access to the most recent DCT backup file as well as any backup files that will need to be 
restored to the system.

To restore an MAS configuration after a catastrophic disk failure, you must have a previously 
saved and updated Data Collection Tool (DCT) file. For information about maintaining a current 
DCT file, see Creating a Data Collection Tool File on page 156.

! CAUTION:
CAUTION: You will not be able to restore the MAS without a DCT file that was created by 

analyzing the system.

Include the updated DCT file in any regular, scheduled backups administered for this site so that 
the file is available if needed for a restore.
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Restoring the Avaya MAS
To restore the MAS, complete the tasks in the following checklist. As you complete a task, make 
a check mark in the " �column. For additional information or detailed procedures, see the 
referenced page number.

Table 26: Avaya MAS restore procedure

Procedure Page Comments

Download required Avaya software updates. This 
includes the latest Data Collection Tool.

3 Web access required.

Collect any software media that is needed for the 
upgrade, such as Microsoft Windows updates or 
anti-virus software. 

152 Leave customer media 
on-site.

Obtain the Exchange System Management Tools 2003 
and Service Pack 2 from the customer.

Obtain and review the configuration notes for any 
changes. 

Web access required.

Replace the hard drive. (For instructions for replacing an 
Avaya S3500 MAS hard drive, see the Modular 
Messaging S3500-Family Hardware Maintenance and 
Additions manual. For instructions for replacing an 
Avaya S3400 MAS hard drive, see Replacing an MAS 
drive in an S3400-family server on page 162.)

Copy the backup DCT data file to a USB storage device 
with the DCT update file, MMDCTDistribute.exe.

Verify that all additional backup files that must be 
restored are at a location accessible to the MAS. This 
includes:

● customized tone files
● customized prompt files
● caller applications
● Avaya license files.
● SIP certificate files
● WSO system services data file

147 See Backing up the 
system on page 147, for 
a complete list of the file 
names and their 
locations on the system.

Use whatever method is required at this site to have the 
monitor display the Avaya MAS that you are restoring. 

154
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Install a new boot image
1. Insert the Avaya Modular Messaging Avaya 

Messaging Application Server and Boot Software 
for Microsoft Exchange media in the DVD drive of 
the MAS.

2. Start the computer and insert or remove disks as 
prompted.

171

Install the Windows license. 171

Perform Windows Product Activation (WPA) to activate 
the operating system.

171

Copy the backup DCT file to the MAS. 173

Update the Data Collection Tool on the MAS. 173

Before beginning installation of the Modular Messaging 
software, be sure you are logged in to the MAS using 
the Modular Messaging customer account. See item 
A12 in Table 18: Modular Messaging logon accounts 
form on page 221.

Run MM_Setup from the desktop. The machine shuts 
down after the utility runs.

172

When the Modular Messaging Configuration Wizard 
launches, click Next on the Welcome screen. Select the 
back up DCT file by selecting the file if it is displayed on 
the Locate Configuration Data screen or by browsing to 
the file at the location where you placed it. 

174

Review the DCT file and complete any empty fields. 
Save the file.

174

On the MAS Number screen, select the number of the 
MAS that you are recovering.

174

Complete the Windows Setup wizard and continue with 
the Modular Messaging Configuration Wizard.

174

Install Exchange 2003 System Management Tools. 175

Install Exchange Server 2003 SP2. 175

Install MSDE. 175

Install anti-virus software. 175

Table 26: Avaya MAS restore procedure

Procedure Page Comments
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After third part software is installed, complete the 
configuration wizard.

176

Administer anti-virus software. 178

Install Modular Messaging software updates. 179

Update Microsoft Windows with any new patches. 
Follow site-specific procedures.

180

Disable the private LAN. 180

Create an offline message share, if needed. 302

Install Modular Messaging Active Directory Exchange 
extensions on the MAS.

71

Configure port boards, if necessary. 111 Step is required only for 
port boards that do not 
use one of the 
automatic-configuration 
switch integrations. This 
is first step in port board 
configuration. 
Configuration is 
completed later in 
procedure.

Resynchronize the FEDB. 181

Restore customer data including:
● customized tone files
● customized prompt files
● caller applications
● SIP certificate files
● WSO system services data file

181

Specify the preferred language for the MAS. 115

Verify that Modular Messaging service is started before 
configuring the voice mail system.

115

If this is the MAS that held the Avaya license file, 
transmit the backup license file to the MAS using the 
preferred customer method. The recommended location 
for the license file is on MAS #1 in the C:\Avaya_Support 
directory. Install the license.

120

Verify license installation. 121

Table 26: Avaya MAS restore procedure

Procedure Page Comments
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Configure specific features as needed, including:
● Call Me service
● MWI service
● Languages or TTS
● Offline access to messages

122

Configure MAS-specific parameters:
● INADS alarming, if used
● Port boards
● Switch integration

125

Restart messaging service. 128

Verify call-handling capability. 131

Verify alarming setup. 131

Verify Tracing Service operation, if you installed Tracing 
Server software on an MAS or supplementary server.

132

Set up test subscribers for each TUI used on the site, if 
they do not already exist in Active Directory.

136

Run all acceptance tests that are relevant to the system. 140

Verify creation of external caller objects including:
Validate proxy addresses
Validate mailbox rights

146

Backup the MAS using the regular backup procedures 
for this site. Be sure to include the revised DCT file in 
this backup.

147

Run the following tests:
● Disk defragmenter system tool
● chkdsk command

178

Complete steps necessary to turn the system over to the 
customer.

149

Table 26: Avaya MAS restore procedure

Procedure Page Comments
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Recovering from a catastrophic disk failure on a 
customer-provided MAS

Overview
There may be site-specific requirements and procedures for recovering from a catastrophic disk 
failure. Use the procedures appropriate to your site. The following is one procedure that can be 
used to recover the CPE MAS.

In summary, to restore a customer-provided MAS you will need to:

1. Replace the failed drive.

2. Configure a network card to support the corporate LAN connection

3. Manually join the Windows domain

4. Install and enable Windows services

5. Install the Modular Messaging Configuration Wizard

6. Run the Modular Messaging Configuration wizard

7. Administer anti-virus software

8. Install Modular Messaging Active Directory Exchange extensions

9. Restore customer data

10. Configure the voice mail system

11. Configure services

12. Perform acceptance tests on the entire system.

13. Back up the restored system and hand it off to the customer.

Table 27: CPE MAS restore procedure on page 298 lists the steps necessary to restore a 
customer-provided MAS. It contains page references to detailed instructions for each step.

Requirements for restore of CPE MAS
To successfully restore a system to Modular Messaging Release 3, you need:

● A replacement hard disk drive.

● Release 3 of the Modular Messaging application software. 

- Avaya Modular Messaging Messaging Application Server Software media
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- Avaya Modular Messaging Documentation

● The following information and software from the Avaya Support Web site at http://
www.avaya.com/support. For more information about how to access these items on the 
Web site, see Required documentation and software on page 1. 

- The most current copy of the configuration notes for this switch integration. 

- Avaya software updates that are required to bring the Avaya Modular Messaging 
software up to date after a restore. Download this software to a USB storage device. For 
more information about downloading the updates, see Updating Modular Messaging 
software on page 279.

- The latest copy of the Data Collection Tool. Download the DCT update file, 
MMDCTDistribute.exe, from the Avaya support site. Download it to a USB storage 
device.

● A completed copy of all relevant forms in Appendix A: System planning forms on page 209 
and a printed copy of Table 26: Avaya MAS restore procedure on page 292.

Note:
Note: A completed copy of the planning forms should be on file from the previous 

installation. Review these forms and verify that all fields are completed. 

● A copy of the customer-provided Microsoft Exchange 2003 media or equivalent access to 
the 2003 System Management Tools and the Microsoft Exchange 2003 Service Pack 2.

● Access to the most recent DCT backup file as well as any backup files that will need to be 
restored to the system.

To restore an MAS configuration with this procedure after a catastrophic disk failure, you must 
have a previously saved and updated Data Collection Tool (DCT) file. For information about 
maintaining a current DCT file, see Creating a Data Collection Tool File on page 192.

! CAUTION:
CAUTION: You will not be able to restore the MAS without a DCT file that was created by 

analyzing the system.

Include the updated DCT file in any regular, scheduled backups administered for this site so that 
the file is available if needed for a restore.

http://www.avaya.com/support
http://www.avaya.com/support
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Restoring the CPE MAS
To restore the MAS, complete the tasks in the following checklist. As you complete a task, make 
a check mark in the " �column. For additional information or detailed procedures, see the 
referenced page number.

Table 27: CPE MAS restore procedure

Procedure Page Comments

Download required Avaya software updates. This 
includes the latest version of the Data Collection Tool.

3 Web access required.

Obtain the backup DCT data file. Copy it to a USB 
storage device with the DCT update file, 
MMDCTDistribute.exe.

Obtain the Exchange System Management Tools 2003 
and Service Pack 2 from the customer.

Obtain virus-checking software for the MAS if required. 4 Customer obtains. 

Replace the hard drive. (For instructions for replacing a 
CPE MAS hard drive, see the manufacturers 
instructions.)

Install the Windows 2003 Server operating system.

Configure a network card to support the corporate LAN 
connection.

94

Manually join the Windows domain. 95

Adjust server default values to support Modular 
Messaging. Adjust:

● Event Viewer values
● File and Printer Sharing properties
● Windows 2003 Server operating system values

96

Add the MM customer account and technical support 
account to the local administrators group.

97

Install Microsoft Windows SP1. 99

Install and enable Windows services, as required. 99

Verify that the USB storage device with the DCT file and 
DCT tool update is inserted in the USB port.

103
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Copy the backup DCT file to a directory on the MAS. 102

Update the Data Collection Tool on the MAS. 103

Verify that all additional backup files that must be 
restored are at a location accessible to the MAS. This 
includes:

● customized tone files
● customized prompt files
● caller applications
● Avaya license files.
● SIP certificate files
● WSO system services data file

147

Before beginning installation of the Modular Messaging 
software, be sure you are logged in to the MAS using 
the Modular Messaging customer account. See item 
A12 in Table 18: Modular Messaging logon accounts 
form on page 221.

Install the Modular Messaging Configuration Wizard and 
enable the checkbox to launch the wizard.

102

When the Modular Messaging Configuration Wizard 
launches click Next on the Welcome screen. Select the 
back up DCT file by selecting the file, if displayed on the 
Locate Configuration Data screen, or by browsing to the 
file at the location where you placed it. (In the procedure, 
complete the steps for an existing DCT file, selecting the 
backup file.)

103

Review the DCT file and complete any empty fields. 
Save the file.

103

On the MAS Number screen, select the number of the 
MAS that you are recovering.

106

Install Exchange 2003 System Management Tools. 107

Install Exchange Server 2003 SP2. 107

Install MSDE. 107

Install Anti-virus software. 107

After third part software is installed, complete the 
configuration wizard.

108

Install updates to Modular Messaging software. 109

Table 27: CPE MAS restore procedure

Procedure Page Comments
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Set logging location if other than default. 110

Administer anti-virus software. 110

Create an offline message share, if needed. 302

Install Modular Messaging Active Directory Exchange 
extensions on the MAS.

71

Configure port boards, if necessary. 111 Step is required only for 
port boards that do not 
use one of the 
automatic-configuration 
switch integrations. This 
is first step in port board 
configuration. 
Configuration is 
completed later in 
procedure.

Restore customer data including:
● customized tone files
● customized prompt files
● caller applications
● SIP certificate files
● WSO system services data file

Specify the preferred language for the MAS. 115

Verify that Modular Messaging service is started before 
configuring the voice mail system.

115

If this is the MAS that held the Avaya license file, 
transmit the backup license file to the MAS using the 
preferred customer method. The recommended location 
for the license file is on MAS #1 in the C:\Avaya_Support 
directory. Install the license.

120

Verify license installation. 121

Configure specific features as needed, including:
● Call Me service
● MWI service
● Languages or TTS
● Offline access to messages

122

Table 27: CPE MAS restore procedure

Procedure Page Comments
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Configure MAS-specific parameters:
● INADS alarming, if used
● Port boards
● Switch integration

125

Restart messaging service. 128

Verify call-handling capability. 131

Verify alarming setup. 131

Verify Tracing Service operation, if you installed Tracing 
Server software on an MAS or supplementary server.

132

Set up test subscribers for each TUI used on the site, if 
they do not already exist in Active Directory.

136

Run all acceptance tests that are relevant to the system. 140

Verify creation of external caller objects including:
● Validate proxy addresses
● Validate mailbox rights

146

Backup the MAS using the regular backup procedures 
for this site. Be sure to include the revised DCT file in 
this backup.

147

Run the following tests:
● Disk defragmenter system tool
● chkdsk command

Complete steps necessary to turn the system over to the 
customer.

149

Table 27: CPE MAS restore procedure

Procedure Page Comments
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Creating the offline message share, if needed
Do this task only if the Offline Message Store is to be located on this MAS. 

In a multiple-MAS system that uses the Offline Access feature, the system requires an offline 
message store to synchronize messages among the MASs. If the folder for offline message 
access is to be located on this MAS, you must first create the shared folder for the offline 
messages. The folder must be available before you can administer the Offline Access feature. 

To create a shared folder for offline messages with the correct permissions:

1. Using Windows Explorer, create a new folder on this MAS. For example, create OfflineStore 
on the C: drive. For the correct folder name, see Item 10 in Table 14: Modular Messaging 
System Planning Form on page 213. 

2. Right-click the folder name and select Sharing and Security. 

3. In the Properties window, on the Sharing tab:

a. Select Share this folder. 
b. Verify the Share name. For example, OfflineStore.

c. Click Permissions.

1. In the Permissions window, add the appropriate Modular Messaging logon accounts. 
See Table 18: Modular Messaging logon accounts form on page 221.

2. Give the correct share permissions to the accounts. In the Permissions window:

- Select each account in turn.

- In the Permissions box, under Allow, select the permissions Change and Read, 
so the boxes are checked.

- Repeat this task for each logon account.

3. Click OK to close the Permissions window.

4. In the Properties window, click the Security tab. 

a. Click Add.

b. Add all the Modular Messaging computer accounts that will access the offline storage 
server.

c. Give the correct share permissions to these accounts. In the Properties window:

1. Select each account in turn.

2. In the Permissions box, under Allow, select the following permissions so the boxes 
are checked:

- Modify

- Read & Execute

- List Folder Contents
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- Read

- Write

3. Repeat this task for each logon account and each MAS local service account.

5. Click OK to close the Properties window.

6. Stop and restart MM Message Application Service on each MAS in the system for the offline 
access permissions to take effect.
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Appendix H: Administrator reference

This appendix details the permissions and data schema modifications that are required to 
support Modular Messaging software in a Microsoft Exchange environment. 

Exchange 2000 or 2003 permissions
Avaya Modular Messaging customer account permissions are covered in Assigning 
permissions to the customer account group on page 62. This section details why the Modular 
Messaging customer account must be added to the following groups:

● The BuiltIn/Account Operators group in each domain contains accounts that will be 
enabled for Avaya Modular Messaging. This ensures that the Modular Messaging software 
has rights to perform the following operations:

- Provide full access to the ms-Exch-Extension-Data attribute for user objects that are to 
be enabled for Modular Messaging. This access right is required to enable Modular 
Messaging subscriber accounts.

- Create container objects. Avaya Modular Messaging creates a voice mail domain 
container. By default, the voice mail domain container is located at the root of the domain 
for which the Modular Messaging customer account is a member. This container stores 
the directory objects required for the Messaging Application Server and Mailbox Monitor 
Server software components.

If the Modular Messaging customer account does not have sufficient privileges to create 
container objects at the base location of the domain that contains the customer account, 
a voice mail domain container must be created manually. For this procedure, see 
Creating the voice mail domain container manually if required on page 64.

- Create User objects, and mailbox-enable User objects, in the voice mail domain 
container. This right is required for the operation of the Messaging Application Server and 
Mailbox Monitor Server software.

● The BuiltIn/Administrators group in the domain that contains the Global Catalog servers, 
that will be used as peer-directory servers for Avaya Modular Messaging servers. This can 
be the domain that contains the customer account, or any sub-domain that contains the 
customer account. The right enables the Modular Messaging software to obtain search 
results from the peer-directory server, including recently deleted objects. This allows 
Avaya Modular Messaging to maintain consistency in its Front End Database (FEDB).

The following table details the property permissions required to support Modular Messaging and 
their purpose. It also indicates the lowest level in the Exchange Service property tree that this 
permission should be applied.
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Table 28: Required switch and messaging information

Permission Description Applies to 
this object 
and 
subcontainer
s

Modular 
Messaging 
requirement 

Read Read permission for items in 
container

Mailbox Store Core requirement

Execute Execute permission for items in 
container

Mailbox Store Automatic with 
�Read�

Read Permissions Ability to read the permissions for 
an object

Mailbox Store Automatic with 
�Read�

Create Children Ability to create an object below 
the current object

Connectors Octel Analog 
Networking

List Contents Displays the contents and 
children of an object

Exchange 
Organization

Exchange System 
Manager

Read Properties Allows for Properties to be read 
from the class object

Administrative 
Group

Core requirement

Write Properties Allows for existing class object 
Properties to be written to

Connectors Octel Analog 
Networking

Administer 
Information Store

Allows creation of objects at root 
of folder

Mailbox Store Voicemail Domain 
Mailbox

Create Named 
Properties in the 
Information Store

Allows new properties to be 
added to the class object

Mailbox Store User Admin

View Information 
Store Status

Required for MAPI Logon Mailbox Store External Caller 
Mailbox

Receive As Receive on behalf of privilege Mailbox Store Core requirement

Send As Send on behalf of privilege Mailbox Store Core requirement
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Active Directory schema updates
Avaya Modular Messaging software requires the following changes to be made to the schema 
in an Exchange 2000 or 2003 environment before any other Modular Messaging server 
components are installed, you must:

● Enable replication of the ms-Exch-Extension-Data attribute in the Global Catalog.

● Increase the maximum amount of data that can be stored in the ms-Exch-Extension-Data 
attribute to 64KB. This increased storage is used for G7.11 audio encoding format, which 
is typically used only on systems that support Teletypewriter (TTY).

● Add classes and attributes for Octel Analog Messaging (if applicable).

The Modular Messaging software stores information about subscriber configurations in the 
ms-Exch-Extension-Data attribute. So that Modular Messaging MASs can obtain this 
information, this attribute must be replicated in the Global Catalog, a central repository for 
information about objects in the Windows 2000 or 2003 forest. When the replication is enabled, 
the system instructs the Global Catalog servers to include the ms-Exch-Extension-Data 
attribute in the list of objects replicated in the Windows 2000 or 2003 forest.

Replication of the ms-Exch-Extension-Data in the Global Catalog is also necessary for the 
correct operation of the Modular Messaging Client software (formerly called the Subscriber 
Options package). This is because the MAPI address book provider for Active Directory uses 
the Global Catalog as its data source. Replication is required for MAPI to support access to 
client applications, such as the MM Client software, through the 
PR_EMS_AB_EXTENSION_DATA property.

When the Modular Messaging Subscriber Administration extensions software component is 
installed, the software makes the following changes:

● Adds a Modular Messaging property page for each user in Active Directory Users and 
Computers. More specifically, the guide �A6688A44-CEDE-456E-AE57-3567D9909AE7� 
is added to the multi-valued attribute adminPropertyPages on the user-Display object, 
which has the dn: CN=user-Display,CN=409, 
CN=DisplaySpecifiers,CN=Configuration,DC=mycorp,DC=com.

● Copies files for the software components required to display the Modular Messaging 
property page to the Program Files\Avaya Modular Messaging directory.
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Appendix I: Removing Modular Messaging 
components from an MAS

This appendix describes how to remove Modular Messaging software components from a 
server where they are currently installed. Normally this procedure is used to prepare a server for 
reassignment to another purpose.

! CAUTION:
CAUTION: Do not uninstall any of the following Modular Messaging services from an MAS 

that is running the Messaging Application Server service.

To stop running unneeded services on an in-service MAS, move services to other 
servers using the Modular Messaging administration tools and disable the 
services that the server does not need. 

● MM Alarming Server service 

● MM Call Me

● MM Event Monitor Server

● MM Mailbox Monitor 

● MM Messaging Application Server 

● MM MWI

● MM Performance Monitor Server

● MM Process Monitor Server

● MM Service Connector

● MM Tracing Server



Removing Modular Messaging components from an MAS
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Removing software components
To remove Modular Messaging software components, use the Modular Messaging 
Uninstallation Wizard.

1. Click Start > Settings > Control Panel.
2. From the Control Panel window, double-click Add/Remove Programs.

3. In the Add/Remove Programs window, scroll down the list of currently installed programs to 
MM Uninstallation Wizard.

! Important:
Important: Do not use Add/Remove Programs to uninstall the MM services listed. Use only 

the MM Uninstallation Wizard.

4. Select the Modular Messaging software components that you want to remove.

5. Click Uninstall and follow the prompts to confirm your choices.

6. The removed components will continue to appear in the Add/Remove Programs list until 
you close and reopen Add/Remove Programs.
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MAS administration
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MAS-like units, see supplementary server
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Message Networking

planning   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  210
Message Waiting Indicator - Voice Mail Domain window123
Message Waiting Indicator (MWI) Server.  .  .  . 123, 224
Messaging - Voice Mail Domain window .  .  .  .  .  .  124
Messaging Application Server .  .  .  .  .  .  .  .  .  .  .  224
Messaging Application Server (MAS)   .  .  .  .  .  .  .  212
Messaging Application Server (MAS), see MAS
messaging services to install   .  .  .  .  .  .  .  .  .  .  .  223
Microsoft Windows Service Pack 1   .  .  .  .  .  .  .  .  . 99
Microsoft Windows services required   .  .  . 99, 100, 196
Microsoft Windows services, see Windows services



314 Avaya Modular Messaging for Microsoft Exchange Release 3 Installation and Upgrades

 

Index

Microsoft Windows updates 4, 88, 99, 101, 180, 198, 199
MISCM directory .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 263
MM Aria interface

acceptance tests  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 143
test subscriber  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 226

MM AUDIX interface
acceptance tests  .  .  .  .  .  .  .  .  .  .  .  .  .  142, 143
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test subscriber  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 226
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PBXpert utility for tones file  .  .  .  .  .  .  .  .  .  . 253, 259
PBXpert wizard.  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 254, 255
performing acceptance tests   .  .  .  . 142, 145, 177, 205
permissions

remote access   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 67
permissions for service account .  .  .  .  .  .  .  .  .  .  305
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MAS features list   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  223
Modular Messaging logon accounts form  .  .  .  .  221
Modular Messaging MAS planning form.213, 216, 217
obtaining  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 2
switch and messaging information  .  .  .  .  .  .  .  225
upgrades .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  . 155, 191

Point-to-Point Protocol, see PPP   .  .  .  .  .  .  .  .  .  212
port boards

configuring  .  .  .  .  .  .  . 54, 128, 263, 265, 266, 269
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moving for upgrades.  .  .  .  .  .  .  .  .  .  .  .  .  .  184
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primary language .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  124
product ID number  .  .  .  .  .  .  .  .  .  .  .  .  .  . 118, 227
Prompt Files  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  224
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